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PRIMEROS PASOS

APRENDIENDO MUSESCORE
Tours
Partitura "Primeros pasos"
Tutoriales de video
Otros tutoriales

VÍDEOS

OBTENGA SOPORTE
Manual de usuario
Ayuda contextual
Foros
Como hacer...
Escriba una pregunta
Reportar un error

INSTALACIÓN
Instalación
Configuración inicial

INSTALAR EN WINDOWS
Instalar

Iniciar MuseScore

Desinstalar
Problemas comunes
Enlaces externos

INSTALAR EN MACOS
Instalar
Desinstalar
Instalar con Apple Remote Desktop
Enlaces externos

INSTALAR EN LINUX
AppImage

Paso 1 - Descargar
Step 2 - Dar permiso de ejecución
¡Paso 3: ejecútalo!
Instalación de AppImage (opcional)
Usar opciones de línea de comando

Paquetes de distribución
Fedora

Enlaces externos

INSTALAR EN CHROMEBOOK
Programa de escritorio
App para Android (solo reproducción)
Enlaces externos

IDIOMA, TRADUCCIONES Y EXTENSIONES
Cambiar idioma
Administrador de recursos{#resource-manager}

Instalar/desinstalar extensiones{#install-extension}
Actualizar las traducciones{#update-translations}

Vea tambien
Enlaces externos

BUSCAR ACTUALIZACIONES
Verificación automática de actualizaciones
Comprobar actualizaciones
Véase también

CONCEPTOS BÁSICOS

CREAR NUEVA PARTITURA
Centro de inicio
Crear nueva partitura

Ingresar la información de la partitura
Seleccione plantilla
Elija instrumentos o partes de voz

Añadir instrumentos
Añadir pentagrama / Añadir pentagrama enlazado
Cambiar el orden de los instrumentos
Eliminar un instrumento

Seleccionar armadura y tempo
Establecer la indicación de compas, anacrusa y el número de compases

Ajustes a la partitura después de la creación
Añadir/eliminar compases
Añadir/editar texto
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Cambiar la configuración del instrumento
Ocultar pentagrama
Ajustar el diseño y formato

Plantilla
Carpeta de plantillas de sistema
Carpeta de plantilla de usuario

Véase también
Enlaces externos

INTRODUCCION DE NOTAS
Introducción de notas basica

Paso 1. Seleccionar una posición inicial
Paso 2. Entrar en el modo de introducción de notas
Paso 3. Seleccione una duración
Paso 4. Introducir la nota o silencio

Seleccione la duración de la nota o silencio
Dispositivos de entrada

Teclado de computadora
Introduzca notas/silencios
Mover notas arriba/abajo
Agregar alteraciones
Acordes
Borrar notas
Atajos de teclado

Ratón
Teclado MIDI
Teclado de piano virtual

Modos de introduccion de notas
Coloración de notas fuera del alcance de un instrumento
Notas pequeñas/cabezas de nota pequeñas
Cambiar notas o silencios ya introducidos

Cambiar duración
Cambiar altura
Cambiar de silencio a nota y viceversa

Propiedades de nota
Véase también
Enlaces externos

ESPACIOS DE TRABAJO
Acoplar/desacoplar
Crear espacio de trabajo personalizado
Editar espacios de trabajo
Véase tambien

MODO DE EDICIÓN
Entrar/salir del modo de edición
Texto
Lineas
Notas

Compensación de notas
Ajustar la longitud de la plica de nota

Atajos de teclado
Ver también

PALETAS
Modo una paleta por vez
Abrir/cerrar paleta

Aplicar símbolos desde una paleta
Paletas personalizadas
Menú de paleta

Comportamiento de texto y líneas aplicadas
Véase tambien

INSPECTOR
Mostrando el Inspector
"Restablecer a estilo por defecto" y "Establecer como estilo"
Categorías del inspector

Elemento
Grupo de elementos
Segmento
Acorde
Nota
Seleccionar
Barras de agrupación
Clave
Articulación
Propiedades del Diagrama de Acorde
Linea
Linea de texto

Cuadros de dialogo de propiedades
Véase tambien

OPERACIONES DE COMPAS
Seleccionar

Compás Solo
Rango de compases

Insertar
Insertar un compás vacío en la partitura
Insertar compases múltiples
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65

Añadir
Añadir un compás vacío al final de una partitura
Añadir múltiples compases vacíos al final de una partitura

Borrar
Borrar un solo compás
Borrar un grupo de compases

Propiedades de compás
Pentagramas
Duración de Compás
Otros

Excluir del contador de compases
Separar compases de espera
Modo de numero de compás
Ancho de diseño
Añadir al número de compás
Cantidad de repeticiones

Numeración
Dividir y unir

Unir compases
Dividir un compás

Enlaces externos

VOCES
Cuándo usar las voces
Cómo ingresar notas en diferentes voces
Borrar y ocultar silencios

Restaurando silencios borrados

Intercambiar notas entre voces
Mover notas a otra voz (sin intercambiar)
Véase tambien
Enlaces externos

COPIAR Y PEGAR
Resumen de comandos
Notas

Copiar o cortar
Pegar
Intercambiar con portapapeles
Copia la altura de una sola nota solamente

Otros elementos
Copiar o cortar
Pegar elementos

Repetición rápida
Duplicar
Filtro de selección
Véase también
Enlaces externos{#external-links}

DESHACER Y REHACER

MODOS DE SELECCIÓN
Seleccionar un solo objeto

Seleccionar una sola nota
Seleccione un acorde
Seleccione un solo compás

Seleccionar un rango continuo de objetos
1. May + selección
2. May + clic en la selección

Seleccione un rango de compases
3. Arrastre selección

4. Seleccionar todo
5. Seleccionar sección

Seleccione una lista de objetos
Seleccionar todos similares
Para qué son útiles las selecciones
Véase tambien

VISUALIZACIÓN Y NAVEGACIÓN
Menu "Ver"

Mostrar barras laterales/paneles
Aumentar / reducir el zoom
Barras de herramientas

Mostrar/ocultar
Personalizar el area de la Barra de herramientas

Espacios de trabajo
Mostrar barra de estado
Pantalla dividida
Opciones de visibilidad
Marcar compases irregulares
Pantalla completa

Página/Vista continua
Vista de pagina
Vista continua
Vista de Página Única

Paneles laterales
Navegación

Navegador
Buscar

Véase también

SONIDOS REALES
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Ver también
Enlaces externos

ABRIR/GUARDAR/EXPORTAR/IMPRIMIR
Abrir
Guardar
Exportar
Imprimir
Véase también

COMPARTIR PARTITURAS EN LÍNEA
Crear una cuenta
Compartir una partitura directamente desde MuseScore
Subir una partitura en MuseScore.com
Editar una partitura en MuseScore.com

Cambiar al método directo de actualización de una partitura en línea

Enlaces externos

NOTACIÓN

ARMADURAS DE CLAVE
Añadir una nueva armadura de clave

Añadir nueva armadura de clave para todos los pentagramas
Añadir la nueva armadura de clave para un pentagrama solamente

Reemplazar una armadura de clave existente
Reemplazar armadura de clave para todos pentagramas
Reemplazar la armadura de clave para un pentagrama solamente

Eliminar una armadura de clave
Becuadros en los cambios armaduras de clave
Cambios armadura de clave y silencios de multicompás
Armaduras de cortesía
Armaduras de clave personalizadas

BARRAS DE COMPÁS
Cambiar el tipo de barra de compás
Insertar barra de compás
Barras de compás personalizadas
Conectar las barras de compás
Véase también

CLAVES
Añadir una clave

Añadir clave al comienzo del compás
Añadir una clave en medio de un compás

Claves de cortesía
Eliminar una clave
Ocultar claves

Mostrar clave solo en el primer compás (para todos los pentagramas)
Mostrar clave solo en el primer compás (para un pentagrama en particular)
Ocultar todas las claves en un pentagrama en particular

ALTERACIONES
Agregar alteracion
Renombrar de las alturas enarmónicas
Renombrar las alturas
Véase también
Enlaces externos

INDICACIONES DE COMPÁS
Añadir un indicación de compás
Borrar una indicación de compás
Para crear una indicación de compás
Propiedades de indicación de compás

Cambiar agrupación predeterminada
Metrónomos aditivos (compuestos)
Indicaciones locales de compás

Compases de anacrusa y cadenzas
Cambios de indicación de compás y descansos
Véase también
Enlaces externos

ARPEGIOS Y GLISSANDO
Arpegios
Glissandos (arraste)

Ajuste los puntos de inicio y fin
Glissandos personalizados

Articulaciones de instrumentos de viento
Slide in por encima/debajo
Enlaces externos

ARTICULACIONES Y ORNAMENTOS
Articulaciones
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Ornamentos
Añadir ornamento/ornamento

Añadir alteración a un adorno
Añadir calderón a una barra de compás
Atajos de teclado

Ajustar posición
Propiedades de articulaciónes y ornamentos
Véase también
Enlaces externos

BENDS
Aplicar un bend
Editar texto y propiedades de linea de un bend
Editar propiedades de un bend
Ajustar la altura
Ajustar posición
Bends personalizados

BARRAS DE AGRUPACIÓN
Símbolos de agrupacion
Cambiar barra de agrupación

Ajuste el ángulo de la barra de agrupacion

Ajustar la altura de la barra de agrupacion
Ajustar la barra de agrupación en posición horizontal
Ajustar barra de agrupación en ángulo
Redistribución local

Invertir barra de agrupación
Restablecer barras de agrupacion
Véase también
Enlaces externos

LLAVES
Añadir
Borrar
Cambiar
Editar
Estilo

NOTAS DE ADORNO
Crear notas de adorno
Cambiar altura
Cambiar duración
Ajuste manual
Enlaces externos

RESPIRACIONES Y PAUSAS
Añadir símbolo
Ajustar la duración de la pausa

LÍNEAS
Aplicando líneas a la partitura

Para aplicar una línea a solo una nota
Para aplicar una línea a través de un rango de notas
Para aplicar una línea desde una nota hasta el final de ese pentagrama
Para aplicar una línea a través de un rango de compases{#range-of-measures}

Lineas y propiedades de reproduccion
Ajustar la posición vertical
Cambiar longitud
Lineas de texto
Lineas personalizadas{#custom-lines}
Copiar líneas
Líneas de adorno extendidas
Enlaces externos

LÍNEAS DE OCTAVA
Aplicar una línea de octava
Cambiar longitud
Líneas personalizadas
Enlaces externos

REGULADORES
Añadir un regulador
Ajustar la longitud
Líneas de cresc. y dim.
Editar propiedades del regulador
Reproducción del regulador

SILENCIOS DE COMPÁS
Silencios de compás completo

Para crear uno o más silencios de compás
Para crear uno o más silencios de compás completo en una voz en particular

Silencios multicompás
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Para mostrar silencios de multicompás
Interrumpir silencios de multicompás

LIGADURAS
Añadir ligaduras en el modo de introducción de notas
Agregar una ligadura fuera del modo introducción de notas

Método 1
Método 2

Ajustar la ligadura
Ligaduras extendidas
Ligaduras punteadas
Véase también

LIGADURAS DE PROLONGACIÓN
Agregar ligaduras a notas individuales
Agregar ligaduras a acordes
Invierta una ligadura
Véase también
Enlaces externos

TRÉMOLO
Agregar un tremolo
Enlaces externos

CASILLAS (1RA Y 2DA REPETICION / FINAL)
Agregar una casilla de repeticion
Cambiar numero de compases abarcados por la casilla
Propiedades de la casilla
Reproduccion
Enlaces externos

REPETICIONES Y SALTOS
Repeticiones simples
1a y 2a terminaciones
Reproducción
Símbolos de repetición y texto
Saltos
Marcadores
Ejemplos de saltos
Ver también
Enlaces externos

VALORES IRREGULARES
Crea un valor irregular

Crear un tresillo en modo normal
Crear un tresillo en el modo de introducción de notas
Crear otros valores irregulares

Eliminar un valor irregular
Cambie la apariencia de un valor irregular

Usando el Inspector
Usando el dialogo de estilo de Valores irregulares

Enlaces externos

TRANSPORTE
Transporte manual
Transporte automático

Transportar cromáticamente
Por tonalidad
Por intervalo

Transportar diatónicamente
Instrumentos transpositores

Sonidos reales
Cambiar la transposición de un pentagrama

Enlaces externos

NOTACIÓN PARA PERCUSIÓN
Tipos de pentagramas de percusión
Métodos de entrada de notas

Teclado MIDI
Teclado de piano
Teclado de computadora

Mouse
Paleta de entrada de percusión
Editar set de percusión
Redoble de tambor
Enlaces externos

TABLATURA
Crea un nuevo pentagrama de tablatura

Con el Asistente de partitura nueva
Con el diálogo Instrumentos
Al cambiar el tipo de pentagrama

Editar datos de las cuerdas
Cambiar afinación
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Añadir cuerda
Eliminar cuerda
Marcar una cuerda al aire
Cambiar el número de trastes del instrumento

Cambiar la visualización de la tablatura
Combinar pentagrama con altura y con tablatura

Cree un pentagrama/tablatura enlazado con el asistente de partitura nueva
Cree un par de pentagramas/tablatura en una partitura existente
Cree un par de pentagramas/tablatura de un pentagrama existente

Introduzca notas en tablatura
Usando un teclado de computadora

Tablatura histórica
Usando un mouse
Seleccione la duración de la nota

Editar notas
Modo de introducción de las notas
En modo normal
Notas cruzadas

Resumen de comandos de teclado
Modo de introducción de las notas
Modo normal

Enlaces externos

SONIDO Y REPRODUCCIÓN

CAMBIAR INSTRUMENTOS EN MEDIO DEL PENTAGRAMA
Efecto de un cambio de instrumento
Agregar un cambio de instrumento
Véase también
Enlaces externos

EDITOR PIANO ROLL
Abriendo el Editor Piano Roll
Vista general
Navegacion
Seleccion de notas
Editar notas
Controles

Primer fila
Segunda fila

Teclado
Personalizar

MEZCLADOR
Abriendo el mezclador
Area de pistas
Ganancia maestra
Area de pistas

Flecha para mostrar/ocultar canales
Silenciar y Solo
Paneo
Volumen
Nombre de pista

Area de detalles
Nombre
Color de la pista
Canal
Set de percusion
Parche
Volumen
Paneo
Puerto y Canal
Reverberancia / Chorus
Silenciar voz
Botón Ocultar Detalles

Sonido
Cambio de sonido en medio del pentagrama (pizz., con sordino, etc.)
Véase también
Enlaces externos

MODOS DE REPRODUCCION
Barra de herramientas de reproducción
Comandos de reproducción

Comenzar/detener la reproducción
Durante la reproducción
Reproducción en bucle

Panel de reproducción

PLAYBACK: CHORD SYMBOLS / NASHVILLE NUMBERS
Turn playback on/off

For all scores (as of version 3.5.1)
For the current score

As of version 3.5.1
As of version 3.5

Change playback sound
Change playback volume / Mute track
Turn symbol sound on/off when editing
Interpretation and voicing of chord symbols
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SOUNDFONTS Y ARCHIVOS SFZ
SoundFonts

Instalar un SoundFont
Desinstalar

SFZ
Instalar un SFZ
Desinstalar

Sintetizador
Lista de archivos de sonido descargables

GM SoundFonts
Archivos de sonido orquestales
Archivos de sonido de piano

Pianos SF2
SFZ Pianos

Descomprimir archivos de sonido descargados

Solución de problemas
Véase también
Enlaces externos

SWING
Aplicar swing a una sección de la partitura

Tresillo en indicacion de tempo

Regresar al ritmo straight
Aplicar swing globalmente
Enlaces externos

SYNTHESIZER
Overview
Save/Load Synthesizer settings
Fluid

To load a soundfont
To reorder the soundfonts
To remove a soundfont

Zerberus
Volume
Effects

Zita 1 reverb
SC4 compressor

Tuning
Dynamics (versions 3.1 and above)
See also
External links

TEMPO
Añadir una Indicación de tempo
Editar tempo
Editar texto de tempo
Ignorar la indicación de tempo
Reproducir accelerando y ritardando
Fermatas
Véase también

DINÁMICAS
Añadir una dinámica
Ajustar propiedades
Personalizar una dinámica
Enlaces externos

REPRODUCCION CON CAPO

TEXTO

CONCEPTOS BÁSICOS DE TEXTO
Añadir texto
Dar formato al texto
Ajustar la posición de los objetos de texto
Vinculación del texto

EDICIÓN DE TEXTO
Entrar/salir del modo de edición de texto

Atajos de teclado

Símbolos y caracteres especiales
Atajos de teclado para caracteres especiales

Ver también

ESTILOS Y PROPIEDADES DEL TEXTO
Estilos de texto
Objetos de texto
Guardar y cargar estilos de texto
Ver también

TEXTO DE PENTAGRAMA Y TEXTO DE SISTEMA
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Texto de pentagrama
Propiedades del texto de pentagrama

Texto de sistema
Propiedades del texto de sistema

Ver también
Enlaces externos

SÍMBOLOS DE ACORDE
Introducir un símbolo de acorde

Comandos de teclado
Sintaxis de los símbolos de acorde
Editar un símbolo de acorde

Transportar símbolos de acorde
Texto de los símbolos de acorde
Estilo de los símbolos de acorde

Apariencia
Nombres de las notas

Capitalización automática
Posicionamiento
Capo

DIGITACIÓN
Añadir digitación a una nota
Añadir digitación a varias notas
Ajustar la posición de la digitación

Ajuste simple
Ajuste múltiple

Editar el texto de una digitación

LETRAS
Introducir líneas de texto cantado

Primera línea
Líneas siguientes
Caracteres especiales
Números de verso
Melismas
Ligado de elisión / Sinalefa

Editar letras
Ajustar las propiedades de la letra
Ajustar la ubicación de líneas de letra individuales
Copiar letras al portapapeles
Pegar letras del portapapeles
Ver también
Enlaces externos

GUÍAS (MARCAS) DE ENSAYO
Añadir una guía de ensayo

Colocación manual
Colocación automática

Agregar una guía de ensayo alfanumérica
Agregar una guía de ensayo basada en el número de compás

Renumerar automáticamente las guías de ensayo
Estilo de texto
Buscar una guía de ensayo
Ver también
Enlaces externos

FORMATO

DISEÑO Y FORMATO
Métodos para cambiar el diseño
Estilo

Partitura
Página
Tamaños
Encabezado, Pie de pagina
Números de Compás
Sistema
Claves
Alteraciones
Compás
Barras de compás
Notas
Barras de agrupación
Valores irregulares
Arpegios
Ligaduras
Reguladores
Casillas de repetición
Octava
Pedal
Trino
Vibrato
Bend
Línea de texto
Articulaciones, ornamentos
Calderón (fermata)
Texto de pentagrama
Texto del tempo
Letra
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Dinámicas
Marcas (guías) de ensayo
Bajo cifrado
Símbolos de acorde
Diagramas de acorde
Estilos de texto
Botones Aceptar / Cancelar / Aplicar

Ajustes de página...
Añadir / Eliminar Saltos de sistema
Expandir

Aumentar / Disminuir ancho de maquetación
Restablecer ancho de maquetación

Restablecer Estilo
Restablecer Barras de agrupación
Restablecer Formas y Posiciones
Cargar / Guardar estilo
Ver también
Enlaces externos

COMPÁS
Introducción
Opciones

AJUSTES DE PÁGINA
Tamaño de la página
Márgenes de página par/impar
Escalado
Unidad
Número de la primera página
Aplicar a todas las partes

SALTOS Y ESPACIADORES
Saltos

Añadir un salto a un compás
Mediante un atajo de teclado
Mediante un símbolo de la paleta

Añadir un salto a un marco
Borrar saltos
Mover un salto
Salto de sección

Espaciadores
Añadir un espaciador
Ajustar un espaciador
Borrar un espaciador

Ver también

MARCOS
Marco horizontal

Insertar/añadir un marco horizontal
Ajustar la anchura de un marco horizontal
Añadir texto o imágenes a un marco horizontal

Marco vertical
Insertar/añadir un marco vertical
Ajustar la altura de un marco vertical
Editar las propiedades de un marco vertical
Añadir texto o imágenes a un marco vertical
Insertar un marco horizontal en un marco vertical
Marco de "título"

Marco de texto
Insertar o agregar un marco de texto
Editar las propiedades de un marco de texto

Crear un marco
Insertar un marco en la partitura
Agregar un marco al final de la partitura

Borrar un marco
Aplicar un salto a un marco
Ver también
Enlaces externos

IMÁGENES
Añadir imagen
Cortar/copiar y pegar una imagen
Modificar una imagen
Ver también
Enlaces externos

CAPTURA DE IMÁGENES
Crear una instantánea
Menú de captura de imagen
Ver también
Enlaces externos

ALINEAR ELEMENTOS
Ajustar a la cuadrícula

TEMAS AVANZADOS
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163
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164
164
165

165
165
165
165

165
166
166
166
166
166

166
166
167
167
167
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169
169
170
171

171
171
172
172
172
172
173

173
173
174
175
175
176

177

177
177
177
177
177

178
178
178
178
178

178
178
178
179

179
179
179
179
179

179
179
179
180
180
180
180
180
180
180
180

180
180

180

ACCESIBILIDAD
Introducción
Configuración inicial
Encontrar tu camino
Ventana de partitura
Leer partituras

Avanzar o retroceder en el tiempo
Moverse entre notas en un momento dado
Filtrar elementos en la lectura de partitura

Reproducir partitura
Editar partituras
Personalizar
Enlaces externos

ALBUMS
Create album
Load album
Print album
Join scores
Save album

BAJO CIFRADO
Añadir una nueva indicación de bajo cifrado
Formato de texto

Números
Alteraciones
Formas combinadas
Paréntesis
Líneas de prolongación
Duración

Editar bajos cifrados existentes
Estilo
Sintaxis correcta
Resumen de teclas

DIAGRAMAS DE ACORDE
Diagramas de acorde generalidades
Vista general de la paleta de acordes de guitarra estándar
Visión general de la creación de acordes modificados o personalizados
Para añadir un Diagrama de acorde

Simbolo de acorde anclado a diagrama de acorde
Uso de Cifrados con el Diagrama de Acorde

To adjust a Fretboard Diagram's element properties (position, color, stacking order...)
To adjust global/default Fretboard Diagram style properties
To edit a Fretboard Diagram

Editing Fretboard Diagram properties
Finger dot editing (basic use)
Finger dot editing (advanced use)

External links

FRETBOARD DIAGRAMS (PRIOR TO VERSION 3.1)
Add a fretboard diagram
Edit a fretboard diagram
To adjust a diagram's element properties
To adjust a diagram's style properties

FILE FORMATS
MuseScore native format

MuseScore format (*.mscz)
Uncompressed MuseScore format (*.mscx)
MuseScore backup file (.*.mscz,) or (.*.mscx,)

Graphic files (export only)
PDF (*.pdf)
PNG (*.png)
SVG (*.svg)

Audio files (export only)
WAV audio (*.wav)
MP3 (*.mp3)
FLAC audio (*.flac)
Ogg Vorbis (*.ogg)

Share with other music software
MusicXML (*.musicxml, *.xml)
Compressed MusicXML (*.mxl)
MIDI (*.mid, *.midi, *.kar)
MuseData (*.md) (import only)
Capella (*.cap, *.capx) (import only)
Bagpipe Music Writer (*.bww) (import only)
BB (*.mgu, *.sgu) (import only)
Overture (*.ove) (import only)
Guitar Pro (various—import only)
Power Tab Editor (*.ptb) (import only)

See also
External links

FUNCIONALIDADES PARA MÚSICA ANTIGUA
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190

192
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194

194
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197
197
197

197
197
198
198
198
198
198
198
198
198
198
198
198
199

199
199

Notación sin compás
Ejemplo

Mensurstrich
Ámbito
Indicaciones mensurales de compás
Ver también

LAYER (EXPERIMENTAL)
See also

MIDI IMPORT
Available operations

MASTER PALETTE
Symbols

Find a symbol
Apply a symbol
Connect symbols

See also

NOTACIÓN DE PENTAGRAMA CRUZADO
Ver también
Enlaces externos

NOTE INPUT MODES
Step-time
Re-pitch
Rhythm
Real-time (automatic)
Real-time (manual)

Real-time Advance shortcut

Insert
Normal mode
See also
External links

NOTEHEAD SCHEMES

NOTEHEADS
Notehead groups
Change notehead group
Change notehead type
Shared noteheads

Change offset noteheads to shared
Examples of notehead sharing
Remove duplicate fret marks

External links

PARTS
Part Playback
Create all parts
Create specific parts
Customize parts

Add instruments to a part
Remove instruments from a part
Select staves for an instrument
Select voices for an instrument

Delete a Part
Export parts
Save parts
Print a part

PLUGINS
What are Plugins?
Installation

Windows
macOS
Linux

Enable/disable plugins
Create/edit/run plugins
Plugins installed by default

ABC Import
Notes → Color Notes
Create Score
helloQml
Notes → Note Names
Panel
random/random2
run
scorelist
ScoreView
Walk

See also
External links
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199
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201
202
202

202
202
203
203
203

203
203
204
205
205
206

206
206
206
206
206

206
207
207
207
207

207
207
208
208
208
208
208

208
208
209
209

210
210

210
211
211
213
213
213
213
213
213
214
215

215
215

216
216
216
216

217
217
217
217
217
217
217
217

217
217
218
218
218
218

218
218

218
218
218

PREFERENCES
General
Canvas
Note input

Note Input
MIDI Remote Control

Score
Default Files
View

I/O
PortAudio (API / Device)
MIDI Input/Output/Output Latency
Jack Audio Server
Audio Engine

Import
Export
Shortcuts
Update
Advanced
See also

POSICIONAMIENTO AUTOMÁTICO
Posición por defecto
Ajustes manuales
Deshabilitar el posicionamiento automático
Orden de superposición

RECOVERED FILES
Saving after session recovery
Finding recovered files
See also
External links

SCORE COMPARISON
Introduction
Select score
Choose view
View comparison
Leave comparison
Example

SCORE PROPERTIES
Edit meta tags
Pre-existing meta tags

Entering Work / Movement / Part metadata

Header/Footer
See also

STAFF / PART PROPERTIES
Staff Types
Staff / Part Properties: all staves
Staff / Part Properties: plucked strings only
Advanced Style Properties

Template
Standard and Percussion staff options
Tablature staff options
Tablature staff options: Fret Marks
Tablature staff options: Note Values
Preview

Change instrument
External links

STAFF TYPE CHANGE
Add a Staff Type Change
Staff type change properties
Example

TIMELINE
Introduction
Overview

Meta labels
Instrument labels
Meta rows
Main grid
Meta

Basic interaction
Select a measure
Select multiple measures

Drag selection
[Shift] selection
[Ctrl] selection

Clearing selection
Meta values selection

Scrolling
Standard scrolling
[Shift] scrolling
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225

225
225
225
225
226
226
226

226
226
226
226
227
227
227

227
227
227
228
231
231
232
232
232
232
232

[Alt] scrolling
Dragging

Labels interaction
Rearranging meta labels
Collapsing the meta labels
Hiding instruments

Zooming
Context menus

Meta labels context menu
Meta rows context menu
Instrument context menu

TOOLS
Transpose
Explode
Implode

Apply implode to a single staff
Apply implode to multiple staves

Voices
Measure
Remove selected range
Fill with slashes
Toggle rhythmic slash notation
Respell pitches
Regroup Rhythms
Resequence rehearsal marks
Unroll Repeats (version 3.1 and above)
Copy lyrics to clipboard
Image capture
Remove empty trailing measures
See also
External links

SUPPORT

HELPING TO IMPROVE TRANSLATIONS
Software translation
Website and handbook translation
See also

REVERT TO FACTORY SETTINGS
Via menu
Via command line

Instructions for Windows
Instructions for MacOS
Instructions for Linux

See also

BUG REPORTS AND FEATURE REQUESTS
Bug reports
Feature requests
Cross linking issues
External links

APPENDIX

ATAJOS DE TECLADO
Navegación
Introducción de notas

Duración
Voces
Alturas
Intervalos

Diseño
Articulationes
Introducción de Texto
Introducción de letra
Mostrar
Miscelánea
Ver también

COMMAND LINE OPTIONS
NAME
SYNOPSIS
DESCRIPTION
Batch conversion job JSON format
ENVIRONMENT
FILES
EXAMPLES

Convert a score to PDF from the command line
Run a batch job converting multiple documents
MIDI import operations
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243
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244
245
245
245
246
246
246
246
246
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246
247

DIAGNOSTICS
SEE ALSO
STANDARDS
HISTORY
AUTHORS
CAVEATS
BUGS

NEW FEATURES IN MUSESCORE 3.6
New score setup and layout features

Automatic instrument ordering
Automatic brackets and braces
Vertical justification of staves
Indentation of first systems

Applying new features to existing scores
Applying new automatic instrument ordering and bracketing
Applying vertical justification of staves

Other engraving changes in 3.6
Beam spacing
Ledger line length
Stem caps and flag positions
Bracketed accidentals
Accidentals in Emmentaler

NEW FEATURES IN MUSESCORE 3
Automatic Placement

Default position
Manual adjustments
Disabling automatic placement
Stacking order

Text Formatting
Text Styles
Text Properties
Custom Formatting

Staff Type Change
Temporary and Cutaway Staves
System Dividers
Staff Spacing
Don't Break
Parts from Voices
Explode and Implode
Insert mode
Split/Join Measures
Timeline
Score Comparison Tool
Mixer
Piano Roll Editor
Capo changes
Fretboard Diagrams
External links

KNOWN LIMITATIONS OF MUSESCORE 3.X
Local time signatures
Regroup Rhythms
Tablature staff linked with standard staff
Mixer
Header & footer

UPGRADE FROM MUSESCORE 1.X OR 2.X
How to upgrade MuseScore
Opening 1.x or 2.x scores in MuseScore 3
Relayout
Getting the sound from MuseScore 1.x

KNOWN INCOMPATIBILITIES
Hardware incompatibilities
Software incompatibilities

AVG Internet Security hangs MuseScore
Font problem on macOS
Font problem on Linux
Save As dialog empty on Linux

GLOSSARY
A
B
C
D
E
F
G
H
I
J
K

16



247
247
247
247
247
247
247
248
248
249
249
249

L
M
N
O
P
Q
R
S
T
U
V
External links
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Published on MuseScore (https://musescore.org)

Este manual de usuario es para la version 3.0 o superior. Es mantenido y traducido por la comunidad de MuseScore.
Averigua como puedes ayudar . En caso de duda consulte la versión en ingles del manual de usuario .

(Si estas usando MuseScore 2.x, puedes acceder al manual anterior aquí ).

Primeros pasos
Este capitulo te ayuda a instalar e iniciar MuseScore por primera vez. Te presentara los distintos recursos de aprendizaje
y ayuda.

Aprendiendo MuseScore

MuseScore incluye una serie de recursos de ayuda para nuevos usuarios a comenzar a usar el programa y escribir
partituras.

Tours

Cuando instale MuseScore por primera vez, se mostrara un Asistente de inicio para ayudarte a configurar algunas
funciones básicas del programa. Cuando veas la ventana de Tours, marca "Si" como respuesta a "¿Le gustaría ver los
tours?"

Esto mostrara el Tour al abrir el programa, mostrandote por primera vez las principales funciones de la interfaz de
usuario.

Para terminar el tour: presione el boton Cerrar.
Para dejar de mostrar el Tour al abrir MuseScore: Desmarca "Continuar mostrando Tours".
Para volver a mostrar el Tour (al reiniciar el programa): Seleccione Ayuda→Tours→Mostrar Tours.
Para volver a ver todos los tours (al reiniciar el programa): Seleccione Ayuda→Tours→Reiniciar Tours.

Tours ofrecidos actualmente:

Introducción a la interfaz de usuario.
Ingresando notas y silencios en la partitura.
Ingresando símbolos desde la paleta.
Navegar por la partitura con la linea de tiempo.

Partitura "Primeros pasos"

La partitura interactiva "Primeros pasos" es una introducción practica a los conceptos básicos para escribir una
partitura. Cuando abres MuseScore por primera vez, esta se mostrara en la ventana principal del Centro de Inicio: haz clic
para abrirla. Sigue las instrucciones escritas en azul y seras guiado por a través de los pasos básicos para escribir una
partitura.

Nota: Si no ves la partitura "Primeros pasos", puede encontrarla en el lado derecho del panel del Centro de Inicio. Haz
clic en las flechas izquierda o derecha para explorar las opciones hasta que aparezca.

Tutoriales de video

MuseScore ofrece una seria completa de vídeos instruccionales, cada uno cubriendo un tema especifico. Puede acceder

18

https://musescore.org
https://musescore.org/es/node/2#Documentation
https://musescore.org/en/handbook
https://musescore.org/es/node/35711


a los vídeos de distintas maneras.

Desde la pagina web de MuseScore en MuseScore.org: Support/Tutorials
En el Centro de Inicio: busque la pagina de vídeos en el panel derecho.
Use la lista de links en la sección Vídeos (mas abajo).
Busque "MuseScore in Minutes" en You Tube  (incluye subtítulos en español)

Otros tutoriales

En la sección Tutoriales  en musescore.org encontrara también tutoriales sobre temas mas específicos (por ejemplo,
Notaciones de percusión).

Vídeos
Lección 1- Configuración de la partitura
Lección 2 - Trabajando con MuseScore
Lección 3 - Ingresar notas
Lección 4 - Ingresar notas con teclado MIDI
Lección 5 - Mas ideas para ingresar notas
Lección 6 - Texto, letras y acordes
Lección 7 - Tablatura y notación de percusion
Lección 8 - Repeticiones y finales, Parte 1
Lección 9 - Repeticiones y finales, Parte 2
Lección 10 - Articulaciones, dinámicas y texto
Lección 11 - Diseño y Partes

Obtenga soporte

Si experimenta problemas mientras trabaja con MuseScore, hay muchas maneras de obtener soporte y ayuda.

Manual de usuario

Para acceder al Manual de usuario :

Desde el sitio web de MuseScore : desde el menú superior, seleccione Soporte → Manual de usuario.
Desde el programa de MuseScore: Desde el menu, seleccione Ayuda → Manual en linea.

Puede buscar a través del manual de usuario usando los menús, o hacer una búsqueda .

Ayuda contextual

Si selecciona un elemento en la partitura y presiona F1, se abrira una pagina web mostrando una lista de enlaces
asociados con ese elemento en el Manual de usuario .

Foros

MuseScore ofrece un grupo de Foros  en linea para que los usuarios colaboren. Puede encontrar una respuesta allí si
su problema ha sido resuelto con anterioridad en un posteo ya existente. Una búsqueda general  del sitio web le
mostrara una lista de resultados relevantes de todos los foros y el manual de usuario.

Como hacer...

Algunas tareas requieren el uso de otras técnicas. Estas pueden ser difíciles de responder en el manual de usuario. Las
soluciones para estas pueden (o no) ser encontradas en Como hacer...

Escriba una pregunta

SI no puede encontrar la respuesta a su problema, puede hacer una pregunta en el foro de Preguntas generales .

Cuando envié su pregunta:

Trate de ser lo mas preciso que pueda, describiendo lo que esta intentando hacer y que pasos ha tomado
anteriormente.
Adjunte la partitura que trae el problema. Esto hace mucho mas fácil entender el problema a otros — use la opción
"Seleccione un archivo" debajo del cuadro de texto, justo arriba de los botones Guardar y Preview.

Reportar un error

Si encuentra algo que considera un error, el primer paso es escribir un mensaje en el foro Support and bug reports  (en
ingles). Esto le permitira a otros usuarios comprobar si esto es realmente un error, y aconsejar posibles soluciones, para
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que pueda continuar con su trabajo. Encontrara mas detalles en Bug reports and Feature requests.

Instalación

MuseScore esta disponible para varios sistemas operativos, como Windows, macOS, muchas distribuciones de Linux  y
varias variantes de BSD . Todas disponibles en la pagina de descarga de MuseScore .

Instalación

Después de haber descargado el software, siga las instrucciones para su sistema operativo:

Instalar en Windows.
Instalar en macOS.
Instalar en Linux.
Instalar en Chromebook.

Configuración inicial

La primera vez que inicie MuseScore después de la instalación, se le pedirá que defina sus preferencias básicas;

Las preferencias de idioma y distribución del teclado son tomadas de su instalación, y usualmente no deberían necesitar
cambios. Solo haga clic en Siguiente para continuar:

Seguido por:
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La pagina de Espacios de trabajo le permite especificar los valores por defecto de las barras de herramientas y paletas.
Elija una opcion del menú desplegable. Después haga clic en Siguiente para continuar:

Ahora se le preguntara si desea tomar los Tours. Si MuseScore es nuevo para usted deje la casilla 'Si' marcada, y haga
clic en Siguiente para continuar:

21



Por ultimo, haga clic en Terminar para iniciar MuseScore.

Instalar en Windows

Instalar

En Windows 10, una version de 32 bits MuseScore puede ser instalada desde Windows Store. Haga clic aquí  para
abrir la pagina de Musescore en Windows Store. Una vez dentro haga clic en Obtener y MuseScore sera descargado,
instalado y posteriormente actualizado cuando haga falta.

También puede conseguir el instalador desde la pagina Descargas  del sitio web de MuseScore. Haga clic el link para
comenzar la descarga (elija entre las versiones 64 o 32 bits). Tu navegador de Internet pedirá confirmación para
descargar el archivo. Clickea Guardar archivo.

Cuando la descarga termine, haga doble clic en el archivo para comenzar la instalación. Windows podría mostrate una
advertencia de seguridad para confirmar que quieres correr este software. Haga clic en Aceptar para continuar.
El proceso de instalación comenzara.
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Si hace clic en Cancelar, aquí o mas adelante, verá:

Si hace clic en Siguiente para continuar, el asistente de instalacion le mostrara los terminos de la licencia de software libre.

23



Lea los términos de la licencia, asegúrese de marcar al lado de "Acepto los términos de la licencia", y haz clic en Siguiente
para continuar. Luego el instalador le pedirá que confirme el directorio al cual instalar MuseScore.

Si esta instalando una versión nueva de MuseScore pero todavía quiere mantener la versión vieja en su computadora,
debe elegir una carpeta diferente (Vale hacer notar que MuseScore 3 puede coexistir con MuseScore 2 y 1 sin la
necesidad de cambios). Sino haga clic en Siguiente para continuar.

Clic en Instalar para continuar.

Aguarde unos minutos mientras el asistente de instalación copia los archivos necesarios. Luego verá:
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y por ultimo

Haga clic en Terminar para salir del instalador. Puedes borrar el instalador una vez que termine el proceso.

Iniciar MuseScore

Para iniciar MuseScore, desde el menú, seleccione Inicio→Todos los programas→MuseScore 3→MuseScore 3.

Desinstalar

Puede desinstalar MuseScore desde el menú seleccionando Inicio→Todos los programas→MuseScore 3→Desinstalar MuseScore; o
a través del panel de control de Windows. Esto no removerá sus partituras o su configuración de MuseScore.

Problemas comunes

El instalador puede estar bloqueado por el sistema. Si no puedes correr el instalador de MuseScore, haz clic derecho en
el archivo que descargaste y clickea Propiedades. Si aparece un mensaje "Este archivo vino desde otra computadora y
puede estar bloqueado para proteger esta computadora", clickea en"Desbloquear", "OK" y haz doble clic en el archivo
descargado de nuevo.

Enlaces externos

Como instalar MuseScore en Windows sin derechos de administrador
Como iniciar MuseScore como administrador en Windows
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Instalar en macOS

Instalar

Encontrará el archivo DMG (imagen de disco) en la página descargar  del sitio web de MuseScore. Haga clic en el
enlace macOS para comenzar la descarga. Cuando la descarga esté completa, haga doble clic en el archivo DMG para
montar la imagen del disco.

Arrastre y suelte el icono de MuseScore en el icono de la carpeta de aplicaciones.

Si no ha iniciado sesión como administrador, macOS puede solicitar una contraseña: haga clic en Autenticar e ingrese su
contraseña para continuar.

Cuando la aplicación haya terminado de copiar, expulse la imagen del disco. Ahora puede iniciar MuseScore desde la
carpeta Aplicaciones, Spotlight o Launchpad.

Desinstalar

Simplemente elimine MuseScore de la carpeta Aplicaciones

Instalar con Apple Remote Desktop

Puede implementar MuseScore en varias computadoras con la función "Copiar" de ARD. Como MuseScore es una
aplicación autónoma, simplemente puede copiar la aplicación en la carpeta '/ Aplicación' en las máquinas de destino.
También es posible instalar múltiples versiones de la aplicación siempre que difieran sus nombres.

Enlaces externos

Como iniciar MuseScore 2.x en Mac OS X 10.6
Como cambiar el idioma en MuseScore

Instalar en Linux

A partir de MuseScore 2.0.3 puede, por primera vez, obtener una copia para Linux directamente desde la página
descargar , al igual que los usuarios de Windows y Mac. Esto es posible gracias al formato de empaquetado AppImage,
que se ejecuta prácticamente en todas las distribuciones de Linux. Si lo prefiere, todavía existe la opción de obtenerlo de
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la manera tradicional a través del administrador de paquetes de distribución (pero es posible que deba esperar a que el
mantenedor correspondiente lo empaquete). Por supuesto, siempre puedes compilar desde el origen .

AppImage

El formato AppImage  es una nueva forma de empaquetar aplicaciones Linux. Las AppImages son portátiles, no tienen
que estar instaladas, y se ejecutan prácticamente en cualquier distribución de Linux. Las dependencias se incluyen en el
archivo de AppImage.

Paso 1 - Descargar

Antes de descargar una AppImage, necesita conocer la arquitectura de su procesador. Estos comandos de terminal lo
mostrarán:

    arch

or

    uname -m

La salida será algo así como "i686", "x86_64" or "armv7":

i686 (o similar) - 32-bit Intel/AMD procesador (encontrado en computadoras viejas).
x86_64 (o similar) - 64-bit Intel/AMD procesador (computadoras portátiles y de escritorio modernas, la mayoría de las
Chromebooks).
armv7 (o después) - ARM procesador (teléfonos y tabletas, Raspberry Pi 2/3 con Ubuntu Mate, algunos
Chromebooks, generalmente de 32 bits en la actualidad).

Ahora puede ir a la página descargar  y encontrar la AppImage que mejor se adapte a su arquitectura. Una vez
descargado, el archivo se llamará "MuseScore-X.Y.Z-$(arch).AppImage ".

Step 2 - Dar permiso de ejecución

Antes de poder usar AppImage, debe otorgar permiso para que se ejecute como un programa.

Desde la Terminal:

Este comando otorga al usuario (u) permiso para ejecutar (x) la AppImage. Funciona en todos los sistemas Linux.

    cd ~/Downloads
    chmod u+x MuseScore*.AppImage

Nota: utilice el comando "cd"para cambiar el directorio a donde haya guardado el AppImage.

Desde un administrador de archivos:

Si prefiere evitar la línea de comando, generalmente hay una forma de otorgar permiso de ejecución desde dentro de un
Administrador de archivos.

En archivos de GNOME (Nautilus), simplemente:

1. Haga clic con el botón derecho en AppImage y seleccione "Propiedades".
2. Abra la pestaña "Permisos".
3. Habilite la opción etiquetada "Permitir la ejecución del archivo como un programa".

El proceso puede ser ligeramente diferente en otros administradores de archivos.

¡Paso 3: ejecútalo!

¡Ahora debería poder ejecutar el programa simplemente haciendo doble clic en él!

Cuando descargó AppImage, probablemente se guardó en su carpeta de descargas, pero puede trasladarse a otro lugar
en cualquier momento (por ejemplo, puede colocarlo en su escritorio para facilitar el acceso). Si alguna vez desea
eliminarlo, simplemente elimínelo.

Instalación de AppImage (opcional)

Puede ejecutar AppImage sin instalarlo, pero debe instalarlo si desea que esté completamente integrado con su entorno
de escritorio. Esto tiene los siguientes beneficios:

Agrega AppImage a su menú de aplicaciones o iniciador
Establece los iconos correctos para los archivos de MuseScore (MSCZ, MSCX) y para los archivos de MusicXML
(MXL, XML)
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Hace que AppImage esté disponible a través del menú "Abrir con ..." de su Administrador de archivos

Para instalarlo, ejecute la AppImage desde la Terminal con la opción "instalar" ([ver inmediatamente debajo] (#
AppImage-options)). Esto copia un archivo de escritorio y varios iconos en su computadora. Si desea eliminarlos, deberá
ejecutar la opción "eliminar" antes de eliminar la AppImage. Esto no afecta ningúna partitura creada con ninguna versión
de MuseScore.

Usar opciones de línea de comando

Ejecutar AppImage desde el Terminal le permite usar varias opciones de línea de comando. El AppImage tiene algunas
opciones especiales además de MuseScore opciones normales de línea de comando .

Deberá cambiar el directorio (cd) a donde esté guardado el AppImage en su sistema, por ejemplo:

    cd ~/Desktop
    ./MuseScore*.AppImage [option...]

O dale la ruta al AppImage:

    ~/desktop/MuseScore*.AppImage [option...]

Use las opciones "--help" y "man" para obtener más información sobre las opciones de línea de comando disponibles:

    ./MuseScore*.AppImage --help   # muestra una lista completa de opciones de línea de comando
    ./MuseScore*.AppImage man      # muestra la página del manual (explica qué hacen las opciones)

Paquetes de distribución

Fedora

1. Importar la llave GPG:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve
 

2. Vaya a la página descargar  del sitio web de MuseScore. Haga clic en el enlace para la descarga estable de
Fedora y elija el paquete de rpm correcto para su arquitectura.

3. Dependiendo de su arquitectura, use uno de los dos conjuntos de comandos para instalar MuseScore

para arch i386

    su
    yum localinstall musescore-X.Y-1.fc10.i386.rpm
 

para arch x86_64

    su
    yum localinstall musescore-X.Y-1.fc10.x86_64.rpm
 

Si tiene dificultades con el sonido, consulte Fedora 11 y sonido .
Vea también las sugerencias para las diversas distribuciones en la página de descarga .

Enlaces externos

Como iniciar una AppImage de MuseScore en Linux  - video
Como cambiar el idioma de MuseScore

Instalar en Chromebook

Programa de escritorio

El programa de escritorio de MuseScore no funcionará de forma nativa en Chrome OS, pero hay algunas soluciones
alternativas:

1. Desde Chrome OS 69, algunos modelos de Chromebook pueden abrir aplicaciones de Linux, asi que podra instalar
MuseScore para Linux desde nuestra pagina de descargas . Comentarios acerca del proceso de instalación y
hardware soportado son bienvenidos en el foro

2. A través del servicio de software a pedido, como rollApp : con solo visitar este sitio web, puede ejecutar
MuseScore en el navegador. Puede acceder a sus puntajes a través de servicios en la nube como Google Drive o
guardarlos en su cuenta de MuseScore en línea a través del menú Archivo→Guardar online.... Tenga en cuenta que
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actualmente, el sonido y la reproducción no funcionan en rollApp.

App para Android (solo reproducción)

Alternativamente, es posible instalar la App para Android de MuseScore  en Chromebooks recientes. Tendra que
actualizar a la ultima verson de Chrome OS primero. Vea la documentacion de soporte de Chromebook para ayuda para
instalar apps para Android en Chromebooks , y una lista de dispositivos soportados . La aplicación solo admite la
reproducción de partituras existentes, no la edición de partituras o la creación, pero puede iniciar sesión en su cuenta de
MuseScore para acceder fácilmente a sus partituras en MuseScore.com.

Enlaces externos

Como iniciar MuseScore en un Chromebook
Vea el proceso de instalación en los comentarios en este tema  (en ingles)
Como cambiar el idioma de MuseScore

Idioma, traducciones y extensiones

MuseScore funcionará con su idioma de "Sistema" (el que se usa para la mayoría de los programas, y generalmente,
dependiendo de su país y la configuración de idioma de la PC o cuenta).

Cambiar idioma

1. Desde el menú, seleccione Editar→Preferencias... (Mac: MuseScore&rar;; Preferencias...);

2. En la pestaña General, seleccione el idioma deseado de la lista desplegable en la sección Idioma:

Administrador de recursos{#resource-manager}

El Administrador de recursos es utilizado para instalar y desinstalar extensiones, y para manejar las actualizaciones de
las traducciones. Para acceder al menú use una de las siguientes opciones:

Desde la barra de menu, seleccione Ayuda→Administrador de recursos.

Desde la barra de menu, seleccione Editar→Preferencias... (Mac: MuseScore→Preferencias...), abra la pestaña General, y
haga clic en el boton Actualizar traducciones.
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Instalar/desinstalar extensiones{#install-extension}

Para instalar o desinstalar una extension:

1. Seleccione la pestaña Extensiones en el Administrador de recursos.
2. Seleccione la extension.
3. Haga clic en Instalar o Desinstalar.

Actualizar las traducciones{#update-translations}

Para actualizar las traducciones:

1. Seleccione la pestaña Idioma en el Administrador de recursos.
2. Haga clic en el botón Actualizar para el lenguaje que desea actualizar.

Nota: El idioma de los menús y cuadros de dialogo sera cambiado de inmediato, pero el inspector no usara el nuevo
idioma o traducción hasta que se reinicie el programa.

Vea tambien

Ayude a mejorar la traducción

Enlaces externos

Como cambiar el idioma en MuseScore

Buscar actualizaciones

Nota: Estas opciones solo están disponibles para las versiones de MuseScore para Mac y Windows (salvo la versión de
la Tienda de Windows), dado que estas solo pueden ser actualizadas directamente de MuseScore.org. Linux (y la Tienda
de Windows) tienen otros mecanismos para buscar las actualizaciones.

Para las versiones de MuseScore que pueden ser actualizadas directamente, hay 2 maneras de buscar actualizaciones.

Verificación automática de actualizaciones

1. Desde el menú, selecciona Edit→Preferencias... (Mac: MuseScore→Preferencias...);
2. Seleccione la pestaña Actualizar:
3. Asegurese de que la casilla "Buscar nueva versión de MuseScore" esta activada (debería estarlo por defecto).
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Si habilita esta opcion, MuseScore buscara actualizaciones en cada inicio. En las versiones para Mac y Windows
(excluyendo la version de la Tienda de Windows), esta opcion activa las actualizaciones automaticas.

Comprobar actualizaciones

1. Desde el menú, selecciona Ayuda→Comprobar actualizaciones:

2. Aparecerá un cuadro de diálogo con el estado de actualización: "No hay actualizaciones disponibles" o "Una
actualización de MuseScore está disponible:" seguido de un enlace para descargarlo.

Véase también

Preferencias: actualizaciones

Conceptos básicos
El capítulo anterior → "Primeros pasos" le guía a través de la instalación. El capítulo "Primeros pasos" ofrece una
descripción general de MuseScore y describe los métodos generales para interactuar con la partitura.

Crear nueva partitura

Para crear una nueva partitura, abra el Asistente de partitura nueva (vea [Crear nueva partitura] (#create-new-score), a
continuación): también se puede acceder a través del Centro de inicio.

Centro de inicio

Esta es la ventana que se muestra cuando se abre MuseScore por primera vez:
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To open the Start Center (if not already visible), use any of the following options:

Para abrir el Centro de inicio (si no está ya visible), use cualquiera de las siguientes opciones:

Presionar F4.
Desde la barra de menú, seleccione Ver→Centro de inicio

Desde el Centro de inicio puedes:
* Crear una nueva partitura (haciendo clic en el icono con el signo de suma).
* Ver miniaturas de partituras previamente abiertas: haga clic en una miniatura para abrirla.
* Abrir una partitura del sistema de archivos de su computadora: haga clic en Abrir una partitura...
* Abrir la partitura tutorial "Comenzando". Use las flechas en la sección derecha para acceder al link.
* Ver la partitura "En el foco" del día.
* Buscar partituras en musecore.com .
* Acceder a otras funcionalidades (vea sección derecha).

Crear nueva partitura

Para abrir el Asistente de partitura nueva cuando el Centro de inicio no está abierto, use una de las siguientes
opciones:

Haga clic en el ícono Nueva Partitura en la barra de herramientas en la parte superior izquierda de la ventana;
Use el atajo de teclado Ctrl+N (Mac: Cmd+N);
Desde el menú, seleccione File→Nuevo....

Ingresar la información de la partitura
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Step 1: Ingresar la información de la partitura.

Ingrese el título, el compositor o cualquier otra información como se muestra arriba, luego haga clic en Next >. Este paso
es opcional: también puede agregar esta información después de crear la partitura (vea Marco vertical).

Seleccione plantilla

Paso 2: Seleccione archivo de plantilla.

En este paso, puedes elegir entre una variedad de plantillas para instrumentos solos, ensambles o orquesta. Todas las
Plantillas personalizadas guardadas en tu carpeta de plantillas de usuario seran mostradas bajo el encabezado Plantillas
personalizadas. Puede usar el Cuadro de Busqueda (arriba a la izquierda) para buscar plantilas especificas.

Haz clic a una plantilla para seleccionarla. Esto automaticamente te llevara a la proxima pagina del asistente (Elige
armadura de clave y tempo).
Tambien, para elegir exactamente que instrumentos incluir en tu partitura, clickea la plantilla "Elegir instrumentos"
(bajo el encabezado "General").

Elija instrumentos o partes de voz
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La ventana Elija instrumentos se divide en dos columnas:

La columna de la izquierda contiene una lista de instrumentos o partes de voz para elegir. Esta lista se clasifica en
familias de instrumentos, y al hacer clic en una categoría se muestra la lista completa de instrumentos en cada
familia.

La entrada predeterminada es "Instrumentos comunes", pero puede elegir entre otros, incluidos "Instrumentos de
jazz" y "Música antigua". Hay un cuadro de búsqueda en la parte inferior de la ventana del instrumento: al escribir el
nombre de un instrumento, lo buscará en "Todos los instrumentos".

La columna de la derecha comienza vacía, pero finalmente contendrá una lista de instrumentos para su nueva
partitura en el orden en que aparecerán.

Añadir instrumentos

Para añadir instrumentos a la partitura, use cualquiera de las siguientes opciones:

Seleccione uno o más instrumentos en la columna izquierda y haga clic en Añadir.
Haga doble clic en un instrumento en la columna izquierda.

Los nombres de los instrumentos y sus respectivos pentagramas aparecen ahora en la lista de instrumentos en la
columna de la derecha. Puede agregar más instrumentos o partes de voz, según sea necesario. Cada instrumento
agregado de esta manera tiene asignado su propio canal del Mezclador .

Nota: si desea que un instrumento use un pentagrama adicional, use los comandos Añadir pentagrama o Añadir
pentagrama enlazado en su lugar (vea abajo).

Añadir pentagrama / Añadir pentagrama enlazado

Para añadir un pentagrama a un instrumento existente en la partitura:
1. Seleccione un pentagrama en la lista de partituras en el lado derecho (por ejemplo, consulte "Pentagrama 1" en la
imagen a continuación). Haga clic en Añadir pentagrama o Añadir pentagrama enlazado.
2. Ajuste el tipo de pentagrama, si corresponde.
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Resumen de comandos:

Comando pentagrama
añadido

¿Editar pentagramas de
forma independiente?

¿Compartir
mezclador de

canal?
Ejemplos

Añadir
pentagrama No enlazado Sí Sí Pentagrama/tablatura de guitarra,

piano gran pentagrama
Añadir
pentagrama
enlazado

Enlazado No. Editar en un pentagrama
actualiza a otros Sí Pentagrama/tablatura de guitarra

Vea tambien, Combinar pentagrama tradicional con tablatura.

Cambiar el orden de los instrumentos

Para cambiar el orden de los instrumentos (o pentagramas) en la partitura:

Haga clic en el nombre del instrumento o en el pentagrama, en la columna de la derecha, y use las teclas ↑ o ↓ para
moverlo más alto/bajo.

Eliminar un instrumento

Para eliminar un instrumento, o pentagrama, de la partitura

Seleccione un instrumento, o un pentagrama, en la columna de la derecha, y haga clic en Eliminar.

Seleccionar armadura y tempo
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Paso 3: Seleccionar armadura y tempo.

El asistente pregunta por dos cosas: la armadura inicial y el tempo de la partitura. Seleccione cualquiera de los anteriores
y haga clic en Siguiente > para continuar. También se puede establecer un tempo inicial aquí.

Establecer la indicación de compas, anacrusa y el número de compases

Step 4: Crear indicación de compas etc.

Puede establecer su indicación de compas inicial aquí. Si la partitura comienza con un compás de anacrusa marque la
casilla Compas de anacrusa y ajuste la "Duración" en consecuencia.

Pentagramas están configurados en 32 por defecto: puede cambiar el número aquí, o añadir/eliminar compases más
tarde de la partitura.

Haga clic en Terminar para crear su nueva partitura.

Ajustes a la partitura después de la creación
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Cualquier configuración que realice en el Asistente de partitura nueva siempre se puede cambiar cuando comience a
editar la propia partitura.:

Añadir/eliminar compases

Para añadir/eliminar compases o crear un compas de anacrusa, vea Operaciones de compas.

Añadir/editar texto

Para añadir texto, vea Agregar texto (básicos de texto). Para cambiar el texto existente, vea Editar texto.

Cambiar la configuración del instrumento

Para agregar, borrar o cambiar el orden de los instrumentos: en el menú, seleccione Edit&rar;; Instrumentos...; o use el atajo
de teclado, I. Esto abre el cuadro de diálogo Instrumentos que es virtualmente idéntico al diálogo Elegir instrumentosen
el Asistente de partitura nueva (ver arriba)

Vea tambien Cambiar instrumento (Propiedades de pentagrama).

Ocultar pentagrama

Para ocultar un pentagrama permanentemente: Abra el dialogo Instrumentos (I) y demarque la casilla "Visible"
para ese instrumento.
Para ocultar un pentragrama en determinadas condiciones: Vea las opciones "ocultar" en General: Partituras, y
Propiedades de pentagrama.

Ajustar el diseño y formato

Para ajustar la distancia entre pentagramas y sistemas, establecer márgenes de página, etc., ver Diseño y formato.

Plantilla

Una Plantilla es simplemente un archivo comun de MuseScore que ha sido guardado en una de las dos carpetas de
"plantillas": cualquier archivo en estas carpetas sera mostrado automaticamente en la pagina "Elegir plantilla" del
asistente de nueva partitura. Dos carpetas de plantillas son creadas por defecto

Una carpeta de plantillas de sistema.
Una carpeta de plantillas de usuario.

Carpeta de plantillas de sistema

Esta carpeta contiene las plantillas que vienen instaladas con MuseScore y no deben ser modificadas. Puede ser
localizada en los siguientes directorios:

Windows: Usualmente en C:\Archivos de programa\MuseScore 3\templates.

Linux: En /usr/share/mscore-xxx si ha instalado desde el gestor de paquetes. Si compilo MuseScore para Linux usted mismo,
busque en /usr/local/share/mscore-xxx (donde xxx es la versión que esta usando).

MacOS: Bajo /Applications/MuseScore 3.app/Contents/Resources/templates.

Carpeta de plantilla de usuario

Las plantillas personalizadas que vayas a utilizar deben ser guardadas en esta carpeta. Una vez que estén en la carpeta
de plantillas de usuario, apareceran en el asistente para nueva partitura—bajo el encabezado "plantillas personalizadas".

Puede configurar la ubicación de su carpeta de plantillas privadas. Desde el menú, seleccione Edit →
Preferencias...→General .

En Windows, la carpeta de la plantilla de usuario se encuentra en %HOMEPATH%\Documentos\MuseScore2\Plantillas.

En macOS y Linux, la carpeta de la plantilla del usuario se encuentra en ~/Documentos/MuseScore2/Plantillas.

Para configurar la ubicación de su carpeta de plantillas privada:

Desde el menu, seleccione Editar→Preferencias...→General.

Véase también

Armadura de clave
Indicación de compas
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Clave
Tempo
Propiedades de pentagrama

Enlaces externos

Video tutorial: MuseScore en minutos: Leccion 1 - Crear nueva partitura

Introduccion de notas

MuseScore le permite ingresar notación musical desde cualquiera de los de cuatro dispositivos de entrada: teclado de
computadora, ratón, teclado MIDI o teclado de piano virtual. El modo de entrada predeterminado es Entrada de notas
por pasos, en el que las notas o silencios se ingresan uno a la vez. Sin embargo, tambien estan disponibles otros modos
de entrada.

Después de salir del Asistente de partitura nueva, su nueva partitura consistirá en una serie de compases llenos de
silencios:

A medida que ingrese notas en un pentagrama, los silencios del pentagrama se cambian a los silencios apropiados para
llenar el resto del pentagrama:

Las notas de diferentes duraciones en el mismo tiempo se ingresan usando Voces:

Introducción de notas basica

Esta sección presenta los conceptos básicos para ingresar notas y silencios en step-time  desde un teclado de
computadora. También se recomienda que complete el tutorial, "Introducción: una introducción a la entrada de notas en
MuseScore". Esto está disponible desde el Centro de inicio.

Paso 1. Seleccionar una posición inicial

Seleccione una posición de inicio para la entrada de notas haciendo clic en una nota o silencio, o seleccione un
pentagrama, , con el ratón. Si no selecciona un punto de inicio, el cursor se predetermina automáticamente al comienzo
de la partitura cuando ingresa al modo de introducción de notas ("Paso 2" abajo).

Paso 2. Entrar en el modo de introducción de notas

Para ingresar al modo de introducción de notas, use cualquiera de las siguientes opciones:

Haga clic en el botón "N" (en el extremo izquierdo de la barra de herramientas Introducción de notas).
Presione N en el teclado de su computadora.

Para salir del modo de Introducción de notas, use cualquiera de las siguientes opciones:

Presione N.
Presione Esc.
Haga clic en el botón "N" de la barra de herramientas.

Paso 3. Seleccione una duración

Una vez dentro del modo Introducción de notas , seleccione una duración de nota usando cualquiera de los siguientes
procedimientos:

Haga clic en el icono de una nota correspondiente en la Barra de herramientas de Introducción de notas
(directamente encima de la ventana del documento).
Ingrese el atajo de teclado para esa duración (ver a abajo).
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Paso 4. Introducir la nota o silencio

Para ingresar un tono de nota de A-G, simplemente haga clic en la letra correspondiente en el teclado de su
computadora.
Para ingresar un silencio, presione 0 (cero).

Este método de entrada también funciona si no está en el modo de introducción de notas, siempre que seleccione una
nota / silencio o que la partitura esté recién creada (en cuyo caso, la introducción de la nota se iniciará por defecto).

Nota: Introducción de notas en MuseScore sobrescribe notas existentes o silencios en un pentagrama. Si necesita
insertar notas, puede hacer espacio moviendo una sección de la partitura con el comando Copiar y pegar. También
puede insertar nuevos compases en cualquier punto (ver Operaciones de compas: Insertar).

Seleccione la duración de la nota o silencio

Los siguientes atajos del teclado son utilizados para seleccionar la duración de una nota o silencio en Modo de
introducción de notas

Semifusa: 1
Fusa: 2
Semicorchea: 3
Corchea: 4
Negra: 5
Blanca: 6
Redonda: 7
Cuadrada: 8
Longa: 9
Puntillo: . (cambia la selección a silencio o nota con puntillo)

Nota: Dobles y triples puntillos son aplicados desde la barra de herramientas de duraciones o desde un atajo
personalizado.

Vea tambien: Valores irregulares.

Dispositivos de entrada

La notación musical puede ser ingresada con:

Teclado de la computadora.
Mouse.
Teclado MIDI.
Teclado de piano virtual.
Cualquier combinación entre las mencionadas.

Teclado de computadora

Esta sección se amplía en "Introducción de nota básica" (ver arriba) y cubre toda la gama de comandos disponibles para
ingresar notas/silencios desde el teclado de la computadora.

Introduzca notas/silencios

Puede ingresar una nota escribiendo la letra correspondiente en su teclado. Por lo tanto, al escribir C, D, E, F, G, A, B, C se
obtiene:

Nota: Cuando ingresa una nota usando el teclado, MuseScore la ubica más cerca de la nota anterior ingresada (arriba o
abajo).

Para ingresar un silencio, escriba "0" (cero). Por lo tanto, al escribir C D 0 E se obtiene:

Nota: La duración seleccionada en la barra de herramientas se aplica tanto a las notas como a los silencios.

Si desea ingresar una nota con puntillo, presione . (punto) después de seleccionar la duración.
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Por ejemplo, escribiendo 5 . C 4 D E F G A se obtiene:

Si quiere ingresar un grupo irregular: vea Valores irregulares.

Si desea escribir musica con dos o mas lineas melódicas independientes simultaneas en un pentagrama (i. e. polifonia):
vea Voces.

Mover notas arriba/abajo

Para mover una nota hacia arriba o hacia abajo un semitono:

Presione la ↑ o ↓ flecha.

Para mover una nota hacia arriba o hacia abajo diatónicamente:

Presiona Alt+May+↑ or Alt+May+↓.

Para mover una nota hacia arriba o hacia abajo una octava:

Presiona Ctrl+↑ (Mac: ⌘+↑) or Ctrl+↓ (Mac: ⌘+↓).

Agregar alteraciones

Cuando una nota se mueve hacia arriba o hacia abajo con una tecla de flecha (ver arriba), el programa genera
automáticamente las alteraciones precisas. Las alteraciones también se pueden agregar manualmente—ver Alteraciones.

Acordes

Si desea agregar una nota del acorde por encima de la anterior nota introducida:

Mantenga presionada May, luego ingrese una nota de A a G.

Por lo tanto, al escribir C, D, May + F, May + A, E, F se obtendrá:

Para agregar una nota a un interval por arriba o por abajo de una o más notas:

1. Asegúrese de que una o más notas sean selected;
2. 2. Use una de las siguientes opciones:

Desde el menú, seleccione Notas→Añadir Intervalo... y elija un intervalo de la lista;
Presione Alt+1-9 para intervalos hacia arriba (intervalos hacia abajo también son posibles agregando los atajos
a la lista en Preferencias).

Nota: Para crear acordes con notas de diferentes duraciones, necesitará usar más de una Voz.

Borrar notas

Para borra una nota individual:

Seleccione la letra y presione Suprimir.

Para borrar un acorde:

1. Presione Esc para asegurarse que esta en Modo normal.
2. Presione Shift y haga clic en una nota para seleccionar el acorde.
3. Presione Suprimir.

El comando suprimir tambien puede ser aplicado a un rango de notas o acordes.

Atajos de teclado

Aquí hay una lista de atajos de edición útiles disponibles en el modo de introducción de notas:

↑ (Arriba): Aumenta el tono de una nota en un semitono (usa ♯).
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↓ (Abajo): Disminuye el tono de una nota en un semitono (usa ♭).
Alt+1-9: Añade intervalo (unísono a novena) por encima de la nota actual
J: Cambia la nota hacia arriba o hacia abajo a la nota enarmónica (altera la ortografía tanto en el tono del concierto
como en los modos transportados). Ver Alteraciones
Ctrl+J (Mac Cmd+J): Cambia la nota hacia arriba o hacia abajo en enarmónicamente (altera la ortografía solo en el
modo actual). Ver Alteraciones
Alt+May+↑: Aumenta el tono de una nota dentro de la tonalidad de la armadura
Alt+Shift+↓: Disminuir el tono de una nota dentro de la tonalidad de la armadura
R: Repite la última nota ingresada
Q: Reduce a la mitad la duración de la última nota ingresada
W: Duplica la duración de la última nota ingresada
May+Q: reduce la duración en un puntillo (por ejemplo, una negra con puntillo se convierte en una negra y una negra
se convierte en un corchea con puntillo).
Shift+W: Aumenta la duración por un puntillo (por ejemplo, un corchea se convierte en corchea con puntillo y un
corchea con puntillo se convierte en negra).
Backspace: Deshace la última nota ingresada.
X: Voltear la dirección de la plica de la nota (se puede restablecer a la posición automatica en el Inspector)
Shift+X: Mueve la cabeza de la nota al lado opuesto de la plica (se puede restablecer a la posición automatica en el
Inspector)

Ratón

Es fácil ingresar notas con el ratón, pero no es la manera más rápida para ingresar muchas notas.

1. Haga clic en el símbolo de duración de la nota deseada en la Barra de herramientas de introduccion de notas.
2. Haga clic en la partitura para añadir un tono de la duración seleccionada.
3. Para añadir más notas a un acorde existente, simplemente repita el paso 2.
4. Para reemplazar un acorde existente (en lugar de añadirlo), presione May antes de hacer clic.

Nota: Si coloca el cursor sobre la partitura en el Modo de introducción de notas, le mostrará una vista previa de la nota o
el silencio que está a punto de agregar.

Teclado MIDI

También puede introducir las notas empleando un teclado MIDI.

1. Conecte su teclado MIDI a la computadora y encienda el primero
2. Inicie MuseScore (esto debe hacerse después de que el teclado esté encendido)
3. Crear nueva partitura
4. Haga clic en el silencio (seleccionándolo) en el pentagrama 1 para indicar dónde desea que comience la

introducción de notas
5. Presione N para ingresar al modo de introducción de notas
6. Seleccione una duración de nota como 5 para negras, como se describe arriba
7. Presione una nota en su teclado MIDI.

La nota debe ser agregada a tu partitura.
Nota: El metodo de entrada por defecto, Por pasos le permite ingresar las notas una a una. Otros metodos para ingresar
notas estan disponibles: vea Modos de introduccion de notas.

Si tiene múltiples dispositivos MIDI conectados a su computadora, es posible que deba informar a MuseScore cuál es el
teclado MIDI.
1. Desde el menu, seleccione Editar→Preferencias... (Mac: MuseScore→Preferencias...).
2. Haga clic en la pestaña I/O y seleccione su dispositivo bajo la seccion "Entrada MIDI".
3. Haga clic en OK para salir. Tendra que reiniciar MuseScore para aplicar los cambios.

Teclado de piano virtual

También puede ingresar notas usando el teclado de piano en pantalla.
* Para activar y desactivar la visualización: Presione P (o seleccione Ver→teclado de piano).
* Para cambiar el tamaño del teclado: mantenga presionado Ctrl (Mac: Cmd) y mueva la rueda de desplazamiento del ratón
hacia arriba/abajo.

El método de entrada de notas es similar al de un teclado midi:

1. Asegurese de estar en Modo de introduccion de notas.
2. Para ingresar:

Nota individual: Haga clic en la tecla de piano apropiada.
Acorde: Seleccione la nota que desea agregar, presione y mantenda Shift, lugeo haga clic en una tecla del
piano (en versiones anteriores a 2.1, utilize Ctrl (Mac: Cmd)). Repita las veces que sea necesario.

Modos de introduccion de notas
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MuseScore ofrece una variedad de Modos de introduccion de notas ademas de Por pasos. Se puede acceder a todso
haciendo clic en la pequeña flecha al lado del boton "N" a la izquierda de la barra de introduccion de notas:

Por pasos (por defecto): El modo predeterminado de entrada de notas. Ver Introducción de nota básica (arriba).
Repitch: Cambia las notas sin cambiar los valores ritmicos.
Ritmo: Ingrese las duraciones con un solo clic o pulsación de tecla.
Tiempo real (automático): Interprete la pieza a un tempo fijo indicado por un ritmo de metrónomo.
Tiempo real (manual): Interprete la pieza mientras toca una tecla o pedal para establecer el ritmo.
Timewise: Ingrese y borre notas o silencios dentro de un compás, automáticamente moviendo toda la musica
posterior hacia adelante o atras,

Coloración de notas fuera del alcance de un instrumento

Dependiendo de la habilidad del musico, ciertas notas son consideradas fuera del rango de un instrumento en particular.
Por propósitos informativos, MuseScore opcionalmente colorea de rojo notas que están fuera del rango de un musico
"profesional", y de verde/amarillo oscuro si están fuera de un "amateur". Los colores aparecen en la computadora pero no
en la partitura impresa.

Para activar o desactivar la coloracion o para determinar los rangos "profesional" y "amateur", vea Rango de notas usable
(Propiedades de pentagrama: todos los pentagramas).

Notas pequeñas/cabezas de nota pequeñas

1. Seleccione la nota(s) que desee en tamaño pequeño.
2. Marque la casilla de verificación "Pequeño" en el Inspector. El que está en la sección Nota se usa para cambiar

solamente el tamaño de la cabeza de nota individual; el que está en la sección Acorde cambiará los tamaños de la
cabeza, plica, barra y gancho de la nota, todos juntos.

Por defecto, el tamaño pequeño es del 70% del tamaño normal. Puede cambiar esa configuración en Format →Estilo →
General...→Tamaños.

Cambiar notas o silencios ya introducidos

Cambiar duración

Para cambiar la duración de una sola nota o silencio:

1. Asegúrese de que no está en modo de introducción de notas (presione Esc para salir) y no tenga otras notas
seleccionadas.

2. Haga clic en la nota o el silencio y utilice los accesos directos de duración enumerados arriba, o los íconos de
duración en la barra de herramientas, para cambiarlos a la duración de su elección.

Aumentar la duración sobrescribirá las notas o silencios que lo siguen; la disminución de la duración agregará silencios
entre ella y las notas o los silencios siguientes.

Por ejemplo, para cambiar tres semicorcheas en una sola corchea con puntillo:

1. Haga clic en el silencio de la primera semicorchea.
2. Presione 4 para convertirlo en un silencio de corchea.
3. Presione . para convertirlo en un silencio de corchea con puntillo.

A medida que la duración aumenta, sobrescribe los otros dos silencios de semicorchea que lo siguen.
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Cambiar altura

Para cambiar la altura de una sola nota:

1. Asegúrese de que no está en modo de introducción de notas y de que no tiene otras notas seleccionadas.
2. Seleccione la nota deseada y use cualquiera de los siguientes métodos:

Arrastre la cabeza de nota hacia arriba o hacia abajo con el ratón;
Presione las flechas del teclado: ↑ (arriba) o ↓ (abajo);
Escriba un nuevo nombre de letra de nota (A ... G). Utilice Ctrl+↓ o Ctrl+↑ para corregir la octava, si es necesario
(Mac: Cmd+↓ o Cmd+↑).

Para cambiar la ortografía enarmónica de una nota, selecciónela y use el comando J. Para obtener más información.
Alteraciones.

Para cambiar las alturas de un pasaje de música por un intervalo constante, puede usarTransposition.

Para cambiar los tonos de un pasaje de música a una melodía diferente, manteniendo el ritmo inalterado, use Modo de
redefinición de alturas .

Si su partitura contiene muchas alteraciones mal escritas, puede intentar el comando Renombrar las alturas (vea
Alteraciones renombrar alturas).

Cambiar de silencio a nota y viceversa

Para cambiar un silencio por una nota de la misma duración:

1. Asegúrese de que no está en modo de introducción de notas (presione
Esc para salir).

2. Seleccione el silencio.
3. Ingrese la altura deseada ingresando la letra de una nota, A–G.

Para cambiar una nota a un silencio de la misma duración:

1. Asegúrese de que no está en modo de introducción de notas (presione
Esc para salir).

2. Seleccione la nota.
3. Presione 0 (cero).

Propiedades de nota

Para ajustar la posición horizontal de una nota / acorde: vea Desplazamiento de notas.
Para editar las propiedades de las notas en general (espaciado, desplazamiento, tamaño, color, dirección de la
cabeza de nota, reproducción, etc.): vea Propiedades del inspector y objeto.
Para ajustar el diseño de todas las notas en la partitura: vea Diseño y formato, especialmente las secciones acerca
de notas, alteraciones y Valores irregulares.

Véase también

Modos de introducción de notas
Notacion de percusion
Tablatura
Valores irregulares
Voces
Cabezas de nota compartidas
Preferencias

Enlaces externos

Como ingresar un acorde
Como ingresar un silencio
Como hacer que una plica abarque 2 pentagramas
Video tutorial: MuseScore en minutos: Leccion 3- Introduccion de notas
Video tutorial: MuseScore en minutos: Leccion 4 - Introduccion por teclado MIDI
Video tutorial: MuseScore en minutos: Leccion 5 - Mas ideas para ingresar notas
Video: Demostracion entrada en Semi-tiempo real MIDI Parte 1: Nuevos modos de entrada  (Disponible desde
MuseScore 2.1)

Espacios de trabajo

Un __espacio de trabajo___ consta de varios componentes, el principal es el área de paletas, situada a la izquierda de la
ventana del documento.
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Cada paleta es una carpeta que contiene símbolos musicales (usualmente relacionados) que puede ser aplicada en la
partitura. Haga clic en el nombre de la paleta para abrirla y cerrarla.

Para ver u ocultar el área de paletas del espacio de trabajo:

Presione, F9; también puede, desde el menu, seleccionar, Ver → Paletas.

MuseScore proporciona dos espacios de trabajo predeterminados: Básico (la opción predeterminada) y Avanzado (una
versión con más paletas y símbolos). Estas contienen símbolos tomados de las distintas secciones de la Paleta maestra.
También puede crear sus propios espacios de trabajo personalizados (mas abajo).

Para cambiar entre espacios de trabajo
* Seleccione un nuevo espacio de trabajo de la lista desplegable en la parte inferior del panel del espacio de trabajo;
tambien puede seleccionar Ver → Espacios de trabajo, y hacer clic en una de las opciones

Acoplar/desacoplar

Para acoplar o desacoplar un área de trabajo, vea Paneles laterales.

Crear espacio de trabajo personalizado

Los espacios de trabajo Basico y Avanzado estan preconfigurados y no pueden ser modificados por el usuario. Sin
embargo, MuseScore le permite crear sus propios espacios de trabajo que son completamente editables:

Para crear un espacio de trabajo personalizable:
1. Seleccione un espacio de trabajo existente: use la lista desplegable en la parte inferior del espacio de trabajo si hace
falta;
2. Haga clic en el boton + (al lado de la lista desplegable), que muestra el siguiente dialogo:

Nota: esto también puede ser abierto desde el menu: Ver→Espacio de trabajo→New;
3. Ingrese un nombre para el nuevo espacio de trabajo
4. Marque los componentes que desea unir al espacio de trabajo, es decir:
* Barras de herramientas: Le permite personalizar las barras de herramientas y el orden en el que estas son
mostradas.Puede acceder a esto desde Ver→Barras de herramientas→Personalizar barras de herramientas.
* Barras de menú: Le permite cambiar los menús y items mostrados en los en la Barra de menú. TODAVÍA NO ESTA
IMPLEMENTADO;
* Componentes de la interfaz gráfica: Guarda información con el espacio de trabajo sobre la posición de lo la interfaz
gráfica y sus componentes, y si están abiertos o no. (e.g. Inspector, Linea de tiempo);
* Preferencias de la interfaz gráfica: Guarda las preferencias seleccionadas para la interfaz grafica en

44



Editar→Preferencias, como el Tema y la configuración del Lienzo;
5. Presione Guardar. El nuevo espacio de trabajo es agregado al panel.
Para insertar, borrar, renombrar y reordenar las paletas dentro de un espacio de trabajo personalizado; o editar la
apariencia de la paleta; o habilitar la edicion de los contenidos de una paleta: vea Menu de paleta.

Para agregar, reordenar, o borrar contenidos de la paleta: vea Paletas personalizadas.

Editar espacios de trabajo

Para editar el nombre del espacio de trabajo o para cambiar que componentes son asociados con el espacio de trabajo:
* Seleccione Ver→Espacio de trabajo→Editar.

Esto muestra una ventana con las mismas opciones que el dialogo Crear nuevo espacio de trabajo (ver arriba).

Véase tambien

Paletas
Paleta maestra

Modo de edición

Modo de edición le permite realizar una amplia gama de operaciones de edición en elementos de puntuación
individuales, como:

Ajustar la longitud y la forma de las ligaduras, líneas, barras, etc.
Agregar, eliminar y formatear texto en objetos de texto.
Ajustar la posición de la mayoría de los elementos de la partitura (pero no del texto).

Entrar/salir del modo de edición

Para ingresar en el Modo de edición use cualquiera de los siguientes métodos:

Haga doble clic en un elemento.
Haga clic derecho en un elemento y, desde el menú, seleccione Editar elemento.
Haga clic en un elemento y presione Ctrl+E (Mac: Cmd+E).

Para salir del Modo de edición use cualquiera de los siguientes:

Presione Esc.
Haga clic en un área en blanco de la ventana del documento.

Texto

Para el Modo de edición, vea Edición de texto.

Lineas

Vea Lineas: Cambiar longitud, and Ajustar ligaduras.

Notas

Compensación de notas

En ocasiones, es necesario desplazar una nota hacia la derecha o hacia la izquierda para evitar una colisión con otro
elemento o anular las cabezas de nota compartidas por ejemplo:

1. Ingrese en Modo de edición en la nota deseada;
2. Presione la tecla de flecha en la dirección (izquierda o derecha) que desea empujar la nota (o use Ctrl+← o Ctrl+→

para ajustes más grandes);
3. Presione la tecla Esc. Esto permitirá que la plica sea redibujada.

Alternativamente, puede seleccionar la cabeza de nota y cambiar el "Desplazamiento horizontal" (en "Acorde") en el
Inspector.

Ajustar la longitud de la plica de nota

1. Ingrese en Modo de edición en la plica deseada;
2. Utilice atajos de teclado (abajo) para extender o acortar la plica;
3. Salga del modo de edición.

Nota: Para reposicionar una plica de nota, debe seleccionarla y ajustar el "Desplazamiento horizontal" en el Inspector.
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Para reposicionar una plica, debe seleccionarla y ajustar el valor "X" o "Y" para "Desplazamiento" bajo "Posicionamiento
automatico" en la seccion "Elemento" del Inspector.

Atajos de teclado

En Modo de edición, los siguientes comandos de teclado se pueden usar para cambiar la posición de (1) un elemento
de partitura (por ejemplo, adorno, alteración, etc.) o (2) un control de ajuste (por ejemplo, ligadura, línea, etc.):

←: Mover a la izquierda 0.1 Ajustes de página.
→: Mover a la derecha 0.1 espacio de pentagrama
↑: Mover hacia arriba 0.1 espacio de pentagrama
↓: Mover hacia abajo 0.1 espacio de pentagrama
Ctrl+← (Mac: ⌘+←): Mover a la izquierda un espacio de pentagrama
Ctrl+→ (Mac: ⌘+→): Mover a la derecha un espacio de pentagrama
Ctrl+↑ (Mac: ⌘+↑): Mover hacia arriba un espacio de pentagrama
Ctrl+↓ (Mac: ⌘+↓): Mover hacia abajo un espacio de pentagrama
Alt+←: Mover a la izquierda 0.01 espacio de pentagrama
Alt+→: Mover a la derecha 0.01 espacio de pentagrama
Alt+↑: Mover hacia arriba 0.01 espacio de pentagrama
Alt+↓: Mover hacia abajo 0.01 espacio de pentagrama
May+←: Mover el ancla del control final a la nota/silencio de la izquierda
May+→: Mover el ancla del control final a la nota/silencio de la derecha
Tab: Ir al siguiente control

Para deshacer todos los cambios, asegúrese de no estar en modo de edición y presione Ctrl+R.

Ver también

Edición de texto
Ligadura
Llave
Línea
Barras de agrupación
Regulador

Paletas

A la izquierda de la ventana del documento está el área de las paletas: una Paleta es una carpeta que contiene simbolos
musicales (normalmente relacionados) que pueden ser aplicados en la partitura. Juntas, las paletas forman la seccion
principal de un espacio de trabajo.
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Mostrar y ocultar paletas:

Desde el menú, seleccioneVer → Paletas, o el atajo, F9 (Mac: fn+F9).

Modo una paleta por vez

Si quiere que solamente se permita abrir una paleta al mismo tiempo, haga clic derecho encima del espacio de trabajo y
marque la casilla "Una paleta por vez". Esto causara que una paleta se cierre automáticamente cuando abra una
diferente.

Abrir/cerrar paleta

Haga clic una vez en el nombre de la paleta o su flecha flecha horizontal.

Aplicar símbolos desde una paleta

Se puede aplicar un símbolo de la paleta a la partitura usando uno de los siguientes métodos:

Seleccione uno o más elementos de partitura y haga doble clic en el símbolo de la paleta.
Arrastre y suelte el símbolo en el elemento de partitura deseado en el pentagrama.

Tip: Para prevenir un reordenamiento accidental de los contenidos durante el uso, haga clic derecho sobre el nombre de
una paleta y desmarque "Habilitar edicion".

Por ejemplo, para agregar marcas tenuto (-) a una selección de notas:

1. Seleccionelas notas deseadas.
2. En la paleta Articulaciones y adornos, haga doble clic en el símbolo de tenuto

Una vez agregado a la partitura, los objetos se pueden copiar, pegar y duplicar: ver Copiar y pegar.

Paletas personalizadas

Una vez que haya creado un espacio de trabajo personalizado, y esté habilitada la edición (vea Menú de la paleta abajo),
puede personalizar las paletas que contiene según sus propias preferencias.

Para agregar un elemento de partitura existente (como una línea, texto, dinámica, diagrama de acorde, etc.) a una paleta
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personalizada:

Mantenga presionada la tecla Ctrl+May, luego arrastre el símbolo a la paleta.
Para agregar un símbolo a un espacio de trabajo personalizado desde la Paleta Maestra:

Arrastre el símbolo desde la paleta maestra hasta una paleta personalizada.

Para reordenar los símbolos en una paleta personalizada:
* Arrastre el símbolo a la celda en la que desea mostrarlo: este cambiara su lugar con el símbolo que esta ocupando esa
celda.

Menú de paleta

Al hacer clic con el botón derecho en el nombre de una paleta en un espacio de trabajo personalizado aparece un menú
con varias opciones:

Propiedades de la paleta...: Esto le permite hacer ajustes en la apariencia de la paleta abierta:

Nombre
Tamaño de celda: Ancho, Altura
Posición de los elementos: Ajusta el desplazamiento vertical de todos los elementos en la paleta.
Escala: Hace que todos los elementos de la paleta aparezcan más grandes o más pequeños.
Mostrar cuadrícula: Marque esta casilla para dividir visualmente la paleta en celdas, una para cada elemento.
Mostrar 'Más elementos ...': Marque esta casilla para crear una celda que abra la paleta maestra.

Insertar paleta nueva: Crea una nueva paleta vacía.
Subir paleta / Bajar paleta: Le permite reordenar las paletas.
Habilitar edición: Marque esta opción si quiere poder editar una paleta.
Guardar paleta: Guardar como un archivo .mpal.
Cargar paleta: Cargue un archivo .mpal.
Eliminar paleta

Al hacer clic derecho en un elemento dentro de una paleta (si la edición de la paleta está habilitada) aparece un menú con
las siguientes opciones:

Borrar: Elimina el elemento de la paleta.
Propiedades...: Abre el diálogo Propiedades de la celda:

Nombre: La información sobre herramientas que aparece cuando pasas el ratón sobre el elemento.
Desplazamiento del contenido (X, Y): Ajusta la posición del elemento en la paleta.
Escala de contenido: Hace que el elemento parezca más grande o más pequeño en la paleta.
Trazar pentagrama: Traza las cinco líneas de un pentagrama musical detrás del elemento de la paleta.

Más elementos: Abre la sección Paleta Maestra correspondiente.

Nota: El cambio de valores en "Propiedades de la celda" solo afecta la apariencia de los elementos en la paleta. No
cambia sus tamaños o desplazamientos en la página de partituras.

Comportamiento de texto y líneas aplicadas

Si el símbolo que está agregando a la partitura desde una paleta contiene un elemento de texto (p. Ej., Texto de la
pentagrama, dinámica, digitación, volta, etc.), entonces propiedades como tipo de tipografía, tamaño de tipografía, el
color del texto y la alineación se adaptarán de acuerdo con las siguientes reglas:

1. Las propiedades del texto que no hayan sido alteradas por el usuario adoptarán los estilos de texto.

2. Las propiedades de texto personalizadas, es decir, aquellas cambiadas por el usuario antes de guardar el símbolo
en una paleta personalizada, permanecen según estaban personalizadas.
A diferencia, las propiedades de linea de una linea aplicada desde una paleta siempre se mantiene sin cambios. (i.e.
como fue configurado por el usuario antes de guardar a un espacio de trabajo personalizado, o como esta
predefinido en el espacio de trabajo Basico/Avanzado.

Véase tambien
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Paleta maestra

Inspector

Mostrando el Inspector

El Inspector se muestra por defecto a la derecha de su pantalla. Para mostrarlo u ocultarlo:

Desde el menú, seleccione y marque o desmarque Inspector; también puede usar el atajoF8 (Mac: fn+F8).

Para desacoplar el panel del Inspector:
* Haga clic en el doble-chevron o doble clic en la barra superior del panel.

Para volver a acoplar el panel haga doble clic en la barra superior de nuevo. Véase también Visualización y navegación.

### ¿Que hace el Inspector? {#what-it-does}
Cuando seleccione cualquier objecto en la partitura, sus propiedades se muestran y se pueden editar desde el inspector.
Elementos múltiples también pueden ser seleccionados y editados simultáneamente, siempre que sean del mismo tipo.
Sin embargo, si los objetos seleccionados son de diferentes tipos, entonces el Inspector lo restringe a la edición de color
y visibilidad solamente.

"Restablecer a estilo por defecto" y "Establecer como estilo"

Cuando seleccione un objeto en la partitura, dos tipos de botones son claramente visibles en a la derecha en el Inspector:

* Restablecer a estilo por defecto: . Presione este boton para restablecer una propiedad en particular al valor por
defecto i.e. la que se muestra en el Menu Estilo.

Establecer como estilo: . Presione este botón para convertir el valor de una propiedad en particular en el valor
por defecto para el estilo. Esto actualizara el Style menu y todos los demás objetos gobernados por ese estilo.
Nota: Tambien puede editar estilos directamente desde el Menu Estilo.

Categorías del inspector

Las propiedades que se pueden editar se dividen en categorías en el Inspector. Las categorías se pueden identificar por
sus letras en negrita y centradas. Por ejemplo, si selecciona una barra de compás, verá lo siguiente en la parte superior
del Inspector:

Para detalles sobre cómo ajustar las propiedades de varios elementos de partitura, vea mas abajo:

Elemento

Todos los elementos de la partitura—excepto cuadros, saltos y espaciadores— se muestran esta categoría en el
Inspector cuando se seleccionan. Las opciones son las siguientes:

Visible: Desmarque esta casilla para hacer que los elementos seleccionados sean invisibles: como alternativa, use
el atajo V (alternar). Los elementos invisibles no aparecen en la música cuando se imprimen o se exportan como
PDF o imagen. Si aún desea que permanezcan en la pantalla en la ventana del documento, asegúrese de que la
opción "Mostrar elementos invisibles" esté seleccionada en Ver → Mostrar elementos invisibles. Los elementos invisibles
serán coloreados gris claro.

Orden de superposición:: Vea Posicionamiento automático: Orden de superposición:
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Color: Haga clic en el rectángulo para abrir un cuadro de diálogo "Seleccionar color". Ajuste el color y la opacidad
de los elementos seleccionados.

Posicionamiento: Vea Posicionamiento automático.

Desplazamiento X/Y: le permite colocar los elementos seleccionados exactamente (en términos de unidades de
espacio). Un número positivo mueve los elementos hacia la derecha o hacia abajo; un número negativo mueve los
elementos hacia la izquierda o hacia arriba. También se proporcionan botones Ajustar a cuadricula.

Grupo de elementos

Esta categoría se muestra solo cuando ha seleccionado una mezcla de diferentes tipos de elementos, y solo permite
editar el color y la visibilidad.

Segmento

Leading Space: Se usa para aumentar o disminuir el espacio antes/después de un elemento. El ajuste también
afecta a las sílabas correspondientes en el texto.

Acorde

Offset X/Y: Cambia la posición de cada nota en la misma voz como las nota/s seleccionada/s. Si quiere hacer
cambios a la posición de solo una nota, use la categoría Elemento en su lugar).
Pequeño: Hace pequeñas las cabezas de nota y plicas.
Sin plica: Quita la plica del acorde.
Dirección de plica: Puede elegir Auto, Arriba, o Abajo.

Nota

Esta categoría le permite realizar cambios en las notas seleccionadas (para la posición de la nota, ver Elemento).
Contiene las siguientes propiedades:

Pequeña: hacer que la cabeza de nota sea más pequeña (puede especificar el tamaño relativo de todas las notas
pequeñas del menú: Formato → Estilo → General… → Tamaños…).
Grupo de cabezas: Vea Grupos de cabezsas.
Tipo de cabeza: Ver Tipos de cabeza.
Orientación de cabeza: coloque la cabeza de nota a la izquierda o a la derecha de la plica (el valor predeterminado
es "Auto").
Afinación: ajusta la afinación de la nota al cent.
Reproducir: desmarcar esta casilla silencia la nota.
Tipo de velocidad: establece la velocidad (volumen) MIDI de las notas directamente. Elija una de dos opciones:

Desplazamiento: haga que el valor mostrado en "Velocidad" relativo a la marca dinámica anterior.
Usuario: hace que el valor mostrado en "Velocity" sea absoluto (es decir, la velocidad MIDI no se vea
afectada por marcas dinámicas).

Velocidad: establece la velocidad MIDI de acuerdo con la opción que se muestra en "Velocity type".
Fijar a la línea: cuando está marcada, la nota se fija en la línea superior del pentagrama estándar de 5 líneas.
Línea: un número positivo mueve la nota "fija" hacia abajo; un número negativo lo mueve hacia arriba.

Seleccionar

Esta categoría aparece de manera diferente según la selección que haya realizado:

Si selecciona una cabeza de nota, la categoría "Seleccionar" muestra botones que le permiten cambiar fácilmente la
selección a la plica, barra de agrupación,corchete, puntillo (o puntillos) de duración o valor irregular asociado con la
cabeza de la nota (vea la imagen a abajo).

Si selecciona un rango de pentagramas, la categoría "Seleccionar" le permite seleccionar ya sea todas notas, _
notas de adorno_ o silencios.

Barras de agrupación

Esta sección se muestra en el Inspector cuando selecciona una o más barras de agrupación de notas, y le permite hacer
ajustes finos en la posición y el ángulo de la barra de agrupación, y también cambiar el espaciado de las notas con
barras. Ver Ajustar la barra de agrupación con el inspector.

Clave
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Esta sección aparece cuando seleccionas una clave: la casilla de verificación te permite activar/desactivar la muestra de
una clave de cortesía anterior.

Articulación

Esta categoría se muestra cuando selecciona una articulación u ornamento. Están disponibles las siguientes opciones:

Dirección: Selecciona si el símbolo apunta hacia arriba o abajo: solo aplicable a ciertos símbolos
Anclaje: El posicionamiento vertical del símbolo.
Expansión de tiempo: Solo aplicable a fermatas. Permite varias la pausa en la reproducción.
Estilo de adorno:: Puede elegir por defecto o estilo barroco.
Reproducir: Activa o desactiva la reproducción.

Propiedades del Diagrama de Acorde

Vea Diagrama de Acorde.

Linea

Esta categoria se muestra cuando se selecciona una linea. Aqui puede configurar varias propiedades generales.

Visible: Muestra u oculta solo la linea: cualquier texto permanecerá visible
Permitir diagonal: Por defecto la linea es horizontal (desmarcado). Marque si desea editar la linea para crear una
diagonal.
Color de linea/grosor/estilo: Elija varias propiedades para la linea.

Linea de texto

Esta categoría es mostrada cuando una line esta seleccionada. Permite determinar la configuración de las palabras en
una linea, editar las propiedades de texto, configurar los ganchos, y alinear el texto con respecto a la linea.

Gancho inicial / Altura: Al principio de una linea, puedes especificar sin gancho, o un gancho vertical o en ángulo;
determinar la altura del gancho.

Gancho final / Altura: Lo mismo pero para el final de la linea

Texto al comienzo / Continuación del texto / Texto final: Se refiere al texto al comienzo de una linea; al principio
de una continuación de la linea; o al final de la linea. Todos tienen las mismas propiedades:* Texto: Crear o editar
texto asociado con la linea.

Tipo de fuente / Tamaño / Estilo: Determine las Propiedades del texto,y/o edite el Estilo de texto de la linea.
Alineación: Determine la alineacion horizontal y vertical del texto en relacion a la linea.
Ubicación: Ubique el texto en (Encima/Debajo), o a la izquierda de la linea.
Desplazamiento X / Y: Ajuste el desplazamiento en los ejes x/y para un posicionamiento exacto.

Cuadros de dialogo de propiedades

Algunas tipos de objetos tienen propiedades adicionales. Se accede a estas haciendo clic derecho en el objeto y
eligiendo una opción "... propiedades" en el menú contextual. Las configuraciones disponibles en estos cuadros de
dialogo son explicadas en la descripción de tipos de objeto en Notacion  o Temas Avanzados .

Vea:

Articulaciones y ornamentos
Indicaciones de compás
Texto de pentagrama y texto de sistema
Operaciones de compas
Propiedades de pentagrama/parte

Véase tambien

Introducción de notas
Formato y diseño
Partes

Operaciones de compas
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Nota: para garantizar que los compases insertados o anexados se visualicen correctamente, los silencios multicompas
deben estar apagados (alternar M).

Seleccionar

Compás Solo

Para seleccionar un solo compás, haga clic en un espacio vacío dentro del compás.

Rango de compases

Para seleccionar un rango continuo de compases, ver Shift + clic seleccion y Shift seleccion.

Insertar

Insertar un compás vacío en la partitura

Use una de las siguientes opciones:

Seleccione un compás, luego presione Ins (sin atajo en Mac).
Seleccione un compás y luego elija desde el menú: Añadir→Compases→Insertar un compás.

Insertar compases múltiples

Use una de las siguientes opciones:

Seleccione un compás, luego presione Ctrl+Ins (sin atajo en Mac); complete el campo "Número de compases para
insertar" y presione Aceptar.
Seleccione un compás y luego elija desde el menú: Añadir→Compases→Insertar compases...; complete el campo
"Número de compases para insertar" y presione Aceptar.

Añadir

Añadir un compás vacío al final de una partitura

Use una de las siguientes opciones:

Presione Ctrl+B (Mac: ⌘+B).
Seleccionar del menú: Añadir→Compases→Añadir un compás al final.

Añadir múltiples compases vacíos al final de una partitura

Use una de las siguientes opciones:

Presione Alt+May+B (Mac: Option+May+B); complete el campo "Número de compases a añadir" y presione Aceptar.
Seleccionar del menú: Añadir→Compases→Añadir compases al final... ; complete el campo "Número de compases a añadir"
y presione Aceptar.

Borrar

Borrar un solo compás

1. Haga clic en el compás;
2. Presione Ctrl+Supr (Mac: Cmd+Supr); o desde el menú, seleccione Editar→Compases→Borrar los compases seleccionados.

Borrar un grupo de compases

1. Select the range of measures to delete;
2. Press Ctrl+Del (Mac: Cmd+Del).

Notas: (1) En partituras de múltiples pentagramas, la eliminación de un compás también elimina todas las compases
correspondientes en los otros pentagramas del sistema; (2) Si desea eliminar solamente el contenido de compás (y no el
compás completo), use el comando Del en su lugar en el paso "2".

Propiedades de compás

Para editar las propiedades de un compás, haga clic derecho en una parte vacía del compás y seleccione Propiedades de
compás...:
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Puede usar los botones  en la esquina inferior izquierda del cuadro de diálogo, para navegar hasta el compás
anterior o siguiente.

Pentagramas

La propiedad visible le permite mostrar/ocultar las notas y las líneas del pentagrama para el compás actual.
La propiedad sin plica le permite mostrar/ocultar todas las plicas de notas en el compás actual. Las notas que
normalmente tienen una plica, como blancas y negras, solo muestran la cabeza de las notas cuando están
marcadas como sin plica.

Duración de Compás

Esta característica le permite ajustar la indicación del compás de un solo compás independientemente de la indicación
del compás indicado en la partitura. Puede usarlo para crear un compás de anacrusa, una sección cadenza, ad lib, etc.

Nominal es la indicación aparente del compás y no se puede editar.
Real se puede establecer en cualquier valor, independientemente de la indicación nominal de compás.

Ejemplo: en la imagen a continuación, la negra compás de anacrusa tiene una indicación de compás nominal de 4/4,
pero una indicación de compás real de 1/4. Los compases en el medio están en 4/4 la indicación de compás normal. El
compás de anacrusa al final del pentagrama, con una blanca con puntillo, tiene una indicación de compás real de 3/4.

Otros

Excluir del contador de compases

Para compases que no deberían contarse en la numeración del compás. Normalmente, un compás de anacrusa se
marca como "Excluir del contador de compases".

Separar compases de espera

Esta propiedad separará silencios multicompas al inicio del compás seleccionado. Esta opción debe marcarse antes de
activar la opción "Crear silencios multicompás" en Formato→Estilo...→Partitura.

Los silencios multicompás se rompen automáticamente en lugares importantes, como Guías de ensayo, cambios en las
indicaciones de compás, barras dobles, compases irregulares, etc. El valor predeterminado para la partitura es apagado,
para las partes esta encendido.
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Modo de numero de compás

Esto le permite controlar como los números de compás son mostrados en el compás seleccionado. Elija "Auto," "Mostrar
Siempre" o "Siempre oculto".

Ancho de diseño

Puede aumentar o disminuir el espacio horizontal entre los elementos de la partitura (notas, silencios, etc.) con esta
opción. Esto proporciona un control más preciso sobre la misma propiedad de espaciado de compás que los comandos
de menú o los métodos abreviados de teclado para Diseño y formato ({ and }), a los que se accede desde el cuadro de
diálogo "Propiedades de compás mientras" se selecciona el compás.

Añadir al número de compás

También puede usar la opción "Añadir al número de compás" para influir en la numeración del compás. Puede ingresar
números positivos o negativos. Tenga en cuen.ta que esto afecta a todos los compases posteriores. Un valor de "-1" tiene
el mismo efecto que marcar un compás para ser excluido del contador de compases

Cantidad de repeticiones

Si un compás precede a una barra de repetición final, este valor controla el número de veces que la sección de repetición
se reproduce: véase también, [node: 278591, title= "Repeticiones y saltos"].

Numeración

MuseScore numera automáticamente el primer compás de cada sistema (a excepción del primer sistema, en realidad,
excepto un compás con el número 1), pero son posibles más opciones de numeración. Desde el menú principal, elija
Formato→ Estilo→General..., en el panel izquierdo, seleccione la pestaña de "Encabezado, Pie, Núm...". En la parte inferior
del panel derecho está la sección __"Numeros de compás".

Marque la casilla de verificación junto a "Numeros de compás" para activar los números de compás automáticos.

Marque "Mostrar el primero" si desea que el primer compás sea numerado.

Marque "Todos los pentagramas" si quiere números en todos los pentagramas. De lo contrario, solo el pentagrama
superior de cada sistema muestra los números del compás.

Elija mostrar números en "En cada sistema" para numerar el primer compás de cada línea, o puede mostrar los números
por "Intervalo" y especificando el tamaño del intervalo. Por ejemplo, un intervalo de 1 numera cada compás; un intervalo
de 5 añade la numeración cada cinco compases.

Dividir y unir

Es posible que desee crear un compás más largo o más corto sin cambiar la indicación de compás. Puede cambiar la
duración de un compás en [Propiedades de compás] (#properties), pero además hay una nueva opción para dividir o unir
compases. (Las barras de agrupación se pueden modificar automáticamente).

Unir compases

Metodo A. Unir solo dos compases:
* Seleccione la barra de compas entre dos compases y presione Ctrl + Delete.

__Metodo B_. Para unir cualquier numero de compases:
1. Seleccione los compases que desea unir.
2. Desde la barra de menu, selecciones Herramientas→Compas→Unir compases seleccionados.

Notas: (1) si selecciona compases en solo un pentagrama en una partitura con múltiples pentagramas, los mismos
compases se unirán en cada pentagrama del sistema. (2) Las barras de agrupación pueden ser modificadas
automáticamente.

Dividir un compás

Puede elegir cualquiera de los siguientes métodos:

Seleccione una nota; luego mantenga apretado Ctrl y haga doble clic en una barra de compás en una paleta.
Mantenga Ctrl y arrastre una barra de compas (desde una paleta) a la nota que empieza el nuevo compas.
Seleccione una nota, en la barra de menú, seleccione Herramientas→Compás→Dividir compás antes de la Nota Seleccionada.

Nota: si selecciona una sola nota de un pentagrama, cada pentagrama del sistema se dividirá en el mismo lugar.

Enlaces externos
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Como borrar compases seleccionados
Como estirar un compás a través de múltiples sistemas
Como escribir partituras sin indicación de compás (ni clave)

Voces

Una voz es una línea o parte musical que puede tener su propio ritmo independientemente de otras voces en el mismo
pentagrama. Las voces a veces se llaman "capas" en otro software de notación.

Puede haber hasta 4 voces en cada pentagrama individual. En un compás polifónico, voz 1 usualmente tiene la plica de
la nota arriba y voz 2 tiene la plica de la nota hacia abajo.

Nota Tenga cuidado de no confundir el concepto de voces de MuseScore (1, 2, 3, 4) con el orden de las voces que se
encuentran en las partituras vocales (SATB, etc.). En particular, al crear una partitura SATB cerrada, use solo las voces
(de MuseScore) 1 y 2 para los pentagramas superior e inferior. No es necesario utilizar las voces (de MuseScore) 3 y 4 a
menos que haya más de dos partes en el mismo pentagrama.

Cuándo usar las voces

Si necesita plicas apuntando en direcciones opuestas dentro de un acorde, en un solo pentagrama.
Si necesita notas de diferentes duraciones dentro de un solo pentagrama, sonando simultáneamente.

Cómo ingresar notas en diferentes voces

Las siguientes instrucciones le muestran cómo anotar un pasaje de música en dos voces:

1. Ingrese en primer lugar las notas de la voz 1: asegúrese de estar en Modo de introducción de notas : el botón
Voz 1 se resalta en azul en la barra de herramientas. Primero ingrese las notas en la parte superior de la voz. Al
ingresarlas, algunas notas pueden tener plicas descendentes, pero estas se voltean automáticamente cuando se
agrega la segunda voz.

El siguiente extracto muestra una clave de Sol con las notas de la voz 1 solamente ingresadas:

2. Mueva el cursor al comienzo de la sección: cuando haya terminado de ingresar una sección de notas de la voz
1, presione la tecla ← repetidamente para mover el cursor, nota por nota , volviendo a la primer nota de la sección;
o alternativamente use Ctrl+← (Mac:Cmd+←) para mover el cursor hacia atrás de compás en compás. O bien,
simplemente puede salir de modo de introducción de notas (presione Esc) y haga clic directamente en la primera
nota.

3. 3. Ingrese las notas de la voz 2: Asegúrese de que está en el modo de introducción de notas y que la primer

nota de la voz 1 al comienzo de la sección está seleccionada. Haga clic en el botón "Voz 2"  (a la derecha
de la barra de herramientas), o use el atajo Ctrl+Alt+2 (Mac: Cmd+Option+2). Ingrese todas las notas de voz más
baja (plicas hacia abajo).

La siguiente imagen muestra el ejemplo anterior después de la adición de notas de la voz 2:

Borrar y ocultar silencios

Mientras que los silencios de las voces 2, 3 y 4 se pueden eliminar, los silencios de la voz 1 son permanentes. Sin
embargo, pueden ocultarse, si es necesario, haciéndolos invisibles. Para ocultar un silencio, selecciónelo y presione V; o
desmarque la casilla "Visible" en el Inspector). Los silencios en las voces 2, 3 y 4 también pueden ser borrados pero no
es recomendado normalmente: hágalos invisibles en su lugar. Los silencios en la voz 1 no pueden ser borrados.

Restaurando silencios borrados

Si un silencio a sido borrado en las voces 2-4, tendra que restaurarlo antes de poder ingresar una nota en ese tiempo en
esa voz (el problema puede surgir, por ejemplo, en archivos importados de XML or MIDI). La manera mas facil de
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arreglar un compas asi es intercambiar esa voz con la voz 1 dos veces. Para el metodo exacto vea Intercambiar notas
entre voces (abajo).

Intercambiar notas entre voces

Para intercambiar las notas entre dos voces:

1. Seleccione uno o mas compases contiguos (o un rango de notas);
2. Desde la barra de Menú, seleccione Editar → Voces;
3. Seleccione la opción para las dos voces que quiere intercambiar

Notas: (a) La selección puede abarcar el contenido de cualquier voz, pero solo dos se procesarán a la vez. (b) Si
selecciona solo una parte del compás, la operación se aplicará a todo el compás igualmente.

Mover notas a otra voz (sin intercambiar)

También puede mover notas de una voz a otra (sin intercambio de notas):

1. Asegúrese de que no está en modo de introducción de notas.
2. Seleccione una o más cabezas de nota (en cualquier voz).
3. Haga clic en la voz de destino en Barra de herramientas de introducción de notas o use el atajo Ctrl+Alt+1–4 (Mac:

Cmd+Option+1-4).

Nota: Para que el movimiento sea exitoso, se deben cumplir las siguientes condiciones:

El (los) acorde(s) en la voz de destino deben tener la misma duración que la(s) nota(s) que se moverán allí.
Hay suficiente duración de silencio en la voz de destino para acomodar las notas nuevas.
La (s) nota (s) no pueden estar ligadas.

Véase tambien

Voces: atajos de teclado
Cabezas de notas: Cabezas de notas compartidas

Enlaces externos

Cómo fusionar/combinar/implosionar dos pentagramas en uno con dos voces
Video tutorial: Cómo escribir dos partes en un solo Pentagrama: Voces

Copiar y pegar

MuseScore permite operaciones estándar de cortar, copiar, pegar, intercambiar con portapapeles. Estos comandos
se pueden aplicar a un rango de:

Notas musicales: p. para repetir una sección de música, o cambiar un pasaje por un tiempo o un compás.
Otros elementos de partitura: como articulaciones, texto de pentagrama, dinámica, digitación, etc.

Nota: Lineasno pueden copiarse, pero pueden duplicarse (ver abajo).

Se puede acceder a los comandos de Copiar/cortar/pegar/intercambiar de tres maneras:

Desde el menú Editar (arriba de la ventana del documento).
Desde el menú mostrado por derecha-clic en un elemento o rango de elementos.
Usando uno de los atajos de teclado estándar.

Resumen de comandos

Comando Kbd Atajo
(Win)

Kbd Atajo
(Mac) Menu con clic derecho Menu principal

Cortar Ctrl+X Cmd+X Cortar Editar → Cortar
Copiar Ctrl+C Cmd+C Copiar Editar → Copiar
Pegar Ctrl+V Cmd+V Pegar Editar → Pegar
Intercambiar con
portapapeles Ctrl+Shift+X Cmd+Shift+X

Intercambiar con
portapapeles

Editar → Intercambiar con
portapapeles

Note: antes de realizar un procedimiento de copiar, cortar, pegar o intercambiar, debe estar en modo normal. . Presione
la tecla Esc para entrar al modo normal.

Notas
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Puede cortar, copiar, pegar o intercambiar notas de la siguiente manera:

Copiar o cortar

Para copiar / cortar un solo acorde

1. Mantenga presionada May y haga clic en una nota en el acorde.
2. Aplique una opción copiar o cortar (ver tabla arriba).

Para copiar / cortar un _rango de acordes

1. HagaClic en la primera nota o compás que desee seleccionar.
2. May+ HagaClic en la última nota o compás que desee seleccionar. Un rectángulo azul resalta la región que

seleccionó.
3. Aplique una opción copiar o cortar (ver tabla arriba).

Pegar

1. Haga Clic en la nota o compás donde desea que comience la selección pegada.
2. Aplicar una opción__Pegar__ ver tabla(arriba).

Intercambiar con portapapeles

la operación intercambiar con portapapeles combina dos comandos en uno: (1) Primero sobrescribe una parte
seleccionada de la partitura con el contenido del portapapeles, al igual que el comando pegar comando; (2) En segundo
lugar, transfiere la parte sobrescrita de la partitura al portapapeles, al igual que el comando copiar.

Se puede usar, por ejemplo, para intercambiar dos secciones de igual longitud de una partitura, A Y B:

1. Seleccione la seccion A, luego aplique el comando cut;
2. Borre la selección (presionando Esc o haciendo clic en un área en blanco de la ventana del documento);
3. Presione May y haga clic en una nota al comienzo de la sección B. O bien, si B comienza al comienzo de un compás

, también puede simplemente seleccionar  el compás ;
4. Seleccionar la opción intercambiar con portapapeles (ver tabla arriba).
5. La sección B ahora está en el portapapeles. Pégalo de nuevo al área en blanco de la partitura que dejó el paso "1".

Copia la altura de una sola nota solamente

Es posible copiar la altura de una sola nota solamente (y ninguna otra propiedad) haciendo clic en la cabeza de nota y
aplicando el procedimiento estándar de copiar y pegar, o copiar e intercambiar. El tono de la nota de destino cambia para
coincidir con el de la nota copiada pero la duración permanece igual.

Otros elementos

Otros elementos de la partitura (como texto de pentagrama, dinámica, digitación, diagramas de acordes, etc.) se pueden
cortar, copiar y pegar de a una por vez. Las articulaciones (sforzato, staccato etc.), además, permiten una selección
múltiple.

Nota: el comando Intercambiar con portapapeles solo está previsto para su uso con secciones de música y no con otros
elementos.

Copiar o cortar

1. Seleccioneel elemento (o elementos).
2. Aplicar una opción Copiar o Cortar (ver tabla(arriba).

Pegar elementos

1. Haga Clic en la nota donde desea que comience su selección pegada.
2. Aplique una de las opciones de Pegar (ver tabla(arriba).

En el caso de las articulaciones, se pegan en las notas de destino exactamente en el mismo orden (continuo o
intermitente) que en la selección inicial.

Repetición rápida

Para copiar y pegar rápidamente una nota, compás o pasaje:

1. Seleccione un acorde, compás o pasaje como se describe arriba.
2. Presione R.
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MuseScore copia y pega la notación seleccionada en un punto inmediatamente después de la última nota de la selección.
Se reemplaza cualquier música existente en el rango de destino.

Duplicar

Para copiar y pegar instantáneamente un elemento de texto, línea u otro objeto:

1. Mantenga presionada Ctrl+May (Mac: Cmd+May), haga clic en el elemento y arrástrelo a cualquier parte de la partitura.
2. Suelte el botón del mouse y el elemento seleccionado se clonará en la nueva ubicación.

Filtro de selección

El Filtro de selección te permite elegir exactamente qué voces y elementos deseas incluir en tu selección.

Para mostrar el filtro Selección, presione F6 (Mac: fn+F6); o desde el menú, seleccione Ver→Filtro de selección.

El filtro de selección aparece por defecto debajo de las Paletas. Para cambiar la ubicación de visualización, vea
Visualización y navegación: paneles laterales.

Ejemplo: supongamos que quiere copiar los compases 1 y 2 en el siguiente pasaje (ver imagen), para dar los compases
3 y 4:

1. Asegúrese de que se muestre el filtro de selección (ver arriba);
2. Desmarque las casillas "Articulaciones y adornos" y "Ligaduras";
3. Copie y pegue los compases deseados (en este ejemplo, 1-2 en 3-4).

Nota: el filtro de selección también funciona con el comando intercambiar con el portapapeles.

Véase también

Si desea cambiar las notas sin alterar el ritmo, puedes combinar el modo de redefinición de alturas  con copiar y pegar.

Enlaces externos{#external-links}

Video tutorial: letras, copia y dinámica

Deshacer y rehacer

MuseScore recuerda un número ilimitado de acciones de deshacer/rehacer.

Los atajos estándar son:

Deshacer Ctrl+Z (Mac: ⌘+Z)
Rehacer Ctrl+Shift+Z or Ctrl+Y (Mac: ⌘+Shift+Z)

O use los botones de la barra de herramientas: 

Modos de selección

Los objetos en la partitura -como notas, compases, articulaciones, etc.- se pueden seleccionar de varias maneras: (1)
uno a la vez, (2) como un rango continuo, or (3) como una lista.

Seleccionar un solo objeto
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La mayoría de los objetos de partitura se pueden seleccionar simplemente haciendo clic en ellos en modo "normal" (es
decir, no Introducción de notas).

Seleccionar una sola nota

1. Asegúrese de que no está en modo de Introducción de notas ;
2. Haga clic en una nota.

Nota: al seleccionar una sola nota y luego copiarla y pegarla, solo se copiará y pegará la altura, no la duración u otras
propiedades (como cabeza sin plica). Para copiar la nota completa, incluidas todas las propiedades, debe mantener
presionada May—como para la selección de acordes (abajo).

Seleccione un acorde

1. Asegúrate de no estar en modo de Introducción de notas ;
2. Mantén presionada May, luego haz clic en una nota en el acorde.

Seleccione un solo compás

Haga clic en un espacio en blanco dentro del compás.

Nota: para seleccionar un rango de compases consecutivos, consulte May + selección Y May + haga clic selección
(abajo).

Seleccionar un rango continuo de objetos

Hay varias formas de seleccionar un rango continuo de notas, acordes o compases:

1. May + selección

1. Asegúrate de no estar en modo de Introducción de notas ;
2. Seleccione la primera nota, acorde, silencio o compás en el rango. Puede extender la selección hacia arriba o hacia

abajo a los pentagramas adyacentes, si es necesario, usando May+↑ o ↓;
3. Luego elige una de las siguientes opciones:

Para avanzar la selección un acorde por vez a la derecha: Presione May+→.
Para avanzar la selección un acorde por vez a la izquierda: Presione May+←.
Para avanzar la selección un compás a la vez a la derecha: Presione May+Ctrl+→ (Mac: May+Cmd+→).
Para avanzar la selección un compás a la vez a la izquierda: Presione May+Ctrl+← (Mac: May+Cmd+←).
Para avanzar la selección al comienzo de la línea: Presione May+Inicio (Mac: May+Fn+←).
Para avanzar la selección hasta el final de la línea: Presione Shift+Fin (Mac: Shift+Fn+→).
Para extender la selección al comienzo de la partitura: Presione May+Ctrl+Inicio (Mac: Shift+Cmd+Fn+←).
Para extender la selección hasta el final de la partitura: Presione Shift+Ctrl+Fin (Mac: Shift+Cmd+Fn+→).

2. May + clic en la selección

Para seleccionar un rango de notas or silencios:

1. Asegúrate de no estar en modo de Introducción de notas ;
2. Haga clic en la primera nota o silencio en el rango;
3. Mantenga presionado May, luego haga clic en la última nota o silencio que desee.

Nota: el ultimo elemento seleccionado puede estar en el mismo pentagrama o en pentagramas encima o debajo de la
nota / silencio inicial. Todos los elementos seleccionados se incluirán en un rectángulo azul, incluidas las líneas y
articulaciones asociadas (pero no las voltas). Puede repetir la operación para extender el rango seleccionado según sea
necesario.

Seleccione un rango de compases

1. Haga clic en un espacio vacío en el primer compás deseado;
2. Mantenga presionada May, luego haga clic en un espacio en el último compas en el rango deseado.

Nota: al igual que con la selección de notas, el rango se puede extender verticalmente así como horizontalmente.

3. Arrastre selección

Este método se puede usar para seleccionar notas o silencios, o, independientemente, para seleccionar símbolos que no
sean notas, como puntos de staccato, letras, etc.:

Mantenga presionado May, luego arrastre el cursor por el rango deseado.
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4. Seleccionar todo

Este método selecciona toda la partitura, incluidas notas, silencios y elementos asociados. Use una de las siguientes
opciones:

Presione Ctrl+A (Mac: Cmd+A).
Desde la barra de menú, seleccione Editar → Seleccionar todo.

5. Seleccionar sección

Este método se usa para seleccionar una __sección __—una región de la partitura que comienza y / o termina con un
salto de sección:

1. Haga clic en un espacio vacío en un compás en la sección;
2. Desde la barra de menú, seleccione Edit → Seleccionar sección.

Nota: Ver Copiar y pegar: filtro de selección para deshabilitar ciertos tipos de elementos para que no se seleccionen en
una selección de rango.

Seleccione una lista de objetos

Para seleccionar una lista ((o rango discontinuo) de elementos de partitura:

1. Haga clic en el primer elemento;
2. Mantenga presionada Ctrl (Mac: Cmd) y haga clic sucesivamente en los elementos adicionales deseados.

Nota: este método no se puede usar para seleccionar compases. Utilice la selección individual o rango en su lugar.

Seleccionar todos similares

Para seleccionar todos los elementos de un tipo específico (por ejemplo, todas las barras de compás, todos los
elementos de texto, todas las marcas de staccato):

1. Seleccione un elemento;
2. Haga clic derecho y elige Seleccionar…;

3. Varias opciones están disponibles:

Todos los elementos similares: Selecciona todos los elementos similares al objeto elegido en el la partitura.
Todos los elementos similares en el mismo pentagrama: Selecciona todos los elementos similares al
objeto elegido en el mismo pentagrama.
Todos los elementos similares en el rango seleccionado: solo se aplica si se ha seleccionado un rango.
Selecciona todos los elementos similares al objeto elegido en el rango.
Más...: abre un cuadro de diálogo que le permite ajustar más opciones. Por ejemplo, si tiene una cabeza de
nota seleccionada, el cuadro de diálogo tendrá el siguiente aspecto:

Seleccionar

Misma cabeza de la nota: En este ejemplo, solo se seleccionarán las cabezas de nota del mismo grupo;
Misma altura: solo se seleccionarán cabezas de nota de la misma altura;
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Mismo tipo: se seleccionarán todas las cabezas de nota (de cualquier grupo);
Misma duración: solo se seleccionarán las cabezas de nota de la misma duración;
El mismo nombre de nota: se seleccionarán las notas de ese nombre en todas las octavas;
Mismo pentagrama: solo se seleccionarán las cabezas de nota en el mismo pentagrama.

Acción

Reemplazar selección: la opción predeterminada: inicia la selección de la nada;
Añadir a la selección: conserva todo lo que ha seleccionado y añade la selección actual a él;
Buscar en la selección:
Sustraer de la selección: conservar todo lo que ya ha seleccionado, pero elimina la selección actual.

Para qué son útiles las selecciones

Copiar y pegar
Modo de edición
Propiedades del inspector y objeto
Herramientas

Véase tambien

Conceptos basicos capitulo esp. Introducción de notas
Notación capítulo, esp. Alteraciones
Texto capítulo, esp. Editar texto y Movimiento de símbolos y texto de pentagrama basado en la cuadrícula

Visualización y navegación

Este capítulo describe las opciones disponibles en el menú Ver y en los menús Zoom y Vista de página/Vista continua
(ubicados en la barra de herramientas sobre la partitura). También detalla los diversos comandos de navegación y
funciones.

Menu "Ver"

Mostrar barras laterales/paneles

Paletas: F9
Paleta maestra: Shift+F9
Inspector: F8
Panel de reproducción: F11
Navegador:
Linea de tiempo: F12
Mezclador: F10
Sintetizador
Filtro de selección: F6
Teclado de piano virtual: P
Herramienta de comparación de partituras

Aumentar / reducir el zoom

Hay varias formas de aumentar o reducir el zoom en la partitura:

Atajo de teclado:

Aumentar zoom: Ctrl++ (Mac: Cmd ++)
Reducir zoom: Ctrl +- (Mac: Cmd +-).

Menu "Ver":

Aumentar zoom: Ver→Aumentar zoom

Reducir zoom: Ver→Reducir zoom.

Mouse

Aumentar zoom: desplazarse hacia arriba con la rueda del mouse mientras mantiene presionado Ctrl (Mac:
Cmd)
Reducir zoom: desplazarse hacia abajo con la rueda del mouse mientras mantiene presionado Ctrl (Mac: Cmd).

Menú desplegable: Para establecer un zoom específico, use el menú desplegable en la barra de herramientas
estándar para configurar la ampliación de la vista de la partitura (25–1600 %) o visualícela usando las opciones
"Ancho de página", "Página completa" o "Dos páginas".
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Para volver al zoom del 100%: Usa el atajo Ctrl+0 (Mac: Cmd+0).

Barras de herramientas

El área Barra de herramientas esta localizada entre la Barra de menú y la ventana de documento.

Contiene las siguientes barras de herramientas:

Operaciones de archivo: Nueva partitura, Abrir partitura, Guardar, Imprimir, Hacer, Deshacer.
Zoom/Vista de pagina.
Controles de reproduccion: Habilitar MIDI, Rebobinar, Reproducir/Detener, Loop, Tocar repeticiones, Metronomo
Sonidos reales: Muestra la partitura en sonidos escritos o reales.
Captura de pantalla: Permite realizar una captura de una parte de la partitura.
Introducción de notas: Modo de introduccion de notas, Duracion, Ligadura, Silencio, Alteraciones, Cambiar
direccion de plica, Voz (1, 2, 3, 4).

Mostrar/ocultar

Para ocultar o mostrar ciertas barras de herramientas.
* Seleccione View→Toolbars, y marque/desmarque las opciones que desee.
* Alternativametne, haga clic derecho en un espacio vacio en el area de la barra de herramientas, o en la barra de titulo
del inspector, y, desde el menu, marque o desmarque las opciones que haga falta (Nota: Esta opcion tambien le permite
ocultar o mostrar la Linea de tiempo, la Herramientas de Comparacion de Partituras, Grabado de Script, Teclado de
piano, Filtro de seleccion y Herramientas de percusion).

Personalizar el area de la Barra de herramientas

Seleccione View→Toolbars, y haga clic en "Personalizar barra de herramientas…"

Esta ventana de dialogo muestra las barras de herramientas que pueden ser personalizadas a la izquierda, los
botones de herramientas actuales para la barra seleccionada en el medio, y los botones que pueden ser agregados
a la derecha. Cuando a seleccionado una barra de herramientas en el panel izquierdo, puede realizar cualquiera de
las siguientes acciones:

Remover un botón: Seleccione el boton en medio del panel, y presione →.
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Añadir un botón: Seleccione el boton en el panel derecho, y presione ←.
Mover un botón: Seleccione el botón en medio del panel, y muevalo arriba o abajo usando ↑ o ↓.

Espacios de trabajo

Seleccione esta opcion para crear un espacio de trabajo personalizado o para editar un espacio de trabajo existente.

Mostrar barra de estado

La barra de estado, en la parte inferior de la pantalla, le da información sobre los elementos seleccionados en la
partitura. Marque/desmarque esta opción para ocultar o mostrar.

Pantalla dividida

Es posible dividir la visualización del documento para ver dos documentos a la vez, o para ver dos partes diferentes del
mismo documento. Las pestañas le permiten elegir qué documento mostrar en cada vista. Puede arrastrar la barrera que
separa los dos documentos para ajustar la cantidad de espacio en la ventana dedicada a cada uno:

Documentos adyacentes: Divide la ventana verticalmente en dos vistas de partituras.
Documentos apilados: Divide la ventana horizontalmente en dos vistas de partituras, una encima de la otra.

Opciones de visibilidad

Esta sección le permite visualizar u ocultar varios elementos no imprimibles:

Mostrar elementos invisibles:Mostrar/ocultar los elementos que se han hecho invisibles para imprimir y exportar.
Si esta opción está marcada, los elementos invisibles se muestran en la ventana de color gris claro.
Mostrar elementos no imprimibles: Mostrar/ocultar los símbolos Saltos y espaciadores.
Mostrar marcos: Mostrar/ocultar los contornos de puntos de los marcos.
Mostrar márgenes de página: Mostrar/ocultar Márgenes de página.

Marcar compases irregulares

Una linea azul en la esquina superior derecha de un compás indica que su duración difiere de la indicación de compás.

Pantalla completa

El modo de Pantalla completa amplía MuseScore para llenar su pantalla para que haya más contenido visible.

Página/Vista continua

Puede alternar entre dos vistas diferentes usando la lista desplegable en el área barra de herramientas:

Para mover la partitura:

Verticalmente: Mueva la rueda del mouse arriba o abajo.
Horizontalmente: Presione Shift y mueva la rueda del mouse arriba o abajo.

Vista de pagina

En Vista de pagina, la partitura está formateada como aparecerá cuando se imprima o se exporte como un PDF o
archivo de imagen: es decir, página por página, con márgenes. MuseScore aplica los saltos de linea y pagina
automáticamente, de acuerdo a la configuración hecha en Ajustes de página y Estilo: General. Adicionalmente, puede
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aplicar su propios saltos de linea pagina o sección.
Para elegir entre desplazamiento de página horizontal o vertical vea Preferencias: lienzo (desplazamiento de página).

Vista continua

En Vista continua, la partitura se muestra como un sistema ininterrumpido. Incluso si el punto de partida no está a la
vista, los números de medición, los nombres de los instrumentos, las claves, las indicaciones de compás y las armaduras
siempre se mostrarán a la izquierda de la ventana.

Nota: MuseScore puede funcionar más rápido en la vista continua que en la de página debido a que el diseño es más
simple.

Vista de Página Única

En Viste de pagina única la partitura es mostrada como una pagina unica con un encabezado pero sin margenes, y con
un largo de pagina infinito. Los saltos de sistema son agregados automáticamente de acuerdo a la configuración en
Ajustes de página y Estilo: General. Adicionalmente, puede aplicar sus propios saltos de sistema o sección.

Paneles laterales

Los espacios de trabajo, el Inspector y el Filtro de selección se muestran convenientemente como paneles laterales
a la izquierda y derecha de la ventana. Para desacoplar un panel lateral, use uno de los siguientes métodos:

Arrastra el panel;
Haga clic en el doble chevron en la parte superior del panel;
Haga doble clic en el área de título en la parte superior del panel.

Para acoplar un panel, use uno de los siguientes procedimientos:

Arrastre el panel hacia la parte superior/inferior de un panel lateral existente y se apilará verticalmente encima /
debajo de ese panel.
Arrastre el panel al centro de un panel lateral existente y se superpondrá a ese panel. A ambos paneles se puede
acceder mediante pestañas.

Alternativamente, al hacer doble clic en la barra de título del panel, se restaurará a su posición previamente acoplada.

Navegación

Hay varios comandos disponibles para ayudarlo a navegar a través de la partitura. Se enumeran en Atajos de teclado.

Navegador

TEl Navegador un panel opcional que le permite navegar una partitura larga más fácilmente, o ir a páginas específicas.
Para ver / ocultar, vaya a Ver→Navegador, o use el atajo F12 (Mac: fn+F12). Aparece en la parte inferior de la ventana del
documento si se desplazan las páginas horizontalmente, o en el lado derecho de la ventana del documento si se
desplazan verticalmente (ver Preferencias: Lienzo).

El cuadro azul representa el área de la partitura que actualmente está visible en la ventana principal. Puede arrastrar el
cuadro azul o la barra de desplazamiento, o hacer clic en un área para ir inmediatamente.

Véase también, Timeline.

Buscar

La función Buscar le permite navegar rápidamente a un pentagrama específico, guía de ensayo o número de página en
la partitura:

1. Presione Ctrl+F (Mac: Cmd+F), o seleccione Editar→Buscar. Esto abre la barra Buscar (o Ir a) en la parte inferior del
espacio de trabajo.

2. Use una de las siguientes opciones:
Para ir a un compás, ingrese el número de compás (contando a partir del compás numerado como 1,
independientemente de los compases de anacrusa, saltos de sección o cambios manuales a los números de
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compás)
Para ir a una página numerada, ingrese el número de página usando el formato pXX (donde XX es el
número de página).
Para ir a una guía de ensayo numérica, ingrese el número usando el formato rXX (donde XX es la
marca de ensayo.
Para ir a una marca de ensayo que comienza con una letra:ingrese el nombre de la guia de ensayo
(el buscador distingue mayúsculas y minúsculas).

Nota: a veces es conveniente evitar nombrar las guías de ensayo con las letras "R", "r", "P", "p", o una de estas letras
con un numero ("R1" o "p3" por ejemplo), ya que pueden confundir al algoritmo de búsqueda.

Véase también

Guardar/Exportar/Imprimir
Tipos de archivo
Diseño y formato

Sonidos reales

Puede elegir mostrar la partitura en el sonidos escritos o reales (sonidos reales). El tono escrito muestra la partitura
como debería verse cuando se imprime para que lo lean los músicos. Sin embargo, durante la preparación, puede
preferir por conveniencia ver el transposing instruments anotado como suena, sin transposición. En este caso, debe
seleccionar la opción "Sonidos reales".

Para alternar la visualización de partitura entre el sonidos escritos o de reales, use una de las siguientes opciones:

Presione el botón Sonidos reales (ubicado en la esquina superior derecha del área de la barra de herramientas).
Cuando se presiona este botón, la partitura está en sonidos reales.

Antes de imprimir la partitura, exportarla a PDF o guardarla en línea, debe asegurarse de que el botón Sonidos reales esté
sin presionar, y que las partes individuales estén correctamente transpuestas.

Ver también

Transporte: Instrumentos transpositores
Alteraciones: Renombrar las alturas

Enlaces externos

[Transposición](https://es.wikipedia.org/wiki/Transposici%C3%B3n_(m%C3%BAsica)  (Articulo de Wikipedia)
Instrumentos transpositores  (Articulo de Wikipedia)
Concert pitch or not??  (Discusión en el foro de MuseScore, en ingles)

Abrir/Guardar/Exportar/Imprimir

En el menú Archivo puede encontrar las siguientes opciones:

Abrir

Además de los archivos en formato nativo (*.mscz and *.mscx), MuseScore también abre una variedad de archivos en
otros formatos: MusicXML, MusicXML comprimido y archivos MIDI, asi como una variedad de archivos en otros formatos.

Para abrir cualquier archivo compatible:

1. Elige una de las siguientes opciones:
Presione Ctrl+O.
Haga clic en el icono "Abrir partitura" en el lado izquierdo del área de la barra de herramientas.
Desde la barra de menú, seleccione Archivo→Abrir....

2. Seleccione un archivo y haga clic en Abrir; simplemente haga doble clic en el archivo.

Abrir reciente… le permite elegir de una lista de partituras recientemente abiertas.

Guardar

Guardar…, Guardar como…, Guardar una copia… y Guardar selección… le permiten guardar archivos nativos de
MuseScore (.mscz y .mscx).

Guardar...: Guarde la partitura actual en el archivo.
Guardar como...: Guarde la partitura actual en un nuevo archivo.
Guardar una copia...: Guarde la partitura actual en un archivo nuevo, pero continúe editando el archivo original.
Guardar selección...: Guarde los pentagramas seleccionados en el nuevo archivo. En las versiones de MuseScore
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anteriores a la 2.1, para garantizar que el archivo se guarde correctamente, la indicación de compras debe
mostrarse en el primer pentagrama del pasaje seleccionado, a menos que sea 4/4..
Guardar online...: Guardar y compartir sus partituras en la web en MuseScore.com . Para más detalles, vea
Compartir partituras en linea.

Exportar

Exportar... y Exportar partes... le permiten crear archivos que no son de MuseScore, como PDF, MusicXML, MIDI y
varios formatos de audio e imagen. En el diálogo Exportar, puede elegir a qué formato exportar:

Export...: Export current score to format of your choice.
Export Parts...: Export current score and all linked parts to separate files in a format of your choice.

MuseScore recuerda qué formato eligió la última vez y lo convierte en el predeterminado para la próxima vez.

Imprimir

Imprimir... permite imprimir su archivo MuseScore. Dependiendo de su impresora, tendrá diferentes opciones, pero en
general puede definir el rango de páginas, el número de copias y la intercalación.

Si tiene instalada una impresora PDF, también puede "exportar" a PDF usando Print, pero generalmente es mejor utilizar
la opción nativa de PDF en Exportar para obtener una representación más precisa. Nota: para que esto funcione
correctamente con Adobe PDF, asegúrese de desmarcar "Confiar solo en las fuentes del sistema, no use las fuentes del
documento" en Propiedades de la impresora.

Véase también

Tipos de archivo
Extracción de partes

Compartir partituras en línea

Vaya a musescore.com/sheetmusic  para ver otras partituras de MuseScore.

Puede guardar y compartir su partitura en línea en MuseScore.com . Puede optar por guardar una partitura de forma
privada para el acceso personal desde cualquier computadora, o compartirla públicamente. MuseScore.com permite la
visualización y reproducción de partituras en su navegador de red; una función adicional titulada VideoScores permite la
sincronización entre la partitura y un video de YouTube. Puede descargar la partitura en una variedad de formatos
(incluidos PDF, MIDI, MP3, MusicXML y el archivo original de MuseScore) para verlas fuera del navegador.

Crear una cuenta

1. Visite MuseScore.com  and click on y haga clic en "Crear nueva cuenta "". Elija un nombre de usuario e ingrese
un correo electrónico válido y presione "Crear nueva cuenta".

2. Espere unos minutos para obtener un correo electrónico del soporte de MuseScore.com. Si no llega ningún correo
electrónico, verifique su carpeta de correo no deseado.

3. Haga clic en el enlace del correo electrónico y visite su perfil de usuario  para cambiar su contraseña.

Compartir una partitura directamente desde MuseScore

Para guardar una partitura en línea:

1. Asegúrese de que el botón Tono de concierto esté desactivado y que las partes individuales estén transpuestas
correctamente.

2. Desde el menú, seleccione Archivo→Guardar en línea.... Aparecerá el cuadro de diálogo "Iniciar sesión en MuseScore":
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3. Ingrese su dirección de correo electrónico o nombre de usuario y contraseña de MuseScore, luego haga clic en
Aceptar.
Nota: si aún no tiene una cuenta de MuseScore, cree una primero haciendo clic en el enlace "Crear una cuenta".
Eso abrirá su aplicación de navegador y lo llevará a musescore.com/user/register .

4. Al iniciar sesión correctamente, podrá ingresar la información de su partitura.

Título: El título de la partitura.
Descripción: El texto descriptivo que aparecerá junto al titulo.
Hacer privada esta partitura: Si está marcado, la partitura solo se puede ver a través de un enlace
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privado. Si no está marcado, la partitura es visible para todos.
Licencia: Elija una licencia de derechos de autor apropiada de la lista desplegable. Nota: Licencia de
Creative Commons , permite a las personas usar sus partituras bajo ciertas restricciones.
Etiquetas: Puede agregar ** etiquetas ** para ayudar a identificar partituras en MuseScore.com. Usa
comas para separar varias etiquetas.

5. En caso de que ya hayas guardado la partitura en línea antes, actualizará automáticamente la existente y puedes
ingresar información adicional en una sección de registro de cambios del diálogo. Desmarque Actualice la
partitura existente para guardar en línea como una nueva partitura

6. Si está utilizando un SoundFontdiferente al predeterminado y si puede exportar MP3 files, na casilla de verificación "
Subir audio de la partitura"estará visible y habilitado.

Si la casilla de verificación está marcada, MuseScore reproducirá el audio de la partitura utilizando los ajustes del
sintetizador y cargará el audio en MuseScore.com.

Subir una partitura en MuseScore.com

1. Haga clic en Subir enlace  en MuseScore.com.
2. Tiene las mismas opciones en el menú Guardar en línea.
3. También tiene acceso a más información, como Género.

Nota: si alcanza el límite de carga de cinco hojas, aún puede subir partituras directamente desde MuseScore,pero solo
las últimas cinco son visibles. Si desea más que esta cantidad, actualice a una Cuenta Pro .

Editar una partitura en MuseScore.com

Si desea realizar cambios en una de sus partituras en MuseScore.com, edite el archivo MuseScore en su propia
computadora, guárdelo y luego haga lo siguiente:

Si originalmente compartió la partitura directamente desde MuseScore, simplemente vaya a File→Gardar Online...
nuevamente para actualizar la partitura en línea.
Si originalmente [subió la partitura]](#upload-a-score-on-musescore-com) a través de Upload page  en
MuseScore.com, entonces siga estos pasos para actualizar la partitura en línea:

1. Abra a la página de partituras en MuseScore.com.
2. Haga clic en el menú de tres puntos ⋮ a la derecha y seleccione "Actualizar esta partitura".
3. En el formulario, puede cargar un archivo de partitura de reemplazo y cambiar la información y la

configuración de privacidad que lo acompañan.

Cambiar al método directo de actualización de una partitura en línea

Es mucho más conveniente actualizar partituras en línea directamente desde MuseScore que actualizarlas manualmente
desde la página web. Siga estos pasos si originalmente cargó la partitura a través de la Página de carga  y ahora desea
cambiar al método directo:

1. Vaya a la página de partituras en MuseScore.com y copie la URL.
2. Abra el archivo de partituras en su computadora con MuseScore.
3. En el menú, seleccione Archivo→Propiedades de la partitura... y pegue la URL en el campo "Source".

Ahora, cuando quiera actualizar la partitura en línea, simplemente vaya a Archivo→Guardar Online....

Enlaces externos

Cómo eliminar una partitura guardada en MuseScore.com

Notación
El capítulo anterior "Conceptos básicos"aprendió sobre la introducción de notas y a interactuar paletas. El capítulo
"Notación" describe los diferentes tipos de notación con más detalle, incluida la notación musical más avanzada.
Véase también "Temas avanzados".

Armaduras de clave
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Armaduras de clave estándar están disponibles en la Paletas Armaduras en los espacios de trabajo básico y avanzado.
También es posible crear armaduras de clave personalizadas (ver abajo).

Añadir una nueva armadura de clave

Añadir nueva armadura de clave para todos los pentagramas

Use cualquiera de los siguientes métodos:

Arrastre una armadura desde la paleta hasta una parte vacía de un compás.
Seleccione un compás y haga doble clic en la armadura de clave en la paleta.
Seleccione una nota y haga doble clic en la armadura de clave en la paleta.

Añadir la nueva armadura de clave para un pentagrama solamente

Si desea cambiar la armadura de clave de solo un pentagrama, dejando los demás sin cambios:

Presione Ctrl (Mac: ⌘) y mantenga presionado mientras arrastra una armadura de clave desde una paleta a un
compás.

Reemplazar una armadura de clave existente

Reemplazar armadura de clave para todos pentagramas

Use cualquiera de los siguientes métodos:

Arrastre una armadura de clave desde la paleta hasta la armadura que se va a reemplazar (o al compás que
contiene la armadura de clave).
Seleccione la armadura clave a reemplazar y haga doble clic en una nueva armadura en una paleta.

Reemplazar la armadura de clave para un pentagrama solamente

Si desea reemplazar la armadura de clave de un pentagrama, dejando a los demás sin cambios:

Presione Ctrl (Mac: ⌘) y mantenga pulsado mientras arrastra una armadura de clave de una paleta a la armadura a
ser reemplazada (o en el compás que contiene armadura de clave)

Eliminar una armadura de clave

Use cualquiera de los siguientes métodos:

Haga clic en una armadura de clave existente y presione Borrar.
Arrastre la armadura de clave vacía desde la paleta (en el espacio de trabajo avanzado) a el compás.

Becuadros en los cambios armaduras de clave

De forma predeterminada, MuseScore solo muestra los becuadros cancelados cuando la armadura de clave cambia a la
Do mayor/La menor (sin sostenidos o bemoles). En todos los demás casos, simplemente muestra la nueva armadura de
clave sin cancelaciones:
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Sin embargo, puede optar por mostrar los becuadros cancelados para todos los cambios de armaduras de clave :

1. Desde el menú, seleccione Formato→Estilo → General... → Alteraciones. Verás las opciones:

2. Seleccione una de las tres opciones.

3. Si está en una parte y quiere que la nueva opción se aplique a todas las partes, haga clic en Aplicar a todas las partes .
4. Haga clic enAceptar para salir.

Por ejemplo, seleccionar la opción "Antes de la armadura si se cambia a una tonidad con menos sostenidos o
bemoles" da:

Y la opción "Después de la armadura si se cambia a una tonalidad con menos sostenidos o bemoles. Antes si se
cambia entre sostenidos o bemoles":

Cambios armadura de clave y silencios de multicompás

Los Silencios de multicompás se interrumpen si hay un cambio en la armadura de clave:

Armaduras de cortesía

Para desactivar la visualización de un armadura de clave de cortesía en particular:

Seleccione la armadura de clave correspondiente y desmarque "Mostrar cortesía" en la sección "armadura de clave"
del Inspector.

Para desactivar la visualización de todas las armadura de clave de cortesía:

Desde el menú, seleccione Formato→Estilo → General... → Página, y desmarque "Crear armaduras de cortesía".

Nota: las armaduras de cortesía no se muestran en los saltos de sección.

Armaduras de clave personalizadas

Para crear una armadura de clave personalizada:

1. Presione May+K para visualizar la sección Armaduras de la Paleta Maestra.
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2. En el panel Crear armadura, arrastre las alteraciones desde la paleta hasta el "pentagrama" que se encuentra
arriba para crear armadura deseada. Utilice el botón Borrar si es necesario, para eliminar todas las alteraciones del
"pentagrama."

3. Presione Añadir para mover la nueva armadura de clave a la biblioteca (panel central).

_Nota: _ La reproducción de Armaduras personalizadas de clave no es compatible actualmente.

Para mover una armadura de clave de la paleta Maestra a una custom palette :

Arrastra y suelta la armadura de clave en una paleta.

Para aplicar una armadura de clave al partitura directamente desde la Paleta maestra, use uno de los siguientes
métodos:

Seleccione un compás y haga doble clic en la armadura de clave en la Paleta maestra.
Arrastre una armadura de clave desde la Paleta maestra a un compás .

Barras de compás

Las distintas barras de compás están disponibles en la paleta Barras de compás:

NOT FOUND: barlines_palette.png

Cambiar el tipo de barra de compás

Para cambiar una barra de compás existente, use una de las siguientes opciones:

Seleccione una barra de compás, luego haga doble clic en un símbolo en la paleta Barras de compás.
Arrastre un símbolo de la paleta Barras de compás en una barra de compás en la partitura.
Arrastre un símbolo de la paleta Barras de compás en un compas .
Seleccione un compás, luego haga doble clic en un símbolo en la paleta Barras de compás.
Seleccione una barra de compás, a continuación, en el Inspector ajuste el "estilo" en la sección "Barra de compás" .

Para cambiar una barra de compras especial a una simple:

Seleccione la barra de compás y presione Borrar.

Para ocultar una barra de compás:

Seleccione la barra y presione V, o desmarque Visible en el Inspector.

Insertar barra de compás
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Para insertar una nueva barra de compás entre las existentes:

Arrastre un símbolo de la paleta Barras de compás en una nota o silencio.
Seleccione una nota o silencio, luego haga doble clic en un símbolo en la paleta Barras de compás.

Barras de compás personalizadas

Es posible crear barras de compás personalizadas mediante la selección de una o varias barras de compás, y luego
ajustando las propiedades en la sección "Barras de compás" del Inspector:

Estilo: Elija de una lista de líneas de barras preestablecidas.
Pentagramas abarcados: El máximo es igual al número de pentagramas en el sistema.
Abarcar desde: Establece la posición de la parte superior de la barra de compás. "0" es la línea del pentegrama
superior. Los números positivos comienzan más abajo en el pentagrama, los números negativos arriba.
Abarcar hasta: Establece la posición de la parte inferior de la barra de compás (ver "Abarcar desde").
Extensión predefinida: Establecer una opción de extensión predefinida.

Ver tambien, Mensurstrich.

Los cambios en el color y el desplazamiento horizontal/vertical también se pueden realizar en el Inspector.

Conectar las barras de compás

Las barras de compás pueden extenderse sobre varios pentagramas, como en el pentagrama de un piano, o en una
partitura orquestal para unir a los instrumentos de una misma sección. Para unir las barras de compás:

1. Haga doble clic en una barra de compás para ingresar modo de edición

2. Haga clic en el punto de ajuste inferior azul y arrástrelo hasta el pentagrama que desea conectar. El punto de ajuste
adapta su posición para que no haya necesidad de colocarlo exactamente.

3. Presione Esc para salir modo de edición. Esto actualizará todas las otras barras de compás relevantes.

Véase también

Operaciones de compás
Añadir calderón a barra de compás

Claves

Las claves comúnmente utilizadas (De Sol, De Fa, De Do en 3a, De Do en 4a) se pueden encontrar en la paleta de
claves en el espacio de trabajo basico. Para obtener una selección más completa, consulte la paleta de claves en el
espacio de trabajo avanzado (ver imagen a continuación).
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Añadir una clave

Añadir clave al comienzo del compás

__Método 1 __- Añadir clave al inicio del compás , sea o no el primer compás de un sistema:

Seleccione un compás y haga doble clic en un símbolo de clave en la paleta.
O,
Arrastre una clave de la paleta a un compás.

__Método 2 __- solo para cambiar la clave al inicio de un sistema

Seleccione la clave existente al comienzo del sistema y haga doble clic en una clave de la paleta.
O,
Arrastre una clave de la paleta directamente sobre la clave existente.

Añadir una clave en medio de un compás

Para crear una clave en medio de un compás:

Haga clic en una nota, luego haga doble clic en una clave en la paleta.

Nota: si la clave no es la primera en el sistema, se dibujará más pequeña.

En esta imagen, el pentagrama superior comienza con una clave de sol y cambia inmediatamente a clave de fa, luego
después de una nota y un silencio, vuelve a la clave de sol.

Nota: Cambiar una clave no cambia el tono de ninguna nota. En cambio, las notas se mueven para preservar el tono. Si
lo desea, puede usar Transportar junto con un cambio de clave.

Claves de cortesía

Cuando se produce un cambio de clave al comienzo de un sistema, se generará una clave de cortesía al final del
sistema anterior

Para mostrar u ocultar todas las claves de cortesía:

1. En el menú, seleccione Formato→Estilo→General...→Página;

2. Marque / desmarque "Crear claves de cortesía".
También es posible mostrar/ocultar claves de cortesía caso por caso:

3. "Crear claves de cortesía" debe marcarse en el menú "General" (ver arriba);

4. Seleccione una clave y marque/desmarque "Mostrar claves de cortesía" en el Inspector.

Eliminar una clave

Seleccione una clave y presione Borrar.

Ocultar claves

Mostrar clave solo en el primer compás (para todos los pentagramas)

1. En el menú, seleccione Formato→Estilo→General...→ Página;
2. Desmarque "Crear clave en todos los sistemas".

Mostrar clave solo en el primer compás (para un pentagrama en particular)

1. Haga clic derecho en el pentagrama, seleccione Propiedades del pentagrama... y desmarque "Mostrar la clave";"
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2. Abra la master palette y seleccione la sección "Símbolos";
3. Arrastre y suelte una clave de la paleta maestra en el primer compás del pentagrama; O seleccione la primera nota

y haga doble clic en una clave en la paleta maestra.

Nota: esta opción puede ser útil para los usuarios de TAB que no quieren que la clave se repita en cada línea.

Ocultar todas las claves en un pentagrama en particular

1. Haga clic derecho en el pentagrama, y seleccione Propiedades de pentagrama...;
2. Desmarque "Mostrar la clave".

Alteraciones

Los tipos más comunes de alteraciones se proporcionan en la barra de herramientas "Alteraciones" y en la paleteta en el
espacio de trabajo basico.

Se puede encontrar una lista más completa en la paleta Alteraciones en el espacio de trabajo avanzado.

Agregar alteracion

Alteraciones se agregan automáticamente a una nota, según corresponda, cuando aumenta o disminuye su altura:

↑: Aumenta la altura de una nota en un semitono (favorece los sostenidos).
↓: Disminuya la altura de una nota en un semitono (favorece los bemoles).

Para agregar (i) un doble bemol o doble sostenido, (ii) una alteración de cortesía (también conocida como advertencia o
recordatorio), or (iii) una alteración no estándar, use una de las siguientes opciones:

Seleccione una nota y haga clic en una alteración en la barra de herramientas sobre la partitura.
Seleccione una nota y haga doble clic en una alteración en la paleta Alteraciones (espacio de trabajo básico o
avanzado).
Arrastre una alteración de la paleta Alteraciones a una nota.

Si desea agregar paréntesis a una alteración de cortesía, use uno de los siguientes:

Seleccione la alteración en la partitura y haga doble clic en el símbolo de paréntesis en la paleta Alteraciones.
Arrastre el símbolo de paréntesis desde la paleta hasta la alteracion.
Seleccione la alteración y marque la casilla Tipo de corchete en el Inspector.

Si es necesario, las alteraciones se pueden eliminar haciendo clic en ellas y presionando Supr.

Renombrar de las alturas enarmónicas

Para renombrar enarmónicamente una nota o notas, tanto en las vistas escritas como en las de tono de concierto:

1. Seleccione una nota o grupo de notas;
2. presione J;
3. Continúe presionando J para recorrer los equivalentes enarmónicos.

Para renombrar la altura enarmónica en la vista de tono escrito, sin afectar la vista de sonidos reales, o viceversa:

1. Seleccione una nota o grupo de notas;
2. Presione Ctrl+J (Mac: Cmd+J);
3. Continúe presionando las mismas teclas para recorrer los equivalentes enarmónicos.

Nota: si las alturas de las notas seleccionadas no son todas iguales, el efecto puede ser impredecible.

Renombrar las alturas

Desde el menú, selecciona Notas→Renombrar las alturas.

Véase también

Armadura de clave: cambiar

Enlaces externos

Alteraciones  en Wikipedia
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Enarmonia  en Wikipedia

Indicaciones de compás

Las Indicaciones de compás se pueden encontrar en la Palette of del mismo nombre en los espacios de trabajo Básico
y Avanzado.

Añadir un indicación de compás

Para Añadir una indicación de compás, use cualquiera de los siguientes métodos:

Arrastrar y soltar una indicación de compás de una paleta en un espacio en un compás.
Seleccione un compás y luego haga doble clic en una indicación de compás en una paleta.
Seleccione cualquier nota o silencio y haga doble clic en una indicación de compás en la paleta.

La indicación de compás aparecerá al comienzo del compás seleccionado.

Para reemplazar una indicación de compás, use cualquiera de los siguientes métodos:

Arrastre y suelte una indicación de compás sobre una indicación de compás existente.
Seleccione una indicación de compás en la partitura, luego haga doble clic en una indicación de compás en la
paleta.

Borrar una indicación de compás

Para borrar una indicación de compás en la partitura, selecciónela y presione Borrar.

Para crear una indicación de compás

Si la indicación de compás que necesita no está disponible en ninguna de las paletas, se puede crear de la siguiente
manera:

1. Presione Shift+T para visualizar la sección Indicaciones de compás de la Paleta maestra.
2. Seleccione una indicación de compás para editar en el panel central.
3. En el panel Crear indicación de compás edite los diversos parámetros (numerador, denominador, texto,

agrupción) para obtener la indicación compás y las propiedades que desee. Para restablecer la agrupación
predeterminada, presione Reset.

4. Presione Añadir para añadir la indicación de compás recién creada al panel central. Para borrar una indicación de
compás del panel central, haga clic derecho sobre ella y seleccione Borrar.

5. Arrastre y suelte la indicación de compás desde la indicación de compás a la ubicación deseada de la partitura.
Esto puede ser guardado a una paleta personalizada  para su uso futuro, si fuera necesario.

Propiedades de indicación de compás

Para mostrar el diálogo de Propiedades de indicación de compás:

Haga clic derecho en una indicación de compás y seleccione Propiedades de indicación de compás….
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Valor global: Muestra la indicación global de compás y se establece automáticamente cuando añadas una indicación de
compás a la partitura. Esta es la referencia para tiempos (como se muestra en la barra de estado) y indicaciones de
metronomo.
* Valor real: Muestra la indicación de compás asociada con un pentagrama en particular. Este valor normalmente es el
mismo que la indicación de compás global, pero se puede configurar de forma independiente si es necesario. Ver
indicaciones de compás local.
* Grupos de notas; Le permite cambiar la agrupación predeterminada de notas asociada con una indicación de compás.
Ver Cambiar agrupación predeterminada.
* Apariencia: Le permite editar el texto mostrado sin afectar la indicación de compás subyacente. Para un ejemplo, vea
los Compases aditivos.

Cambiar agrupación predeterminada

Para cambiar una agrupación para una indicación de compás en particular:

1. Haga clic derecho en la indicación de compás y seleccione, Propiedades de indicación de compás…;
2. Para romper una agrupación de notas en el panel Grupos de notas, haga clic en la nota que lo sigue. Para

restablecer la barra de agrupacion, haga clic en el mismo lugar. Alternativamente, puede cambiar la agrupación
arrastrando un icono de agrupamiento a una nota, de la siguiente manera:

 Comienzo de barra de agrupación en esta nota.

 No cortar barra de agrupación en esta nota.

 Grupo de semicorcheas a la izquierda de esta nota.

 Grupo de fusas a la izquierda de esta nota.
Si la casilla "También cambiar notas más breves" esta marcada, significa que cualquier cambio de agrupación
en un nivel se aplicará automáticamente a las duraciones más breves. El botón Restablecer cancela cualquier
cambio realizado en esa sesión.

Metrónomos aditivos (compuestos)

Indicaciones aditivas (compuestas) de compás a veces se usan para aclarar la división de los tiempos dentro de un
compás. Para crear un indicación aditiva de compás:

1. Haga clic derecho en una indicación de compás en la partitura y seleccionePropiedades de indicación de compás…;
2. En la sección Apariencia, ajuste la propiedad "Texto" según sea necesario;
3. Ajuste la agrupación de notas en la sección Grupos de notas si es necesario.

Nota: la sección Indicación de compás de la paleta maestra también le permite crear indicaciones de compás aditivas
(ver arriba).

Indicaciones locales de compás
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En ciertos casos, una partitura puede mostrar pentagramas con diferentes indicaciones de compás ejecutándose al
mismo tiempo. Por ejemplo, en 26. Variación de Goldberg de Bach:

En el ejemplo anterior, la indicación global de compás es 3/4, pero el inicación de compás del pentagrama superior se ha
establecido de forma independiente a 18/16.

Establecer una Indicación local de compás por solo un pentagrama:

Mantenga presionado Ctrl (Mac: Cmd) y arrastre y suelte una indicación de compás desde una paleta a un compás
vacío.

Compases de anacrusa y cadenzas

Ocasionalmente necesitará disminuir o aumentar la duración de un compás sin cambiar la indicación de compás—por
ejemplo, en un compás de anacrusa en una cadenza, etc. Ver Operaciones de compas.

Cambios de indicación de compás y descansos

Los Multi-measure rests se interrumpen cuando se produce un cambio en la indicación de compás. También un salto de
sección evitará que se muestre una indicación de compás de cortesía al final del compás anterior.

Véase también

Armaduras de clave

Enlaces externos

How To Using Polyrhythm, mixed meters and local time signatures in MuseScore
Compases aditivos  en Wikipedia.

Arpegios y glissando

Los símbolos de Arpegio y Glissando se pueden encontrar en la paleta en el espaci o de trabajo avanzado.sta paleta
también incluye flechas de rasgueo, una llave de arpegio, articulaciones de instrumentos de viento y símbolos de
deslizamiento por encima y debajo.

ara agregar un símbolo a la partitura, use uno de los siguientes métodos:

Seleccione una o más notas, luego haga doble clic en un símbolo en la paleta "Arpegios y Glissando".
Arrastre un símbolo de la paleta "Arpeggios y Glissando" a una nota.

Cualquier símbolo se puede personalizar ajustando sus propiedades en el Inspector. En la mayoría de los casos se
proporcionan controles de edición para permitir el ajuste de la longitud/curvatura en el Modo de edición. Si es necesario
para usarlo en el futuro, puede guardar el resultado en una paleta personalizada.

Arpegios

Cuando se agrega una flecha de arpegio o rasgueo a la partitura, inicialmente se extiende solo a una voz. Sin embargo,
puede ajustar fácilmente su altura haciendo doble clic en el símbolo y arrastrando los puntos de ajuste hacia arriba o
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hacia abajo (para un ajuste más fino use las flechas del teclado). La reproducción del símbolo se puede activar o
desactivar en el Inspector.

Glissandos (arraste)

Un Glissando abarca dos notas consecutivas, normalmente en la misma voz.

Los glissandos de acordes también son posibles.

Ajuste los puntos de inicio y fin

1. Haga doble clic en el símbolo para ingresar al modo de edición ;
2. Haga clic en el punto de ajuste de inicio o final:

Use May+↑↓ para mover el punto hacia arriba o hacia abajo, de nota a nota.
Use Shift+←→ para mover el punto hacia arriba o hacia abajo, de nota a nota.

Este método también le permite mover los puntos de ajuste entre notas en diferentes voces o incluso de un pentagrama a
otro, por ejemplo, glissandos entre pentagramas. También puede usar las flechas del teclado o Ctrl + + flecha para hacer
ajustes finales en las posiciones de los puntos.

Glissandos personalizados

Para personalizar el glissando según sus requisitos, selecciónelo y ajuste las propiedades en el Inspector de la siguiente
manera:

Tipo: Elige entre una línea recta u ondulada;
Texto: Edita o elimina el texto. Nota: si no hay espacio suficiente entre las notas, el texto no se muestra;
Estilo: Elija cómo se reproduce el glissando. Hay cuatro opciones: cromático, teclas blancas, teclas negras,
diatónicas;
Reproducir: Marque/desmarque la casilla para activar o desactivar la reproducción.

Articulaciones de instrumentos de viento

Los símbolos Fall, Doit, Plop and Scoop son provistos en la misma paleta, para cambiar la longitud y la curvatura,
seleccione el símbolo, ingrese el modo de edicion y ajuste los controladores como se describe en Edit mode: Lineas.

Slide in por encima/debajo

Las líneas para Slide in y Slide out también se pueden encontrar en la paleta "Arpegios & Glissando". Para editar la
longitud y el ángulo de una línea, haga doble clic en ella y arrastre el gancho (o use las flechas del teclado para un ajuste
más fino).

Enlaces externos

Arpegio  en Wikipedia
Glissando  en Wikipedia

Articulaciones y ornamentos

Se puede encontrar el conjunto completo de símbolos en la paleta en el espacio de trabajo avanzado:
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Y la paleta Ornamentos (Espacio de trabajo avanzado):

También hay una versión abreviada de Articulaciones en el espacio de trabajo básico.

Articulaciones

Las Articulaciones son los símbolos usados en la partitura para mostrar cómo se tocará una nota o acorde. Los
símbolos principales en este grupo son:

Calderones
Staccato
Mezzo-staccato / Portato
Staccatissimo
Tenuto
Sforzato
Marcato

También se incluyen articulaciones especiales para cuerdas frotadas y pulsadas, instrumentos de viento, etc..

Ornamentos

Los Ornamentos incluyen:

Mordentes, Mordentes invertidos, Mordentes dobles
Trinos
Grupetos
Bends
Nota: Appoggiaturas y acciaccaturas se pueden encontrar en la paleta Notas de Adordno.

Añadir ornamento/ornamento

Puede usar los siguientes metodos:

Seleccione una nota o un rango de notas, luego haga doble clic en un símbolo en la paleta.
Arrastre un símbolo de la paleta a una cabeza de nota.

Añadir alteración a un adorno

Para aplicar una alteración a un ornamento existente, como un trino:

1. Seleccione la nota a la que se adjunta el ornamento;
2. Abra la Sección de símbolos de la Master palette;
3. Busque y apliquela alteración deseada de la partitura (se pueden encontrar pequeñas alusiones utilizando el

término de búsqueda "figured bass"); Nota: debe buscar las palabras en inglés.
4. Arrastra la alteración a su posición (o recoloca usando los atajos de teclado o elInspector).

Añadir calderón a una barra de compás

Un calderón se puede aplicar directamente a una barra de compas seleccionando la barra de compás y haciendo doble
clic en el calderón desde una paleta. Esto no afecta la reproduccion.

Atajos de teclado
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Alternar Staccato: Shift+S
Alternar Subrayado: Shift+N
Alternar Sforzato (accent): Shift+V
Alternar Marcato: Shift+O
Añadir Acciaccatura (nota de adorno): /

Los atajos de teclado se pueden personalizar en las Preferencias.

Ajustar posición

Inmediatamente después de agregar una articulación o ornamento desde una paleta, el símbolo se selecciona
automáticamente: luego se puede mover _ arriba o abajo_ del teclado de la siguiente manera:

Presione las teclas de flecha arriba / abajo para un posicionamiento preciso (0.1 sp a la vez);
Presione Ctrl+↑ o Ctrl+↓ (Mac: Cmd+↑ o Cmd+↓) para ajustes verticales más grandes (1 sp a la vez).
Para voltear un símbolo al otro lado de la nota (donde sea posible), selecciónela y presione X.

Para habilitar ajustes en todas las direcciones desde el teclado:

1. Haga doble clic en el símbolo para ingresar al Edit mode,"modo Edición"], o haga clic en él y presione Ctrl+E (Mac:
Cmd+E), o haga clic derecho sobre el símbolo y seleccione "Editar elemento";

2. Presione las teclas de flecha para posicionamiento fino (0.1 sp a la vez); o presione Ctrl+Arrow (Mac: Cmd+Arrow) para
ajustes más grandes (1 sp a la vez).

También puede cambiar los valores de desplazamiento horizontal y vertical en el Inspector. Para colocar más de un
símbolo a la vez, seleccione los símbolos deseados y ajuste los valores de desplazamiento en el Inspector.

Nota: El símbolo también puede reposicionarse haciendo clic y arrastrando, pero para un control más preciso, use los
métodos anteriores.

Propiedades de articulaciónes y ornamentos

La mayoría de las propiedades de articulaciones / ornamentos se pueden editar desde el Inspector y suele incluir:

Ubicación: Por encima o debajo del pentagrama.
Dirección: Auto / Arriba / Abajo.
Anclaje: Ajusta la posición vertical del símbolo.
Expansión de tiempo: Para calderones, ajusta el largo de la pausa
Estilo de adorno: Común o Barroco.
Reproducir: Enciende o apaga la reproducción.

Para propiedades de Bend, vea Bends.

También puede realizar ajustes globales en todas las articulaciones existentes y aplicadas posteriormente seleccionando
Formato → Estilo… → General… → Articulaciones, ornamentos.

Véase también

Notas de adorno

Enlaces externos

Adornos  en Wikipedia

Bends

Se puede crear una variedad de bends simples y complejos (etapas múltiples) con la Herramienta de Bends , ubicada
en la paleta Articulationes del espacio de trabajo avanzado.

Aplicar un bend

Seleccione una o más notas y haga doble clic en el símbolo de bend en la paleta.
Arrastre el símbolo de bend desde la paleta a una nota.

Editar texto y propiedades de linea de un bend

Varias propiedades de la fuente, y grosor de la linea, pueden ser editados en la seccion Bend del inspector. Las
propiedades de texto y liena aplicadas a todos los bends enla partitura pueden ser editadas en Formato→Estilo...→Bend

Editar propiedades de un bend
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Seleccione un símbolo de bend en la partitura y presione "Propiedades" en la sección Bend delInspector.

Las opciones preestablecidas están disponibles, si es necesario, en el lado izquierdo de la ventana de Propiedades de
Bends.El bend actual está representado por un gráfico que consiste en líneas grises conectadas por nodos cuadrados y
azules (ver imagen arriba). La pendiente de la línea indica el tipo de bend:

Pendiente ascendente = Bend hacia arriba
Pendiente abajo = Bend abajo
Línea horizontal = Sostener (Release)

El eje vertical del gráfico representa por cuanto se dobla el tono, hacia arriba o hacia abajo: una unidad equivale a un
cuarto de tono: 2 unidades a un semitono, 4 unidades a un tono completo, y así sucesivamente. El eje horizontal del
gráfico indica la longitud del bend: cada segmento de línea gris se extiende para Glossary en la partitura.

Una bend se modifica añadiendo o eliminando puntos en el gráfico:

Para añadir un punto, pulse en una intersección vacía.
Para eliminar un punto, haga clic en él.

Añadir un punto alarga el bend en 1 sp; eliminar un punto acorta el bend en 1 sp. Los puntos de Inicio y Fin del bend se
pueden mover hacia arriba y hacia abajo solamente.

Ajustar la altura

La altura del símbolo de bend se ajusta automáticamente para que aparezca justo encima del pentagrama. Esta altura se
puede reducir, si es necesario, con una solución alternativa:

1. Cree otra nota en la línea superior (o espacio) del pentagrama, verticalmente sobre la nota en la que desea que
comience el bend.

2. Primero aplique el bend a la nota más alta: esto creara un símbolo de bend con la altura más baja.
3. Para aumentar la altura del bend, mueva esta nota hacia abajo.
4. Arrastre el símbolo de bend hacia abajo a la posición correcta.
5. Marque la nota superior como invisible y silenciosa (usando el Inspector).

Ajustar posición

Para ajustar la posición usa uno de los siguientes:

Arrastre el símbolo de bend con el mouse.
Haga clic en el símbolo y ajuste los desplazamientos horizontales y verticales en el Inspector.
Haga doble clic en el símbolo; o haga clic en él y presione Ctrl+E (Mac: Cmd+E); o haga clic derecho en el símbolo y
seleccione "Editar elemento". Luego use las teclas de flecha para un posicionamiento preciso (0.1 sp a la vez); o
Ctrl+Flecha (Mac: Cmd+Flecha) para ajustes más grandes (1 sp a la vez).

Bends personalizados

Después de editar un bend en la partitura, este se puede guardar para uso futuro arrastrando y soltando el símbolo en
una paleta mientras se mantiene presionado Ctrl+May (Mac: Cmd+May). Vea Espacio de trabajo personalizado

Barras de agrupación

Las propiedades de agrupación de notas se configuran automáticamente, según la indicación de compás.

Para ajustar la agrupación por defecto: haga clic derecho en una indicación de compás y seleccione
"Propiedades de la indicación de compás". Ver Cambiar la agrupación predeterminada para más detalles.

Sin embargo, si desea ajustar la agrupación de notas manualmente, caso por caso, utilice los símbolos de agrupación
que se encuentran en la paleta "Propiedades de agrupación" en los Paletas "Básico" o "Avanzado":
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Símbolos de agrupacion

La siguiente es una lista de símbolos de agrupacion y sus efectos:

 Comience una agrupación en esta nota (o silencio).

 No termine una agrupación en esta nota (o silencio).

 No agrupe esta nota.

 Comience un segundo grupo de nivel en esta nota.

 Comience un grupo de tercer nivel en esta nota.

 volver al modo en que se elige dependiendo de la indicación de compás automaticamente.

 Comience la barra de agrupación en ángulo (más lenta) en esta nota.

 Comience la barra de agrupación en ángulo (más rápida) en esta nota.

Cambiar barra de agrupación

Para cambiar una o más barras de agrupación (excepto las barras en ángulo), use cualquiera de los siguientes métodos:

Arrastre y suelte un símbolo de agrupación desde un Paletas en una nota en la partitura.

Modos de selección una o más notas en la partitura y haga doble clic en en el símbolo de agrupación en el espacio
de trabajo deseado.

Para aplicar barras de agrupación en ángulo, use cualquiera de los siguientes métodos:

Arrastre y suelte un símbolo de barra de agrupación en ángulo desde un espacio de trabajo a una barra de
agrupación de notas en la partitura.

Seleccione una o más barras de agrupación de nota en la partitura, luego haga doble clic en un símbolo de barra de
agrupación en ángulo en el espacio de trabajo.

Notas: (1) Las barras en ángulo pueden usar 2 o 3 líneas dependiendo del metrónomo y la velocidad deseada del
cambio; (2) Para crear una barra en ángulo de 2 líneas, debe comenzar con un grupo continuo de semicorcheas; (3) (3)
Para crear una barra en ángulo de 3 líneas, debe comenzar con un grupo continuo de fusas; (4) La reproducción de
barras en ángulo no es posible.

Ajuste el ángulo de la barra de agrupacion

Para ajustar con el teclado o mouse:

1. Haga doble clic en una barra de agrupacion o selecciónela y presione Ctrl+E para ponerla en el modo de edición—el
punto de ajuste del extremo derecho se selecciona automáticamente.

2. Use las flechas arriba/abajo o arrastre el punto de ajuste del extremo derecho para cambiar el ángulo de la barra.
3. Presione Esc para salir del modo de edición.

Para ajustar con Inspector:

1. Haga clic en una barra de agrupacion de notas.
2. Marque la casilla "Posición de usuario" en la sección "Barra de agrupación" del Inspector.
3. Establezca los valores de "Posición" para obtener el ángulo deseado.

Ajustar la altura de la barra de agrupacion

Para ajustar con el mouse o teclado:

1. Haga doble clic en una barra de agrupacion o seleccionela y presione Ctrl+E para entrar al modo de edicion—el punto
de control al extremo derecho es seleccionado automaticamente,
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2. Presione Shift+Tab o haga clic en el punto de ajuste izquiedo para seleccionarlo.
3. Use las flechas arriba/abajo o arrastre el punto de ajuste en el extremo izquierdo para cambiar la altura de la barra.
4. Presione Esc para salir del modo de edicion.

Para ajustarla desde el Inspector:

1. Haga clic en una barra de agrupacion de notas.
2. Marque la casilla "Posición de usuario" en la sección "Barra de agrupación" del Inspector.
3. Establezca los valores de "Posición" para obtener el ángulo deseado.

Ajustar la barra de agrupación en posición horizontal

1. Haga clic en una barra de agrupaciones de notas.
2. Marque la casilla "Horizontal" en la sección "Barra de agrupación" del Inspector.
3. Si lo desea, ajuste la altura de la barra con el teclado/mouse/inspector (ver arriba).

Si desea que todas las barras de agrupación en la partitura sean horizontales, hay una opción "Acoplar todas las barras
de agrupación" en Formato→Estilo→General...→Barras de agrupacion.

Ajustar barra de agrupación en ángulo

Para ajustar barras de agrupación en ángulo:

1. Seleccione barras de agrupación en ángulo.
2. Ajuste los valores en los cuadros "Expandir hacia la izquierda" y "Expandir hacia la derecha" en la sección "barras

de agrupación" del Inspector.

Redistribución local

MuseScore espacia las notas de acuerdo con sus valores de tiempo (siguiendo la practica comun), lo que permite
alteraciones, letras, etc. En sistemas donde hay más de un pentagrama, esto puede ocasionar un espaciado de notas
irregular, como en el siguiente ejemplo:

La redistribución local es una opción de casilla de verificación en el Inspector que le permite especificar los pasajes de
la partitura en los que desea que el espacio de notas sea independiente de otros pentagramas en el sistema. La
aplicación de la "redistribución local" a las barras de la agrupación de notas en la parte superior del personal del ejemplo
anterior da como resultado una distribución más uniforme:

Para hacer una redistribución local:

1. Seleccione una o más barras de agrupación de notas.
2. Marque la opción Redistribución local en la sección "Barras de agrupación" del Inspector.

Invertir barra de agrupación

Para invertir barra de agrupación de arriba a abajo de las notas, o viceversa:

1. Seleccione una o más barras de agrupación.
2. Use cualquiera de las siguientes opciones:

Presione la tecla X;

Presione el ícono "Invertir dirección" , en la barra de herramientas.

* Seleccione una opción de "Dirección" (Automático, Arriba o Abajo) en la sección "barra de agrupación" del Inspector.
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Restablecer barras de agrupacion

Para restablecer al modo definido en las indicaciones de compás:

1. Seleccione la sección de la partitura que desea restablecer. Si no se selecciona nada, la operación se aplicará a
toda la partitura;

2. Seleccione Diseño→Restablecer modo de Agrupación de Notas.

Véase también

Notación de pentagrama cruzado
Modo de edición
Introducción de notas

Enlaces externos

Cómo agregar una barra de agrupación por encima de un silencio
Cómo colocar una barra de agrupación entre notas

Llaves

MuseScore proporciona corchetes estándar y una llave dentro de la paleta Llaves en el espacio de trabajo) avanzado.

Añadir

Para añadir un corchete o llave a los sistemas, use uno de dos métodos:

Arrastre un símbolo de llave desde una paleta a un espacio vacío en el primer compás del pentagrama donde
desea que comience el corchete.
Seleccione el primero compás del pentagrama donde desea que se inicie la llave y haga doble clic en un símbolo de
corchete en una paleta.

Borrar

Seleccione la llave y presione Borrar.

Cambiar

Arrastre un símbolo de llave desde una paleta a una llave existente en la partitura.

Editar

Cuando aplica por primera vez una llave esta solo abarcara un pentagrama. Para extender a otros pentagramas:

1. Entre al Modo de edición.
2. Arrastre el punto de ajuste hacia abajo para abarcar los pentagramas necesarios. El punto de ajuste se adapta a su

nueva posición, por lo que no se requiere una colocación exacta.

Estilo

El grosor y la distancia predeterminados del sistema de corchetes y llaves se pueden ajustar en Formato → Estilo →
General... → Sistema.

Notas de adorno

Una nota de adorno es un tipo de ornamento, generalmente impreso mas pequeño que las notas normales. La nota de
adorno corta, o Acciaccatura, aparece como una pequeña nota con un trazo a través de la plica. La nota de gracia larga,
o Apoyatura, no tiene un trazo.

Crear notas de adorno
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Las notas de gracia se pueden encontrar en la Paletas"Notas de adorno" en el espacio de trabajo Básico o Avanzado.

Añadir un nota de adorno

Use uno de los siguientes métodos:

Seleccione una nota normal y haga doble clic en una nota de adorno dentro de la paleta;
Arrastre una nota de adorno desde una paleta a una nota normal;
Seleccione una nota y presione / para crear una acciaccatura.

Esto agregará una nota de gracia del mismo tono que la nota normal. Para agregar una secuencia de notas de gracia a
una nota normal, simplemente repita las acciones anteriores tantas veces como sea necesario. Ver Cambiar altura
(abajo).

Nota: Cuando se añade una nota de adorno a la partitura, una ligadura no se crea automáticamente con ella, por lo que
necesita ser añadida por separado Ligaduras.

Añadir un acorde de notas de adorno

Los acordes de notas de adorno se crean igual que los acordes regulares:

1. Ingrese la primera nota del acorde como se muestra arriba
2. Seleccione esta primera nota de gracia e ingrese las notas subsecuentes como lo haría con cualquier otro acorde

regular (i.e. May+A...G).

También puede crear un acorde de nota de gracia usando el atajo de añadir intervalo en el paso 2: Alt+1...9 para
intervalos desde un unísono hasta una novena arriba.

Cambiar altura

La altura de una nota de adorno se puede ajustar al igual que una nota regular:

1. Seleccione una o más notas de adorno
2. Ajuste la altura usando los comandos de la flecha del teclado, a saber:

↑ o ↓ para aumentar o disminuir la altura en un semitono;
Alt+May+↑ or Alt+May+↓ para aumentar o disminuir la altura un paso a la vez, de acuerdo con la armadura.

Cambiar duración

Si desea cambiar la duración de una nota de gracia creada anteriormente, selecciónela y elija una duración desde la
barra de herramientas o ingrese con una de las teclas 1...9 (ver Introducción de notas ).

Ajuste manual

La posición de una nota de adorno después de una nota comun (como una terminación de trino) puede tener que
ajustarse seleccionando la nota, yendo a modo de edición y usando las flechas izquierda/derecha del teclado; o cambie
los valores de desplazamiento de acordes en el Inspector.

Enlaces externos

Adornos  en Wikipedia
Apoyatura  en Wikipedia
Acciaccatura  at Wikipedia

Respiraciones y pausas

Las marcas de Respiración y Pausa están disponibles en la paleta de Respiraciones y pausas en el espacio de trabajo
avanzado.

Añadir símbolo

Para agregar una respiración o pausa (también llamada cesura, o informalmente "coma") a la partitura, use una de las
siguientes opciones:
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Seleccione una nota o silencio y haga doble clic en un símbolo de respiración o pausa en una paleta.
Arrastre un símbolo de respiración o pausa desde una paleta a una nota o silencio en la partitura.

El símbolo se coloca después de la nota. puede ajustar su posición editando las propiedades desplazamiento X/ Y en el
Inspector, o, en el modo de edición, usando las flechas del teclado.

Ajustar la duración de la pausa

Puede ajustar la duración de la pausa (en segundos) en el Inspector.

Líneas

La paleta Líneas del espacio de trabajo avanzado incluye los siguientes tipos de líneas:

Como puede ver, la paleta incluye: Ligaduras, Reguladores, Casillas de repetición, Lineas de octava, y muchas otras.

Aplicando líneas a la partitura

La mayoría de líneas (excepto Ligaduras, Casillas de repetición y Ambitus) se pueden aplicar desde una paleta de las
siguientes maneras:

Para aplicar una línea a solo una nota

1. Haga clic en una nota, luego Ctrl+ hagaClic en la nota siguiente;
2. Haga doble clic en una línea.

Para aplicar una línea a través de un rango de notas

1. Seleccione un rango de notas;
2. Haga doble clic en una línea.

Para aplicar una línea desde una nota hasta el final de ese pentagrama

Use cualquiera de los siguientes métodos:

Haga clic en una nota, luego haga doble clic en una línea.
Arrastra y suelta una línea en la partitura.

Para aplicar una línea a través de un rango de compases{#range-of-measures}

1. Seleccione one or more measures;
2. Double click a line in a palette.

Lineas y propiedades de reproduccion
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Algunas lineas, como los Reguladores, Casillas de repetición, Octavas etc., tienen un efecto en la reproduccion ademas
de ser indicativas. Cara __punto de ajuste extremo___ esta conectado por una linea punteada a un ancla en el
pentagrama (visible en modo de edición). Estas anclas indican el alcance del efecto de reproduccion.

Ajustar la posición vertical

En Modo normal, use uno de los siguientes metodos:

Haga clic en una o más líneas y cambie el desplazamiento vertical en el Inspector;
Haga clic en una línea, presione y mantenga May y arrástrelo hacia arriba / abajo con un mouse.

Nota: también puede ajustar la posición vertical en el modo de edicion

Cambiar longitud

1. Ingrese al Modo de edicion y haga clic en el punto de control al final:

2. Use uno de los siguientes accesos directos:

Shift+→ para mover el punto de ajuste, y su ancla, hacia la nota a la derecha (o, en el caso de Casillas, un
compás)

Shift+← para mover el punto de ajuste, y su ancla, hacia la nota a la izquierda (o, en el caso de Casillas, un
compás);

Nota: Este metodo permite que la linea abarque distintos sistemas si es necesario, y asegura que la reproduccion
coincida con el aspecto visual de la linea.

3. Para cambiar la posición de un punto de ajuste final sin cambiar la posición de su anclaje, use la siguiente:

→ para mover el mango hacia la derecha por 0.1 sp (1 sp = un espacio de pentagrama = la distancia entre
dos lineas de pentagrama).
← para mover el punto de ajuste a la izquierda 0.1 sp.
Ctrl+→ (Mac: Cmd+→)para mover el punto de ajuste a la derecha un sp.
Ctrl+← (Mac: Cmd+→) para mover el punto de ajuste a la izquierda un sp.

Nota: también puede arrastrar los puntos con un mouse.

Lineas de texto

Una linea de texto es una linea que tiene un texto incrustado en ella—como una casilla de repetición, octava, cejilla de
guitarra, etc.
Cuando aplica texto a una linea de la partitura desde una paleta, las propiedades de linea siempre se mantienen sin
cambios, pero las propiedades de texto pueden, en ciertas cirunstancias, tomar las del
estilo actual para lineas de texto. Para detalles, vea Comportamiento de texto incrustado y lineas.

Lineas personalizadas{#custom-lines}

Cualquier linea en la partitura puede ser personalizada ajustando sus propiedades en el Inspector de la siguiente manera:

1. Seleccione la linea;
2. Si son necesarios ganchos en la linea, haga una selección desde Gancho inicial, Gancho final y Altura (en la

sección Texto de linea);
3. Para agregar texto, marque Texto inicial, Continuación de texto, o Texto final, luego escriba en la caja "Texto":

Comienzo: El texto agregado aqui aparecerá al principio de la linea;
Continuación: El texto agregado aquí aparecerá al principio de una continuación de la linea;
Final: El texto agregado aquí aparecerá al final de la linea;

4. Edite las propiedades de texto y alineamiento segun haga falta;
5. Edite Ubicación: "Encima" o "Debajo" configura el texto con respecto a la linea. "Izquierda" pone el texto a la

izquierda de la linea;
6. Haga ajustes al color de la linea, grosor y estilo (solido, rallado etc.) en la sección Linea. La opción Diagonal

permite crear una linea diagonal arrastrando los puntos de ajuste;
7. Para guardar el resultado para uso futuro, vea Paletas personalizadas.

Copiar líneas

Una vez aplicadas a la partitura, las líneas no se pueden copiar utilizando los procedimientos habituales de copiar y
pegar. Sin embargo, puede duplicar líneas dentro de una partitura: mantenga presionada Ctrl+May (Mac: Cmd+Shift), haga
clic en la línea y arrástrela hasta el lugar deseado.

Líneas de adorno extendidas
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Para agregar una alteración a un adorno extendido, como una línea de trino, seleccione la línea y haga doble clic en un
símbolo de la paleta de alteraciones.

Enlaces externos

Marcas del pedal del teclado  en Wikipedia
[https://es.wikipedia.org/wiki/Cejilla ) en Wikipedia

Líneas de octava

__Las líneas de octava (Ottava) __ se utilizan para indicar que una sección de música debe reproducirse a una o más
octavas por encima o por debajo del tono escrito: la línea puede ser punteada o ser sólida. Los Ottavas están disponibles
en la paleta Lineas de los espacios de trabajo basico y avanzado.

8─────┐or 8va─────┐: reproduce una octava por encima del tono escrito
8─────┘or 8vb─────┘: reproduce una octava por debajo del tono escrito

Las líneas 8va/8vb son particularmente comunes en las partituras de piano, aunque a veces se utilizan en otras músicas
instrumentales.1 15ma (2 octavas por encima) y 15mb (2 octavas por debajo) también se usan ocasionalmente.

MuseScore ajusta automáticamente la reproducción de la partitura bajo la indicación de octava al registro correcto.

Aplicar una línea de octava

Vea Aplicar lineas a la partitura.

Para ajustar la posición vertical, vea Lineas: Ajustar posición vertical.

Cambiar longitud

Vea Lineas: cambiar longitud.

Líneas personalizadas

Las octavas se pueden personalizar como cualquier otra línea. Vea Líneas : Líneas personalizadas y propiedades de
línea.

Enlaces externos

Octava  en Wikipedia

1. Gerou/Lusk. Essential Dictionary of Music Notation ([Archivo de Internet] (en inglés)
(https://archive.org/details/EssentialDictionaryOfMusicNotation )). ↩︎

Reguladores

Añadir un regulador

Los Reguladores son simbolos usados para indicar un cambio gradual de dinamicas en la partitura. Hay 2 tipos:
crescendo (mas fuerta) and decrescendo (mas debil).

Para crear un regulador:
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1. Seleccioneun rango de notas o compases;
2. Use uno de los siguientes accesos directos:

<: para crear un regulador de crescendo.
>: topara crear un regulador diminuendo (decrescendo).

Alternativamente, puede usar una de las siguientes opciones:

Seleccione un rango de notas o compases, y haga doble clic en un regulador en una paleta.
Arrastre y suelte un regulador desde una paleta a un pentagrama.

Ajustar la longitud

Un regulador es un tipo de Linea con propiedades de reproducción, y su largo es ajustado de manera similar:

1. Haga doble clic en el regulador para ingresar al modo de edición. A continuación, haga clic en el punto de ajuste que
desea mover:

2. Use uno de los siguientes atajos:

May+→ para mover el punto de ajuste final, y su anclaje , justo por una nota o silencio.
May+← para mover el punto de ajuste final, y su ancla, a la izquierda de una nota o silencio;
Este método de extender o acortar el regulador mantiene la integridad de reproducción y le permite cruzar
saltos de línea:

3. Para cambiar la posición de un punto de ajuste sin cambiar la posición de anclaje, use los siguientes atajos:

→ para mover el punto a la derecha en 0.1 sp .
← para mover el punto a la izquierda en 0.1 sp.
Ctrl+→ (Mac: Cmd+→) para mover el punto a la derecha un sp.
Ctrl+← (Mac: Cmd+→) para mover el punto a la izquierda un sp.

Para cambiar la altura de un regulador:
* Mueva el punto de ajuste inferior en la boca del regulador (e.g. el cuadrado azul mas abajo):

Líneas de cresc. y dim.

Además de los reguladores, hay cresc.   _     _     _ y dim.   _     _     _ líneas con la misma función en la paleta Lineas.
Puede ajustar el texto, si desea, desde la sección Texto de linea del Inspector

Para convertir un regulador en su línea de texto equivalente:

1. Seleccione el regulador y, en la sección Regulador del Inspector, seleccione la linea adecuada en "Tipo".

Editar propiedades del regulador

Las propiedades del regulador pueden ser editadas en el inspector:

Elemento: Edite la ubicación en Y para cambiar la altura del regulador hacia arriba o abajo del pentagrama.
Linea: Edite las propiedades de linea como color, estilo y grosor.
Texto de linea: Añada texto y determine las propiedades del texto.
Regulador:

Tipo: Cambie el tipo de regulador: crescendo, decrescendo o texto.
Ubicación: Ponga el regulador encima o debajo del pentagrama.
Rango dinámico: i.e. que pentagramas serán afectador por la reproducción del regulador.
Cambio de velocidad: … durante la duración del regulador;
Alto: Ajusta el ancho de la boca del regulador.
Altura de continuación: El ancho del regulador al final del sistema, antes de que continué en el sistema
siguiente.
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Reproducción del regulador

Las lineas de crescendo y diminuendo solo afectan la reproducción de una nota a la siguiente, no tienen efecto
(actualmente) en la reproducción de una nota larga o una serie de notas ligadas .
Por defecto, los reguladores solo afectaran la reproducción si dinámicas son usadas antes y después del regulador. Por
ejemplo, un crescendo abarcando notas desde las dinámicas p y f__causaran un cambio en la reproducción.
Sin embargo, entre dos dinámicas sucesivas cualquiera solo el primer regulador apropiado tendrá efecto: un
diminuendo entre __p y f sera ignorado; o dos o mas crescendos entre p y f, todos menos el primero serán ignorados
Un regulador puede ser usado sin marcas de dinámica, ajustando "Cambio de velocidad" en el Inspector  (los valores
están en rango de 0
a 127).

Silencios de compás

Silencios de compás completo

Un silencio de redonda, centrado dentro de un compás (que se muestra a continuación), se usa para indicar que un
compás completo (o una voz dentro de un compás) está en silencio, independientemente de la indicación del compás.

Para crear uno o más silencios de compás

Utilice el siguiente método si todos los compases seleccionados son "estándar", es decir. sin duraciones personalizadas:

1 Seleccione un compás , o rango de compases.
2. Presione Borrar.

Si uno o más de los compases contiene una Duración personalizada, use el siguiente método en su lugar:

1. Seleccione un compás, o Modos de selección de compases.
2. Presione Ctrl+May+Borrar (Mac: Cmd+May+Borrar).

Para crear uno o más silencios de compás completo en una voz en particular

1. En la voz apropiada, ingrese un silencio que se extienda por el compás completo.
2. Asegúrate de que el silencio esté seleccionado, luego presione Ctrl+May+Borrar (Mac: Cmd+May+Borrar).

Silencios multicompás

Un Silencio multicompás indica un período de silencio para un instrumento: el número de compases se muestra por el
número encima del pentagrama.

Los silencios de multicompás se interrumpen automáticamente en puntos importantes, como barras dobles de compás,
guías de ensayo, cambios en la armadura o indicaciones de compás, saltos de sección etc.

Para mostrar silencios de multicompás

Para activar o desactivar silencios de multicompás:

Presione M en su teclado.

Alternativamente:

1. Desde el menú, seleccione Formato→Estilo→General...
2. Haga clic en la pestaña "Partitura", si no está seleccionada;
3. Marque/desmarque "Crear silencios multicompás".

Nota: se recomienda que ingrese todas las notas en la partitura primero antes de habilitar los silencios multicompás.

Interrumpir silencios de multicompás

Si desea dividir un silencio de multicompás en dos:

1. Asegúrese de que la opción para mostrar silencios multicompás en la partitura esté desactivada (vea arriba).
2. Haga clic con el botón derecho en el compás donde desea que comience el segundo silencio de multicompás ;
3. Desde el menú, seleccione Propiedades de compás y marque "Separar compases de espera"
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Ver : Separar compases de espera.

Ligaduras

Una __ligadura es una línea curva entre dos o más notas que indican que se deben tocar legato—suavemente y sin
separación. No debe confundirse con Ligaduras por prolongación, que unen dos notas del mismo tono.

Hay varias maneras de agregar una ligadura a una partitura, y todas pueden ser útiles dependiendo del contexto
(también es posible agregar una ligadura desde paleta de líneas también es posible pero no es lo mas practico).

Añadir ligaduras en el modo de introducción de notas

1. Mientras está en el Introduccion de notas, ingrese la primera nota en la sección con una ligadura;
2. Presione S para comenzar la sección con una ligadura;
3. Escriba las notas restantes en la sección con una ligadura;
4. Presione S de nuevo para finalizar la sección con una ligadura.

Agregar una ligadura fuera del modo introducción de notas

Método 1

1. Asegurese de estar en Modo normal;

2. Seleccione la nota donde quiere comenzar la ligadura:

3. Presione S para agregar una ligadura que se extienda a la nota siguiente:

4. (Opcional) Mantenga May y presione → (tecla de flecha a la derecha) para extender la ligadura a la nota siguiente.
Repita según sea necesario:

5. (Optional) (Opcional) Presione X para invertir la dirección de la ligadura:

6. Presione Esc para salir del modo de edición:

Método 2

1. Asegúrese de no estar en el modo introducción de notas;
2. Seleccione la primera nota que desee que este cubierta por la ligadura;
3. Elija una de las siguientes opciones:

Para agregar una ligadura a una sola voz: mantenga presionada Ctrl (⌘ en una Mac) en una Mac) y seleccione
la última nota que desea que este cubierta la ligadura.
*Para agregar ligaduras a _todas_ las voces: mantenga presionada May (⌘ en una Mac) y seleccione la última
nota que desea que este cubierta por las ligaduras.

4. Press S.

Ajustar la ligadura

Si solo quieres ajustar la posición de una ligadura:
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1. Seleccione la ligadura;
2. Use cualquiera de los siguientes métodos:

Arrastre la ligadura.
Ajuste los valores de desplazamiento horizontal y vertical en el Inspector.

Para ajustar todas las propiedades de una ligadura (longitud, forma y posición):

1. Asegúrese de que no esté en el modo introducción de notas;
2. Haga doble clic en la ligadura para ingresar al modo de edición  (o selecciónela y presione Ctrl+E; o haga clic con el

botón derecho y seleccione "Editar elemento");
3. Haga clic en un punto de ajuste para seleccionarlo, o use Tab para pasar por los distntos puntos de ajuste;
4. Para mover los puntos de ajuste izquierdo y derecho de una nota a otra, use los siguientes atajos:

May+→: Mover a la siguiente nota.
May+←: Mover a la nota anterior.
May+↑: Mover a la voz inferior (voz 2 a voz 1, etc.).
May+↓: Mover a voz más alta (voz 1 a voz 2, etc.).

5. Para ajustar la posición de cualquier punto de ajuste, use cualquiera de los siguientes métodos:
Arrastre el punto de ajuste.
Use las teclas de flecha para un ajuste fino (0.1 sp.  a la vez). Para ajustes más grandes (1 sp.  a la vez)
use Ctrl+Flecha.

6. Presione Esc para salir modo de edición.

Nota: las dos puntos externos ajustan el inicio y el final de la ligadura, mientras que las tres puntos de la curva ajustan el
contorno. El punto del medio en la línea recta se usa para mover toda la ligadura arriba/abajo/izquierda/derecha

Ligaduras extendidas

Una ligadura puede abarcar varios sistemas y páginas. El inicio y el final de una ligadura está anclado a una nota, acorde
o silencio. Si las notas se reposicionan debido a cambios en el diseño, estiramiento o estilo, la ligadura también se mueve
y se ajusta en tamaño.

Este ejemplo muestra una ligadura que abarca desde la clave de fa hasta la clave de sol. Con el mouse, seleccione la
primera nota de la ligadura, mantenga presionada Ctrl (Mac: ⌘) y seleccione la última nota dentro de la ligadura, y
presione S para agregar la ligadura.

X flips the direction of a selected slur.

Ligaduras punteadas

Las ligaduras punteadas se usan a veces en canciones donde la presencia de una ligadura varía entre estrofas. Las
ligaduras punteadas también se usan para indicar la sugerencia de un editor (a diferencia de las marcas originales del
compositor). Para cambiar una ligadura existente en una ligadura punteada o discontinua, selecciónela y luego en
Inspector (F8) cambie Tipo de línea deContinuo a Punteado o discontinua.

Véase también

Ligadura de prolongación
Modo de edición
Introducción de notas

Ligaduras de prolongación

Una ligadura de prolongación es una línea curva entre dos notas de la misma altura, lo que indica que deben
reproducirse como una sola nota con las duraciónes combinadas (ver enlaces externos abajo). Las ligaduras de
prolongación normalmente se crean entre notas adyacentes en la misma voz, pero MuseScore también admite ligaduras
de prolongación entre notas no adyacentes y entre notas en diferentes voces.

En el modo de introducción de notas, si especifica una ligadura de prolongación inmediatamente después de ingresar una
nota o acorde, el programa genera automáticamente las notas de destino correctas para ir con las ligaduras de
prolongación. O bien, puede simplemente crear ligaduras de prolongación "después del hecho", entre notas existentes.

Nota: Las ligaduras de prolongación, que unen notas de la misma altura, no se deben confundir con ligaduras , que unen
notas de diferentes alturas e indican articulación legato.
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Agregar ligaduras a notas individuales

En Modo Normal:

1. Haga clic en una nota, o use Ctrl (Mac: Cmd) + haga clic para seleccionar más de una nota.

2. Presione + o el botón de la ligadura de prolongación, :

.

Se crearán ligaduras de prolongación entre la(s) nota(s) seleccionada(s) y la(s) siguiente(s) nota(s) del mismo tono.

En Modo de introducción de notas:

1. Seleccione una nota individual (una que no sea parte de un acorde).
2. Seleccione una nueva duración para la nota siguiente si es necesario (pero vea la "Nota" mas abajo).

3. 3. Presione + o el botón de la ligadura de prolongación, .

Note: Este atajo funciona, como esta descrito arriba, solo si no hay un acorde seguido de la nota seleccionada. Si lo
hubiera, la duracion es ignorada y la nota ligada se agrega al acorde siguiente.

Agregar ligaduras a acordes

En Modo Normal:

1. Use one of the following selection options:
Mantenga presionada Shift y haga clic en cualquier nota en el acorde, o
Haga clic en la plica del acorde.

2. Luego presione + o el botón de la ligadura de prolongación .

Se crearán ligaduras de prolongación entre todas las notas del acorde seleccionado y las siguientes notas de los mismos
tonos.

En Modo de introducción de notas:

1. Asegúrese de que una nota esté seleccionada en un acorde.
2. Seleccione un nueva note duration para el siguiente acorde, si es necesario (pero ver "Nota" abajo).

3. Presione + o botón de la ligadura de prolongación, .

Nota: este acceso directo funciona, como se describió anteriormente, solo si no hay un acorde después de la nota
seleccionada. Si lo hay, se ignora la duración y la notas ligadas se agregan al acorde siguiente.

Invierta una ligadura

X invierta la dirección de la ligadura seleccionada, de encima de la nota a debajo, o viceversa.

Véase también

Ligadura

Enlaces externos

Cómo crear ligaduras de prolongación que conducen a un segundo final
Ligadura (musica)  en Wikipedia

Trémolo

Los simbolos de Tremolo se encuentran en la paletaTremolo en el espacio de trabajo avanzado: tremolos sobre una o
dos notas son posibles.
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Tremolo es la repetición rápida de una nota, o una alternancia rápida entre dos notas o acordes. Se indica mediante
trazos a través de las plicas de las notas o acordes. Si el trémolo está entre dos, las barras se dibujan entre ellos. Los
símbolos de trémolo también se usan para anotar los redobles en percusión.

Agregar un tremolo

Tremolo de una sola nota: Para agregar tremolo a una sola nota, seleccione la cabeza de nota y haga doble clic
en el símbolo deseado en la paleta de tremolo.
Tremolo de dos notas: Seleccione la primer nota del par y haga doble clic sobre el simbolo de tremolo deseado en
la paleta.

Nota:En un tremolo de dos notas, cada nota tiene el valor de la duración total del tremolo. Para ingresar un trémolo con
la duración de una blanca, ingrese dos negras, y luego de aplicar un símbolo de trémolo a la primera nota, las duraciones
de las notas se duplicarán automáticamente a blancas.

Enlaces externos

Tremolo  (Wikipedia)

Casillas (1ra y 2da repeticion / final)

Las casillas de primer y segunda repeticion o Voltas, se utilizan para indicar finales distintos para una repeticion.

Agregar una casilla de repeticion

Use uno de los siguiente metodos:

Seleccione un compas o rango de compases y haga doble clic en el icono de la casilla de repeticion en Líneas.
Arrastre la indicacion de casilla desde la Paleta de lineas, luego ajuste el largo segun sea necesario (ver abajo).

Cambiar numero de compases abarcados por la casilla

1. Haga doble clic en la casilla para entrar en el Modo de edicion. El punto de ajuste del final sera seleccionado
automaticamente.

2. Presione Shift+→ para mover el punto de ajuste hacia adelante por un compas. Presione Shift+← para mover el punto
de ajuste hacia atras por un compas. Repita hasta alcanzar el resultado deseado.

Nota: Solo los comandos que icluyen Shift alteraran los puntos de comienzo y final de las repeticiones durante la
reproduccion. Para un ajuste mas fino para la visual de los puntos de comienzo y final puede utilizar los otros comandos
con las flechas, o arrastrar los puntos de ajuste con el mouse, pero estos no afectaran la reproduccion.

Cuando se selecciona un punto de ajuste, se muestra una linea rayada que se conecta con un punto de anclaje en el
pentagrama. Este punto de anclaje muestra la posicion de comienzo y final de la repeticion para la reproduccion.

Propiedades de la casilla

Para hacer cambios al texto de la casilla:
* Seleccione la casilla, y edite las propiedades en la seccion Linea de Text en el Inspector.
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Para especificar el orden de las repeticiones:

Seleccione la casilla, y en la "lista de repeticiones" (la sección casillas de repetición del Inspector) escriba un
numero, o secuencia de números separados por comas, para indicar la repetición/es en las que la casilla debe ser
tocada.
por ejemplo, un primer final muestra el numero "1"; un segundo final, el numero "2" y etc. Repeticiones mas
complejas son posibles: e.g. una "lista de repeticion" como "1, 2, 4, 5, 7" indica que la repeticion se toca durante las
repeticiones 1, 2, 4, 5 y 7.

Reproduccion

Algunas repeticiones se reproducen mas de dos veces. Si desea cambia la cantidad de veces que MuseScore reproduce
una repetición, vaya al compás que contiene la barra de repetición y cambie el valor de 'Cantidad de repeticiones'. Vea
"Operaciones de compás: otras propiedades",fragment="other"] para mas detalles.

Enlaces externos

MuseScore en minutos - Lección 8 - Repeticiones y Finales, Parte 1
Como crear ligaduras hacia una segunda casilla de repeticion

Repeticiones y saltos

Repeticiones simples

Puede crear una repetición simple colocando una barra de repetición de cominezo y final al principio y al final de un
pasaje. Estas barras de compás se aplican desde la paleta Repeticiones y Saltos.

Nota: si el inicio de una repetición coincide con el comienzo de una pieza o seccion, la barra de inicio de repetición puede
omitirse si se desea. También, una barra de repetición al final puede ser omitida al final de la partitura o sección.

1a y 2a terminaciones

Primero cree una repetición simple (como se muestra arriba), luego aplique las terminaciones de primera y segunda vez,
ver Casillas.

Reproducción

Para escuchar repeticiones durante la reproducción, asegúrese de que esté seleccionado el botón "Reproducir

repeticiones"  en la barra de herramientas. Del mismo modo, puede desactivar las repeticiones durante la
reproducción deseleccionando el botón.
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Para establecer el número de veces que se reproduce una sección de repetición:

1. Asegúrese de que las barras de inicio de repetición de inicio y fin estén en su lugar (por ejemplo repeticiones
simples arriba).

2. Haga clic derecho en la última medida antes de la barra de repetición final y seleccione Compás propiedades.
3. Ajuste el "Conteo de reproducciones" según sea necesario.

Símbolos de repetición y texto

El texto y los símbolos relacionados con las repeticiones se encuentran en la" paleta "___ Repeticiones y saltos __" (en
los espacios de trabajo Básico y Avanzado). Esta paleta contiene:

Símbolos para repetición de compás, Segno, Coda y barras de repetición
Textos de D.S., D.C., To Coda, y Fine

Para agregar un símbolo de repetición a la partitura, use cualquiera de los siguientes metodos:

Arrastre y suelte un símbolo de repetición desde la paleta encima (¡no arriba!) el compás deseado (para que el
compás cambie de color).
Seleccione un compás, luego haga doble clic en el símbolo de repetición deseado en la paleta.

Saltos

Los saltos son símbolos en la partitura que le dicen al músico, y la reproducción, que salten a un marcador con nombre
(ver abajo). Los saltos incluyen varios tipos de texto D.C. (Da Capo) y D.S. (Dal Segno).

Si hace clic en un salto, se muestran tres etiquetas una casilla de verificación en la sección "Saltar" del Inspector. Estas
tienen los siguientes efectos en la reproducción:
* Saltar a: saltar a un [marcador] (# marcadores) cuya "Etiqueta" es la misma que la etiqueta "Saltar a".
* Reproducir hasta: continúa tocando hasta que llegues a otro marcador cuya "Etiqueta" sea la misma que la etiqueta
"Reproducir hasta".
* Continuar: pasar al siguiente marcador cuya "Etiqueta" es la misma que la etiqueta "Continuar".
* Reproducir repeticiones: Al marcar esta casilla, se dice a MuseScore que se repita después del salto al segno o al
comienzo de la partitura. Si esta opción no está marcada, repeticiones simples no se toman después de los saltos y la
reproducción funciona como si fuera la última repetición. Nota: si marca esta casilla, las repeticiones después de los
saltos aún no se reproducirán en versiones anteriores de MuseScore.

Nota: las etiquetas comienzo y final, que hacen referencia al principio y al final de una partitura o sección, son implícitas y
no necesitan ser agregadas por el usuario.

Marcadores

Los marcadores son los lugares a los que se refieren los saltos, además del implícito 'comienzo' y 'final' hay:

: Segno (tag: segno)

: Segno Variation (tag: varsegno)

: Coda (tag: codab)

: Coda Variation (tag: varcoda)
Fine: (tag: fine)
To Coda: (tag: coda)

Si hace clic en un marcardor, las siguiente propiedades apareceran en la seccion Marcardor del Inspector:

Tipo de marcador: Esto puede ser cambiado desde la lista desplegable, si es necesario.
Etiqueta: Esta es la etiqueta asociada con el marcador. Véase también, Jumps (above).
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Ejemplos de saltos

Da Capo (D.C.): En una indicación Da Capo la reproducción salta al inicio (a la etiqueta comienzo implícita) y
reproduce toda la partitura o sección otra vez (hasta la etiqueta final implícita).
Da Capo (D.C.) al Fine: En una indicación la reproducción salta al principio (a la etiqueta comienzo implícita) y
reproduce la partitura hasta la el final (la etiqueta fine).
Dal Segno (D.S.) al Fine: En una indicación salta al símbolo de Segno (la etiqueta segno) y luego se reproduce
hasta el final (la etiqueta fine)
Dal Segno (D.S.) al Coda: En una indicación salta al símbolo de Segno (la etiqueta segno) y luego juega hasta el
"To Coda" (la etiqueta coda). La reproducción continúa en el símbolo Coda (la etiqueta codab).

Note: Las propiedades (es decir, los nombres de las etiquetas) de saltos y marcadores se pueden establecer a través del
Inspector. Necesita modificarlos si usa múltiples saltos y marcadores.

Ver también

Líneas de compás
Casillas

Enlaces externos

*MuseScore en minutos: Repeticiones y Finales, parte 2  (video tutorial)
* Cómo separar una coda del resto de la partitura  (Cómo hacer de MuseScore)

Valores irregulares

Los valores irregulares se usan para escribir ritmos más allá de las divisiones de tiempos generalmente permitidos por
el indicación de compás. Por ejemplo, un tresillo de semicorchea dividirá un compás de corchea en tres semicorcheas en
lugar de dos:

Un dosillo de corchea dividirá una blanca punteada en dos corcheas en lugar de tres:

Crea un valor irregular

El método exacto para ingresar un grupo irregular depende de si está comenzando en el Introduccion de notas o en el
Modo normal. Comenzaremos con un ejemplo simple: la creación de un tresillo de corcheas.

Crear un tresillo en modo normal

1. Seleccione una nota o silencio que especifique la duración completa del grupo tresillo deseado. En el caso de un
tresillo de corcheas, deberá seleccionar una negra o silencio, como en el siguiente ejemplo:

2. Presione el atajo de teclado para un tresillo, Ctrl+3 (Mac: ⌘+3); o En el menú principal, seleccione Notas→Grupos
irregulares →Tresillo. Esto dará el siguiente resultado:

3. El programa cambia automáticamente al modo de introducción de notas y selecciona la duración más apropiada, en
este ejemplo una corchea. Ahora ingrese la serie deseada de notas/silencios. Por ejemplo:
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Crear un tresillo en el modo de introducción de notas

1. Asegúrese de estar en el modo de introducción de notas (presione N).
2. Navegue hasta la nota / silencio (o compás vacío) donde desea que comience el tresillo (use las teclas de flecha

izquierda/derecha según sea necesario).
3. Seleccione una duración final para todo el grupo de tresillo. En el caso de un tresillo de corcheas, haga clic en la

negra en la barra de herramientas de introducción de notas (o presione 5 en el teclado).
4. Desde el menú principal, seleccione Notas→Valores irregulares→Tresillo, o presione Ctrl+3 (Mac: ⌘+3). Esto crea una

indicacion de tresillo / corchete y divide apropiadamente la nota/silencio original (ver imagen arriba).
5. El programa selecciona automáticamente la duración más apropiada, en este ejemplo una corchea, lo que le

permite comenzar a ingresar de inmediato la serie deseada de notas / silencios.

Crear otros valores irregulares

La mayoría de los otros grupos irregulares se pueden ingresar de manera similar, sustituyendo las indicaciones de arriba
por las de otro con el comando general:

Ctrl+2–9 (usuarios de Mac Cmd+2–9) – en la serie de pasos anterior: esto creará grupos irregulares que van desde un
dosillo (2) a un novenillo (9), (2) para dosillo, (3) para tresillo, etc

Desde el menu, seleccione Agregar→Valores irregulares, y haga clic en la opción deseada.

Para casos más complejos, vea abajo.

Para crear otros grupos irregulares que las opciones predeterminadas (por ejemplo, 13 semicorcheas en el espacio de
una negra):

1. En Modo de introducción de notas, seleccione una nota o silencio igual a la duración total del grupo irregular.; o, en
el Modo normal, ingrese/seleccione una nota o silencio igual a la duración total deseada.

2. Abra el cuadro de diálogo Crear valor irregular desde el menú: Notas→valores irregulares→Otro...

3. Seleccione la relación numérica deseada (por ejemplo, 13/4 para trece semicorcheas en el espacio de una negra)
en "Relación" en la sección "Tipo". Especifique "Número" y "Llave" usando los botones de opción en la sección
"Formato".

4. Haga clic en Aceptar para cerrar el cuadro de diálogo.

5. Ingrese las notas/silencios deseados.

Eliminar un valor irregular

Seleccione el número/llave y presione Borrar.

Cambie la apariencia de un valor irregular

Usando el Inspector

Para cambiar las propiedades de visualización de un grupo irregular, seleccione el grupo irregular o llave, y ajuste las
propiedades deseadas en la sección "Valor irregular" en el
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Inspector:

Dirección: Coloca la llave/numero en la posición por defecto . Arriba siempre posiciona el corchete encima de las
cabezas de nota; Abajo siempre los posiciona debajo de las cabezas de nota.
Tipo de numero: Numero a elección, Relación o Nada.
Tipo de corchete: Automático oculta la llave para notas agrupadas por una barra y muestra la llave si el valor
irregular incluye notas o silencios sin agrupar. "Corchete" muestra el corchete. "Nada" esconde el corchete.

Usando el dialogo de estilo de Valores irregulares

Para hacer ajustes finos en la manera que todos los valores irregulares son mostrados en la partitura: desde el menu,
seleccione Formato → Estilo...→Valores irregulares.
La leyenda abajo muestra algunas de las propiedades que pueden ser ajustadas en el dialogo de estilo para valores
irregulares:

(2) Distancia vertical desde la plica.
(3) Distancia vertical desde la cabeza.
(5) Distancia antes de plica de la primera nota.
(6)Distancia antes de plica de la ultima nota.

Enlaces externos

¿Cómo crear tresillos y otros grupos irregulares?
¿Como crear valores irregulares no estandar?
Valores irregulares  en Wikipedia
La guía del usuario para grupos irregulares en MuseScore  [video]

Transporte

Transportar es subir o bajar el tono de una selección de notas un determinado intervalo. Puede optar por transportar
notas ya sea manualmente o mediante la ventana de Transporte.

Transporte manual

1. Seleccione las notas que desea transportar;
2. Use cualquiera de las siguientes opciones:

Para transportar cromáticamente: Presione ↑ or ↓. Repita según sea necesario;
Para transportar diatónicamente; Presione Alt + Mayús + ↑ or ↓. Repita según sea necesario;
Para transportar una octava: Presione Ctrl + ↑ or ↓ (Mac: Cmd + ↑ or ↓).

Transporte automático

La ventana Transportar de MuseScore le brinda más opciones para transportar notas.
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Nota: De forma predeterminada, esta ventana se abre desde el menú Herramientas, pero también puede abrirla usando
un atajo de teclado (ver Preferencias).

Transportar cromáticamente

Por tonalidad

Para transportar notas hacia arriba o hacia abajo a la tonalidad más cercana:

1. Seleccione las notas que desea transportar. Si no selecciona ninguna, se seleccionará toda la partitura;
2. Desde la barra de menú, elija Herramientas → Transportar...;
3. Marque "Transportar cromáticamente" y "Por tonalidad";
4. Marque o desmarque "Transportar las armaduras" y "Transportar símbolos de acordes" si es necesario;
5. Elija entre "La más cercana", "Ascendente" o "Descendente" y seleccione una armadura de clave del menú

desplegable;
6. Haga clic en Aceptar.

Por intervalo

Para transportar notas seleccionadas hacia arriba o hacia abajo en incrementos de semitonos:

1. Seleccione las notas que desea transportar. Si no selecciona nada, se seleccionará toda la partitura;
2. Desde la barra de menú, elija Herramientas → Transportar...;
3. Marque "Transportar cromáticamente" y "Por intervalo";
4. Marque o desmarque "Transportar las armaduras" y "Transportar símbolos de acordes", si es necesario;
5. Marque "Ascendente" o "Descendente" y seleccione un intervalo de transporte desde el menú desplegable;
6. Haga clic en Aceptar.

Transportar diatónicamente

Para transportar las notas seleccionadas un intervalo diatónico hacia arriba o hacia abajo:

1. Seleccione las notas que desea transportar. Si no selecciona nada, se seleccionará toda la partitura;
2. Desde la barra de menú, elija Herramientas → Transportar...;
3. Marque "Transportar diatónicamente";
4. Marque o desmarque "Transportar armadura de clave y "Transportar diagramas de acorde", si fuera necesario;
5. Marque o desmarque "Transportar las armaduras" y "Transportar símbolos de acordes", si es necesario;
6. Haga clic en Aceptar.

Instrumentos transpositores
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Los instrumentos transpositores, como la trompeta en Si♭ o el saxo en Mi♭, suenan más bajos o más altos que el tono
escrito. MuseScore tiene una serie de características para facilitar la colocación de estos instrumentos en una partitura.

Sonidos reales

El modo de visualización predeterminado de MuseScore muestra la notación musical en el tono escrito, pero puede elegir
mostrar la partitura en sonidos reales. En este último modo, la notación musical de todos los instrumentos coincide con
los tonos reales que se escuchan en la reproducción.

Para cambiar a sonidos reales: Presione el botón Sonidos reales para que se muestre resaltado.

Debe asegurarse de que el botón de Sonidos reales esté DESELECCIONADO antes de imprimir la partitura principal o
cualquier parte individual.

Cambiar la transposición de un pentagrama

Las transposiciones de los instrumentos ya están preconfiguradas en MuseScore. Sin embargo, si desea utilizar un
instrumento infrecuente o una transposición que no está disponible en MuseScore, es posible que deba editar la
transposición del instrumento manualmente.

1. Haga click derecho en una parte vacía del pentagrama del instrumento y seleccione Propiedades del Pentagrama....
2. En la parte inferior de la ventana, seleccione el intervalo de transposición, cualquier cambio de octava, y si el

intervalo es "Arriba" (suena más alto que lo escrito) o "Abajo" (suena más bajo que lo escrito).

También puede usar el botón Cambiar instrumento… en la ventana Propiedades del Pentagrama para cambiar
automáticamente la transposición a la de un instrumento estándar diferente.

Enlaces externos

Cómo transportar  (MuseScore Cómo hacer)
Concert pitch or not?  (discusión en el foro en ingles)

Notación para percusión

Introducir notación para percusión es algo diferente a la de instrumentos melódicos (como el piano o el violín).

Tipos de pentagramas de percusión

Cuando se crea un set de percusión utilizando el Asistente para nueva partitura o el cuadro de diálogo Instrumentos
MuseScore elige automáticamente el tipo de pentagrama más apropiado (1-, 3- o 5-líneas) para el instrumento: esto
puede cambiarse , si es necesario, utilizando la columna "Tipo de pentagrama" en la página Elegir instrumentos /
instrumentos. Cualquier cambio adicional (por ejemplo, en un pentagrama de 2 líneas) puede realizarse a partir de la
propia partitura (Ver Propiedades de estilo avanzado).

En un pentagrama de percusión de 5 líneas, a cada instrumento se le asigna una posición de pentagrama vertical (línea o
espacio) y una forma de cabeza de nota. Para una batería, se pueden usar uno o dos voces. Si se usan dos la voz 1 (la
voz superior) generalmente contiene notas (plicas hacia arriba) tocadas por las manos, mientras que la voz 2 (la voz
inferior) generalmente contiene notas (plica hacia abajo) tocadas por los pies (ver imagen a continuación).

Métodos de entrada de notas

Puede agregar notas a un pentagrama de percusión usando cualquiera de los siguientes métodos:

Teclado MIDI externo;
Teclado de piano (virtual);
Teclado de computadora;
Mouse.

Estos métodos se pueden usar en cualquier combinación deseada:

Teclado MIDI

Para agregar notas a un pentagrama de percusión desde un __ teclado MIDI__:

1. Asegúrese de que el teclado MIDI esté conectado y funcionando correctamente.
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Nota: si hace clic en el pentagrama de percusion sin ingresar al modo de introducción de notas, puede probar los
instrumentos de percusión desde el teclado MIDI.

2. Haga clic en la nota o silencio donde desea comenzar
3. Active el modo de Introduccion de notas.
4. Seleccione la Voces correcta. Por ejemplo, Cajas claras, golpes de aro y todos los platillos normalmente se agregan

a la voz 1; bombo para la voz 2.
5. Establezca la duración de la nota.
6. Presione una tecla para agregar una nota a la partitura. Para agregar otra nota en la misma posición, mantenga

presionada la primera tecla mientras presiona la segunda tecla.

Nota: Consulte un GM2 drum map para obtener detalles sobre qué tecla del teclado MIDI corresponde a qué instrumento
de percusión. Algunos teclados (por ejemplo, Casio) muestran símbolos de percusión junto a las teclas como ayuda para
el usuario.

Teclado de piano

1. Asegúrese de que se muestre el teclado del piano. Presione P (o selecciónelo en el menú, View → Teclado de piano).

Nota: si hace clic en el pentagrama de percusión sin ingresar al modo de introducción de notas, puede demo los
instrumentos de percusión del teclado MIDI.

2. Haga clic en la nota o silencio donde desea comenzar.
3. Ingrese al modo introducción de notas.
4. Seleccione la voz correcta. Por ejemplo, Cajas claras, golpes de aro y todos los platillos normalmente se agregan a

la voz 1; bombo para la voz 2.
5. Establezca la duración de la nota.
6. Haga clic en una tecla del piano virtual para agregar una nota a la partitura.
7. Para añadir otra nota a una existente, presione May y manténgala presionada mientras presiona la nueva nota(en

las versiones anteriores a la 2.1, use Ctrl (Mac: Cmd)).

Nota: Consulte un GM2 drum map para obtener detalles sobre qué tecla del teclado MIDI corresponde a qué instrumento
de percusión.

De forma predeterminada, el teclado del piano está acoplado en la parte inferior de la pantalla, a la izquierda de la paleta
de entrada de percusión. Sin embargo, puede desacoplarlo arrastrando, luego acoplar el panel de varias maneras:

Arrastre el panel hacia abajo hasta el centro y se superpondrá a la paleta de entrada de percusión, en la longitud
completa. A ambos paneles se puede acceder mediante tabuladores.
Arrastre el panel hacia abajo a la derecha/izquierda y se acoplará a la derecha / izquierda de la paleta de entrada
de percusión.

Teclado de computadora

Para ingresar notas en un pentagrama de percusión usando el teclado de su computadora:

1. Haga clic en la nota o silencio donde desea comenzar.
2. Ingrese al modo introducción de notas. La paleta de entrada de percusión ahora aparece en la parte inferior de la

pantalla (ver abajo).
3. Establezca la duración de la nota.
4. Presione el atajo de la tecla (A-G) para el instrumento que desea ingresar; consulte la ventana de la paleta de

entrada de percusión.
5. Si desea agregar otra nota a una existente en esa voz, presione May + [A-G].

Nota: la asignación de voz está determinada por el color de la nota en la paleta de entrada de percusión: azul para voz 1,
verde para voz 2.

Mouse

Para agregar una nota a un pentagrama de percusión

Utilice el siguiente método para agregar una nota nueva o para reemplazar un acorde existente.

1. Seleccione la nota o silencio donde desea comenzar. También puede seleccionar un compás.
2. Presione N para ingresar al modo de introducción de notas. La Paleta de entrada de percusión ahora aparece en la

parte inferior de la pantalla (ver abajo).
3. Establezca la duración de la nota.
4. Elige una de las siguientes opciones:

Haga doble clic en una nota en la Paleta de entrada de percusión.
Seleccione una nota (por ejemplo, bombo o Snare) en la Paleta de entrada de percusión, luego haga clic en
una nota o silencio en la partitura.

Para agregar una nota a un acorde existente en el pentagrama de percusión
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1. Asegúrese de estar en el note input mode.
2. Seleccione una duración de nota igual a la nota a la que está agregando.
3. Haga clic en la nueva nota en la Paleta de entrada de percusión.
4. Haga clic encima o debajo de la nota existente en el pentagrama de percusión.

Nota: la asignación de voz está determinada por el color de la nota en la paleta de entrada de percusión: azul para voz 1,
verde para voz 2.

Paleta de entrada de percusión

Cuando se selecciona un pentagrama de percusión y se activa el modo de introducción de notas, se abre una ventana en
la parte inferior de la pantalla llamada paleta de entrada Percusión. Esta ventana es esencial para la entrada del mouse
y muestra atajos para la entrada teclado de la computadora, pero puede ignorarse si se usa un teclado MIDI o el teclado
virtual Teclado de piano.

Cada nota en la paleta representa un instrumento de percusión: al pasar el puntero del mouse sobre la nota, se muestra
el nombre del instrumento.

Las letras A-G (que se muestran arriba de ciertas notas en la paleta) se designan como atajos para ingresar instrumentos
particulares (bombo, caja, charles cerrado, etc.), en lugar de referirse a tonos de notas. Se pueden cambiar o reasignar
como se desee en la ventana Editar set de percusión.

Cuando las herramientas de percusión están abiertas, al hacer doble clic en una nota en la paleta o al ingresar un atajo
con el teclado se agregará la nota del instrumento al pentagrama de percusión. El color de la nota en la paleta muestra la
voz asignada para esa nota: azul para la voz 1, verde para la voz 2. Esto se puede cambiar en el cuadro de diálogo Editar
set de percusión si es necesario.

Esta asignación de voz se aplica solo a la entrada de notas en el teclado y el mouse: la entrada a través de un teclado
MIDI o el teclado de Piano virtual permite utilizar cualquier voz.

Editar set de percusión

Para abrir la ventana Editar set de percusión, use uno de los siguientes metodos:

Haga clic en Editar set de percusión a la izquierda de la Paleta de entrada de percusión
Haga clic derecho en un pentagrama de percusión y elija "Editar set de percusión".

El diálogo Editar set de percusión muestra los instrumentos de percusión disponibles y las notas / números MIDI a los
que están asignados. También determina cómo se muestra cada instrumento en el pentagrama— su nombre, posición,
tipo de cabeza de nota y dirección de la plica de la nota. Cualquier cambio realizado aquí se guarda automáticamente en
el archivo principal de MuseScore.

Al hacer clic en una fila en la columna de la izquierda, puede editar las propiedades de visualización para esa nota de la
siguiente manera:

Nombre: El nombre que desea que se muestre en la paleta de entrada de percusión cuando pasa el mouse sobre la
nota.
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Cabeza de nota: Elige una cabeza de nota para ese instrumento de una lista desplegable de opciones (si está
configurado como "no válido", el instrumento no se mostrará en la [paleta de entrada de percusión] Nota: la cabeza de
nota predeterminada es "no válido".
Línea del pentagrama: Este numero indica la linea o el espacio en el que sera mostrada la nota. "0" significa q la nota
sera mostrada en la primera linea de un pentagrama de 5 lineas. Los números negativos mueven la nota hacia arriba
paso por paso, mientras que los numeros positivos la mueven hacia abajo de la misma manera.
Dirección de la plica: Se puede seleccionar, automático, arriba o abajo.
Atajo: Asigna un atajo de teclado para ingresar esa nota.
Voz predeterminada: Asignar la nota a una de las cuatro voces. Esto no afecta la entrada desde un teclado MIDI o el
teclado de Piano virtual.

El set de percusión personalizado se puede guardar como un archivo .drm presionando Guardar como.... También puede
importar un set de percusión personalizado usando el botón Cargar....

Redoble de tambor

Para crear un redoble de tambor, use Tremolo.

Enlaces externos

Cómo crear notación de percusión de jazz  [MuseScore Cómo hacer]
Video tutorial: MuseScore en minutos: Lección 7 - Notación de tambor y tablatura
Piezas de percusión  [video]
Editar la paleta de percusión en MuseScore 1.1  [video]
Guardar cambios de set de percusión en MuseScore 1.1  [video]
Guía para la notación de batería y percusión

Tablatura

La música para instrumentos de cuerda con trastes suele escribirse usando tablatura, también conocida como tab, que
proporciona una representación visual de las cuerdas y los números del traste:

La tablatura también se puede combinar con notación de pentagrama tradicional:

Crea un nuevo pentagrama de tablatura

Si desea crear tablatura como parte de una partitura, utilice el Asistente de partitura nueva. Si desea agregar tablatura a
una partitura existente, use el cuadro de diálogo Instrumentos O, alternativamente, puede convertir un pentagrama
estándar existente. Vea abajo para detalles.

Con el Asistente de partitura nueva

Para crear tablaturas en una nueva partitura (para sistemas de pentagrama / tablatura combinados, consulte → below):

1. Abra el Asistente de partitura nueva.
2. Ingrese los detalles de la partitura (opcional). Haga clic en Siguiente.
3. En la página Elegir archivo de plantilla, haga clic en Elija instrumentos.
4. En la página Instrumentos, seleccione una (o más) opciones de tablatura en "Cuerda pulsada" en la columna de la

izquierda (vea la imagen abajo). Luego haga clic en Añadir.
5. Complete el resto del Asistente de partitura nueva.

Nota: Si la tablatura deseada no esta disponible en la lista Elija instrumento, agregue un pentagrama de tablatura de
todos modos en el paso 4 (arriba). Luego edite la tablatura para sus requisitos usando el dialogo Propiedades de
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pentagrama/parte.

Con el diálogo Instrumentos

Para agregar un solo pentagrama de tablatura a una partitura existente (para el sistema de pentagrama / tablatura
combinado, ver → abajo):

1. Abra el cuadro de diálogo de instrumentos (presione I; o desde la barra de menú, seleccione Editar → Instrumentos…).
2. Agregue el pentagrama de tablatura como se describe en Añadir instrumentos ("Crear nueva partitura").

Al cambiar el tipo de pentagrama

Para convertir un pentagrama estándar existente en tablatura o tablatura en un pentagrama estándar:
1. Haga clic derecho en el pentagrama y seleccione Propiedades de pentagrama…. Si "Instrumento" ya está configurado en un
tipo de cuerda pulsada, salga de las propiedades del pentagrama y vaya al paso 3.
2. Si "Instrumento" no esta configurado en un tipo de cuerda pulsada, haga clic en Cambiar instrumento y seleccione un
instrumento apropiado de "Cuerda pulsada"
3. Haga clic en Propiedades de estilo avanzadas, seleccione la opcion de tablatura apropiada en "Plantilla", luego presione <
Restablecer a plantilla. Puede ajustar de manera mas exacta la apariencia usando las pestañas "Marcas de traste" y "Valores
de nota" si es necesario.
4. Haga clic en OK dos veces para salir.

Editar datos de las cuerdas

Cambiar afinación

Nota: si solo desea ver (en lugar de cambiar) la altura del instrumento, siga únicamente los pasos 1 y 2.

1. Haga clic derecho en el pentagrama y seleccione Propiedades del pentagrama….

2. Presione el botón Editar datos de las cuerdas…  en la parte inferior del cuadro de diálogo. Se abre el cuadro de diálogo
Datos de las cuerdas:
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3. Haga clic en una altura de cuerda y seleccione Editar cuerda… o simplemente haga doble clic en la altura de la cuerda.

4. Seleccione una nueva altura en el cuadro de Selección de notas y haga clic en Aceptar. O simplemente haga doble
clic en la nueva altura.

5. Haga clic en Aceptar para cerrar el cuadro de diálogo "Datos de las cuerdas". Después haga clic en Aceptar para
cerrar el cuadro de diálogo "Editar propiedades de pentagrama/parte".

Notas: (1) Si se cambia la altura cuando la tablatura para ese instrumento ya contiene algunas notas, las marcas del
traste se ajustarán automáticamente (si es posible); (2) Cualquier cambio de ajuste a un instrumento en particular se
aplica sólo a la partitura en cuestión y no cambia ninguna configuración predeterminada del programa.

Añadir cuerda

1. Haga clic derecho en el pentagrama, seleccione Propiedades del pentagrama…, luego presione Editar datos de las cuerdas .
2. Haga clic en un campo de texto y seleccione Añadir cuerda... .
3. Seleccione la nueva altura y presione Aceptar— simplemente haga doble clic en la nueva altura. La nueva cuerda se

inserta debajo de la cuerda seleccionada.

Nota: después de agregar una cuerda a la tablatura necesitará ajustar el número de líneas en el diálogo Staff/Part
properties dialog.

"Propiedades del pentagrama"].

Eliminar cuerda

1. Haga clic derecho en el pentagrama, seleccione Propiedades del pentagrama…, luego presione Editar datos de las cuerdas .
2. Haga clic en una altura de cuerda y seleccione Eliminar cuerda.

Nota: después de eliminar una cuerda de tablatura, deberá ajustar el número de líneas en el cuadro de diálogo
Propiedades del pentagrama.

Marcar una cuerda al aire

Esta característica se usa para designar cuerdas sin trastes, como las cuerdas graves de un Laúd, donde el único valor
valido es 0:

1. Haga clic derecho en el pentagrama, seleccione Propiedades del pentagrama…, luego presione Editar datos de las cuerdas .
2. Marque una o más casillas en la columna "Abrir".

Cambiar el número de trastes del instrumento

Esta propiedad define el número de traste máximo que se puede ingresar en un pentagrama de tablatura.

1. Haga clic derecho en el pentagrama, seleccione Propiedades del pentagrama…, luego presione Editar datos de las cuerdas .
2. Selecciona o ingresa un nuevo número en el cuadro de giro "Cantidad de trastes".

Cambiar la visualización de la tablatura

Puede personalizar tanto la apariencia de un pentagrama de tablatura como la forma en que muestra las marcas del
traste. Para acceder a estas opciones:

1. Haga clic derecho en el pentagrama y seleccione Propiedades del pentagrama….
2. Haga clic en el botón Propiedades del estilo avanzadas….
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Combinar pentagrama con altura y con tablatura

Los instrumentos de cuerda pulsada, como la guitarra, se anotan comúnmente utilizando tanto un pentagrama tradicional
y una tablatura (TAB) juntas. MuseScore le da la opción de tener los dos pentagramas no enlazado o enlazado:

1. Pentagramas no enlazados: puede ingresar, eliminar o editar notación en un pentagrama sin afectar al otro. Para
transferir notación musical de un pentagrama a otro, seleccionar el rango deseado y copiar y pegar en el otro
pentagrama.

2. Pentagramas enlazados: cualquier cambio que realice en un pentagrama se aplicará automáticamente al otro
pentagrama también ("traducción mutua").

Una nota acerca de conflictos en el numero de traste: Cuando la misma nota es ingresada en dos voces distintas,
MuseScore intentara asegurarse de que dos numeros de traste no se superpongan en la misma cuerda. En el caso de
que ocurra una superposición esta se marcara con un cuadrado rojo: las marcas solo se mostraran en la ventana del
documento pero no en la copia impresa. En la mayoría de los casos (trastes 0 a 4 en la 6ta cuerda, por ejemplo) la
superposición es el resultado deseado y no es necesario ningún ajuste adicional. se pueden ocultar las marcas rojas
seleccionando "vista" y desmarcando la casilla "mostrar elementos invisibles".>

Cree un pentagrama/tablatura enlazado con el asistente de partitura nueva

1. Abra el Asistente de partitura nueva.
2. Ingrese los detalles de la partitura (opcional). Haga clic en Siguiente.
3. En la página Elegir archivo de plantilla, haga clic en Elija instrumentos bajo "General".
4. Seleccione un instrumento en la sección "Cuerdas pulsadas" de la columna de la izquierda. Luego haga clic Añadir.
5. Seleccione el pentagrama recién creado (es decir, marcado como "Pentagrama ...") en la columna de la derecha y

elija una de las dos opciones:
Haga clic en Añadir pentagrama para crear un par de pentagrama y tablatura no enlazado.
Haga clic enAñadir pentagrama enlazado para crear un par de pentagrama y tablatura enlazado.

6. En la columna Tipo de pentagrama, haga clic en la lista desplegable para el pentagrama recién creado y
seleccione una opción de tablatura (esto puede modificarse más adelante, si es necesario, en la página de
partituras Staff/Part Properties).

7. Cambie el orden de los pentagramas usando el boton ↑ en caso de ser necesario.
8. Complete el resto del Asistente de partitura nueva, o haga clic en Terminar.

Nota: para crear pentagramas no enlazados con canales mezcladores separados, en lugar del paso "5" (arriba),
seleccione un pentagrama de tablatura en la columna de la izquierda y haga clic en Añadir. Luego continúe con los pasos
6 y 7.

Cree un par de pentagramas/tablatura en una partitura existente

. Abra el editor de instrumentos (presione I, o desde la barra de menú, seleccione Editar → Instrumentos…).
2. Luego siga los pasos 4–8 más arriba.

Cree un par de pentagramas/tablatura de un pentagrama existente

Para agregar tablatura a un pentagrama de cuerda pulsada en la partitura (o viceversa):

1. Abra el editor de instrumentos (presione I, o desde la barra de menú, seleccione Editar → Instrumentos…).
2. Luego siga los pasos 5-8 mas arriba.

Introduzca notas en tablatura

Usando un teclado de computadora

1. En Modo normal, Seleccione el compás o nota existente desde la que desea comenzar a ingresar notas.
2. Cambie al modo de introducción de la nota (N): aparece un pequeño "rectángulo azul" alrededor de una secuencia

de tablatura: esta es la cuerda actual.
3. Seleccione la duración de la nota o silencio que desea ingresar (ver abajo).
4. Presione las teclas de flecha arriba / abajo para mover el cursor a la cuerda deseada. Use las teclas de flecha

izquierda / derecha para navegar a través de la partitura.

5. Presione 0 a 9 en la cuerda actual; para ingresar números con varios dígitos, presione cada dígito en secuencia. Las
teclas A a K (saltarse I) también se pueden usar: convenientes cuando se trabaja en tablatura francesa. Para L , M, N,
use el teclado alfanumérico y el tipo respectivamente 10, 11, 12... ( Nota: no puede ingresar un número superior al
valor "Número de trastes" establecido en la cuerda de diálogo Editar datos de las cuerdas.).

Press ; (punto y coma) para ingresar un silencio de la duración seleccionada.

6. Puede ingresar notas en diferentes voces si es necesario—tal como lo haría en un pentagrama estándar.

Ver, Editar notas (below).
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Tablatura histórica

La notación de períodos para cuerdas de bajo (laúd y sim.) esta soportada:

Tablatura francesa: letras con trazos prefijados tipo barra oblicua justo debajo del pentagrama de la tablatura: es
decir, 7ma cuerda: "a", 8va cuerda: "/ a", 9ma cuerda: "// a" y así sucesivamente, todo en la primera posición debajo
del pentagrama de tablatura.

Tablatura italiana: números con un segmento de 'línea tipo libro mayor' sobre el pentagrama de tablatura: es decir,
7ma secuencia: "0" una posición arriba del pentagrama de tablatura con una 'línea de libro mayor'; 8ª cuerda: "0"
dos posiciones por encima del pentagrama de tablatura con dos 'líneas de libro mayor', etc.

La entrada se realiza solo a través del teclado de la computadora: moviendo el cursor de entrada de nota debajo
(francés) o superior (italiano) el pentagrama de tablatura, las barras sombreadas o las líneas del libro mayor indicarán la
cuerda objetivo a la cual se aplicará la marca del traste; presionando una de las teclas del traste, ingresará (y colocará) la
nota en esa cuerda.

Usando un mouse

Para ingresar notas en tablatura con un mouse:

Ingrese al modo de introducción de notas y seleccione la duración de la nota o del silencio (ver abajo).
Haga clic en una cuerda para crear una nota allí. Las notas se crean inicialmente en el traste 0 (o a para las
tablaturas francesas): para corregir, escriba el número correcto en el teclado.
También puede aumentar/disminuir el numero de traste con Alt+May+↑ o Alt+May+↓.
Puedes ingresar notas en diferente voces  si es necesario—tal como lo haría en un pentagrama estándar.

Ver, Editar notas (below).

Seleccione la duración de la nota

En el modo de entrada de notas, puede usar cualquiera de los siguientes métodos para establecer la duración de la nota
en tablatura:

Presione Shift+1 to Shift+9: establece la duración desde una garrapatea a una longa (la disponibilidad de estos atajos
puede depender de la plataforma y/o distribución del teclado);
Press NumPad 1 to Numpad 9: establece la duración desde una garrapatea a una longa (si existe un teclado numérico
y NumLock está activada);
Haga clic en el icono de duración de una nota en la Barra de herramientas de entrada de notas encima de la
ventana del documento;
Presione Q para disminuir la duración seleccionada y W para aumentarla.

Editar notas

Modo de introducción de las notas

Para editar una indicación de traste existente en modo de introducción de las notas:

Coloque el cursor sobre la indicacion de traste y simplemente vuelva a escribir el número.
Incremente o disminuya el numero de traste con Alt+May+↑ or Alt+May+↓.

En modo normal

Para editar una marca de traste existente fuera de modo de introducción de las notas:

1. Seleccione una o más indicaciones de traste.
2. Use cualquiera de los siguientes comandos:

Para aumentar o disminuir, sin cambiar de cuerda: Presione ↑ / ↓.
Para aumentar o disminuir, cambiando de cuerda, cuando sea necesario, para minimizar el número del traste:
Presione Alt+May+↑ / ↓
Para pasar a una cuerda adyacente (si la cuerda esta libre y puede producir esa nota): Presione Ctrl+↑ / ↓.

Nota: la indicación de traste no puede ser más alta que el valor "Número de trastes" establecido en el cuadro de diálogo
Editar datos de las cuerdas.

Notas cruzadas

Para cambiar una indicación de traste a una nota de cruzada:

1. Seleccione una o más indicaciones de traste (fuera del modo de introducción de las notas).
2. Presione Shift+X para activar/desactivar las cabezas de nota fantasma.
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Resumen de comandos de teclado

Modo de introducción de las notas

Teclear: para hacer:
↑ Seleccione la cuerda anterior como actual.
↓ Seleccione la cuerda a continuación como actual.

May+1 to May+9
Seleccione una duración (garrapatea a una
longa)

NumPad 1 a NumPad 9 Seleccione una duración (garrapatea a una
longa)

Q Disminuir la duración de entrada actual.
W Aumentar la duración de entrada actual.
0 to 9 Ingrese un dígito/letra de traste.
A to K Ingrese un dígito/letra de traste (I excluido).
Alt+Shift+↑ Aumentar la marca del traste actual.
Alt+Shift+↓ Disminuir la marca del traste actual.
; (semicolon) Ingrese un silencio

Modo normal

Teclear: para hacer:

0 to 9 Cambiar la duration de la nota seleccionada o el resto (garrapatea a una
longa)

Alt+May+↑ Aumenta la altura de la nota seleccionada (MuseScore elige la cuerda).
↑ Aumenta la altura sin cambiar la cuerda.
Alt+Shift+↓ Disminuya la altura de la nota seleccionada (MuseScore elige la cuerda).
↓ Disminuya la altura sin cambiar la cuerda.
Ctrl+↑ Mueva la nota a la cuerda de arriba, manteniendo la altura.
Ctrl+↓ Mueva la nota a la cadena a continuación, manteniendo la altura.
Shift+X Alternar entre activar/desactivar la nota fantasma.

Enlaces externos

Video tutorial: MuseScore en minutos: Lección 7 - Notación de bateria y tablatura

Sonido y reproducción
MuseScore tiene las funciones de "Sonido y reproducción" incorporadas. Este capítulo cubre los controles de
reproducción y formas de extender los sonidos de los instrumentos.

Cambiar instrumentos en medio del pentagrama

Cuando se requiere que un músico doble en un instrumento diferente para una sección de una pieza, la instrucción de
cambiar los instrumentos generalmente se coloca por encima del pentagrama al comienzo de esa sección. El retorno al
instrumento primario se muestra de la misma manera.

MuseScore permite al usuario insertar una clase especial de texto llamada Cambio de instrumento para este proposito.
Esta clase de texto es diferente de los textos de Pentagrama o Sistema en que ancla el texto a la reproducción y cambia
el sonido a un nuevo instrumento.

Efecto de un cambio de instrumento

Cuando un cambio de instrumento es realizado:

El sonido reproducido sera cambiado al de un nuevo instrumento desde este momento en adelante, pero el nombre
en el mezclador permanece sin cambios.
Las notas siguientes son ajustadas automáticamente para indicar el tono escrito correcto para el nuevo instrumento
(pero la nueva armadura de clave sigue teniendo que ser agregada manualmente— vea abajo).
El nuevo nombre instrumento sera mostrado enfrente de los siguientes sistemas.

Agregar un cambio de instrumento

1. Seleccione el punto de inicio del cambio haciendo clic en una nota o silencio.
2. Abra la paleta maestra apretando F9 (o desde el menú Ver), y haga clic en Texto para abrir la sub-paleta de texto:
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3. Haga doble clic en Cambiar instr.;
4. Las palabras "Cambiar Instr." aparecerá sobre la nota de anclaje o silencio;
5. Haga doble clic en el texto, luego presione Ctrl + A para seleccionar todo.
6. Escriba el texto real que desea que aparezca en la partitura, y salga del modo de edición de texto;
7. Haga clic derecho en el texto y elija "Cambio de instrumento…"

8. Elija el instrumento, luego haga clic en Aceptar

;
9. Agregue la nueva armadura si clave si es necesario, en el cambio, para el pentagrama en cuestion.

Note: Cambiar instrumentos en medio del pentagrama están limitados al mismo tipo de pentagrama. Por ejemplo, no
puede cambiar entre un pentagrama de percusión y un instrumento melódico o vice versa

Véase también

Cambiar instrumento
Cambiar instrumentos en medio del pentagrama

Enlaces externos

Como cambiar el sonido de un instrumento (e.g. pizz., con sordino) en medio de la partitura

Editor Piano Roll

El Editor Piano Roll le permite editar notas individuales y ajustar aspectos de su reproducción.

Abriendo el Editor Piano Roll

Para abrir el Editor Piano Roll (EPR), haga clic derecho en un compás de la partitura y elija la opción Editor Piano Roll en
el menú contextual. El Editor Piano Roll se abrira mostrando el pentagrama y el compas donde usted hizo clic. Si el Editor
Piano Roll ya esta abierto, este sera actualizado para mostrar el nuevo pentagrama y compas en el que se ha hecho clic.
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Vista general

El Editor Piano Roll esta dividido en varias secciones. En la parte superior, arriba de todo, hay una fila de botones y
controles que afectan la reproducción y puede modificar las notas. El nombre de la parte que esta siendo editada de
muestra en la parte superior derecha.

La parte central contiene el Area de representación de notas que le permite ver y editar notas. Cada nota es mostrada
como un bloque, con bloques amarillos que representan las notas seleccionadas, y bloques de un verde mas oscuro que
representan las notas no seleccionadas (estos colores pueden ser modificados en las Preferencias). Si se le da el
espacio necesario, cada bloque mostrara su altura a la izquierda y en la voz en la que esta asignado a la derecha.
Cambiar el tamaño de los bloques de las notas esta cubierto en la sección navegación.

A la izquierda del Area de Representación de notas esta el Teclado. haciendo clic en una tecla del Teclado, puede
escuchar una muestra de esa nota siendo tocada. A medida que mueva el mouse en Area de Representación de Notas o
el Teclado, una tecla en el teclado se iluminara correspondiente a la altura sobre la que esta el mouse. También puede
pasar el mouse encima de una tecla en particular para tener mas información sobre esa altura. Si esta usando un Set de
Percusión, las teclas en el teclado mostraran el nombre del sonido de percusión asociado con esa altura. Para
instrumentos transpositores que no están afinados en Do, el teclado sera ajustado automáticamente para que el Do del
teclado sea el mismo que el Do del instrumento.
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A lo largo de la parte superior del Area de Representación de notas esta la Regla de Compases que muestra la posición
actual del la aguja de reproducción, así como el rango actual de la reproducción en bucle.

La parte inferior del editor contiene el Area de Representación de Niveles. Esto es una barra gráfica que muestra
valores de datos extra asignados a cada nota, como lo son su velocidad o el cutoff time. A la izquierda del Area de
Niveles hay un menú desplegable que le permite selecciona el tipo de datos que desea ver representados o editar.

Navegacion

Hay varias formas para moverse en el Editor Piano Roll. Primero, puede hacer clic y arrastrar en las barras de
desplazamiento en los bordes del Area de Representacion de notas.

La rueda del mouse tambien puede ser usada para moverse y hacer zoom:

Moverse verticalmente: Rueda del mouse.
Moverse horizontalmente:Shift + rueda del mouse.
Zoom vertical: Ctrl + rueda del mouse.
Zoom horizontal:Ctrl+Shift + rueda del mouse.

Para saltar a un compás en particular, vuelve a la vista de partitura y encuentre el compás que desea ver. Luego haga
clic derecho en el compás y selección Editor Piano Roll. El editor piano roll se desplazara para centrar el compás sobre el
que hizo clic.

Seleccion de notas

En el Area de Representacion de Notas, puede hacer clic en notas individuales o arrastrar para seleccionar para
seleccionar un grupo de notas. Mantener apretado las teclas modificadores afecta como cambia la seleccion:

Shift: Invierte la seleccion existente: i.e notas que estaban seleccionadas anteriormente son deseleccionadas, y las
notas que no estan seleccionadas son seleccionadas. Es util para alternar una nota entre seleccionada y
deseleccionada.
Ctrl: Agrega notas a la seleccion.
Ctrl+Shift: Quita notas a la seleccion.

Editar notas

Para cambiar la altura de una seleccion de notas: Arrastre una nota seleccionada arriba o abajo a la nueva altura o
presione el ↑ o las flechas ↓. Nota: Arrastrar una nota horizontalmente para cambiar el momento de inicio todavia no esta
soportado.
Para borrar una seleccion de notas: Presione la tecla Supr.
Para mover una seleccion de notas a otra voz: Haga clic en el numero de voz deseada en los botones ubicados arriba
del editor.

Para agregar notas:
Se puede insertar notas haciendo clic en el Area de Notas de Piano con las teclas modificadores mantenidas. Estas
operaciones de edicion usaran la linea de pulso o subdivisiones a la izquierda del lugar donde haga clic como el punto
donde la nota es alterada:

Ctrl: Una nota del valor de insercion de nota actual sera agregado a la subdivision del pulso y altura en que hizo clic.
El valor de insercion de nota es el mismo que el que ha usado para agregar notas en el modo de introduccion de
notas en la partitura. Si desea cambiar la duracion, tendra que seleccionarlo en la vista de partitura dado que el
editor Piano Roll no tiene estos botones actualmente. Si las notas existen con anterioridad en esta ubicacion, un
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pedazo de ellas sera cortado para hacer lugar a la nota que esta insertando, menos que tengan el mismo tiempo de
comienzo y duracion que esta agregando, en ese caso la nueva nota sera simplemente anexada al acorde
existente. Los valores irregulares no estan soportados actualmente, y seran ignorados

Shift: Busca un acorde que ocupe esta linea de subdivisión previamente. Si encuentra uno, agrega una nueva nota
al acorde existente. De lo contrario, esto es un silencio y el silencio sera reemplazado por una nota con el mismo
momento de inicio y duración existente al silencio.

Ctrl+Shift: Busca un acorde o silencio que ocupe esta subdivisión del pulso. Este acorde sera dividido en dos en esta
linea de subdivisión. Esta función no soporta valores irregulares todavía, estos serán ignorados.

Para editar datos de eventos de una nota:
Los datos de eventos pueden ser cambiados en el Area de muestra de Niveles. Para editar datos de evento como la
velocidad y cutoff time, primero seleccione las notas que desea editar en el área de nota. Luego haga clic en Area de
Muestra de Niveles en el compás correspondiente; el valor del nivel sera cambiado para corresponder con el punto donde
hizo clic. También puede hacer clic y arrastrar en esta área para cambiar los niveles de varias notas con un solo gesto. Si
desea que todos los niveles sean puestos en el mismo valor, mantenga Shift mientras arrastra. Solo las notas
seleccionadas cambiaran su valor - esto lo previene de modificar accidentalmente valores de otras notas.
El área de Niveles puede mostrar los mismos datos de distintas maneras. Por ejemplo, datos de velocidad pueden ser
mostrados en valores absolutos (ie, relativos al volumen de salida MIDI) y relativos (ie, como un desplazamiento de
valores de dinámicas). Puede alternar entre estos modos de visualización según su conveniencia.

Controles

De izquierda a derecha los controles tienen estas funciones;

Primer fila

Deshacer
Deshace la ultima acción

Rehacer
Rehace la ultima acción

Alternar MIDI
Alterna entre entradas MIDI

Rebobinar
Rebobina al principio de la partitura.

Reproducir
Comienza o detiene la reproducción.

Reproducción en bucle
Determina el rango y alterna la reproducción en bucle.

Reproducir repeticiones
Alterna si las repeticiones son reproducidas o no.

Desplazar Roll durante la reproducción
Si esta seleccionado, la ventana se desplazara automáticamente al centro de la aguja de reproducción durante la
reproducción.

Metrónomo
Alternar metrónomo.

Wave
Actualmente no hace nada.

Números de voz
Mueve las notas seleccionadas a la voz elegida.

Parte
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Nombre de la parte que esta siendo vista/editada actualmente.

Segunda fila

Cursor
Le da información acerca del compás y nota que se encuentre debajo del mouse en el Area de Representación de
notas.

Subdiv
Subdivide el pulso agregando divisiones extra en el Area de Representación de notas. El valor indicada la cantidad
de tiempos en las que sera subdividido el pulso. Así que, para 4/4, una división de 2 dibujara celdas en cada
corchea; una división en cada semicorchea, y así. Determinar la subdivisión necesario para algunas operaciones de
edición si desea ingresar notas desplazadas del pulso.
Para subdivisiones mas largas, puede necesitar acercar el zoom para ver lineas de las celdas exta ya que las lineas
de las celdas no son dibujadas debajo de determinada densidad. Combine con el control de valores irregulares que
también afecta el posicionamiento de las celdas.

Valores irregulares

Agrega lineas de celda adicionales, subdividiendo el pulso para mostrar el posicionamiento ritmico de valores
irregulares. Por ejemplo, estableciendo valores irregulares a 3 mostrara el pulso dividido en partes iguales.
Combine con el control subdiv para mostrar subdivisiones del valor irregular. Por ejemplo, estableciendo valores
irregulares a 3 y subdiv a 2 dibujara lineas de celda mostrando los valores irregulares divididos en dos partes - i.e.,
el pulso sera dividido en 6.

Seleccionando un modo de valores irregulares distinto a 1 deshabilitara algunas herramientas de inserción de notas
para el editor Piano Roll. Para números de subdivisión mas grandes, puede llegar a necesitar acercar el zoom para
ver lineas de celda extra ya que las celdas no son dibujadas debajo de cierta densidad.

Patrón de cuadros
Cambia el patrón a cuadros mostrado detrás de las notas en el área de representación de notas. Por defecto los
tonos de Do mayor están resaltados, pero puede cambiar esto para resaltar los tonos de una tonalidad diferente, o
incluso escalas, como la disminuida o por tonos enteros.

Velocidad

Muestra la velocidad de la nota seleccionada actualmente (solo una nota puede estar seleccionada). Indica el
volumen absoluto de la nota. Esto puede estar expresado en "Desplazamiento" o "Usuario".

Desplazamiento: El valor es tratado como un multiplicador para la velocidad determinada anteriormente por
las dinámicas.
Usuario: Este es el valor bruto enviado a MIDI y sobrescribe el valor de las dinámicas. Los valores pueden
estar entre 0 y 127, donde 64 es "medio, ni fuerte ni suave".

Cuando cambia de Usuario a Desplazamiento o viceversa, el valor sera recalculado para ajustarse mejor al valor en
el otro sistema. De esta manera puede, por ejemplo, cambiar de modo Usuario para determinar el valor que quiere
que reproduzca la salida MIDI y después cambiar a Desplazamiento para que este valor respete la indicación
dinámica en lugar de sobrescribirla. Al momento de volver atrás, el valor de desplazamiento sera recalculado para
ajustarse al valor Usuario en volumen pero no actuara mas sobrescribiéndolo así que podrá cambiar la dinámica
luego.

Altura
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Muestra la altura y octava de la nota seleccionada en formato de texto (i.e. f#4).
La altura cambiara si la nota es arrastrada arriba o abajo a una nueva altura. Actualmente no puede ser editado.

EnTiempo
Mueve el comienzo de una nota en el tiempo, puede ser usado para modificar el estilo de toque. Valores negativos
harán que la nota suene antes, positivos la harán sonar después. La duración de la nota corresponde al valor de
1000 (e.g. poner el valor en 250 hace sonar todas las notas 1/4 de su duración después.

Largo
Determina el tiempo que una nota sigue sonando, puede ser usado para modificar la cantidad de "legato". Valores
mas bajos hacen que la nota suene mas staccato, valores mas altos hacen que suene mas legato. La duración de
la nota corresponde a un largo de 1000, pero se puede poner un valor mas alto. 950 es generalmente considerado
"non-legato".

Teclado

Algunas teclas estan configuradas para realizar operaciones especiales:

↑: Mueve las notas seleccionadas un semitono arriba
↓: Mueve las notas seleccionadas un semitono abajo
Supr: Borra las notas seleccionadas
Barra espaciadora: Comienza/detiene la reproducción

Personalizar

El editor Piano Roll se mostrara en modo claro u oscuro. SI desea cambiar los colores que usa editor Piano Roll en estos
modos, pueden ser ajustados en Preferencias bajo la pestaña Avanzado. Todas las propiedades relacionads con el editor
Piano Roll comienzan con ui/pianoroll/light para el modo claro y ui/pianoroll/dark para el modo oscuro.

Mezclador

El mezclador le permite cambiar los sonidos del instrumento y ajustar el volumen, el panorama y otros ajustes para cada
pentagrama.

Abriendo el mezclador

Para mostrar/ocultar el mezclador, use uno de los siguientes:

Presione F10 (Mac: fn+F10).
Desde el menú principal, seleccione Ver→Mezclador.
The Mixer is split into a Details Area on the top and a Track Area below.

Area de pistas
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El area de las pistas esta abajo de todo y muestra la Ganancia maestra así como una fila de pistas.

Ganancia maestra

La ganancia maestra controla el volumen de salida general. Para ajustarlo, haga clic y arrastre el deslizador o ingrese un
valor en la caja debajo.

Area de pistas

Los controles en el área de pistas permite ajustar el volumen de los instrumentos usados por tus pentagramas.
MuseScore crea una "pista de parte" para cada pentagrama en su partitura). Estas "pistas de parte" pueden ser
subdivididas en "canales de pista" correspondiendo a distintos sonidos usados dentro del pentagrama. Mientras que
muchos pentagramas necesitan un solo canal de pista, otros requieren varios canales para que el instrumento pueda
tocar mas de un sonido (e.g. un violin puede tocar en arco, tremolo o pizzicato) ; o debido a un Cambio de instrumento en
medio del pentagrama. Estos canales de pista extra pueden ser mostrados o escondidos haciendo clic en la flecha
encima del control de pista.

Pista de parte expandida, mostrando los canales "hijos" en rosa.

Flecha para mostrar/ocultar canales

Cada pista de parte tiene un botón encima con una flecha. Al hacerle clic, este cambiara si las canales de pista de un
pentagrama son mostrados al lado de este. Los Canales de pista no tienen el botón con la flecha. En cambio, el nombre
de la pista de la que forman parte es mostrado

Silenciar y Solo

Encima de cada pista hay un botón verde de solo y uno rojo de silenciar: cada uno puede ser encendido o apagado.
Cuando cualquier botón de Solo esta encendido solo se reproducen las pistas que tienen el botón de Solo encendido. Si
ningún botón de Solo esta encendido, todas las partes pueden ser reproducidas potencialmente. Silenciar hace lo
opuesto: cualquier pista marcada con silenciar no sera reproducida. Usando una combinación de silenciar y solo, puede
controlar que instrumentos se escuchan en la reproducción.

Paneo

El dial giratorio debajo del botón de silenciar controla el paneo izquierdo o derecho. Puede hacer clic y arrastrar el dial
para cambiar el valor de paneo. Nota: MuseScore todavía no soporta valores de paneo para cada canal en la pista, asi
que los canales dentro de una pista tendran el mismo valor de paneo que el primer canal. Configurar un valor de paneo
para la pista configura automáticamente el mismo valor de paneo para todos los canales de pista.

Volumen

El dial en el medio de la pista controla el volumen de reproduccion. Nota: MuseScore todavía no soporta valores de
volumen para cada canal en la pista, asi que los canales dentro de una pista tendran el mismo valor que el primer canal.
Configurar un valor de volumen para la pista configura automáticamente el mismo valor de volumen para todos los
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canales de pista.

Nombre de pista

Una caja de texto debajo de la pista contiene el nombre actual de la pista o sus canales.

Area de detalles

El area de detalles muestra y provee controles mas finos para la pista seleccionada actualmente.

Nombre

El nombre de la parte a la que esta asociado esta pista. Las pistas de una parte y sus canales se muestran bajo el
nombre de la parte.
Nota: El nombre de la parte es editable, pero solo tendrá efecto en el mezclador. El nombre del canal no es editable.

Color de la pista

Este es un color q el usuario puede configurar para ayudar a distinguir una parte en particular. Hacer doble clic en esta
paleta de colores permitirá cambiar el color mostrado en el nombre de la pista. Configurar el color de la pista de una parte
automáticamente cambiara el color de los canales que dependan de este.

Canal

Si un canal es seleccionado, el nombre del canal se mostrara aquí.

Set de percusion

Indica si esta parte representa un instrumento melódico o un pentagrama de percusión. Para instrumentos melódicos
regulares, cada altura en el mismo parche de sonido tiene el mismo timbre, mientras que los parches de sonido de
percusión suelen tener diferentes timbres en cada altura.

Parche

Este es el sonido actual del soundfont, que es usado para reproducir el instrumento.

Volumen

La intensidad sonora con la que el instrumento es reproducido.

Paneo

El paneo aplicado a la parte.

Puerto y Canal

El puerto de salida MIDI y el canal en el que la parte es reproducida.

Reverberancia / Chorus

El valor de Reverberancia / Chorus enviado a la salida MIDI. Esta informacion es enviada a los dispositivos MIDI y no
afectara el sonido integrado de MuseScore.

Silenciar voz
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Esto le permite silenciar voces individuales dentro de cada pentagrama. Cada fila representa un pentagrama distinto en la
parte. Asi que presionar '2' en la fila de mas arriba silenciara la segunda voz en el primer pentagrama de la parte.

Botón Ocultar Detalles

Abajo de todo en el área de detalles hay un botón amplio con un pequeño triangulo en el. Hacer clic en este botón
ocultara el área de detalles para darle mas espacio. Hacer clic de nuevo restaurara el área de detalles

Sonido

El menú desplegable "Sonido" es una lista de cada instrumento soportado por su SoundFont actual. Si tiene múltiples
SoundFonts cargadas en el Sintetizador, todos los partes de todas las SoundFonts (y/o archivos SFZ) aparecerán en esta
lista—en el orden seleccionado previamente en el Sintetizador.

Tip: Para encontrar un instrumento, haga clic en la lista "Sonido" y escriba la primer letra del nombre del instrumento.
Repita las veces que sea necesario.

Cambio de sonido en medio del pentagrama (pizz., con sordino, etc.)

Algunos instrumentos vienen con múltiples canales en el Mezclador que pueden ser usados para cambiar el sonido en la
mitad de una partitura. por ejemplo, un pentagrama de un instrumento de cuerdas (violín, viola, cello, etc.) tiene
asignados tres canales: uno para "arco" (o "normal", otro para "pizzicato" y otro para "tremolo". Un pentagrama de
trompeta tendrá un canal para "normal" y otro reservado para "sordina", y así.

Las siguientes instrucciones usan cuerdas pizzicato como un ejemplo, pero el mismo principio puede ser aplicado a
cualquier instrumento que permita cambiar el sonido.

1. Seleccione la primer nota de la sección que desea reproducir como pizzicato
2. Desde el menú principal, elija Agregar→Texto→Texto de pentagrama;
3. Escriba "pizz.", este texto es para referencia visual y no afecta la reproduccion;
4. Haga clic derecho en el pentagrama seleccionado y elija Propiedades de texto de pentagrama…;
5. En la pestaña "cambiar canal" en el cuadro de dialogo "Propiedades de texto de pentagrama", seleccione una o

mas voces a la izquierda;

6. Desde el menú desplegable, seleccione pizzicato;

7. Haga clic en OK para volver a la partitura.

Cada nota después del texto de pentagrama agregado sonara pizzicato. Para volver al sonido normal de cuerdas mas
adelante en la partitura, siga las mismas direcciones que arriba pero en cambio seleccione "arco" en el paso 3 y
seleccione normal en el paso 6.

Véase también

SoundFont
Sintetizador
Cambiar instrumento

Enlaces externos

Como cambiar el sonido de un instrumento (e.g. pizz., con sordino) en la mitad de una partitura

Modos de reproduccion
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Barra de herramientas de reproducción

Las funciones básicas de reproducción son accedidas desde la barra de Herramientas reproducción ubicada encima de
la ventana del documento:

De izquierda a derecha, los iconos son:

Alternar 'Entrada Midi':
*Retroceder a la posición de inicio: la reproducción vuelve al comienzo de la partitura, o al inicio del bucle (si está
configurado).
__ Iniciar o detener reproducción__: Ver Iniciar/detener la reproducción.
__ Activar o desactivar la reproducción de bucle __: Ver Reproducción de bucle.
Reproducir repeticiones: Desactivar si quieres que la reproducción ignore las repeticiones.
__ Desplazar partitura al reproducir__: Desactívelo si desea que la partitura permanezca siempre en el mismo lugar.
*Reproducir metrónomo: Alterna entre metrónomo ENCENDIDO y APAGADO.

Comandos de reproducción

Comenzar/detener la reproducción

Para comenzar la reproducción:

1. Haga clic en una nota, silencio o la parte vacía de un compás para establecer el punto de partida. Nota: si no se
realiza ninguna selección, la reproducción vuelve al lugar que dejó o, si no hay reproducción previa, al comienzo de
la partitura.

2. Presione el botón de reproducción o presione Barra espaciadora.

Durante la reproducción puede saltar a una nota específica o silencio en la partitura simplemente haciendo clic en ella.

Para detener la reproducción:

Presione el botón Reproducción; o presione Barra espaciadora.

Durante la reproducción

Una vez que la reproducción ha comenzado, los siguientes comandos están disponibles:

Volver al acorde anterior: ←
Avanzar al siguiente acorde: →
Volver al inicio del compas anterior: Ctrl+← (Mac: Cmd+←)
Avanzar al inicio de la siguiente compás: Ctrl+→ (Mac: Cmd+→)
Retroceder al inicio de la partitura: Inicio (Mac: ⌘+Inicio); o presione el botón Retroceder (barra de herramientas de
reproducción).

Durante la reproducción, puede usar los atajos de teclado para abrir y cerrar los paneles, como Reproducción,
Sintetizador, Mezclador, etc.

Reproducción en bucle

La reproducción debe estar apagada, y el "botón de reproducción de bucle" encendido.
Seleccione la región deseada de la partitura para la reproducción en bucle.
Presione el botón de reproducción.

La reproducción ahora se desplazará dentro de la región marcada por las banderas azules.

Use el botón "Reproducción en bucle" para activar o desactivar el bucle.

Véase también: Panel de reproducción (below).

Panel de reproducción

Para abrir el Panel de reproducción, use una de las siguientes opciones:

Presione F11 (Mac: Fn+F11).
Desde la barra de menú, seleccione Ver → Panel de reproducción.
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El panel de reproducción le permite hacer cambios temporales al tempo y volumen, y reproducir en bucle entre puntos
específicos etc.
* Reproducción en bucle: Seleccione una nota de comienzo y haga clic en el botón Comienzo del bucle; seleccione
una nota de final y haga clic en el botón Fin del bucle. Presione Reproducir para escuchar el bucle. Los controles
también funcionan durante la reproducción.
* Rebobinar, Reproducir: Controles de reproducción.
* Metrónomo: Alterna el metrónomo entre ENCENDIDO o APAGADO.
* Cuenta de entrada: (Icono de director) Agrega una cuenta de entrada al empezar la reproducción desde el comienzo
de un compás. Se agregan tiempos extra si empieza en medio de un compás. Alterna ENCENDIDO y APAGADO.
* Tempo: Hace cambios momentáneos al tempo. Esto es mostrado como un porcentaje y como ppm (pulsos por minuto).
Haga doble clic para restablecerlo. (Nota: Cambios permanentes al tempo deben hacerse usando un texto de tempo)
* Volumen: Haga cambios temporales al volumen (se restablece cuando al abrir y cerrar el programa). Nota: Para
cambiar el _volumen de reproducción__ de la partitura, vea Sintetizador.

Playback: Chord symbols / Nashville numbers

As of MuseScore version 3.5, both chord symbols and Nashville numbers (but not Roman numerals) automatically sound
when you play back the score.
As of MuseScore 3.5.1 this only happens with scores initially created with MuseScore 3.5 or later, for older scores you'd
need to enable it, using the methods described below.

Turn playback on/off

Note: Settings made below also affect Audio and MIDI export.

For all scores (as of version 3.5.1)

To enable or disable chord symbol playback for all scores:

Select Edit (Mac: MuseScore)→Preferences…→Advanced); then the following options, as required:
To disable/enable playback of pre-version 3.5 scores: Check/Uncheck score/harmony/play/disableCompatibility
(default is checked—no playback)
To disable/enable playback of version 3.5 or later scores: Check/Uncheckscore/harmony/play/disableNew
(default is unchecked, playback)

For the current score

As of version 3.5.1

To turn playback of ALL chord symbols on/off:

Tick/Untick Format→Style…→Chord Symbols→Play.

As of version 3.5

To turn playback of ALL chord symbols on/off:

1. Select a chord symbol or Nashville number
2. In the "Chord Symbol" section of the Inspector check/uncheck the "Play" box.
3. Click on the associated "Set as style" button (to the right of that box, you may need to scroll a bit)

Alternatively, you can mute the playback track(s) in the mixer—see below. This might be necessary, for example, when
you have chord symbols on more than one staff and want to have playback for only one of them. Score parts need to be
adjusted separately.

To turn playback of a SELECTION of chord symbols on/off:

1. Select a range of symbols.
2. Right-click a chord symbol or Nashville number.
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3. Click on Select→Select all similar elements in selected range , OK.
4. In the "Chord Symbol" section of the Inspector check/uncheck the "Play" box.

or

1. Click on first chord symbol or Nashville number in that range.
2. Shift+click on last chord symbol or Nashville number in that range.
3. In the "Chord Symbol" section of the Inspector check/uncheck the "Play" box.

Note: This does not affect the parts which need to be adjusted seperately.

Change playback sound

The default sound for chord symbols is "Grand Piano". As of version 3.5.1, scores created from Guitar solo templates, use
"Nylon String Guitar" instead.

To change the chord symbol playback sound:

1. Open the Mixer (shortcut: F10, Mac: Fn+F10)
2. In the Track area locate the track for the part in question.
3. Click on the "Show channels" arrow to display all the child tracks for that part.
4. Click on the track whose name contains the words "harmony" or "Chord syms." (may be truncated, should be the

rightmost).
5. Select a new "Sound" in the Sound drop-down list.

This setting is shared between score and parts.

Change playback volume / Mute track

1. Open the Mixer (shortcut: F10, Mac: Fn+F10)
2. In the Track area locate the track for the part in question.
3. Click on the "Show channels" arrow to display all the child tracks for that part.
4. Click on the track whose name contains the words "Chord syms." (may be truncated, should be the rightmost).
5. Adjust the volume slider; or press the "M" button to mute the track.

You'd need to do this for the score and/or the parts, separately.

Turn symbol sound on/off when editing

To turn the sound of the symbols on/off when editing:

1. From the menu, select Edit (Mac: MuseScore)→Preferences…→Note input.
2. Check/Uncheck the "Play chord symbol when editing" option.

Interpretation and voicing of chord symbols

If desired, you can adjust the playback properties of selected chord symbols as follows:

1. Select one or more chord symbols.
2. In the Inspector make changes as follows:

Interpretation. The options are:
Literal;
Jazz. This adds color tones (e.g. the major 9th) but may also omit certain notes—this depends on both
the chord itself and the context (the next chord in particular).

Voicing. Options are:
Auto
Root only = Just the bass note;
Close = arranges the notes within the span of an octave;
Drop 2 = lowers the second highest note of the chord by one octave;
Six Note;
Four Note = 3rd, 5th, 7th and 9th intervals;
Three Note.
Note: All voicings include a bass note, 2 octaves below the root note of the chord.

Duration: Options are
Until next chord symbol
Until measure end
Chord/rest duration.

The following shows how the Interpretation and Voicing options affect the playback of a C major seventh symbol (Cmaj7
or CM7).
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Note: The "Close" and "Auto" Voicing options are the same for this particular chord, but this isn't necessarily the case for
every chord. So if you specifically want "Close", it is best to make the option explicit.

SoundFonts y archivos SFZ

La reproducción de audio es provista por el sintetizador incorporado en MuseScore, que alberga una gran selección de
instrumentos virtuales (o software) ̣—incluyendo percusión y efectos de sonido.
MuseScore soporta instrumentos virtuales en dos formatos:

SoundFont (extensión de archivo sf2/sf3). Un solo archivo que contiene uno o más instrumentos virtuales.
SFZ (extensión de archivo sfz). Una colección de archivos de audio y definición que contiene uno o más
instrumentos virtuales.

SoundFonts

MuseScoreviene con su propio [General MIDI] (http://en.wikipedia.org/wiki/General_MIDI ) (GM) SoundFont,
MuseScore_General.sf3, que consta de más de 128 instrumentos y varios tipos de conjuntos de batería / percusión.

GM (General MIDI) es un formato universal, así que una vez que su partitura este configurada para una reproducción
correcta usando el Soundfont nativo de MuseScore, debería ser posible exportarla al formato que usted prefiera y tener la
misma reproducción en la computadora de cualquier otro usuario.

Se encuentran disponibles muchos tipos de sonido diferentes en Internet, tanto gratuitos como comerciales.
Para una lista de soundfonts gratis, vea abajo.

Instalar un SoundFont

Después de encontrar y descomprimir un SoundFont (ver →abajo), haga doble clic para abrirlo. En la mayoría de los
casos, el tipo de archivo SoundFont ya estará asociado con MuseScore, MuseScore se iniciará y aparecerá un cuadro de
diálogo que le preguntará si desea instalar SoundFont. Ocasionalmente, una aplicación distinta de MuseScore se
asociará con el tipo de archivo SoundFont; si este es el caso, deberá hacer clic con el botón derecho o presionar la tecla
Control y hacer clic en el archivo, para mostrar un menú desde el cual puede elegir abrir el archivo en MuseScore. En
cualquier caso, cuando aparece el cuadro de diálogo que le pregunta si desea instalar SoundFont, haga clic en "Sí" para
colocar una copia del archivo SoundFont en el directorio SoundFonts de MuseScore. Este directorio se puede ver o
cambiar en las Preferencias de MuseScore, pero la ubicación predeterminada es:

Windows: %HOMEPATH%\Documentos\MuseScore3\Soundfonts

macOS y Linux: ~/Documentos/MuseScore3/Soundfonts

En contraste con los SoundFonts agregados por el usuario, el SoundFont predeterminado inicial instalado con
MuseScore se encuentra en un directorio del sistema, destinado solo para ese fin, que no debe ser modificado. Este
directorio y su archivo SoundFont predeterminado es:

Windows (32-bit): %Archivos de programa%\MuseScore 3\sound\MuseScore_General.sf3

Windows (64-bit): %Archivos de programa(x86)%\MuseScore 3\sound\MuseScore_General.sf3

macOS: /Applications/MuseScore 3.app/Contents/Resources/sound/MuseScore_General.sf3

Linux (Ubuntu): /usr/share/mscore-xxx/sounds/MuseScore_General.sf3 (dondexxxes la versión de MuseScore)

Desinstalar

Para desinstalar un SoundFont, simplemente abra la carpeta donde está instalado su archivo y elimínelo.

SFZ

Un SFZ consiste en un conjunto de archivos y directorios, un archivo SFZ y un montón de archivos de sonido reales en
formato WAV o FLAC, siendo el archivo SFZ un archivo de texto que básicamente describe qué archivo de sonido se
encuentra y dónde se usará para qué instrumento y rango de alturas.
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Instalar un SFZ

Después de encontrar un SFZ (ver →abajo), necesitaría extraer manualmente todos los archivos que pertenecen al SZF
(el archivo SFZ mismo y todos los subdirectorios y los archivos de sonido reales) al directorio listado arriba.

Desinstalar

Para desinstalar una SFZ, simplemente abra la carpeta donde están instalados sus archivos (ver arriba ) y elimínelos
todos.

Sintetizador

El sintetizador es el panel de control central de MuseScore para salida de sonido. Una vez que se ha instalado un
SoundFont, debe cargarse en el sintetizador para que MuseScore pueda usarlo para la reproducción. Para hacer que un
SoundFont diferente sea el predeterminado, cárguelo en el sintetizador y haga clic en Establecer como valor predeterminado.

Para mostrar el sintetizador, vaya a Ver → Sintetizador . Para más detalles, vea Sintetizador.

Lista de archivos de sonido descargables

GM SoundFonts

Las siguientes bibliotecas de sonido cumplen con el estándar General MIDI (GM2). Esta especificación le brinda un
conjunto de sonido de 128 instrumentos virtuales y kits de percusión.

GeneralUser GS  (29.8 MB sin comprimir)
Por cortesia de S. Christian Collins
Magic Sound Font, version 2.0  (67.8 MB sin comprimir)
Arachno SoundFont, version 1.0  (148MB sin comprimir)
Por cortesía de Maxime Abbey
MuseScore 1 venia con TimGM6mb  (5.7 MB sin comprimir)
Licencia: GNU GPL, versión 2
Por cortesía de Tim Brechbill
MuseScore 2 (hasta la versión 2.1) venia con FluidR3Mono_GM.sf3  (13.8 MB).
MuseScore 2 (hasta la version 2.2) y 3 vienen con MuseScore_General.sf3  (35.9 MB) (Versión SF2  (208 MB)).
Licencia: liberado bajo la licencia MIT
Por cortesía de S. Christian Collins
Timbres of Heaven, version 3.2  (369 MB sin comprimir)
Por cortesía de Don Allen

Archivos de sonido orquestales

Sonatina Symphonic Orchestra (503 MB uncompressed)
Descargas: SoundFont  | Format SFZ
Licencia: Creative Commons Sampling Plus 1.0
Aegean Symphonic Orchestra
Por cortesía de Ziya Mete Demircan  (352 MB sin comprimir)

Archivos de sonido de piano

Pianos SF2

Piano de cola acústico, lanzamiento 2016-08-04
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Descripción: Yamaha Disklavier Pro Grand Piano, formato sf2, 36MiB comprimido, 113MiB sin comprimir, 121
muestras, 5 capas de velocidad
Más información: http://freepats.zenvoid.org/  incluyendo otros soundfonts.
License: Creative Commons Attribution 3.0
Licencia: Creative Commons Attribution 3.0
Cortesía de Roberto Gordo Saez
Salamander C5 Light
Por cortesía de Ziya Mete Demircan  (24.5 MB sin comprimir)

SFZ Pianos

Salamander Grand Piano
Descargas: versión 2  | version 3
Descripción: Yamaha C5, 48kHz, 24bit, 16 capas de velocidad, entre 80 MB y 1.9 GB sin comprimir
Licencia: Creative Commons Attribution 3.0
Cortesía de Alexander Holm
Detuned Piano  (244 MB sin comprimir)
Licencia: Creative Commons Attribution-ShareAlike 3.0
Plucked Piano Strings
Descripción: 44.1kHz, 16bit, estéreo, 168 MB sin comprimir
Licencia: Creative Commons Attribution-ShareAlike 3.0
The City Piano
Descripción: Baldwin Baby Grand, 4 capas de velocidad, 696 MB sin comprimir
Licencia: Dominio público
Cortesía de Big Cat Instruments
Kawai Upright Piano, release 2017-01-28
Descripción: 68 muestras, 44 KHz, 24 bits, estéreo, 2 capas de velocidad, 58MiB sin comprimir
Licencia: Licencia pública general de GNU versión 3 o posterior, con una excepción especial
Cortesía de Gonzalo and Roberto

Descomprimir archivos de sonido descargados

Como los archivos de sonido son grandes, a menudo se zipean (comprimen) en una variedad de formatos, incluidos .zip,
.sfArk y .tar.gz. Necesita descomprimir estos archivos antes de que puedan ser utilizados.

ZIP es el formato de compresión estándar admitido por la mayoría de los sistemas operativos.

sfArk es un formato de compresión diseñado especialmente para comprimir archivos SoundFont. Para
descomprimirlo use Polyphone  (software multiplataforma); o este servicio online: https://cloudconvert.com/sfark-
to-sf2

.tar.gz es un formato de compresion popular en Linux. Usuarios de windows pueden usar 7-Zip ; usuarios de Mac
pueden usar The Unarchiver , o la utilidad de compresion incorporada en macOS. Tenga cuenta que usando 7-
Zip, necesitara aplicar la descompresion dos veces—una paraGZip y otra para TAR.

Solución de problemas

Si el panel de reproducción de la barra de herramientas está atenuado o no está visible, siga las instrucciones a
continuación para que el sonido vuelva a funcionar:

1. Haga clic derecho en la barra de menú y asegúrese de que haya una marca de verificación junto a la opción de
menú Controles de reproducción . Si este paso no resuelve su problema, vaya al Paso 2.

2. Si el panel de juego desaparece después de cambiar SoundFont, vaya a la pestaña Editar → Preferencias... → E/S y
haga clic en Aceptar sin realizar ningún cambio. Después de reiniciar MuseScore, el panel de juego debería
reaparecer.

Si la reproducción tartamudea, es posible que su computadora no pueda manejar el SoundFont que se está utilizando. El
siguiente consejo puede ayudar:

Reduzca la cantidad de RAM (memoria) utilizada por MuseScore utilizando un SoundFont más pequeño. Vea la
lista arriba para sugerencias.
Aumente la cantidad de RAM disponible para MuseScore al salir de todas las aplicaciones excepto MuseScore. Si
aún tienes problemas y un SoundFont grande es importante para ti, considera más RAM para tu computadora.

Véase también

Sintetizador
Mezclador

Enlaces externos
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Cómo cambiar SoundFont o agregar otro
El formato SFZ  (para detalles sobre la especificación sfz)

Swing

La función swing de MuseScore le permite cambiar la reproducción de su partitura de un ritmo "straight" a uno "swing".
Swing se puede aplicar globalmente o solo a una sección de la partitura, y es completamente variable.

Aplicar swing a una sección de la partitura

1. Haga clic en la nota donde desea que comience el swing;
2. Haga doble clic en Swing en la paleta de texto;
3. Edite el texto de Swing según sea necesario;
4. Si necesita variar el swing de la configuración predeterminada, haga clic derecho en el texto Swing y seleccione

Propiedades del texto de sistema... Haga clic en la pestaña "Ajustes Swing" y ajuste la duración de la nota y el valor en
"Seleccionar proporción del swing" según sea necesario.

El texto Swing puede editado y formateado como cualquier otro objeto de texto.

Tresillo en indicacion de tempo

A menudo, esta notación se usa para indicar el swing:

MuseScore no tiene una forma de incluir un tresillo en el texto como indicacion de tempo, pero hay una solución fácil:

1. Agregue el texto de Swing como se describe arriba y hágalo invisible (atajo V, o desmarque "Visible" en el
Inspector);

2. Agregue la Imagen apropiada del indicación de tempo requerido a la partitura. Estas se puede descargar desde la
parte inferior de la página "Cómo hacer...": : How to create a visual swing marking .

3. Cambiar el tamaño y la posición de la imagen según sea necesario.

Regresar al ritmo straight

Si desea que la reproducción regrese a tiempo "straight" después de una sección "swing":

1. Agregue el texto de Swing a la primera nota o al resto de la sección "straight" (vea arriba).
2. Edite el texto para indicar un retorno al tiempo "straight": por ejemplo "Straight."
3. Haga clic derecho en el texto y seleccione Propiedades del texto de sistema…. Haga clic en la pestaña "Ajustes de Swing"

y configure "Ajustes de Swing" Off ".

Aplicar swing globalmente

Si desea aplicar swing a toda la partitura, puede hacerlo desde el menú:

1. Seleccione Formato → Estilo... → Partitura.
2. En la sección "Ajustes de Swing", configure el valor de nota deseado y la "proporción del swing".

Enlaces externos

How to create a visual swing marking .
Swing (jazz performance style)  (Wikipedia)

Synthesizer

Overview

To display the Synthesizer: from the menu, select View→Synthesizer.

The Synthesizer controls MuseScore's sound output and allows you to:

Load and organize different sound sample libraries to play back the music.
Apply effects such as reverb and compression.
Adjust overall tuning.
Alter the output volume.
Select Midi Continuous Controllers to use with Single Note Dynamics (versions 3.1 and above).
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The Synthesizer window is divided into the following sections/tabs:

Fluid: A software synthesizer that plays SF2/SF3 SoundFont sample libraries.
Zerberus: A software synthesizer that plays SFZ format sample libraries.
Master Effects: Used to apply multi-effects to the score.
Tuning: Used to adjust overall playback tuning.
Dynamics (versions 3.1 and above): Used to configure Single Note Dynamics Midi controllers.

Save/Load Synthesizer settings

The buttons at the bottom of the Synthesizer window have the following functions:

Button Function
Set as
Default

Saves all current synthesizer settings as the default settings. These are automatically applied to the
Synthesizer when you open MuseScore.

Load Default Loads the last saved default settings to the Synthesizer.
Save to
Score

Saves all current synthesizer settings to the current score only.

Load from
Score

Loads the settings from the current score to the synthesizer.

Notes: (1) "Synthesizer settings" include the order of SoundFonts and SFZ files, effects set-up, master tuning and volume.
(2) Only one set of Synthesizer settings can be in effect at a time—i.e. if multiple scores are open at once, it is not
possible to make changes to the Synthesizer in one score and leave other scores' settings untouched. (3) Changes to
synthesizer settings will not be heard in exported audio files unless saved to the score first (see table, above). See also
Tuning (below).

Fluid

Click on the Fluid tab to access the control panel for SF2/SF3 SoundFont sample libraries. By default, the SoundFont
MuseScore_General.sf3 should already be loaded.

You can load, rearrange and delete soundfonts as required. Playback can be shared between any combination of different
soundfonts (and/or SFZ files). The order of soundfonts in Fluid is reflected in the default order of instruments in the mixer.

To load a soundfont

1. Click on the Add button
2. Click on a soundfont in the list.

To be able to load the soundfont, it first needs to be installed in your Soundfonts folder. This will ensure that it appears in
the list in step 2 (above).

To reorder the soundfonts

1. Click on a soundfont
2. Use the up/down arrows (on the right-hand side) to adjust the order.
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3. Repeat with other soundfonts in the list if required.
4. Or use the double up arrow (on the top right-hand side) to move any SoundFont to the top of the list.

The order of virtual instrument sets in the Synthesizer is reflected in the order of instruments listed in the Mixer. So, if
playback of a score depends on a mix of instrument sets, it is advisable to save the Synthesizer configuration to the score
in question by pressing the Save to Score  button. When you next wish to play back the score, press the Load from Score to
load the same configuration. However, remember this only sets the order of instruments—not the instruments themselves,
which should be in place on your computer.

To remove a soundfont

1. Click on the name of the soundfont
2. Click on the Delete button.

This removes the soundfont from the synthesizer but does not uninstall it from the Soundfonts folder: it will still be
available if you wish to reload it later.

Zerberus

Click on the Zerberus tab to access the control panel for SFZ sound sample libraries. You can add, delete or reorder files
in a similar way to the Fluid tab. Note that, as with Fluid, the SFZ files must first be installed in your soundfonts folder
before they can be loaded into the synthesizer.

Volume

The slider on the right of the Synthesizer controls the playback volume: any changes made here last only to the end of the
session, unless saved to the score or set as the new default.

Effects

The Master Effects tab of the Synthesizer allows you to add reverb and compression to your score.

Master Effects with Zita1 Reverb and SC4 Compressor.

To turn an effect on or off:

Select an option from the drop-down list next to Effect A or Effect B (the effects are applied in series, A → B).

To store and load effects configurations, use the buttons at the bottom of the Synthesizer window. See Synthesizer
settings (above) for details.

Zita 1 reverb

The Zita 1 stereo reverb module allows you to simulate the ambience of anything from a small room to a large hall. The
pre-delay, reverb time and tone of the reverb can be finely tuned using the controls provided:

Delay: Set a pre-delay for the reverb from 20-100 ms.
Low RT60 (Low frequency reverb time): Use the grey control to adjust the center frequency (50–1000 Hz) of the low
frequency band which you want to affect: the green control adjusts the reverb time (1–8 secs) of this frequency
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band.
Mid RT60 (Mid-range reverb time): Adjust the reverb time (1–8 secs) of the mid-range frequency band.
HF Damping: Adjusts the high frequency component of the reverb. Increasing this value increases the frequency of
the cut-off point and makes the reverb appear brighter and longer.
EQ1: Allows you to cut or boost (-15 to +15) a frequency band (center = 40 Hz - 2 KHz) in the lower part of the
spectrum.
EQ2: Allows you to cut or boost (-15 to +15) a frequency band (center = 160 Hz - 10 KHz) in the higher part of the
spectrum.
Output: Controls the amount of effect applied. "Dry" is no effect. "Wet" indicates 100% reverb. "Mix" is a 50/50
balance of wet/dry signal.

Note: EQ1 and EQ2 affect the tone of the reverb only, not the dry (unprocessed) signal.

To quickly set up an effects patch, set "Output" to "Mix" and adjust the "Mid RT60" control to the desired reverb time.
Then fine tune the effect as explained above.

SC4 compressor

The SC4 stereo compressor gives you fine control over the playback's dynamic range, reducing the volume variation
between loud and soft sounds. It offers the following controls:

RMS: Adjusts the balance between RMS (0) and Peak (1) compression. In the former, the compressor responds to
averaged-out levels in the signal; in Peak mode, the compressor responds to peak levels.
Attack: (1.5–400 ms) The length of time it takes for compression to engage fully after the signal exceeds the
threshold level.
Release: (2–800 ms) The time it takes for compression to return to zero after the signal falls below the threshold
level.
Threshold: (in dB) The signal level above which compression starts to take effect. Lowering the threshold increases
the amount of signal that is compressed.
Ratio: The amount of compression applied to the signal above the threshold. The higher the ratio, the greater the
compression. Varies between 1:1 and 20:1.
Knee: Allows you to select a range between "soft knee" and "hard knee". The softer the knee, the more gradual the
transition between uncompressed and compressed signal.
Gain: Compression tends to lower the volume, so use this control to boost the signal as required.

To quickly set-up, try setting RMS = 1, Threshold = -20 db, Ratio = 6. Increase Gain to restore the lost volume. Then fine-
tune as explained above.

Tuning

The Tuning tab is where you can adjust the program's master tuning. For Concert Pitch instruments, A4 = 440 Hz by
default.

To change the Master tuning:

Enter a new value in the Master tuning field, then press Change Tuning.

Notes: (1) This tuning applies to all scores in the current session only. To make this the program default or to store it to a
particular score, see Save/Load Synthesizer settings. (2) To apply the new tuning to exported audio files (WAV, MP3,
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OGG), press Save to Score  before exporting.

Dynamics (versions 3.1 and above)

Click on the Dynamics tab to access the control panel for Single Note Dynamics:

Dynamics method: You can choose either between 1) Default (single-note dynamics and velocity), 2) Velocity only
(no single-note dynamics), 3) CC events only (constant velocity).
CC to use: Depending on the SoundFont you use, you may have to choose the Continuous Controller to use, 1) CC
1, 2) CC 2 (default), 3) CC 4, 4) CC 11.

In the Advanced Settings box, you can choose to enable or disable the Expression Controller for Instruments Sound:

Switch all patches: Select 1) To Expressive (to enable for all instruments sounds), 2) To Non-Expressive (to
disable for all instruments sounds), 3) Reset All (Reset all instruments sounds to defaults)

See also

SoundFont
Mixer

External links

How To: Using Single Note Dynamics (SND)  (MuseScore HowTo)

Tempo

Las indicaciones de Tempo se pueden encontrar en la paleta  Tempo en los espacios de trabajo  Básico y
Avanzado. Se muestran como indicaciones de metrónomo, pero pueden editarse posteriormente para mostrar el tempo o
la expresión que desee. El tempo de reproducción se puede variar a través de la partitura mediante el uso de múltiples
marcas de tempo, visibles o invisibles.

Añadir una Indicación de tempo

Use cualquiera de los siguientes métodos:

Seleccione una nota o silencio y presione el __ atajo de teclado__ Ctrl+May+T.
Seleccione una nota o silencio, y desde la barra de menú seleccione Añadir→Texto...→Indicación de tempo.
Seleccione una nota o silencio y haga doble clic en una indicación de metrónomo apropiada en la paleta;
Arrastre y suelte una indicación de metrónomo de la Tempo paleta Tempo directamente en una nota o silencio.

Nota: si se aplica una indicación de tempo desde el menú o usando un atajo de teclado, el valor rítmico del pulso sigue
automáticamente la indicación de tempo. La ventaja de aplicar desde una paleta es que tu puedes elegir qué valor usar
para el pulso.

Editar tempo
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Para cambiar el tempo de una indicación de metrónomo existente en la partitura:

1. Ingrese al Modo de edición para la marca de tempo en cuestión;
2. Edite el número de metrónomo y/o la nota de compás según sea necesario;
3. Salir del modo de edición.

También puede anular el tempo de una marca de metrónomo existente del Inspector:

1. Seleccione la marca de tempo;
2. Desmarque "Seguir texto" en la sección Indicación de tempo del Inspector;

3. Ajuste el tempo de reproducción deseado en el campo "Tempo" debajo.

Nota: la reproducción puede ser más rápida o más lenta si la configuración del tempo en el panel de reproducción está
en un porcentaje distinto al 100%.

Editar texto de tempo

Las marcas de tempo pueden ser editadas y formateadas igual que cualquier otro objeto de texto. Para establecer las
propiedades del texto o el estilo del texto, vea Estilos y propiedades de texto.

El tempo indicado por una indicación de metrónomo por lo general persiste incluso si se sobrescribe con una expresión,
como Andante, Moderato, etc. También puede agregar más texto a una indicacion de metrónomo simple. p.ej.

Ignorar la indicación de tempo

Puede ignorar la indicación de tempo, y reproducir la partitura a cualquier tiempo que desee usando el Panel de
reproducción:

1. Panel de reproducción: Ver→Panel de reproducción or F11 (Mac: fn+F11):

NOT FOUND: Play_Panel_en.png

2. Mover el indicador de tempo arriba o abajo segun haga falta. El tempo es mostrado como valor absoluto y como
porcentaje de la indicación de tempo actual. Haga doble clic en el indicador de tempo para restablecerlo.

Nota: Los BPM siempre son medidos y mostrados en negras por minuto, independientemente del denominador de la
indicación de tempo en efecto.

Reproducir accelerando y ritardando

Puede simular la reproducción ritardando ("rit.") y accelerando ("accel.") agregando indicaciones de tempo ocultas en la
partitura. La indicacion impresa para el musico tambien debe ser agregada como texto de sistema/pentagrama.

En el ejemplo ilustrado abajo, el tempo era originalmente 110 BPM (pulsos por minuto). En el ritardando, el tempo
disminuye en 10 BPM en la primer nota de cada compás. Se hace a cada cambio de tempo invisible desmarcando la
casilla Visible en el Inspector, para que solo el ritardando se muestre en la partitura impresa.

Se ha desarrollado un plugin para automatizar este proceso: TempoChanges

Fermatas

Fermatas, disponibles en la paleta de Articulaciones y adornos, tienen una propiedad Expansión de tempo que se puede
configurar a través del Inspector.. De manera predeterminada, esta propiedad está establecida en 1.00. Para que
MuseScore reproduzca una fermata durante el doble de su duración normal, haga clic en fermata y ajuste "Expansión de
tempo" en 2.00. Esto, por supuesto, no funciona Articulaciones y ornamentos, ya que las barras de compás no tienen una
duración para estirar.
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Véase también

Modo de reproducción
Indicación de tiempo

Dinámicas

Las dinámicas son símbolos que indican el volumen de una nota o frase musical. Los símbolos se pueden encontrar en
la paleta Dinámicas en el espacio de trabajo Básico o Avanzado:

Están disponibles dinámicas adicionales en la Paleta Maestra (Shift+F9).

Nota: el volumen de reproducción general de la partitura se puede cambiar utilizando el deslizador de volumen en el
Modos de reproduccion o Sintetizador.

Añadir una dinámica

Para aplicar una dinámica a la partitura, use uno de los siguientes métodos:

Seleccione una nota y haga doble clic en un símbolo de dinámica en una paleta.
Arrastre un símbolo de dinámica de una paleta a una nota.

Para crear un signo de crescendo o decrescendo, vea Regulador.

Ajustar propiedades

La dinámica por defecto de una partitura es mf (mezzoforte)—determinado en una velocidad MIDI de 80 (de 127).
Dependiendo de la dinámica gobernando una sección particular de la partitura, la velocidad (y por lo tanto el volumen)
puede ser mayor o menor que esto.

Para editar la velocidad (i.e. hacer la reproducir mas fuerte o suave):
* Seleccione la dinámica y, en la sección Dinámica del Inspector edite el valor Velocity—mas alto para mas volumen,
mas bajo para menos.

Para ajustar el rango (i.e. los pentagramas en el sistema que son afectados por la dinámica):

Seleccione la dinámica, y en la sección Dinámica del Inspector, elija una opción de "Rango Dinámico". El valor por
defecto es "Parte", lo que significa que todos los pentagramas de ese instrumento en particular serán afectados.
"Pentagrama" limita el efecto al pentagrama al que esta anclado la dinámica. "Sistema" significa que todos los
pentagramas del sistema serán afectados por la dinámica.

Personalizar una dinámica

Cualquier dinámica puede ser editada después de ser agregada a la partitura, al igual que el texto estándar. También
puede editar la velocidad y el rango dinámico etc. (vea arriba). Si lo desea, puede guardar el resultado para usar en el
futuro en una paleta personalizada.

Enlaces externos

Video tutorial: Lección 10 - Articulaciones, dinámica y texto
Dinámicas  en Wikipedia

Reproduccion con capo

MuseScore le permite transportar la reproducción de un pentagrama, sin alterar la notación musical. Esto simula el efecto
de un capo  (Wikipedia) en el instrumento.
Para agregar un capo:

1. Añada texto de pentagrama a la nota/silencio desde la que desea que empiece la reproducción con capo.
2. Haga clic derecho en el texto de pentagrama, seleccione Propiedades de texto de pentagrama, luego haga clic en la

pestaña Ajustes de capo;
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3. Marque la casilla "Ajustes de capo", y determine el valor Posición capo (traste) al numero de traste en el que
desea aplicar al capo (cada numero de traste aumenta las alturas por un semitono).

4. Haga clic en Ok para aplicar los cambios;
5. Edite las palabras del texto según haga falta.

La reproducción con capo se aplicara desde la nota a la que esta anclado el texto, hasta que haya otro texto de
pentagrama como "Ajustes de Capo" activado, o hasta el final de la partitura. Un valor de Posición de capo
(traste) de "Sin capo" remueve cualquier capo puesto anteriormente en el pentagrama, volviendo a la afinación
original.

Texto
Existen muchos tipos de objetos de texto en MuseScore (ver las tablas de abajo); el texto también puede aparecer
formando parte de las líneas. Este capítulo explica cómo crear, dar formato y editar objetos de texto, e incluye
información sobre textos de los siguientes tipos:

Tipo de texto Uso
Texto de
pentagrama

Texto de propósito general vinculado a un único pentagrama. Aparecerá exclusivamente en la parte
correspondiente a ese instrumento.

Texto de sistema Texto de propósito general asociado a todo un sistema. Aparecerá en las partes de todos los
instrumentos.

Símbolos de
acorde Muestran los acordes asociados a una melodía. Generalmente irán colocados sobre el pentagrama.

Digitación Números o letras asociados a notas, mostrando el dedo a utilizar en cada una.
Letras Textos a cantar con la melodía.
Guías (marcas) de
ensayo Sirven para facilitar los ensayos, dividiendo la partitura en secciones, pasajes significativos, etc.

Para otros tipos de texto disponibles en MuseScore, siga los enlaces a continuación:

Tipo de texto Uso
Dinámicas Indican el volumen con que se interpreta una nota o frase.
Bajo cifrado Indicaciones armónicas para acompañantes al teclado.
Texto de marco Detalles sobre Título/Compositor/Letrista al comienzo de la partitura; letras de canciones, etc.

Cabeceras/Pies Números de página, información sobre el copyright, etc. en la parte superior o inferior de la
página.

Texto de instrumento Cambio de instrumento a mitad de pentagrama.
Repeticiones y saltos Da Capo, Dal segno, Fine, etc.
Swing Cambiar de tempo estricto a swing o viceversa.
Marcas de tempo Metrónomo o indicaciones de tempo mediante texto (ej. Allegro ma non troppo).
Líneas Voltas, octavas, líneas de pedal, reguladores, etc.

Conceptos básicos de texto

Añadir texto

Para agregar un elemento de tipo texto a una partitura se pueden usar los siguientes métodos:

Atajo de teclado: Por ejemplo, pulse Ctrl+Tpara introducir Texto de pentagrama, Ctrl+L para introducir una Letra de
canción, y así sucesivamente.
Opción de menú: Añadir→Texto permite elegir entre distintos tipo de elementos basados en texto.
Sobre una nota: Seleccione una nota y haga doble click sobre un icono de una de las paletas o, en alternativa,
arrastre un símbolo de la paleta sobre el pentagrama, p. ej. Swing, Texto de tempo, etc.

Notas: (1) El método exacto dependerá del tipo de texto que desee añadir (ver Texto). (2) Para bloques de texto
vinculados al pentagrama, ver Texto de pentagrama y de sistema.

Dar formato al texto

Cuando en MuseScore se crea un objeto de texto, éste adopta el Estilo de texto correspondiente, es decir, adopta un
estilo de texto único, como el de las marcas de tempo, dinámicas, símbolos de acorde, etc. Cada estilo de texto consiste
en una serie de propiedades (tipo de letra, tamaño, estilo de fuente, etc.), que pueden ser examinadas en la pantalla de
Estilos de texto a la que se accede mediante (Formato→Estilo…→Estilos de texto).

Un objeto de texto recién creado adopta siempre las propiedades establecidas por el Estilo de texto, las cuales pueden
ser examinadas mediante el Inspector:

132



No obstante, esas propiedades no están limitadas a las que establece el Estilo de texto por defecto. Si se requiere,
pueden ser editadas en el propio Inspector, con independencia del Estilo de texto general.

Por último, si se necesita aplicar un formato especial a caracteres concretos del texto (tipo de letra, tamaño, negrita,
cursiva, subrayado, superíndice, subíndice), puede hacerse en el modo de edición de texto.

Ajustar la posición de los objetos de texto

Para posicionar un objeto de texto es posible utilizar los métodos siguientes:

Arrastrar el objeto.
Seleccionar el objeto y ajustar los valores de desplazamiento X e Y en el Inspector.
Seleccionar el objeto y aplicar uno de estos atajos de teclado:

←: Mover texto a la izquierda 0.1 espacios de pentagrama.
→: Mover texto a la derecha 0.1 espacios de pentagrama.
↑: Mover texto hacia arriba 0.1 espacios de pentagrama.
↓: Mover texto hacia abajo 0.1 espacios de pentagrama.
Ctrl+← (Mac: ⌘+←): Mover texto a la izquierda un espacio de pentagrama.
Ctrl+→ (Mac: ⌘+→): Mover texto a la derecha un espacio de pentagrama.
Ctrl+↑ (Mac: ⌘+↑): Mover texto hacia arriba un espacio de pentagrama.
Ctrl+↓ (Mac: ⌘+↓): Mover texto hacia abajo un espacio de pentagrama.

Vinculación del texto

Cuando se añade un elemento de texto a una partitura, su vinculación dependerá del tipo de elemento:

Título, Subtítulo, Compositor, Letrista: Están vinculados a un marco.
Digitación: Vinculada a cabezas de nota.
Letra: Vinculada a un tiempo de compás (ya sea nota o acorde, pero no a un silencio).
Símbolo de acorde: Vinculado a un tiempo de compás.
Texto de pentagrama: Vinculado a un tiempo de compás.
Texto de sistema: Vinculado a un tiempo de compás.

Edición de texto

Entrar/salir del modo de edición de texto

Para acceder al Modo de edición de texto dispone de las siguientes alternativas:

Hacer doble click sobre un elemento de texto.
Hacer click con el botón derecho del ratón sobre un elemento de texto y seleccionar Editar elemento.
Hacer click sobre un elemento de texto y pulsar Ctrl+E (Mac: Cmd+E).

En este modo es posible aplicar formatos a caracteres individuales, incluyendo opciones tales como negrita, cursiva,
subrayado, subíndice, superíndice, tipo de letra y tamaño. Estas opciones aparecen en la Barra de herramientas de
texto de la parte inferior de la pantalla:
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Para salir del Modo de edición de texto existen las siguientes opciones:

Pulsar Esc.
Hacer click en una zona de la partitura fuera de la ventana de edición.

Atajos de teclado

En el Modo de edición de texto, están disponibles los siguientes atajos de teclado:

Ctrl+B (Mac: ⌘+B) activa o desactiva la negrita.
Ctrl+I (Mac: ⌘+I) activa o desactiva la cursiva.
Ctrl+U (Mac: ⌘+U) activa o desactiva el subrayado.
Inicio Fin ← → ↑ ↓ mueve el cursor.
Retroceso (Mac: Delete) borra el carácter a la izquierda del cursor.
Supr (Mac: → Delete or fn+Supr) borra el carácter a la derecha del cursor.
↵ inicia una nueva línea.
F2 (Mac: fn+F2) Inserta caracteres especiales (ver más abajo).

Símbolos y caracteres especiales

Puede utilizar la ventana de Caracteres especiales para insertar negras, fracciones y muchas otras clases de símbolos y
caracteres especiales en el texto. Algunos símbolos disponen también de atajos de teclado (ver más abajo).

Para abrir la ventana de Caracteres especiales, dispone de los métodos siguientes:

Hacer click en el icono  de la barra de herramientas de texto (en la zona inferior de la pantalla).
Pulsar F2 (Mac: fn+F2).

Nota: (1) Este método sólo funciona en el Modo de edición de texto; (2) La ventana de Caracteres especiales no debe
confundirse con el elemento del menú del mismo nombre en la versión macOS de MuseScore.

La ventana dispone de 3 pestañas: Símbolos comunes, Símbolos musicales y Símbolos Unicode. Las pestañas de
símbolos musicales y símbolos Unicode están subdivididas en categorías ordenadas alfabéticamente.

Al hacer doble click en cualquier elemento de la ventana de Caracteres especiales, dicho elemento se añade
inmediatamente al texto en la posición del cursor. Es posible agregar varios elementos sin cerrar la ventana. Asimismo, el
usuario puede continuar tecleando y añadiendo caracteres normales, borrarlos, etc, sin necesidad de cerrarla.

Atajos de teclado para caracteres especiales

En el Modo de edición de texto están disponibles los siguientes atajos de teclado para acceder a determinados
caracteres especiales:

Ctrl+Mayús+B: Bemol.
Ctrl+Mayús+F: Forte.
Ctrl+Mayús+H: Becuadro.
Ctrl+Mayús+M: Mezzo.
Ctrl+Mayús+N: Niente.
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Ctrl+Mayús+P: Piano (indicación dinámica).
Ctrl+Mayús+R: Rinforzando.
Ctrl+Mayús+S: Sforzando.
Ctrl+Mayús+Z: Z.
Ctrl+Mayús+#: Sostenido.

Ver también

Símbolos de acorde
Letras
Marcos
Modo de edición

Estilos y propiedades del texto

Estilos de texto

Un Estilo de texto se aplica a todos los objetos de texto de la partitura que sean de un determinado tipo. Todos los
textos de pentagrama, por ejemplo, tienen un estilo propio, al igual que todas las marcas de tempo, todas las letras de
canción, todos los símbolos de acorde, y así sucesivamente.

Es posible ver y editar cualquiera de los estilos de texto seleccionando en el menú Formato→Estilo…→Estilos de texto. La
acción da acceso a las siguientes propiedades del texto para cada estilo:

Nombre: Puede cambiar el nombre del estilo, si lo desea.
Tipo de fuente / Tamaño de fuente / Estilo de fuente: El nombre del tipo de letra (ej. Times New Roman, Arial,
etc.), su tamaño en puntos y cualquier combinación de formato (negrita, cursiva, subrayado).
Alineación: Horizontal (izquierda, derecha, centro) y Vertical.
Desplazamiento X/Y: Desplazamiento horizontal y vertical en unidades de espacios de pentagrama (sp).
El tamaño se ajusta al valor de espaciado de pentagrama: Determina si el tamaño del texto se ve afectado o no
por la escala de la partitura.
Marco: El texto puede estar rodeado de un marco circular o rectangular.
Color de primer plano: del borde del marco.
Color de fondo: del marco.
Borde: Grosor de la línea que constituye el marco, en unidades de espacios de pentagrama.
Margen del texto : Margen interior del marco, en espacios de pentagrama.

Radio del borde: Radio de las esquinas en marcos rectangulares,

Notas: (1) La opacidad se ajusta mediante el parámetro "Canal alfa" en la ventana de "Color": un valor entre 0,
transparente, y 255, opaco. (2) Otras propiedades del texto, tales como el color de la fuente, pueden ser ajustadas
mediante el Inspector.
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También es posible editar las propiedades de un Estilo de texto seleccionando un objeto de la partitura con el estilo
deseado, ajustando sus propiedades mediante el Inspector, y pulsando los botones de Establecer como estilo sobre la
marcha. Esta acción actualizará automáticamente el Estilo de texto correspondiente y todos los objetos sujetos a él en
la partitura.

Objetos de texto

Si desea dar formato a un objeto de texto concreto en la partitura, de manera diferente a como establece su Estilo de
texto, selecciónelo y ajuste sus propiedades de texto mediante el Inspector:

Si ha hecho cambios en una propiedad de texto concreta mediante el Inspector, pero desea revertir dichos cambios a lo
que establece el Estilo de texto correspondiente, pulse el botón "Restablecer a estilo por defecto".

Guardar y cargar estilos de texto

Los estilos de texto (junto con los estilos de otros elementos de una partitura) pueden ser almacenados en un archivo de
estilo y cargados desde otras partituras de MuseScore. Ver Guardar y cargar estilos.

Ver también

Edición de texto
Cabecera/Pie
Comportamiento de los textos y líneas

Texto de pentagrama y texto de sistema

Tanto el Texto de pentagrama como el Texto de sistema son excelentes herramientas para incluir texto de propósito
general en una partitura. Para añadirlos, puede utilizarse los siguientes métodos:

Seleccione una nota o un silencio. Para agregar un Texto de pentagrama, pulse Ctrl+T. Para agregar un Texto de
sistema, pulse Mayús+Ctrl+T.
Seleccione una nota o un silencio. A continuación, seleccione la opción deseada en el menú Añadir→Texto.
Seleccione una nota o un silencio y haga doble click en el texto deseado de una paleta.
Arrastre el texto deseado desde una paleta sobre una nota o un silencio.

La acción generará una caja vacía para la introducción de texto. Pulse Esc o haga click en un espacio en blanco fuera de
la caja para abandonar la edición.

Aparte de su propósito primario, los textos de pentagrama o de sistema poseen ciertas propiedades relacionadas con la
reproducción (ver abajo).

Resumen de diferencias:

Estilo de texto Aplica a Afecta en reproducción (si es el
caso) Aparece en

Texto de
pentagrama

Pentagrama al que va
asociado Al pentagrama solamente La parte de ese instrumento

Texto de sistema Todos los pentagramas del
sistema

A todos los pentagramas del
sistema

Las partes de todos los
instrumentos

Texto de pentagrama

El Texto de pentagrama está vinculado a un pentagrama (o a un pentagrama doble de teclado) y sólo aplica a ese
pentagrama. Cualquier efecto en la reproducción derivado del contenido del texto sólo tendrá efecto sobre ese
instrumento. El texto aparecerá únicamente en la parte correspondiente a dicho pentagrama.

Si decidimos ocultar pentagramas vacíos, cualquier texto asociado a un pentagrama vacío quedará también oculto.
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El texto de pentagrama puede utilizarse, por ejemplo, para aplicar incicaciones como Solo o Pizzicato a un pentagrama
concreto de la partitura. Dependiendo de las instrucciones de que se trate, la reproducción MIDI de ese pentagrama
puede ser alterada a partir del punto donde se encuentra la indicación haciendo click con el botón derecho sobre el texto
y seleccionando Propiedades del texto de pentagrama…. Ver Cambio de sonido en medio del pentagrama.

Propiedades del texto de pentagrama

Para acceder a Cambiar canal, Ajustes de swing o Ajustes de capo:

Haga click con el botón derecho sobre el texto y seleccione "Propiedades del texto de pentagrama". A continuación,
seleccione la pestaña correspondiente.

Texto de sistema

El Texto de sistema se asocia a un pentagrama de la partitura, pero es aplicable a todos los pentagramas del sistema.
Cualquier propiedad relativa a la reproducción afectará al sistema completo. El texto se mostrará en las partes de todos
los instrumentos.

Un texto de sistema no quedará oculto aunque seleccionemos la opción ocultar pentagramas vacíos.

Propiedades del texto de sistema

Para añadir o editar el Swing:

Haga click con el botón derecho sobre el texto y seleccione Propiedades del texto de sistema. A continuación,
seleccione la pestaña Ajustes de swing.

Ver también

Cambio de sonido en medio del pentagrama

Enlaces externos

Cómo cambiar el sonido de un instrumento (ej. pizz., con sordina) en medio de la partitura

Símbolos de acorde

Los Símbolos de acorde son una forma abreviada de representar los acordes musicales (ver Acorde  (Wikipedia) para
más detalles). Por ejemplo:

Introducir un símbolo de acorde

1. Seleccione una nota o una barra inclinada;
2. Pulse Ctrl+K (Mac: ⌘+K).

El cursor se sitúa sobre el pentagrama, listo para recibir texto. Introduzca el símbolo de acorde como si fuera texto
normal, de este modo:

Nota fundamental: A, B, C, D, E, F, G.
Sostenido: # (símbolo almohadilla).
Bemol: b ("b" minúscula).
Doble sostenido: x ("x" minúscula) o bien ## (dos almohadillas).
Doble bemol: bb (dos "b" minúsculas).
Becuadro: natural (la palabra "natural", sin espacios por delante).
Para otros símbolos, ver Sintaxis de los símbolos de acorde (más abajo).

Al terminar de editar un símbolo de acorde, los caracteres introducidos asumirán automáticamente el formato correcto:
por defecto, una fundamental escrita en minúscula adoptará el formato mayúscula (para opciones alternativas, ver
Capitalización automática); una "#" o una "b" se convertirán en un sostenido (♯) o en un bemol (♭), y así sucesivamente.
No trate de usar los símbolos reales del bemol o el sostenido, ya que MuseScore no los interpretará correctamente.

Una vez se ha terminado de introducir un símbolo de acorde, se puede:

Mover el cursor hacia adelante o hacia atrás para seguir introduciendo o editando símbolos de acorde (ver
comandos abajo).
Abandonar la edición, pulsando Esc.
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Nota: Para rellenar compases con barras inclinadas, ver Rellenar con barras o Conmutar a notación rítmica (barras
inclinadas).

Comandos de teclado

Durante la edición de símbolos de acorde se dispone de los siguientes comandos:

Espacio mueve el cursor a la siguiente nota, silencio o tiempo de compás
Mayús+Espacio mueve el cursor a la nota, silencio o tiempo de compás anterior
Ctrl+Espacio (Mac: ⌘+Espacio) añade un espacio al nombre del acorde
; mueve el cursor al tiempo de compás siguiente
: mueve el cursor al tiempo de compás anterior
Tab mueve el cursor al compás siguiente
Mayús+Tab mueve el cursor al compás anterior
Ctrl más un número (1 - 9) mueve el cursor la duración correspondiente a un número (ej. una blanca para el 6)
Esc Salir.

Sintaxis de los símbolos de acorde

MuseScore entiende la mayoría de las abreviaturas empleadas para los símbolos de acorde:

Mayor: M, Ma, Maj, ma, maj, Δ (escriba t o ̂  para el triángulo)
Menor: m, mi, min, -
Disminuido: dim, ° (escrita con la o minúscula, aparece como ° si se está usando el estilo jazz; en caso contrario,
como una o normal)
Semidisminuido: ø (teclee 0, es decir, el cero). Se puede usar también como alternativa abreviaturas del tipo de
mi7b5, etc.
Aumentado: aug, +
Las siguientes abreviaturas son asimismo válidas: extensiones y alteraciones como b9 o #5, sus, alt, y no3;
inversiones y acordes con barra inclinada, como C7/E; comas; paréntesis que engloben parte o incluso un símbolo
de acorde entero.

Editar un símbolo de acorde

Un símbolo de acorde existente puede ser editado de manera similar a un texto ordinario: Ver Edición de texto.

Transportar símbolos de acorde

Por defecto, los símbolos de acorde son transportados automáticamente cuando aplicamos el comando de menú
Transportar a los compases que los contienen. Si no se desea que esto ocurra, se puede desactivar la casilla
"Transportar símbolos de acordes" que aparece en la ventana del comando.

Texto de los símbolos de acorde

Para ajustar la apariencia de todos los textos de los símbolos de acorde, existen las alternativas siguientes:

Desde el menú principal, elija Formato → Estilo... → Estilos de texto → Símbolo de acorde. Seguidamente, edite las
propiedades del texto según lo requerido.
Seleccione un símbolo de acorde y realice los cambios mediante el Inspector. Seguidamente, pulse el botón "S"
(Establecer como estilo) correspondiente al parámetro.

Estilo de los símbolos de acorde

Las opciones de formato de los símbolos de acorde son accesibles de este modo:

Desde el menú, seleccione Formato→Estilo…→Símbolos de acorde. Las propiedades que es posible ajustar se listan en
los apartados siguientes:

Apariencia

Se dispone de tres opciones: Estándar, Jazz y Personalizada.

En el estilo Estándar los acordes se muestran tal cual, con el tipo de letra determinado por el estilo del texto de los
símbolos de acorde.
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En el estilo Jazz el tipo de letra MuseJazz imita texto escrito a mano e incorpora superíndices y otras
particularidades de formato. El estilo Jazz se selecciona por defecto al usar cualquiera de las plantillas de jazz.

El estilo Personalizado permite ajustar libremente el aspecto de los símbolos de acorde (y, por otra parte, sirve
para asegurar la compatibilidad con partituras antiguas).

Nombres de las notas

Por defecto, MuseScore utiliza las letras de la escala musical anglosajona para identificar los acordes. Para usuarios
pertenecientes a regiones con otros sistemas de notación, MuseScore proporciona las siguientes opciones:

Estándar: A, B♭, B, C, C♯,...
Alemán: A, B♭, H, C, C♯,...
Alemán completo: A, B, H, C, Cis,...
Solfeo: Do, Do♯, Re♭, Re,...
Francés: Do, Do♯, Ré♭, Ré,...

Capitalización automática

Por defecto, MuseScore convierte automáticamente en mayúsculas los nombres de todas las notas al abandonar la
edición, con independencia de cómo hayan sido tecleados. No obstante, es posible elegir otros tipos de conversión
automática:

Acordes menores en minúscula: c, cm, cm7,...
Notas de bajo en minúscula: C/e,...
Todos los nombres de notas en mayúsculas: DO, RE, MI,...

También es posible desactivar por completo la capitalización automática, en cuyo caso los nombres de las notas
aparecerán como hayan sido tecleados.

Posicionamiento

Distancia al diagrama de acorde: Para los diagramas de acorde de guitarra y similares, este valor representa la
altura a la que el símbolo de acorde aparecerá por encima del diagrama (es posible usar valores negativos).
Espaciado mínimo de los acordes: El espacio a dejar entre símbolos de acorde.
Distancia máxima de las barras de compás: Cambia el tamaño del intervalo entre el último símbolo de acorde en
un compás y la barra de compás subsiguiente. Sólo hace falta ajustar este valor si aparece un problema repetitivo
de superposición del último símbolo de un compás y el primer símbolo del siguiente.

Nota: Además de los ajustes descritos arriba, la posición por defecto de los símbolos de acorde viene también
determinada por los parámetros elegidos en la ventana de Estilos de texto . El efecto es acumulativo.

Capo

Escriba el número del traste donde estará ubicado el capo o cejilla. Los acordes sustitutivos aparecerán entre corchetes,
tras cada símbolo de acorde.

Digitación

Los símbolos de digitación para diversos instrumentos se encuentran en la paleta Digitación, dentro del Espacio de
trabajo avanzado.

La música para Teclado se sirve de los números 1–5 para representar los dedos de la mano izquierda o derecha.
En MuseScore existe además un plugin denominado posicionador de digitación  que ayuda a diseñar digitaciones
para piano o instrumentos de teclado en general.
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La música para Guitarra utiliza los números 0–4 para representar la digitación de la mano izquierda (en ocasiones,
una letra T representa el pulgar). La digitación de la mano derecha viene indicada por las letras p, i, m, a, c. Los
números rodeados de un círculo representan las cuerdas del instrumento.

Los últimos cinco símbolos de la paleta sirven para la digitación del laúd en la música antigua.

Nota: Para que la digitación aparezca en una tablatura, seleccione la tablatura (TAB), haga click con el botón derecho
sobre ella, seleccione Propiedades de pentagrama...→Propiedades de estilo avanzadas, y active "Mostrar digitación en tablatura".

Añadir digitación a una nota

Se dispone de las alternativas siguientes:

Seleccionar la nota y hacer doble click sobre uno de los símbolos de la paleta de Digitación.
Arrastrar con el ratón uno de los símbolos de la paleta de Digitación y soltarlo sobre la nota.

Cuando se añade una digitación a una nota, el foco se desplaza al símbolo, para que pueda proceder a ajustarlo según
desee.

Añadir digitación a varias notas

1. Seleccione las notas deseadas;
2. Haga doble click sobre uno de los símbolos de la paleta de Digitación.

Ajustar la posición de la digitación

Ajuste simple

Para cambiar la posición de un único símbolo, existen las siguientes alternativas:

Para el ajuste fino (0.1 sp) utilizar las teclas de flecha. Para desplazamientos mayores (1 sp) usar Ctrl+Flecha.
Cambiar los desplazamientos X e Y mediante el Inspector .
Arrastrar el símbolo por medio del ratón.

Ajuste múltiple

Para cambiar la posición de varios símbolos a la vez:

1. Seleccione los símbolos deseados;
2. Ajuste los desplazamientos X e Y mediante el Inspector .

Nota: Puede usar el plugin posicionador de digitación  mencionado más arriba para optimizar el diseño de las
digitaciones de piano.

Para devolver un símbolo a su posición por defecto, selecciónelo y pulse Ctrl+R.

Editar el texto de una digitación

La digitación es un tipo de texto más y, como tal, puede ser editado y se le puede aplicar un estilo. Haciendo click con el
botón derecho sobre el símbolo se accede a diversas opciones al respecto.

Letras

Introducir líneas de texto cantado

Primera línea

1. Introduzca previamente las notas de la melodía;
2. Seleccione la nota en la que desea iniciar el texto cantado;
3. Para acceder al modo letra, pulse Ctrl+L (Mac: ⌘+L), o en el menú principal seleccione Añadir→Texto→Letra;
4. Escriba una sílaba;
5. Utilice las opciones siguientes para continuar escribiendo la letra:

Ir a la sílaba siguiente: Pulse Espacio (o Ctrl+→) al final de la sílaba.
Guión (para conectar sílabas): Pulse - al final de la sílaba.
Ir a la sílaba anterior: Pulse Mayús+Espacio (o Ctrl+←).
Moverse a la izquierda: Pulse ← (flecha izquierda). Si el cursor se halla al principio de la sílaba, saltará a la
sílaba anterior.
Moverse a la derecha: Pulse → (flecha derecha). Si el cursor se halla al final de la sílaba, saltará a la sílaba
siguiente.
Moverse a la sílaba de abajo: Pulse ↓ (flecha abajo).
Moverse a la sílaba de arriba: Pulse ↑ (flecha arriba).
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Iniciar una nueva línea de texto cantado: Pulse ↵ (Intro) al final de una sílaba existente (Nota importante:
No haga uso de la tecla Intro del teclado numérico, si existe).

6. Para salir del modo letra, pulse Esc.

Líneas siguientes

Si desea añadir más líneas de texto cantado a las ya existentes (ej. una segunda o tercera estrofa):

1. Haga uso de una de estas opciones:
Seleccione la nota en la que debe empezar la nueva línea. Acceda al modo letra como se indica en el paso 3
de (arriba). El cursor se posicionará en una nueva línea (en blanco).
Acceda al modo de edición de texto sobre una sílaba existente, vaya al final de la sílaba y pulse ↵ (Intro). El
cursor se posicionará en la línea siguiente.

2. Continúe introduciendo la letra desde el paso 4 de (arriba).

Ejemplo:

Caracteres especiales

En la mayoría de los casos, las letras pueden editarse como si fueran texto normal. No obstante, se requieren ciertos
atajos de teclado para introducir algunos caracteres:

Carácter espacio: Ctrl+Espacio (Mac: ⌥+Espacio).

- (guión): Ctrl+- (Mac: ⌥+-) or AltGr+-.

Salto de línea: Ctrl+↵ (Mac: ⌥+Intro) or Intro (desde el teclado numérico).

Números de verso

Para numerar los versos, teclee simplemente un número (ej. 1.) seguido de un espacio antes de la primera sílaba.
MuseScore alineará correctamente los números y la primera sílaba del texto cantado.

Melismas

Un melisma es una sílaba o palabra que abarca dos o más notas. Se indica por medio de un subrayado que se extiende
desde la base de la sílaba en cuestión hasta la última nota del melisma. El subrayado se crea posicionando el cursor al
final de la sílaba y pulsando Mayús+_ una vez por cada nota del melisma. Ver la imagen de abajo:

El texto cantado de la imagen fue creada de este modo:

1. Teclee las letras soul,.
2. Al final de la palabra, pulse Mayús+___.
3. Teclee las letras To, y termine pulsando Esc.

Para extender sílabas que no sean la última, añada simplemente guiones -. Generalmente, sólo se mostrará uno de ellos
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(salvo que la distancia entre sílabas permita mostrar más) y la sílaba se alineará con la primera nota, de manera similar a
como sucede con las últimas sílabas que forman parte de un melisma (ver arriba).

Ligado de elisión / Sinalefa

Dos sílabas bajo una misma nota pueden ser unidas mediante un ligado de elisión, también conocido como "sinalefa".
Por ejemplo:

Para crear el texto del ejemplo de arriba, empezando con la sílaba "te":

1. Teclee te;

2. Haga clic en el icono , o pulse F2 para abrir la paleta de Caracteres Especiales;

3. Use una de las siguientes opciones:

Haga doble clic en uno de los tres caracteres de elisión disponibles en la pestaña "Símbolos comunes":
"Elisión estrecha", "Elisión", o "Elisión ancha" (ver imagen abajo):

Haga doble clic en la ligadura de elisión que se encuentra después de la fracción de 7/8 en la pestaña
"Símbolos comunes". Dependiendo de la fuente, agregue uno o más espacios antes o después de la ligadura
usando Ctrl+Espacio (Mac: ⌥+Espacio).

Nota: no todos los tipos de letra incluyen el carácter "undertie" (U + 203F ‿ "undertie", presente en "Caracteres
especiales" principalmente por compatibilidad con las partituras de MuseScore 1.x). Para saber qué fuentes en su
computadora lo admiten, ver "fontlist " (busque cualquier fuente que muestre una ligadura entre "te" y "A", en lugar
de un rectángulo en blanco).

4. Teclee A.

Editar letras

1. Acceda al modo de edición de texto en una sílaba existente;
2. Use los comandos estándar de edición de texto para hacer cambios;
3. Continue ingresando la letra (ver arriba) o salga del modo letras pulsando Esc.

Ajustar las propiedades de la letra

Para hacer ajustes globales a las propiedades de todas las letras de la partitura:

1. Desde el menú, seleccione Formato→Estilo...→Letra;
2. Edite las propiedades de Ubicación, Posición, Altura de la línea, Márgenes, etc. según se requiera.

Ajustar la ubicación de líneas de letra individuales

Para ajustar la posición de una línea de letra en particular:
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1. Seleccione la línea de letra: haga doble clic en una palabra de la línea. Seguidamente, haga click con el botón
derecho y en el menú contextual elija Seleccionar→Más...; después marque las opciones apropiadas (entre las que
debería estar "Mismo sistema");

2. Ajuste los valores X y Y en el Inspector.

Copiar letras al portapapeles

Para copiar todas las letras al portapapeles:
* Desde la barra de menu, seleccione Herramientas→Copiar Letra al Portapapeles .

Pegar letras del portapapeles

Para copiar y pegar letras de un archivo de texto (por ejemplo) en una partitura:

1. Ingrese las notas de la partitura a la que se añadirá la letra.
2. Prepare las letras a añadir en un archivo de texto, con los espacios apropiados, guiones, saltos de línea, etc.
3. Copie al portapapeles la letra del archivo de texto.
4. Seleccione la nota de inicio en MuseScore y pulse Ctrl+L (Mac: Cmd+L) (paso 3 bajo Letras).
5. Realizando repetidamente la acción de pegar se introducirán las palabras sucesivas de la letra. Puede necesitar

ingresar melismas y hacer otras correcciones a medida que avanza.

Ver también

Texto
Símbolos de acorde

Enlaces externos

Cómo insertar letras
Cómo mover letras
Cómo copiar letras solas o la letra más la melodía
Cómo agregar un bloque de texto a una partitura
Video tutorial: MuseScore en minutos: Lección 6 - Texto, letras y acordes

Guías (marcas) de ensayo

Las guías o marcas de ensayo pueden ser utilizadas de varias maneras:

Para identificar puntos específicos de la partitura y facilitar los ensayos.
Como marcas en la partitura a las que desplazarse fácilmente —mediante el comando Buscar.
Para definir las diversas secciones de la partitura.

Generalmente, las guías de ensayo consisten en una o varias letras y/o números y aparecen en secuencia en la
partitura —ej. A, B, C…, o 1, 2, 3… etc. También pueden mostrar el número de compás (habitualmente, a un tamaño
mayor que los números de compás normales, con los caracteres en negrita o rodeados de un marco). Los silencios
multicompás son divididos automáticamente antes y después de una guía de ensayo.

Las guías de ensayo se pueden añadir a la partitura (i) automáticamente —lo cual garantiza que reciben un nombre
secuencial— o (ii) manualmente, lo que le permite darles un nombre arbitrario.

Añadir una guía de ensayo

Colocación manual

Para crear manualmente una guía de ensayo:

1. Haga click sobre una nota o silencio en el punto deseado;
2. Siga uno de estos métodos:

Pulse Ctrl+M (Mac: Cmd+M);
En el menú, seleccione Añadir → Texto → Guía de ensayo;

3. Introduzca el texto deseado.

Colocación automática

Agregar una guía de ensayo alfanumérica

Siga uno de estos procedimientos:

Haga click sobre una nota o silencio en el punto deseado y, seguidamente, haga doble click en el icono [B1] que
figura en la paleta de "Texto".
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Arrastre el icono [B1] de la paleta de Texto sobre una nota o silencio que se halle en en el punto deseado de la
partitura.

Notas: (1) Por defecto, las guías se crean siguiendo la secuencia A, B, C, etc. (2) Para cambiar el formato de las guías
que se agreguen a continuación de una dada (a letras minúsculas o números, por ejemplo), edite la guía en cuestión
según lo deseado. (3) Las guías que se inserten entre otras ya existentes añadirán un número o una letra a la guía
anterior. Se recomienda aplicar el comando Renumerar tras realizar la inserción (ver abajo).

Agregar una guía de ensayo basada en el número de compás

1. Añada la primera guía de ensayo de la serie en su forma alfabética. Seguidamente, edite la guía, sustituyendo la
letra por el número del compas al que está asociada;

2. Agregue las guías siguientes como se indica más arriba. Adoptarán automáticamente el formato de número de
compás.

Renumerar automáticamente las guías de ensayo

MuseScore permite reordenar automáticamente una serie de guías de ensayo que hayan quedado desordenadas por
alguna razón. El método a emplear es el siguiente:

1. Antes de realizar la selección, es posible establecer un nuevo formato para las guías de ensayo, si fuera preciso
(mayúsculas/minúsculas, números o número de compás), editando manualmente la primera guía de la serie.

2. Seleccione el intervalo de compases al que desea aplicar el comando Renumerar (si no hace ninguna selección,
MuseScore asume que desea renumerar todos los compases).

3. En el menú, seleccione Herramientas → Renumerar Guías de Ensayo.

MuseScore detecta automáticamente la secuencia basada en la primera guía de ensayo de la serie seleccionada y ajusta
en consecuencia todas las guías pertenecientes a la selección. Son posibles las secuencias siguientes:

A, B, C, etc.
a, b, c, etc.
Numérica: 1, 2, 3, etc.
Numérica, según el número de compás. Este tipo requiere que la primera guía de la serie sea un número idéntico al
del compás al que está vinculada.

Estilo de texto

Las guías de ensayo son una variante de texto de sistema, y aparecen tanto en la partitura completa, como en cada una
de las partes. Por defecto, se crean en negrita, en un tipo de letra grande y rodeadas de un marco con las esquinas
redondeadas. Todas las características de su aspecto pueden ser cambiadas globalmente mediante el Estilo de texto de
las marcas de ensayo.

Buscar una guía de ensayo

Ver Buscar (Vista y navegación).

Ver también

Propiedades de texto

Enlaces externos

Rehearsal Letter  (Wikipedia en inglés)

Formato

Diseño y formato

Las opciones de diseño y formato para la partitura se abren desde el menú de Formato.

Métodos para cambiar el diseño

Esta sección enumera los principales comandos y pantallas que afectan el diseño de la partitura. Otras opciones de
formato serán cubiertas mas abajo en la página (pero para texto, vea Estilos y propiedades del texto).

Configuración de página: Ajuste las dimensiones generales de su partitura, como el tamaño de página, los
márgenes de página y la escala.

Expandir/Contraer: Ajuste el espaciado de la partitura expandiendo o contrayendo los compases seleccionados.
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Estilo de partitura: Establezca los detalles generales de la partitura, como la fuente musical, la visualización de
silencios de multicompás y si se deben ocultar los pentagramas vacíos.

Estilo de página: Ajuste el pentagrama y espaciado de sistema, márgenes de partituras y letra, etc.

Estilo de compás: Establezca el espaciado entre compases, lo que afecta el número de compases por línea.

Tamaños: Establezca el tamaño predeterminado de "pequeño" y las notas de adorno, pequeños pentagramas y
pequeñas claves.

Otros comandos:

Añadir/Eliminar saltos de línea: Establecer el número de compases por sistema.

Saltos y espaciadores: Aplicar saltos de línea, página o sección. También puede agregar espacio extra entre
sistemas o pentagramas particulares cuando sea necesario.

Estilo

El submenu de Estilo contiene cuadros de diálogo que le permiten ajustar el formato global de varios elementos en la
partitura. Para abrir Estilo:

Desde el menú, seleccione Formato→Estilo...
Haga clic derecho en un espacio en la ventana de documento y seleccione Estilo....
Use un atajo de teclado (ver Atajos de teclado).

Los cuadros de diálogo de Estilo son los siguientes:

Partitura

Para abrir la pantalla de Partitura, seleccione Formato→Estilo...→Partitura.

Esta pantalla le permite establecer las propiedades globales, como la fuente musical, mostrar silencios multicompás,
mostrar/ocultar pentagramas vacíos, reproducción con "swing" etc.

Tipografía de los símbolos musicales: Elija entre las fuentes Emmentaler, Bravura o Gonville. Marcar la casilla le
permite "cargar automáticamente las configuraciones de estilo basadas en la fuente".

Tipografía del texto musical: Elija entre Emmentaler, Bravura, Gonville o MuseJazz.

Mostrar en sonidos reales: Marque esta opción para mostrar la partitura en sonidos reales. Si se deja
desmarcada, la partitura mostrará los sonidos escritos.

Crear silencios multicompás: Marque para mostrar silencios multicompás.

Numero mínimo de compases vacíos: El valor por defecto es 2.
Ancho mínimo del compás: El valor por defecto es 4 sp.

Esconder pentagramas vacíos entre sistemas : Esta opción ahorra espacio escondiendo pentagramas en un
sistema que contenga solo compases vacíos. Usado para partituras condensadas.

No esconder pentagramas vacíos en el primer sistema: Mostrar siempre los pentagramas en el primer sistema
aunque solo contengan compases vacíos.

Mostrar figuras que atraviesasn la barras de compás: Esta función es útil para escribir musica antigua. Ver
Notaciónn sin compás.

Ocultar el nombre del instrumento si hay solo un instrumento: Por lo general no hace falta mostrar el nombre
en este caso.

Ajustes de swing: Le permiten controlar el grado de swing para toda la partitura.

Swing: Elija entre Encendido (por defecto) / Corchea / Semicorchea.
Seleccionar proporción del swing: Por defecto es 60%.

Si prefiere ajustar el swing en la página de la partitura, vea Swing.

Página

Para abrir la pantalla de Página: en el menú, seleccione Formato→Estilo...→Página.

Esta pantalla le permite ajustar el espacio encima y debajo de los sistemas, pentagramas, letras y marcos, y entre la
partitura y los márgenes de página superior / inferior. También puede controlar la visualización de armaduras,
indicaciones de compás y claves.
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El diagrama de abajo es una guía para los parámetros que controla esta pantalla:

Margen superior de la partitura: La distancia entre la línea superior del primer pentagrama en la página y el
margen superior de la página.
Margen inferior de la partitura: La distancia entre la línea inferior del último pentagrama en la página y el margen
inferior de la página.
Distancia entre pentagramas: El espacio entre pentagramas que no forman parte de un pentagrama doble o de
piano (ver abajo).
Distancia del sistema de piano: El espacio entre pentagramas destinados a un mismo instrumento, como el piano,
el órgano o los de un par pentagrama/tablatura de guitarra.

Nota: Para cambiar el espacio sobre un pentagrama en particular, ver Distancia extra por encima del pentagrama
(Propiedades del pentagrama).

Distancia mínima entre sistemas: La distancia mínima permitida entre un sistema y el siguiente.
Distancia máxima entre sistemas: La distancia máxima permitida entre un sistema y el siguiente.
Margen superior del marco vertical: La altura del margen predeterminada por encima de un marco vertical.
Margen inferior de marco vertical: La altura del margen predeterminada por debajo de un marco vertical.
Umbral de relleno para el último sistema: Si el último sistema es más largo que este porcentaje del ancho de la
página, será estirado para rellenar el ancho.

Las siguientes casillas de verificación le permiten controlar la aparición de claves, indicaciones de tempo y armaduras de
clave (incluyendo las de cortesía):

Crear claves para todos los sistemas / Crear armaduras para todos los sistemas / Crear claves de cortesía / Crear
indicaciones de compás de cortesía / Crear armaduras de clave de cortesía.

Tamaños

Para abrir la pantalla de Tamaños, seleccione Formato→Estilo...→Tamaños.

La pantalla permite establecer el tamaño proporcional de las notas "pequeñas" y de adorno, así como el de los
pentagramas pequeños y las claves. Cambiar estos parámetros suele ser inusual.

Encabezado, Pie de pagina

Para abrir la pantalla de Encabezado, Pie de pagina, seleccione Formato→Estilo...→Encabezado, pie.

La pantalla le permite agregar un encabezado y pie de pagina usando las metaetiquetas de una partitura (ver Información
de partitura), como números de pagina, encabezado, copyright etc. Por ejemplo, puede crear encabezados y pies de
pagina diferentes para páginas pares e impares (como poner números de pagina a la derecha para páginas impares y a la
izquierda para pares).

Al pasar el puntero del ratón sobre la región de Texto de cabecera o la de Texto del pie de página, emergerá una lista de
macros que mostrará su significado, así como las metaetiquetas existentes y su contenido.

Para crear un encabezado o pie de pagina para una parte individual, la parte tiene que estar en la pestaña activa. Para
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crear un encabezado o pie para una partitura con partes vinculadas, asegúrese de que la partitura principal esté en la
pestaña activa.

Números de Compás

Para abrir la pantalla de Números de Compás, seleccione Formato→Estilo...→Números de Compás.

La pantalla permite especificar si los números de compás han de aparecer en la partitura, y en caso de que aparezcan,
con qué frecuencia. También puede especificar propiedades de fuente.

Sistema

Para abrir la pantalla de Sistema, seleccione Formato→Estilo...→Sistema.

Esta pantalla permite ajustar ciertas propiedades de todos los sistemas.

Llaves:
* Grosor de corchete: Especifique un ancho para los corchetes de sistema.
* Grosor de la llave: Especifique un ancho para las llaves de sistema.
* Distancia del corchete al sistema: Especifique una distancia entre los corchetes de sistema y el comienzo de las
barras de compás.
* Distancia de la llave al sistema: Especifique una distancia entre las llaves de sistema y el comienzo de las barras de
compas.

Ver también Llaves.

Divisores:
* Izquierda / Derecha: Especifique si quiere mostrar los divisores de sistema, que tipos, y aplicar valores de
desplazamiento globales.

Nombres de instrumentos:
* Nombres largos de instrumento: Especifique las características de la fuente y la alineación.
* Nombres cortos de instrumento: Especifique las características de la fuente y la alineación.

Claves

Para abrir la pantalla de Claves, seleccione Formato→Estilo...→Claves.

Elija el estilo por defecto para la clave de tablatura: Estándar o Serif.

Alteraciones

Para abrir la pantalla de Alteraciones, seleccione Formato→Estilo...→Alteraciones.

Esta pantalla le permite especificar como serán mostradas las armaduras de clave en los cambios de clave en la
partitura.
Ver tambien Becuadros en cambios de clave.

Compás

Para abrir la pantalla de Compás, seleccione Formato→Estilo...→Compás.

Para detalles, vea Compás.

Barras de compás

Para la pantalla de Barras de compás, seleccione Formato→Estilo...→Barras de compás.

Mostrar barras de repetición en forma de corchete:
Barra de compás al inicio de un único pentagrama: Mostrar o no las barras de compás al comienzo de un
pentagrama.
Barra de compás al inicio de varios pentagramas: Mostrar o no las barras de compás al comienzo de un
conjunto de pentagramas.
Ajustar barras de compás al tamaño del pentagrama: Afecta solo a pentagramas "pequeños".

Otras propiedades le permiten especificar el grosor de las barras de compás "finas", "gruesas" y dobles barras, la
distancia entre dobles barras, y la distancia entre la barra de repetición y los puntos.

Notas

Par abrir la pantalla de Notas, seleccione Formato→Estilo...→Notas. La pantalla también puede ser abierta directamente
desde la partitura haciendo click derecho en cualquier nota y seleccionando "Estilo...".
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Mediante esta pantalla puede ajustar la distancia y grosor de los objetos relacionados con las notas (plicas, líneas,
puntillos, alteraciones). Cambiar estas opciones es inusual.

Barras de agrupación

Para abrir la pantalla de _Barras de agrupación__, seleccione Formato→Estilo...→Barras de agrupación.

La pantalla permite determinar las propiedades generales de las barras de agrupación en una partitura:
* Grosor de las barras
* Distancia entre las barras: Distancia vertical entre barras.
* Longitud mínima de las barras interrumpidas: Afecta a las barras secundarias que no se extienden completamente
de nota a nota.

Marcar la opción Todas las barras de agrupación horizontales hace que todas las barras sean solo horizontales (es
decir, no inclinadas).

Valores irregulares

Para abrir la pantalla de Valores irregulares (tresillos, dosillos, etc.), seleccione Formato→Estilo...→Valores irregulares.

Distancia vertical desde las Notas:
* Inclinación máxima: Limita la inclinación de los corchetes para los valores irregulares.
* Distancia vertical desde plica: Se refiere a los números y los corchetes de los valores irregulares.
* Distancia vertical desde la cabeza: Se refiere a los números y los corchetes de los valores irregulares.

Distancia horizontal desde las Notas:
* Distancia antes de la plica de la primer nota: Determina la posición por defecto del comienzo del corchete de un valor
irregular cuando aparece encima o debajo de las plicas.
* Distancia antes de la cabeza de la primera nota: Determina la posición por defecto del comienzo del corchete de un
valor irregular cuando aparece encima o debajo de las cabezas de las notas.
* Distancia después de la plica de la ultima nota: Determina la posición por defecto del final del corchete de un valor
irregular cuando aparece encima o debajo de las plicas.
* Distancia después de cabeza de la ultima nota: Determina la posición por defecto del final del corchete de un valor
irregular cuando aparece encima o debajo de las cabezas de las notas.

Llaves:
* Grosor de la llave:
* Altura del corchete: Determina la longitud por defecto de los ganchos verticales al final de los corchetes de los valores
irregulares.

Propiedades:
* Dirección / Tipo de número / Tipo de corchete

Arpegios

Para abrir la pantalla de Arpegios, seleccione Formato→Estilo...→Arpegios. Desde ella puede cambiar la distancia a las
notas, el grosor de la línea y la longitud de los ganchos de los símbolos de arpegio o rasgueado siguiente:

Ligaduras

Para abrir la pantalla de Ligaduras de expresión o de duración, seleccione Formato→Estilo...→Ligaduras. Mediante ella,
puede establecer los siguientes parámetros:

Grosor de línea al final
Grosor de línea en el centro
Grosor de la línea de puntos
Longitud mínima de la ligadura de prolongación
Distancia mínima de autocolocación

Reguladores

Para abrir la pantalla de Reguladores, seleccione Formato→Estilo...→Reguladores. Con ella puede determinar las
propiedades por defecto de los reguladores (líneas de crescendo y decrescendo):

Ubicación: Establezca si deben ir por encima o por debajo del pentagrama.
Posición arriba/abajo: Determine un valor en unidades de sp.
Alto: El grado de abertura de la boca del regulador.
Altura de continuación para salto de sistema
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Distancia respecto a dinámicas en colocación automática
Grosor de las líneas

Casillas de repetición

Para abrir la pantalla de Casillas de repetición, seleccione Formato→Estilo...→Casillas de repetición. Mediante ella puede
determinar la propiedades por defecto de las casillas de repetición:

Posición predeterminada: Determine el desplazamiento por defecto X e Y.
Altura del gancho: La longitud de las líneas descendentes al final de las casillas.
Grosor de las líneas
Estilo de línea: La opción por defecto es una línea continua, pero se puede elegir líneas de puntos o formadas por
rayas.

Octava

Para abrir la pantalla de Octava, seleccione Formato→Estilo...→Octava. Con ella puede determinar las propiedades por
defecto de las líneas de octava:

Solo números: Si la casilla está desmarcada, la octava también se muestra con "va" o "vb" después del número.
Posición arriba/abajo: Determine el desplazamiento X e Y de la octava.
Altura del gancho arriba/abajo: La longitud de la línea ascendente/descendente al final de la línea de octava.
Grosor de las líneas
Estilo de línea: La opción por defecto es una línea continua, pero se puede elegir líneas de puntos o formadas por
rayas.

Pedal

Para abrir la pantalla de Pedal, seleccione Formato→Estilo...→Pedal. Mediante ella puede determinar las propiedades por
defecto de las líneas de pedal:

Ubicación: Encima o debajo del pentagrama.
Posición ariba/abajo: Determine la posición exacta por defecto usando los valores de desplazamiento.
Grosor de las líneas:
Estilo de línea: La opción por defecto es una línea continua, pero se puede elegir líneas de puntos o formadas por
rayas.

Trino

Para abrir la pantalla de Trinos, seleccione Formato→Estilo...→Trinos. A través de ella puede determinar la ubicación por
defecto de las lineas de trino:

Ubicación: Encima o debajo del pentagrama.
Posición encima o debajo: Determine la posición exacta usando los valores de desplazamiento.

Vibrato

Para abrir la pantalla de Vibrato, seleccione Formato→Estilo...→Vibrato. Con ella puede determinar la posición por defecto de
las lineas de Vibrato:

Ubicación: Encima o debajo del pentagrama.
Posición encima o debajo: Determine la posición exacta usando los valores de desplazamiento.

Bend

Para abrir la pantalla de Bend, seleccione Formato→Estilo...→Bend. Mediante ella puede determinar las propiedades de los
bends, incluyendo el grosor de la línea, el ancho de la flecha y las propiedades del tipo de letra.

Línea de texto

Para abrir la pantalla de Linea de texto, seleccione Formato→Estilo...→Línea de texto. Esta pantalla le permite determinar el
posicionamiento por defecto de las líneas de texto:

Ubicación: Encima o debajo del pentagrama.
Posición encima o debajo: Determine la posición exacta usando los valores de desplazamiento.

Articulaciones, ornamentos

Para abrir la pantalla de Articulaciones, ornamentos, seleccione Formato→Estilo...→Articulaciones, ornamentos. Con ella podrá
determinar el posicionamiento y tamaño (en porcentaje) de las articulaciones y ornamentos.
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Calderón (fermata)

Para abrir la pantalla de Calderón, seleccione Formato→Estilo...→Calderón. Mediante ella, podrá determinar el
posicionamiento por defecto de las fermatas o calderones.

Texto de pentagrama

Para abrir la pantalla de Texto de pentagrama, seleccione Formato→Estilo...→Texto de pentagrama. Esta pantalla le permite
determinar las propiedades de ubicación y posicionamiento automático de los Textos de pentagrama.

Texto del tempo

Para abrir la pantalla de Tempo del texto, seleccione Formato→Estilo...→Texto del tempo. A través de ella es posible
establecer las propiedades de ubicación y posicionamiento automático de los textos de tempo.

Letra

Para abrir la pantalla de Letra, seleccione Formato→Estilo...→Letra.

Ubicación, Posicion arriba/abajo: Determine la posición por defecto de la línea de letra más cercana al
pentagrama.
Altura de la línea: Determine la distancia por defecto entre lineas de letra.
Guión entre sílabas: Determine la longitud del guión entre las sílabas y el espacio entre ellos.
Melisma de letra: Determine las propiedades por defecto de melismas.

Dinámicas

Para abrir la pantalla de Dinámicas, seleccione Formato→Estilo...→Dinámicas. Esta pantalla permite determinar las
propiedades de ubicación y posicionamiento automático de las Dinámicas.

Marcas (guías) de ensayo

Para abrir la pantalla de Guías de ensayo, seleccione Formato→Estilo...→Marcas de ensayo. La pantalla permite definir las
propiedades de ubicación y posicionamiento automático de las Guías (marcas) de ensayo.

Bajo cifrado

Para abrir la pantalla de Bajo cifrado, seleccione Formato→Estilo...→Bajo cifrado. Mediante ella, podrá determinar el tipo de
letra por defecto, el estilo, la alineación y la posición del Bajo cifrado.

Símbolos de acorde

Para abrir la pantalla de Símbolos de acorde, seleccione samp class="menu">Formato→Estilo...→Símbolos de acorde. Esta
pantalla permite ajustar el formato y posicionamiento de los Diagramas de acorde:

Apariencia:
* Elija un estilo: Estándar (por defecto), Jazz o Personalizado.
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Enarmonía de notas:
* Elija la convención de nombres para los diagramas de acorde y si se usarán letras mayúsculas o minúsculas.

Posicionamiento:
* Distancia al diagrama de acorde: La distancia (en unidades sp.) de símbolo de acorde al diagrama de acorde cuando
ambos símbolos son aplicados a una misma posición en el pentagrama. Este valor sobrescribe el valor superior "Posición
vertical por defecto". Es posible colocar el símbolo de acorde debajo del diagrama de trastes introduciendo un valor
negativo
* Espaciado mínimo de los acordes: El espacio mínimo permitido entre símbolos de acorde.
* Distancia máxima de las barras de compás: Incrementa la distancia entre el último símbolo de acorde en un compás
y la barra de compás siguiente. Sirve para ajustar este valor si en la partitura hay colisiones repetitivas entre el último
símbolo de acorde en un compás y el siguiente símbolo de acorde.

Capo:
* Posición del capo: Ingrese el número de traste en el que desea posicionar el capo, y en el que serán mostrados los
acordes sustitutivos, entre corchetes, para todos los símbolos de acorde en la partitura.

Diagramas de acorde

Para abrir la pantalla de Diagramas de acorde, seleccione Formato→Estilo...→Diagramas de acorde. Mediante ella, podrá
ajustar el formato y posicionamiento de los Diagramas de acorde.

Posición vertical predeterminada: La distancia en unidades sp. desde un diagrama de acorde nuevo al
pentagrama. Puede usarse un valor negativo.
Escala: Aumenta o disminuye el tamaño del diagrama de acorde en la partitura.
Tamaño de fuente para número de traste: Aumenta o reduce el tamaño del número de traste mostrado al lado del
diagrama.
Posición izquierda/Derecha: Determina si el número de traste aparece a la izquierda o a la derecha del diagrama
de acorde.
Grosor de la línea de cejilla: Hace las líneas de cejilla más gruesas o más finas.

Estilos de texto

Para abrir la pantalla de Estilos de texto, seleccione Formato→Estilo...→Estilos de texto. Esta pantalla permite establecer el
formato de todos los estilos de texto. Los estilos de texto individuales pueden ser ajustados también mediante el
Inspector.

Botones Aceptar / Cancelar / Aplicar

Cualquier cambio realizado a través de las pantallas de Estilo es aplicado inmediatamente a toda la partitura. Para anular
el efecto, pulse Cancelar (lo cual cierra también la pantalla de Estilo). Para cerrar la pantalla aplicando los cambios, pulse
Aceptar.

Si los ajustes de formato se están haciendo sobre una parte instrumental solamente y desea extenderlos a todas, pulse
Aplicar a todas las partes .

Ajustes de página...

Ver Ajustes de página.

Añadir / Eliminar Saltos de sistema

Esta funcionalidad sirve para agregar o eliminar los saltos de sistema en toda o parte de la partitura:

1. Seleccione una gama de compases. Si no se hace ninguna selección, el comando se aplicará a toda la partitura.

2. En el menú, seleccione Formato→Añadir/Borrar Saltos de sistema.... Se mostrará la siguiente pantalla:

3. Elija entre las opciones siguientes:
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Saltos de sistema cada X (seleccione número) compases;
Añadir salto de sistema al final de cada sistema;
Eliminar saltos de sistema actuales;

4. Pulse Aceptar.

Expandir

Sirve para aumentar, reducir o restablecer el espacio horizontal entre las notas de los compases seleccionados.

Aumentar / Disminuir ancho de maquetación

1. Seleccione una gama de compases, o bien pulse Ctrl+A para seleccionar toda la partitura.
2. Elija una de estas opciones:

Para incrementar el espacio:
Use el atajo de teclado } (llave apuntando a la derecha) (Mac: Ctrl+Alt+9).
O bien, en el menú seleccione Formato→Expandir→Aumentar ancho de maquetación.

Para reducir el espacio:
Use el atajo de teclado { (llave apuntando a la izquierda) (Mac: Ctrl+Alt+8).
O bien, en el menú seleccione Formato→Expandir→Disminuir ancho de maquetación.

Restablecer ancho de maquetación

Para restablecer al valor por defecto (1) el ancho de maquetación:

1. Seleccione una gama de compases, o bien pulse Ctrl+A para seleccionar toda la partitura.
2. En el menú, seleccione Formato→Expandir→Restablecer ancho de maquetación.

Ver también Propiedades del compás: Expandir diseño. Esta modalidad permite ajustar este parámetro de forma más
precisa.

Restablecer Estilo

Para restablecer todos los estilos de texto a sus valores "de fábrica":

En el menú, seleccione Formato→Restablecer Estilo.

Restablecer Barras de agrupación

Para restablecer las barras de agrupación de notas al esquema establecido por la indicación de tempo local:

1. Seleccione la sección de la partitura que desea reajustar. Si no se hace ninguna selección, la operación se aplicará
a toda la partitura;

2. Seleccione Formato→Restablecer Barras de agrupación.

Ver también Barras de agrupación.

Restablecer Formas y Posiciones

El comando Restablecer Formas y Posiciones restaura las posiciones por defecto, la dirección de las plicas de las
notas y las formas de las ligaduras, etc. para los elementos de la partitura seleccionados. Para aplicarlo:

1. Seleccione los elementos o la región de la partitura que desea restablecer. Use Ctrl+A para seleccionar toda la
partitura.

2. Pulse Ctrl+R o bien, en el menú, seleccione Formato→Restablecer Formas y Posiciones .

Cargar / Guardar estilo

Es posible transferir un conjunto completo de estilos (todos los ajustes generales de Estilo, todos los estilos de texto y los
ajustes de página) de una partitura a otra mediante esta funcionalidad.

Para cargar un estilo personalizado:

1. En el menú, seleccione Formato→Cargar estilo....
2. Busque y seleccione el fichero de estilo (.mss) deseado y pulse Abrir (o haga doble click en el fichero).

Todos los estilos existentes en la partitura serán automáticamente actualizados.

Para guardar un estilo personalizado:

1. En el menú, seleccione Formato→Guardar estilo....
2. Nombre y guarde el fichero de estilo (la carpeta por defecto está en Preferences). Los estilos se almacenan como
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ficheros *.mss.

Nota: Es posible establecer un estilo preferido para las partituras y las partes instrumentales en la pestaña Partitura de
las Preferencias de MuseScore (en Editar --> Preferencias...).

Ver también

Editar el espacio entre notas
Actualización desde MuseScore 1.x: rediseño local

Enlaces externos

Tutorial – Cómo crear notación de pentagrama a gran tamaño (MSN)
MuseScore en 10 Pasos fáciles: Parte 10A Diseño y Formato (video tutorial)
MuseScore en 10 Pasos fáciles: Parte 10B Diseño y Formato (video tutorial) .

Compás

Para abrir la pantalla de Compás, en el menú seleccione Formato→Estilo...→Compás.

Esta pantalla permite ajustar la distancia entre diversos elementos que aparecen en el interior de los compases.

Introducción

Si se cambia una propiedad del estilo de compás, MuseScore ajustará automáticamente la partitura para mantener un
espaciado correcto entre notas y silencios, conforme a las buenas prácticas de grabado de partituras. Asimismo,
MuseScore recolocará de manera adecuada cualquier elemento asociado a notas o silencios, como digitaciones,
dinámicas, líneas, etc.

Los ajustes relativos al ancho de compás o espaciado de notas son siempre valores mínimos. Los compases son
automáticamente ensanchados, en caso necesario, para mantener los márgenes de página existentes.

Todas las propiedades enumeradas más abajo utilizan como unidad de medida el espacio de pentagrama ("sp" en
abreviatura). Ver Ajustes de página: Escalado para más detalle.

Opciones

Ancho mínimo de compás: Define la dimensión horizontal mínima de los compases. En compases que contengan
muy pocos elementos (ej. una redonda o un silencio de redonda solamente), el ancho del compás adoptará como
mínimo este valor.

Espaciado (1=ajustado): Contrae o expande el espacio que hay detrás de las notas o silencios. El parámetro no
sólo afecta al espaciado entre las notas, sino también a la distancia entre la última nota de un compás y la barra de
compás siguiente. Para ajustar el espacio entre el comienzo de un compás y la primera nota o silencio contenidos
en él, ver Margen izquierdo de nota (abajo).

Margen izquierdo de nota: Establece la distancia entre la barra inicial de un compás y la primera nota o silencio
contenidos en él.

Distancia entre la barra de compás y la nota de adorno: Establece la distancia entre la barra inicial de compás y
una nota de adorno que se encuentre antes de la primera nota normal del compás (con independencia del "Margen
izquierdo de nota").

Distancia entre la barra de compás y la alteración: Establece la distancia entre la barra inicial de compás y una
alteración que se encuentre antes de la primera nota normal del compás (con independencia del "Margen izquierdo
de nota").

Distancia de la nota a la barra de compás: Establece la distancia entre la última nota de un compás y la barra de
compás siguiente.

Distancia mínima entre notas: Especifica el espacio mínimo que MuseScore dejará detrás de cada nota
(dependiendo de otros factores, MuseScore podrá dejar más espacio).

Margen izquierdo de la clave: Establece la distancia entre el comienzo de cada línea y la clave. (Se trata de una
opción que no es probable que necesite.)

Margen izquierdo de la armadura: Establece la distancia entre el comienzo del compás y la armadura de clave.

Margen izquierdo de la indicación de compás: Establece la distancia entre el comienzo del compás y la
indicación de compás.

Distancia entre indicación de compás y barra de compás: Pendiente de definición.
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Margen derecho de la clave o armadura: Establece la distancia entre los elementos que hay al principio de cada
línea (por ejemplo, la clave y/o la indicación de compás) y la primera nota o silencio del primer compás de la línea.
(Obsérvese que, aunque no se cite expresamente, si hay una indicación de compás, será este elemento el que
determine el comienzo del margen en cuestión.)

Distancia de la clave a la barra de compás: Establece la distancia entre una barra de compás y un eventual
cambio de clave que la preceda.

Distancia de clave a armadura: Establece la distancia entre la clave y la armadura que la sigue.

Distancia de clave a indicación de compás: Establece la distancia entre la clave y la indicación de compás que la
sigue (siempre que no haya una armadura de clave entre medias).

Distancia de armadura de clave a barra de compás: Pendiente de definición.

Distancia a encabezado de sistema: Pendiente de definición.

Distancia entre encabezado de sistemae indicación de compás: Pendiente de definición.

Margen de los silencios multicompás: Establece la distancia entre un silencio multicompás y las barras de
compás que hay a cada lado de él.

Grosor de las líneas del pentagrama: Define el grosor de las líneas de los pentagramas, lo que permite hacerlas
más anchas y oscuras, en caso de necesitar aumentar la visibilidad de éstas en la partitura impresa.

Nota: Los cambios que se realicen sobre el Ancho de un pentagrama concreto (mediante Formato→Expandir →
Aumentar/Disminuir ancho de maquetación) se aplican con posterioridad y de forma proporcional al Espaciado global que
se haya establecido.

Ajustes de página

Ajustes de página le permite establecer las dimensiones generales de la partitura, tales como el tamaño de la página,
los márgenes y el escalado. Es una de las principales herramientas de diseño en MuseScore, junto con las opciones
disponibles en Formato→Estilo...

Para abrir la pantalla de Ajustes de página, en el menú, seleccione Formato → Ajustes de página....

Tamaño de la página

Puede elegir el formato del papel, bien por su denominación estándar (ej. Letter or A4), bien especificando su ancho y
altura en milímetros o pulgadas (use el botón de opciones para elegir la unidad). El tamaño de página por defecto tras
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instalar el programa dependerá de su localización.

También puede elegir la orientación del papel, entre Vertical y Apaisada. Opcionalmente, puede seleccionar Doble cara
(es decir, formato libro, con los márgenes izquierdo y derecho en espejo, según sea la página par o impar (ver abajo).

Márgenes de página par/impar

Los parámetros Margen de las páginas pares y Margen de las páginas impares permiten definir el área de impresión
de las páginas. Además de establecer los márgenes alrededor de la música en cada página, hay otros ajustes, como la
posición de los pies y cabeceras, que son calculados respecto a los márgenes definidos aquí.

Cuando está seleccionada la opción "Doble cara", es posible ajustar por separado los márgenes de página par e impar.
En caso contrario, sólo se podrá establecer un conjunto de márgenes, que aplicará a todas las páginas.

Para mostrar en pantalla los márgenes de página (aunque no se imprimirán), en el menú seleccione Ver→Mostrar márgenes
de la página.

Escalado

El Escalado establece el tamaño de todos los símbolos e indicaciones musicales de la partitura.

En MuseScore, el tamaño de los elementos de la partitura, como las cabezas y las plicas de las notas, las alteraciones,
las claves, etc., está definido en términos de una unidad de medida llamda espacio de pentagrama ("sp" en abreviatura).
Un espacio de pentagrama equivale al espacio entre dos líneas adyacentes de un pentagrama (o, lo que es lo mismo, a
la cuarta parte de la altura de un pentagrama de cinco líneas).

Cuando se cambia el "Espaciado de pentagrama" (en el apartado Escalado), todos los elementos de la partitura ajustan
automáticamente su tamaño para mantener la proporción correcta. La excepción es el Texto, para el cual es posible
establecer un valor absoluto, con independencia del "Escalado."

Nota: Al cambiar el "Escalado" no siempre cambiará el número de sistemas por página, ya que la distancia entre
sistemas puede variar entre los límites definidos por la "Distancia mínima entre sistemas" y la "Distancia máxima entre
sistemas" (ver Formato→Estilo...→Página).

Unidad

Es posible elegir entre pulgadas y milímetros.

Número de la primera página

Establece la numeración de la primera página de una partitura concreta. Los números inferiores a 1 no se imprimen. Por
ejemplo, si se establece como número de la primera página el -1, la primera y la segunda página no mostrarán
numeración y la tercera vendrá numerada con el 1.

Aplicar a todas las partes

El botón Aplicar a todas las partes  sólo se activa al modificar los ajustes de una parte, y no la partitura principal (ver Partes).
Sirve para extender a todas las partes los cambios realizados en los parámetros de página de una de ellas.

Saltos y espaciadores

La paleta Saltos y espaciadores del espacio de trabajo Avanzado contiene los siguientes símbolos no imprimibles:

Los tres primeros símbolos son denominados saltos; las líneas verticales azules se denominan espaciadores.

Saltos

Un salto puede ser aplicado tanto a un compás, como a un marco. Existen tres tipos:

Salto de sistema : Hace que los compases que siguen inicien un nuevo sistema.
Salto de página: Hace que los compases que siguen encabecen una nueva página.
Salto de sección: Hace que los compases que siguen inicien un nuevo sistema y crea una nueva sección en la
partitura (ver abajo). Puede combinarse con un salto de página, si se requiere.

Notas: (1) Los símbolos azules de salto son visibles en pantalla, pero no se imprimen. (2) Para añadir (o eliminar) saltos
de sistema en toda o en parte de la partitura, ver Añadir/Eliminar saltos de sistema. (3) Para dividir un compás, ver
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Operaciones de compás: Dividir y unir.

Añadir un salto a un compás

Los saltos pueden ser añadidos: (1) mediante un atajo de teclado, o (2) por medio de un símbolo de salto de una paleta.

Mediante un atajo de teclado

Para añadir un Salto de sistema o un Salto de página:

1. Seleccione cualquiera de estos elementos:
Barra de compás;
Compás;
Cabeza de nota;
Texto asociado a un pentagrama (ej. sílaba de una canción, símbolo de acorde, texto de pentagrama, etc.);
Grupo de compases (si elige esta opción, el salto se aplicará tanto antes como después de los compases
seleccionados);

2. Elija entre estas opciones:
Salto de sistema: Pulse ↵ (conmutador).
Salto de página: Pulse Ctrl+↵ (Mac: Cmd+↵) (conmutador).

Mediante un símbolo de la paleta

Cualquier salto puede ser agregado desde una paleta de este modo:

1. Seleccione cualquiera de estos elementos:
Barra de compás;
Compás;
Cabeza de nota;
Texto asociado a un pentagrama (ej. sílaba de una canción, símbolo de acorde, texto de pentagrama, etc.);
Grupo de compases (si elige esta opción, el salto se aplicará tanto antes como después de los compases
seleccionados);

2. Haga doble click sobre el símbolo de la paleta (conmutador).

Como alternativa, se puede arrastrar el símbolo de salto desde la paleta y soltarlo sobre un compás.

Añadir un salto a un marco

Para añadir un salto a un marco, dispone de estas opciones:

Arrastrar un salto desde la paleta y soltarlo sobre el marco.
Seleccionar un marco y hacer doble click en el símbolo de salto de la paleta.

Borrar saltos

Siga el siguiente método:

Seleccione uno o más saltos y pulse Supr.

Ver también: Añadir/Eliminar saltos de sistema.

Mover un salto

Aunque los saltos no son visibles al imprimir la partitura, se puede cambiar su posición entrando en el modo edición sobre
el salto en cuestión y usando las teclas de flecha (ver Ajustar la posición de los objetos de texto).

Salto de sección

Como su nombre indica, un Salto de sección, sirve para crear secciones separadas en la partitura. Al igual que un salto
de sistema, obliga al siguiente compás o marco a iniciar un nuevo sistema y puede ser también usado, en caso
necesario, junto a un salto de página. Un salto de sección podría ser utilizado, por ejemplo, para dividir una pieza en
movimientos.

Cada sección puede tener su propia numeración de compases, independiente del resto de la partitura. Por defecto, al
primer compás de una sección se le asigna el número "1" (ver la imagen de abajo), aunque igual que sucede con el
primer compás de la partitura en sí, ese número no se muestra, salvo que se haya establecido lo contrario en la pantalla
de propiedades del compás. Esa misma pantalla puede ser usada para cambiar la numeración, según se requiera.

Si se cambia la Indicación de compás o la Armadura de clave al comienzo de la nueva sección, no habrá indicación de
cortesía al final de la sección anterior. Ver el ejemplo siguiente:
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Al reproducir la partitura, MuseScore inserta una breve pausa entre secciones. Por otra parte, la primera barra de final de
repetición que haya en una sección remite el cursor de reproducción al inicio de la seccción, por lo que la barra de
comienzo de repetición es opcional.

Haciendo click con el botón derecho del ratón sobre un Salto de sección y seleccionando Propiedades de saltos de
sección... es posible especificar:

La duración de la pausa;
Si el primer sistema de la nueva sección debe o no mostrar nombres largos para los instrumentos;
Si la nueva sección comienza a numerar los compases desde el 1.

Espaciadores

Hay tres tipos de espaciadores:

Espaciador de pentagrama por arriba: Una flecha azul que apunta hacia arriba. Sirve para añadir espacio encima
de un pentagrama.
Espaciador de pentagrama por abajo: Una flecha azul que apunta hacia abajo. Sirve para añadir espacio debajo
de un pentagrama.
Espaciador de pentagrama fijado abajo: Parece una letra "I" mayúscula. Sirve para fijar la distancia entre dos
pentagramas. Resulta útil para ignorar las configuraciones de estilo o de posicionamiento automático en un punto
concreto de la partitura. Admite valores negativos.

Nota: Los espaciadores no pueden ser aplicados a un marco.

Añadir un espaciador

Se dispone de los siguientes métodos:

Seleccione un compás y haga doble click en el símbolo de espaciador de la paleta correspondiente.
Arrastre un símbolo de espaciador desde la paleta y suéltelo sobre el compás al que se desea aplicar.

Los símbolos azules de los espaciadores se muestran en pantalla, pero no aparecen al imprimir la partitura.

Nota: Los espaciadores sirven exclusivamente para hacer ajustes locales. Si desea cambiar el espacio entre
pentagramas para toda la partitura, use los ajustes disponibles en Formato → Estilo... → Página.

Ajustar un espaciador

Para ajustar la altura de un espaciador, utilice uno de estos métodos:

Haga doble click en el espaciador y arrastre con el ratón el punto de control hacia arriba o hacia abajo.
Haga doble click en el espaciador y use las teclas ↑ ↓  y/o Ctrl+↑ ↓  para mover el punto de control hacia arriba o hacia
abajo.
Haga click (o doble click) en el espaciador y establezca su altura mediante el Inspector.

Borrar un espaciador

Haga click sobre el espaciador y pulse la tecla Supr.

Ver también

Añadir/Eliminar saltos de sistema

Marcos

Un Marco es un contenedor rectangular de espacio vacío, texto o imágenes. En MuseScore puede ser de tres tipos:

Horizontal: Sirve para crear una interrupción en un sistema concreto. Puede contener uno o más objetos de texto
y/o imágenes.
Vertical: Se inserta encima de un sistema o debajo del último. Puede contener uno o más objetos de texto y/o
imágenes.
Texto: Se inserta encima de un sistema o debajo del último. Puede contener un único objeto de texto.
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Marco horizontal

Un marco horizontal sirve para crear una interrupción en un sistema. Algunos ejemplos de uso:

Crear una coda, separada por un espacio ajustable del resto de la partitura (ver el ejemplo de abajo).

Crear un indentado al comienzo de la partitura, cuando no hay un nombre del pentagrama que realice esa función.
Crear un margen derecho ajustable al final de un sistema.
Crear un espacio destinado a texto o imágenes.
Crear un espacio entre un 'íncipit histórico' y en comienzo de la edición moderna.

Insertar/añadir un marco horizontal

Ver Crear un marco (más abajo).

Ajustar la anchura de un marco horizontal

Siga uno de estos procedimientos:

Haga doble click en el marco y arrastre el punto de control hacia la derecha o hacia la izquierda.
Seleccione el marco y ajuste su "Ancho" mediante el Inspector.

Añadir texto o imágenes a un marco horizontal

Para agregar texto: Haga click con el botón derecho del ratón sobre el marco y seleccione Añadir → Texto.

Para añadir una imagen: Haga click con el botón derecho del ratón sobre el marco y seleccione Añadir → Imagen.

Marco vertical

Un marco vertical puede ser insertado encima de un sistema o añadido al último sistema. Puede contener uno o más
objetos de texto y/o imágenes. La altura es ajustable; la anchura iguala la del sistema.

Puede ser utilizado, por ejemplo, para:

Crear un área en la cabecera de la partitura, destinada al Título/Subtítulo/Compositor/Letrista, etc. (ver abajo).
Agregar un texto cantado en una o varias columnas, al final de la partitura.
Crear una página de portada.
Insertar subtítulos u otras anotaciones entre sistemas.

Insertar/añadir un marco vertical

Ver Crear un marco (abajo).

Ajustar la altura de un marco vertical

Siga uno de estos procedimientos:

Haga doble click en el marco y arrastre el punto de control hacia arriba o hacia abajo.
Seleccione el marco y ajuste su "Alto" mediante el Inspector.

Editar las propiedades de un marco vertical

Una vez seleccionado un marco, mediante el Inspector es posible ajustar diversos parámetros:
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Separación superior: Distancia entre el marco y el elemento que haya encima.
Separación inferior: Distancia entre el marco y el elemento que haya debajo.
Alto: Altura del marco.
Margen Izquierdo: Desplaza hacia la derecha los elementos de texto alineados a la izquierda.
Margen Derecho: Desplaza hacia la izquierda los elementos de texto alineados a la derecha.
Margen Superior: Desplaza hacia abajo los elementos de texto alineados arriba (ver también Formato → Estilo... →
Página).
Margen Inferior: Desplaza hacia arriba los elementos de texto alineados abajo (ver también Formato → Estilo... → Página).

Añadir texto o imágenes a un marco vertical

Para agregar texto: Haga click con el botón derecho del ratón sobre el marco y seleccione Añadir → Texto.

Para añadir una imagen: Haga click con el botón derecho del ratón sobre el marco y seleccione Añadir → Imagen.

Puede crear tantos objetos como necesite dentro de un marco. Sus posiciones pueden ser ajustadas de manera
independiente arrastrándolos con el ratón o, de modo más preciso, alterando su desplazamiento XY mediante el
Inspector. Para dar formato a objetos de texto, ver Edición de texto y Estilos y propiedades del texto.

Insertar un marco horizontal en un marco vertical

Haga click con el botón derecho del ratón en el marco y seleccione Añadir → Insertar Marco Horizontal.

El marco horizontal queda automáticamente alineado a la izquierda y llena por completo el marco vertical. Para alinearlo a
la derecha:

1. Reduzca la anchura del marco horizontal.
2. Deseleccione el marco y arrástrelo hacia la derecha. Para restablecer la alineación a la izquierda, vuelva a

arrastrarlo en esa dirección.

Marco de "título"

MuseScore crea automáticamente un marco vertical al comienzo de la partitura, en el que se muestran el título, el
subtítulo, el compositor, el letrista, etc., cuando rellenamos los campos de información que aparecen en la página 1 del
Asistente de partitura nueva .

Si la partitura no dispone de un marco vertical al inicio, puede crear uno de esta manera:

1. En el menú, seleccione Añadir → Texto → Título/Subtítulo/Compositor/Letrista;
2. Introduzca el texto deseado;
3. Pulse Esc o haga click en una zona vacía de la partitura, para salir.

Marco de texto

Un Marco de texto tiene la apariencia de un marco vertical, pero es específico para introducir texto. Sólo se permite un
único objeto de texto en un marco de este tipo. La altura del marco se expande automáticamente para adaptarla al
contenido; el marco en sí no permite ajustes de tamaño.

Un marco de texto sirve, por ejemplo, para:

Añadir un poema o la letra de una canción al final de la partitura.
Crear subtítulos u otras anotaciones entre sistemas.

Insertar o agregar un marco de texto

Ver Crear un marco (más abajo).

Editar las propiedades de un marco de texto
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Seleccionando el marco y mediante el Inspector es posible modificar estos parámetros:

Separación superior: Distancia entre el marco y el elemento que haya encima.
Separación inferior: Distancia entre el marco y el elemento que haya debajo.
Alto: No aplicable a los marcos de texto.
Margen Izquierdo: Desplaza hacia la derecha los elementos de texto alineados a la izquierda.
Margen Derecho: Desplaza hacia la izquierda los elementos de texto alineados a la derecha.
Margen Superior: Desplaza hacia abajo los elementos de texto alineados arriba.
Margen Inferior: Desplaza hacia arriba los elementos de texto alineados abajo.

Crear un marco

Insertar un marco en la partitura

1. Seleccione un compás.
2. En el menú, seleccione Añadir → Marcos → Insertar Marco Horizontal/Vertical/de Texto.

Agregar un marco al final de la partitura

En el menú, seleccione Añadir → Marcos → Añadir Marco Horizontal/Vertical/de Texto al final .

Borrar un marco

Seleccione el marco y pulse Supr.

Aplicar un salto a un marco

Al igual que un compás, un marco admite saltos de línea, de página o de sección. Para aplicarlos se dispone de estos dos
métodos:

Seleccione un marco y haga doble click en un símbolo de salto de una paleta.
Arrastre un símbolo de salto y suéltelo sobre un marco.

Ver también

Propiedades del texto: para rodear un texto con un borde.
Insertar compases: para insertar compases antes de un marco.

Enlaces externos

Cómo añadir un bloque de texto a una partitura
Formatear páginas en MuseScore 1.1 - 1. Marcos, Texto y Saltos de línea  [vídeo]

Imágenes

Puede utilizar Imágenes para ilustrar partituras, o para agregar simbolos que no estén incluidos en las paletas estándar.
MuseScore soporta los formatos siguientes:

PNG (*.png)
JPEG (*.jpg and *.jpeg)
SVG (*.svg) (actualmente, MuseScore no soporta sombreado, desenfoque, recorte o enmascaramiento en los
SVG.)

Añadir imagen

Use uno de estos métodos:

Arrastre un archivo de imagen (desde fuera de MuseScore), bien sobre un marco, bien sobre una nota o silencio de
la partitura.
Haga click con el botón derecho del ratón sobre un marco, seleccione Añadir→Imagen y elija un archivo de imagen
mediante el selector de ficheros que aparece.

Cortar/copiar y pegar una imagen

1. Haga click sobre una imagen de la partitura.
2. Aplique cualquiera de los comandos estándar para cortar o copiar.
3. Haga click en una nota, silencio o marco.
4. Aplique cualquiera de los comandos estándar para pegar.

Modificar una imagen
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Para modificar la anchura o la altura de una imagen, haga doble click sobre ella y arrastre con el ratón el punto de control
correspondiente. Si desea ajustar de manera independiente ambos parámetros, deseleccione previamente la casilla
"Bloquear relación de aspecto" en el Inspector.

La posición de una imagen puede ser ajustada arrastrándola simplemente con el ratón.

Ver también

Captura de imágenes
Paletas personalizadas

Enlaces externos

Cómo crear un ossia mediante captura de imágenes
Cómo crear un ossia con otro pentagrama

Captura de imágenes

La captura de imagen en MuseScore permite crear una instantánea de cualquier zona de la partitura. Los formatos
soportados son PNG, PDF y SVG.

Crear una instantánea

1. Pulse el botón de Alternar Captura de imagen  para hacer aparecer un rectángulo de selección.
2. Arrastre los puntos de control del rectángulo de selección para abarcar la zona deseada.
3. Si necesita definir el tamaño y posición del rectángulo con precisión, ajuste los parámetros correspondientes

mediante el Inspector.
4. Haga click con el botón derecho del ratón sobre el rectángulo para abrir el menú de Captura de imagen y

seleccione la opción deseada:
Guardar como (Modo de Impresión). Guarda la imagen incluida en el área tal como aparecería impresa.
Ejemplo:

Guardar como (Modo de Captura de Pantalla). Guarda la imagen incluida en el área tal como se ve en
pantalla, es decir, incluyendo los símbolos invisibles como los saltos y espaciadores. Ejemplo:

La imagen puede ser guardada en formato PNG (por defecto), SVG o PDF.

Menú de captura de imagen

Haciendo click con el botón derecho del ratón sobre el rectángulo de selección se abre el menú de Captura de imagen
(Mac: Ctrl + click, o toque con dos dedos):
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Copiar: Elija esta opción para copiar la imagen, antes de pegarla en la misma partitura o en otra de MuseScore.
Resolución: Ajuste la resolución y, con ella, el tamaño de la imagen a copiar o guardar. Si no está seguro, pruebe
100 dpi para empezar.
Fondo transparente: Active o no la transparencia de la imagen.
Auto ajustar a página: Haga que el rectángulo de selección se ajuste a la página.
Cambiar tamaño a A/B/C/D: Elija un rectángulo de selección personalizado (ver abajo).
Fijar tamaño estándar...: Ajuste el tamaño del rectángulo de selección y, seguidamente, elija "Fijar tamaño
A/B/C/D" para memorizarlo.

Ver también

Imagen

Enlaces externos

Cómo crear un ossia mediante captura de imágenes
Cómo crear un ossia con otro pentagrama

Alinear elementos

Mientras arrastra un elemento:

Pulse Ctrl para limitar el movimiento a sólo horizontal.
Pulse Mayús para limitar el movimiento a sólo vertical.

Ajustar a la cuadrícula

Ajustar a cuadrícula es una característica que le permite arrastrar un elemento en pasos exactos para conseguir un
posicionamiento preciso.

Para activar el ajuste a cuadrícula, seleccione un elemento y pulse uno o ambos de los botones ubicados a la derecha de
los desplazamientos X e Y que aparecen en el Inspector. Si a continuación arrastra el elemento, éste se moverá en pasos
determinados por el espaciado de cuadrícula. El valor por defecto es 0.5 sp.

Para cambiar el espaciado de cuadrícula:

1. En el Inspector, haga click con el botón derecho del ratón sobre cualquiera de los botones de Ajustar a cuadrícula y
seleccione Configurar Cuadrícula.

2. Introduzca los valores que requiera para el espaciado horizontal y vertical. Observe que el dato introducido es el
denominador de una fracción.

Temas avanzados

Accesibilidad

Introducción

Este documento fue escrito para usuarios no videntes o con dificultades de MuseScore 2.x. No busca dar una descripción
completa de todas las funciones de MuseScore; debe leer esto en conjunto con la documentación común de MuseScore.
MuseScore tiene soporte para el NVDA screen reader  de código libre y abierto para Windows. Las funciones en este
documento fueros probadas en Windows con NVDA. Por el momento otros lectores de pantalla como el Jaws  para
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Windows, o VoiceOver  para macOS no están soportados, podrían funcionar de una manera distinta o no funcionar del
todo.

En este momento, MuseScore 2.x es usable mas que nada como un lector de partituras, no tanto como un editor. Este
documento se concentrara en las funciones para leer partituras, con una breve descripción de edición de partituras.

Configuración inicial

Cuando ejecute MuseScore por primera vez, es posible que desee desactivar permanentemente la ventana del Centro de
Inicio. Para ello, ir a cerrar el Centro de Inicio de la ventana en primer lugar, a continuación, en el menú Edición (Alt+E),
elija Preferencias, y allí, desactive la opción Mostrar el Centro de Inicio. Guarde y cierre la ventana de preferencias.

Encontrar tu camino

La interfaz de usuario en MuseScore funciona muy parecido a otros programas de notacion musical, y otros programas
orientados a documentos en general. Tiene una ventana de documento principal en la que se puede trabajar con una
partitura. MuseScore soporta múltiples pestañas de documentos dentro de esta ventana. También soporta una vista de
pantalla dividida para permitirle trabajar con dos documentos a la vez, y puede tener varias pestañas en cada ventana.
Además de la ventana de la partitura, MuseScore tiene una barra de menú a la que se puede acceder a través de los
accesos rápidos para los Menús individuales:

Archivo: Alt+F
Editar: Alt+E
Ver: Alt+V
Agregar: Alt+A
Notas: Alt+N
Formato: Alt+L
Estilo: Alt+S
Plugins: Alt+P
Ayuda: Alt+H

De estos, sólo el menú Archivo es de mucho interés cuando se utiliza MuseScore como lector de partitura. Una vez
abierto un menú, puede tomar apretar varias veces la tecla Arriba o Abajo antes de que todo se lea correctamente.

También hay una serie de barras de herramientas, paletas, y subventanas dentro de MuseScore, y puede desplazarse a
través de los controles en estas usando Tabulador (o Shift+Tabulador para desplazarse hacia atrás a través de este mismo
ciclo). Cuando se inicia por primera vez MuseScore, o al cargar una partitura, el enfoque debe estar en la ventana
principal de Partitura. Pulsar Tab le lleva a una barra de herramientas que contiene una serie de botones para
operaciones como Nuevo, Abrir, Reproducir, etc. La pestaña saltará los botones que no estén activos actualmente. Los
nombres y accesos directos (en su caso) para estos botones deben ser leídos por su lector de pantalla.

Una vez que haya atravesado los botones de la barra de herramientas, la siguiente Ventana visitará la paleta. Esto se
usaría para añadir varios elementos a una partitura, pero actualmente no es accesible excepto para dos botones que son
visitados por Tab: un desplegable para seleccionar entre diferentes espacios de trabajo (un arreglo guardado de paletas),
y un botón para crear un nuevo espacio de trabajo.

Si ha abierto una de las ventanas opcionales, como el Inspector, o el Filtro de Selección, la tecla de Tabulación también
las visitará. Puede cerrar las ventanas que no necesita yendo al menú Ver y asegurándose de que no se selecciona
ninguno de los primeros conjuntos de casillas (las ventanas que aparecen antes de la configuración del Zoom). Por
defecto, sólo se debe seleccionar el centro de Inicio, Paletas e Inspector. Consulte Configuración de inicio para obtener
instrucciones para deshabilitar el centro de Inicio. F9 puede ser utilizado para cambiar las Paletas mientras que F8
cambiará el Inspector.

Para volver a enfocar la ventana de partitura después de visitar la barra de herramientas, o una subventana, pulse Esc.
Esto también borra cualquier selección que hayas hecho en la ventana de Partitura.

Ventana de partitura

Cuando empiece por primera vez MuseScore 2.x, una partitura de ejemplo llamada "My First Score” se carga por defecto.
Si desea experimentar con las características de edición, este sería un buen lugar para comenzar. De otra manera, es
probable que desee comenzar por la carga de una partitura. MuseScore utiliza el estándar de accesos directos para
acceder a los comandos del sistema como Ctrl+O (Mac: Cmd+O) para abrir un archivo, Ctrl+S (Mac: Cmd+S) para guardar,
Ctrl+W (Mac: Cmd+W) para cerrar, etc.

Si pulsa Ctrl+O (Mac: Cmd+O) para cargar una partitura, se mostrara un un cuadro de diálogo de archivo bastante estándar.
MuseScore puede abrir partituras en su propio formato (MSCZ o MSCX) así como importar partituras en el formato
MusicXML estándar, en formato MIDI, o de algunos otros programas como Guitar Pro, Capella, y Band-in-a-Box. Una vez
que ha cargado un resultado, se muestra en una nueva pestaña dentro de la ventana de resultados. Puede moverse
entre las pestañas en la ventana de partitura usando Ctrl+Tabulador (no aplica para Mac).

Hay algunas cosas interesantes que puedes hacer con una partitura cargada además de leerla nota por nota. Puedes
pulsar Espacio para que MuseScore toque la partitura. Puede utilizar Archivo / Exportar para convertir a otro formato,

163

https://en.wikipedia.org/wiki/VoiceOver


incluyendo PDF, PNG, WAV, MP3, MIDI, MusicXML, etc. Y, por supuesto, usted puede imprimir a través de Archivo /
Imprimir o Ctrl+P (Mac: Cmd+P).

Si una partitura contiene varios instrumentos, es posible que ya tenga partes enlazadas generadas. Las partes enlazadas
se presentan como pestañas de parte dentro de las pestañas de partitura, pero actualmente, no hay forma de navegar
por estas pestañas de parte usando el teclado. Las partes normalmente no contendrían información diferente de la
partitura; simplemente se mostrarían de manera diferente (cada parte en su propia página). Si una partitura no tiene
partes generadas, puede hacerlo a través de archivo / Partes, y ese diálogo es accesible. Si desea imprimir las partes,
puede solucionar la imposibilidad de acceder a las pestañas de las partes de forma individual mediante el diálogo Archivo
/ Exportar Partes, que automáticamente exporta PDF (u otros formatos) para todas las partes en un solo paso.

Leer partituras

Cuando cargue una partitura por primera vez, la ventana de partitura tendra el foco en el teclado, pero no habrá nada
seleccionado. El primer paso para leer una partitura es seleccionar algo, y el lugar más natural para comenzar es con el
primer elemento de la partitura. Ctrl+Inicio (Mac: Cmd+Inicio) selecciona el primer elemento en la partitura. Probablemente
también querrá usar esto, en caso de que alguna vez despeje su selección pulsando Esc.

A medida que navega entre los elementos, su lector de pantalla debe dar el nombre del elemento seleccionado (muy
probablemente la clave al principio del pentagrama superior de su partitura). Lo oirás leer el nombre del elemento (por
ejemplo, "clave de sol") y también dar información de posición (por ejemplo, "Compás 1; Pulso 1; Pentagrama 1"). La
cantidad de información leída no es actualmente personalizable, pero hemos tratado de colocar lo más importante en
primer lugar para que pueda pasar rápidamente al siguiente elemento antes de que haya terminado de leer, o
simplemente la ignore el resto de lo que se lee. Pulsar Shift actualmente interrumpe la lectura, lo que también podría ser
útil.

La mayor parte de la navegación en MuseScore se centra sólo en las notas y los silencios: saltará las claves, las
armaduras de clave, las indicaciones de compás, las líneas divisorias y otros elementos. Así que si usted sólo tiene que
utilizar las teclas estándar Derecha y Izquierda para moverse a través de su partitura, sólo escuchara acerca de las notas y
silencios (y los elementos vinculados a ellos). Sin embargo, hay dos comandos especiales de navegación que usted
encontrará útil para obtener un resumen más completo de la partitura:

Elemento siguiente: Ctrl+Alt+Shift+Derecha (Mac: Cmd+Option+Shift+Derecha)
Elemento anterior: Ctrl+Alt+Shift+Izquierda (Mac: Cmd+Option+Shift+Izquierda

Estos comandos incluyen claves y otros elementos que los otros comandos de navegación se saltan, y también navegar a
través de todas las voces dentro del pentagrama actual, mientras que otros comandos de navegación, tales como Derecha
y Izquierda sólo navegan a través de la voz actualmente seleccionada hasta que haga explícitamente el cambio de voces.
Por ejemplo, si usted está en una negra en el pulso 1 del compas 1, y hay dos voces, en ese compas, a continuación,
pulsar el botón Derecha y pasará a la siguiente nota de voz 1—que será pulso 2—mientras que pulsando
Ctrl+Alt+Shift+Derecha (Mac: Cmd+Opción+Shift+Derecho) va a permanecer en el pulso 1 sino que se mueve a la nota de la voz 2.
Sólo una vez que se haya movido a través de todas las notas en el ritmo actual en el pentagrama actual, el atajo le
llevará al siguiente compás. La intención es que este atajo sea útil para navegar a través de una partitura si no se sabe ya
cuál es el contenido.

Cuando usted navega hacia un elemento, su lector de pantalla debe leer la información sobre él. Para notas y silencios,
también se leerá información sobre elementos unidos a ellos, como letras, articulaciones, símbolos de acordes, etc. Por
el momento, no hay manera de navegar directamente a estos elementos.
Una nota importante: Arriba y Abajo por sí mismos, con Shift o con Ctrl / Cmd no son accesos directos útiles para la
navegación! En su lugar, cambian el tono de la nota o notas seleccionadas. Tenga cuidado de no editar inadvertidamente
una partitura que está tratando de leerla. Arriba y Abajo sólo se debe usar con Alt/Option si su intención es sólo la
navegación. Consulte la lista de accesos rápidos de navegación a continuación.

Avanzar o retroceder en el tiempo

Los siguientes accesos rápidos son útiles para moverse "horizontalmente" a través de una partitura:

Elemento siguiente: Ctrl+Alt+Shift+Derecha
Elemento anterior: Ctrl+Alt+Shift+Izquierda
Próximo acorde o silencio: Derecha
Acorde o silencio anterior: Izquierda
Próximo compás: Ctrl+Derecha
Compás anterior: Ctrl+Izquierda
Ir a compas: Ctrl+F
Primer elemento: Ctrl+Inicio
Ultimo elemento: Ctrl+Fin

Moverse entre notas en un momento dado

Los siguientes atajos son útiles para mover "verticalmente" a través de una partitura:

Próximo elemento: Ctrl+Alt+Shift+Derecha

164



Elemento anterior: Ctrl+Alt+Shift+Izquierda
Proxima nota mas aguda en la voz actual, voz anterior, o pentagrama encima: Alt+Arriba
Proxima nota mas grave en voz actual, proxima voz, o pentagrama inferior: Alt+Abajo
Nota mas aguda en el acorde: Ctrl+Alt+Arriba
Nota mas grave del acorde: Ctrl+Alt+Abajo

Los comandos Alt+ y Alt+Abajo son similares a los Ctrl+Alt+Shift+Derecha y Ctrl+Alt+Shift+Izquierda los comandos que están
diseñados para ayudarle a descubrir el contenido de una partitura. No necesitas saber cuántas notas hay en un acorde,
cuántas voces hay en un pentagrama, o cuántas pentagramas hay en una partitura para moverse verticalmente a través
de la partitura usando estas órdenes.

Filtrar elementos en la lectura de partitura

Es posible excluir ciertos elementos como las letras o nombres de acordes durante la lectura de la partitura mediante el
filtro de Selección (F6). Desmarque los elementos que no quiere leer.

Reproducir partitura

El Barra espaciadora sirve tanto para iniciar como para detener la reproducción. La reproducción comenzará con la nota
seleccionada si está seleccionada; donde se detuvo la reproducción por ultima vez si no se selecciona ninguna nota; o al
principio de la partitura de la primera reproducción.

MuseScore es compatible con la reproducción en bucle para que pueda repetir una sección de una pieza con fines de
estudio. Para establecer los puntos " in " y " out " para la reproducción en bucle a través del Panel de reproducción
(término kbd>término kbd>F11 término/kbd>término/kbd>):

1. Primero seleccione la nota en la ventana de partitura donde debe comenzar el bucle
2. Vaya al Panel de reproducción y pulse el botón establecer lazo en la posición
3. Volver a la ventana de partitura, vaya a la nota donde desea que termine el bucle
4. Vuelva a cambiar al Panel de reproducción, y presione el botón de alternar la posición del bucle establecido
5. Para activar o desactivar el bucle, presione el botón de alternar la Reproducción del Bucle

También puede controlar la reproducción de bucle y el control de otros parámetros de reproducción, tales como
reemplazar el tempo básico de una partitura, usando el panel de Ver / Reproducir (F11).

Editar partituras

Editar partituras no es actualmente del todo accesible – demasiados elementos de partitura requieren la intervención del
ratón para colocar objetos en una partitura. Además, la referencia visual y el ajuste manual de la posición de varios
elementos es a veces necesaria debido al limitado apoyo de MuseScore para evitar conflictos.

En contraste, MuseScore a menudo proporciona un amplio margen, y una plataforma para experimentar con los
elementos básicos de la entrada de notas.
Para entrar en modo de entrada de notas, primero vaya al compas en la que desea introducir notas, luego pulse "n". Casi
todo lo relacionado con la entrada de notas está diseñado para ser accesible al teclado, y la documentación estándar
debe ser buena para ayudarle a través del proceso. Tenga en cuenta que MuseScore puede estar en la entrada de la
nota o en modo normal, y no siempre estará claro en qué modo de estos se encuentra. En caso de duda, pulse Esc. Si
estabas en modo de entrada de notas, esto te sacará. Si usted estaba en modo normal, usted permanecerá allí, aunque
también perderá su selección.

Personalizar

Puede personalizar los accesos rápidos de teclado usando editar / Preferencias / accesos Rápidos. En algún momento,
podemos ofrecer un conjunto de accesos rápidos de accesibilidad especial y/o una forma de guardar y cargar conjuntos
de definiciones de accesos rápidos.

Enlaces externos

Crear una nueva partitura en MuseScore usando NVDA
Ingresar notas en MuseScore con NVDA
Crear notacion modificada de pentagrama en MuseScore

Albums

The Album feature has been disabled for 3.x. It will come back in 4.0.

The Album Manager allows you to prepare a list of multiple scores and save the list as an album file ("*.album"), print all
the scores as one long print job with consistent page numbers, or even join the scores into a single new MSCZ score.
This is ideal for preparing an exercise book or combining multiple movements of an orchestration.

To open the Album Manager, go to File → Album...
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Create album

1. To create a new album, click the New button. Fill in a title in the "Album Name:" box at the top.
2. To add scores to the album, click Add Score. A file selection dialog will appear and let you choose one or multiple

scores from your file system. Click OK.
3. The scores you add will appear in a list in the Album Manager. You can rearrange their order by selecting a score

and clicking the Up or Down button.

Load album

If you have previously created an album, you can open it through the Album Manager by clicking the Load button. A file
selection dialog will appear to let you load the .album file from your file system.

Print album

To print an album as if it were a single document, click Print Album. The scores loaded into the Album Manager are printed
in the order they are listed in with the correct page numbers, ignoring the page number offset values in Layout → Page
Settings... → First page number for all but the first score. As the album is printed in one print job, double-sided printing (duplex
printing) also works as expected.

Join scores

To combine multiple scores into a single .mscz file, click Join Scores. The scores are combined in the selected order into
one single score. If not already present, line- and section breaks are added to the last measure or frame of each score in
the combined file.
All style settings are taken from the first score, different style settings from subsequent score are ignored.

All the scores should have the same number of parts and staves for this to work correctly, ideally with the same
instruments in the same order. If the scores have the same total number of instruments but not the same ones, or not in
the same order, then the instrument names from the first score will overwrite ones from subsequent scores. If some of the
scores have fewer instruments than the first score, then empty staves will be created for those sections. Any part or staff
that is not present in the first score will be lost in the joined score.

Save album

Upon clicking the Close button, you will be prompted to save your album as a .album file. This file is not the same as a
joined score; it simply consists of the list of scores. Album files can be loaded into the Album Manager as described
above.

Bajo cifrado

Añadir una nueva indicación de bajo cifrado

1. Seleccione la nota a la que desea aplicar el bajo cifrado
2. Pulse el atajo para el Bajo cifrado (por defecto Ctrl+G; puede ser modificado en Preferencias)
3. Introduzca el texto requerido en la 'caja azul' del editor (ver abajo)
4. Pulse Espacio para pasar a la siguiente nota en la que introducir otra indicación de bajo cifrado (o haga click fuera de

la caja del editor para abandonar éste)
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Pulsando Espacio, el editor avanza hasta la nota o el silencio siguiente del pentagrama al que se le está añadiendo el bajo
cifrado. Para desplazarse a un punto intermedio, o para extender la duración de un bajo cifrado, ver más abajo Duración.

Tab avanza la caja de edición al comienzo del compás siguiente.

Mayús+Espacio retrocede la caja de edición a la nota o silencio anterior.

Mayús+Tab retrocede la caja de edición al principio del compás anterior.

Formato de texto

Números

Los números se escriben de forma directa. Para apilar en vertical varios números, basta con utilizar Intro dentro de la caja
de edición:

Alteraciones

Las alteraciones pueden ser introducidas mediante el teclado normal:

Para obtener: escriba:
doble bemol bb
bemol b
becuadro h
sostenido #
doble
sostenido ##

Los caracteres se convertirán en el símbolo correspondiente al abandonar la edición. Las alteraciones pueden escribirse
antes o después de un número (y, por supuesto, en lugar del número, cuando se trata de terceras alteradas), según el
estilo requerido; en cualquiera de los casos, quedarán alineadas correctamente.

Formas combinadas

Los números barrados o con una cruz pueden ser introducidos añadiendo \, / o + tras escribir el número; el símbolo
correspondiente aparecerá al abandonar la edición:
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El tipo de letra incluido en MuseScore gestionará la combinación de signos, favoreciendo la equivalencia más habitual:

1+, 2+, 3+, 4+ se convertirán en  (o )

y 5\, 6\, 7\, 8\, 9\ se convertirán en  (o )

Recuerde que la / sólo puede ser combinada con el 5; cualquier otro símbolo 'barrado' dará lugar a una interrogación.

El signo + puede ser también usado antes de un número; en este caso no se combina con éste, sino que queda alineado
como corresponda.

Paréntesis

Los paréntesis de apertura o cierre, tanto los redondos '(', ')' como los cuadrados '[', ']', pueden ser insertados antes o
después de las alteraciones, antes o después de un número y antes o después de una línea de prolongación; los
paréntesis no afectan a la alineación del carácter principal.

Notas:

El editor no verifica si los paréntesis de apertura y cierre están correctamente equilibrados.
Agregar varios paréntesis en una misma línea se considera incorrecto e impide que MuseScore reconozca
adecuadamente el texto introducido.
Un paréntesis ubicado entre un número y un sufijo ('+', '\', '/') es aceptable, pero impide que ambos símbolos se
combinen.

Líneas de prolongación

Las líneas de prolongación se introducen añadiendo un '_' (guión bajo) al final de la línea. Cada número de un grupo
puede tener su propia línea de prolongación:

Las líneas de prolongación abarcarán la duración total del grupo de bajo cifrado.

Líneas de prolongación 'extendidas'

Ocasionalmente, una línea de prolongación debe conectar con la línea de prolongación del grupo siguiente, debido a que
los dos acordes comparten una de las notas. Ejemplos (pertenecientes a J. Boismortier, Pièces de viole, op. 31, Paris
1730):

En el primer caso, cada grupo tiene su propia línea de prolongación; en el segundo, la línea de prolongación del primer
grupo es 'insertada' en el siguiente.

El esquema se puede obtener escribiendo uno o varios guiones bajos "__" al final de la línea de texto del primer grupo.
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Duración

Cada grupo de bajo cifrado posee una duración, indicada por una línea gris por encima de él. Por supuesto, esta línea es
meramente informativa y no se imprime ni se exporta al generar un PDF .

En principio, un grupo tiene la misma duración que la nota a la que está vinculado. En ocasiones, puede ser necesario
que varios grupos aparezcan bajo una misma nota o que un único grupo se extienda a varias notas.

Para lograrlo, puede utilizar las combinaciones de teclas enumeradas más abajo:

para hacer avanzar la caja de edición la duración indicada
Y
para añadir esa duración al grupo anterior.

Pulsando varias combinaciones en secuencia, sin teclear un nuevo bajo cifrado, extenderá el grupo anterior el valor
acumulado.

Pulse: para obtener:
Ctrl+1 una semifusa
Ctrl+2 una fusa
Ctrl+3 una semicorchea
Ctrl+4 una corchea (quaver)
Ctrl+5 una negra (crochet)
Ctrl+6 una blanca (minim)

Ctrl+7
una redonda
(semibreve)

Ctrl+8 una cuadrada (breve)

(Los números son los mismos que se usan para establecer la duración de una nota)

Establecer la duración exacta de un bajo cifrado sólo es obligatorio en dos casos:

1. Cuando bajo una única nota del pentagrama deben aparecer varios cifrados (no hay otro modo de hacerlo).
2. Cuando se usan líneas de prolongación, ya que la longitud de éstas depende de la duración del grupo.

No obstante, es buena práctica establecer siempre la duración, a efectos de los plugins y del formato MusicXML.

Editar bajos cifrados existentes

Para editar una indicación de bajo cifrado ya existente:

Selecciónela, o seleccione la nota a la que pertenece, y pulse el atajo de teclado usado para crear un Bajo cifrado
o
Haga doble click sobre dicha indicación

Se abrirá la caja de edición habitual, con el texto convertido en caracteres simples ('b', '#' y 'h' para las alteraciones,
sufijos separados, guiones bajos, etc.), con el fin de facilitar la edición.

Una vez editada la indicación, pulse Espacio para avanzar hasta la nota siguiente o haga click fuera de la caja de edición
para abandonar ésta.

Estilo

Para configurar el modo de presentación del bajo cifrado, en el menú, seleccione Formato → Estilo.… → Bajo cifrado.
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Tipografía: La lista desplegable contiene todos los tipos de letra disponibles para el bajo cifrado. La instalación
estándar contiene un único tipo, "MuseScore Figured Bass," que es también el tipo de letra por defecto.
Tamaño: Seleccione el tamaño de la letra en puntos. Nota: Este valor se ve afectado por los cambios que se hagan
en Escalado (Formato → Ajustes de página...), o en Escala ("Propiedades de Pentagrama/Parte").
Posición vertical: La distancia (medida en espacios) desde la parte superior del pentagrama al margen superior
del texto del bajo cifrado. Los valores negativos van hacia arriba (el bajo cifrado se coloca por encima del
pentagrama) y los positivos, hacia abajo (el bajo cifrado se coloca por debajo del pentagrama). Se requiere un valor
superior a 4 para superar la altura del propio pentagrama.

Altura de la línea: La distancia entre líneas de texto del bajo cifrado, expresada como porcentaje del tamaño de
letra.

En la imagen siguiente se describen los distintos parámetros numéricos:

Alineamiento: Con Parte superior, es la línea de arriba de los bajos cifrados la que queda alineada; el resto de las
posibles líneas 'cuelgan' de ella (esta es la manera habitual de mostrar el bajo cifrado y la adoptada por defecto en
MuseScore). Con Parte inferior, es la línea de abajo de los bajos cifrados la que queda alineada; el resto de las
líneas 'se apilan' sobre ella (esta disposición se utiliza a veces en anotaciones de análisis armónico):

Estilo: Elija entre "Moderno" e "Histórico." En la figura de abajo se puede apreciar la diferencia entre ambos:

Sintaxis correcta

Para que las sustituciones o combinaciones de símbolos tengan lugar y el alineamiento de éstos sea el correcto, es
necesario respetar ciertas reglas a la hora de introducir el texto (unas reglas, en cualquier caso, que son las estándar
para la escritura de bajos cifrados):

Sólo puede haber una única alteración (colocada antes o después), o un único sufijo por cifra.
No puede haber a la vez una alteraciónl y un sufijo.
Se puede escribir una alteración sin número (tercera alterada), pero no un sufijo sin número asociado.
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Cualquier carácter fuera de los enumerados más arriba dará lugar a una indicación de error.

Un texto que no respete las reglas sintácticas no será procesado: aparecerá tal cual en la partitura.

Resumen de teclas

Teclee: para:
Ctrl+G Añadir un nuevo bajo cifrado a la nota seleccionada.
Espacio Avanzar la caja de edición a la nota siguiente.
Mayús+Espacio Retroceder la caja de edición a la nota anterior.
Tab Avanzar la caja de edición al compás siguiente.
Mayús+Tab Retroceder la caja de edición al compás anterior.
Ctrl+1 Avanzar la caja de edición una semifusa, incrementando la duración del cifrado anterior.
Ctrl+2 Avanzar la caja de edición una fusa, incrementando la duración del cifrado anterior.

Ctrl+3
Avanzar la caja de edición una semicorchea, incrementando la duración del cifrado
anterior.

Ctrl+4 Avanzar la caja de edición una corchea, incrementando la duración del cifrado anterior.
Ctrl+5 Avanzar la caja de edición una negra, incrementando la duración del cifrado anterior.
Ctrl+6 Avanzar la caja de edición una blanca, incrementando la duración del cifrado anterior.
Ctrl+7 Avanzar la caja de edición una redonda, incrementando la duración del cifrado anterior.
Ctrl+8 Avanzar la caja de edición una cuadrada, incrementando la duración del cifrado anterior.
Ctrl+Espacio Escribir un espacio; resulta útil cuando la cifra aparece "en la segunda línea" (ej. 5 4 -> 3).
BB Escribir un doble bemol.
B Escribir un bemol.
H Escribir un becuadro.
# Escribir un sostenido.
## Escribir un doble sostenido.
_ Introducir una línea de prolongación.
__ Introducir una línea de prolongación extendida.

Diagramas de acorde

Nota: _ Esta página se aplica únicamente a MuseScore 3.1 y posteriores. Los usuarios de versiones anteriores a 3.1
deben dirigirse a diagramas de acorde (anterior a la versión 3.1)._

Diagramas de acorde generalidades

MuseScore permite el uso y la creación de diagramas de trastiera trastiera (o acordes) . Por lo general aparecen por
encima del pentagrama en partituras de cifrado de acorde y partituras de piano. Se utilizan comúnmente para los acordes
de guitarra, pero MuseScore permite la creación de diagramas para cualquier instrumento.

A continuación se muestra un ejemplo sencillo de uso de Diagramas de trastes.

(Nota: los Diagramas de trastes son una alternativa y muy diferente de Tablatura, que es una notación especializada que
es preferida por algunos instrumentistas de cuerda.)

El mecanismo de Diagrama de acorde se puede utilizar de distintas maneras.

1. Acordes estándar. Un conjunto de 21 diagramas de acordes comunes para la guitarra se encuentran en los
Diagramas de trastes paleta en el espacio de trabajo Avanzado. Estos consisten en un solo ejemplo de un acorde
mayor, menor, y séptima para cada tono de la escala diatónica (CDEFGAB). Estos 21 acordes son adecuados para
muchas partituras simples de música pop o folk. Vea la vista general de esta paleta abajo.
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2. Acordes modificados. En muchos casos, los acordes estándar de la paleta Diagramas de acordes se utilizan
como punto de partida para crear diagramas de acordes modificados, a través del Inspector. Esta técnica permite
extensiones de acordes, alteraciones, diferentes vocaciones, diferentes posiciones, etc. se aplicará a los 21
diagramas normalizados. Hay descargas de miles de acordes de guitarra en el uso general, haciendo una paleta
completa o un diccionario poco practico. Ver cómo usar Diagramas de trastas para acordes
personalizados/complejos  para ejemplos.

3. Acordes de "mano libre". Los guitarristas más avanzados a menudo prefieren comenzar desde una rejilla de cuerda
en blanco, y luego dibujar los tonos de cuerda específicos deseados. Ver cómo usar Diagramas de trastes para
acordes personalizados/complejos  para ejemplos.

Nota: Muchos aspectos de la música culminaron siguiendo estándares de notación musical bien establecidos. Los
diagramas de acordes de guitarra son una excepción. El uso ha variado ampliamente de año en año, de editor en editor,
de maestro en maestro, y de arreglador en arreglador. Muchas prácticas inconsistentes persisten hoy en día, y diferentes
estilos de diagramas de acordes son preferidos en diferentes géneros musicales y regiones. Por esta razón, la interfaz de
diagrama de diagrama MuseScore soporta diagramas de varios tipos. Los usuarios son libres de elegir sus preferencias.

Vista general de la paleta de acordes de guitarra estándar

Los Diagramas de traste paleta en el Espacio de trabajo Avanzado proporcionan 21 diagramas, que comprenden un solo
acorde mayor, menor y séptima para cada tono diatónico de escala (CDEFGAB). El nombre de cada diagrama aparece
cuando el cursor se cierne sobre la entrada.

Note: esta gama de diagramas de acordes, o de hecho cualquier selección de 21 acordes, normalmente no sería
suficiente para propósitos de publicación. Los arregladores deben considerar muchas otras cualidades de voz, posición y
acorde. Esta paleta es también un ejemplo de los diversos formatos de diagrama en uso, como se discutió anteriormente.
Estos 21 acordes suelen incorporar indicaciones de al aire/tapas indicadores de cuerda _ (los símbolos de X y O por
encima de los diagramas). Aunque esos símbolos suelen a menudo aparecer en partituras publicadas, su uso varía
según el contexto. Por ejemplo, los arreglos de jazz generalmente omiten indicadores de cuerda tapada, a menos que
sean contextualmente importantes, y rara vez usan al aire.

Se espera que en el futuro se disponga de paletas adicionales que contengan una gama más amplia de acordes
estándar. Estos tratarían de satisfacer las necesidades de géneros musicales y situaciones específicas.

Visión general de la creación de acordes modificados o personalizados

Los Diagramas de trastes modificados se crean mediante agregar y luego [editando] (#edit-fretboard-diagram) un
diagrama existente de la paleta. Mediante la modificación de los acordes estándar, es posible crear Diagramas de trastes
para cualquier acorde reproducible, y para reflejar la digitación en cualquier instrumento de cuerda con trastes
occidentales, sin tener en cuenta la afinación, el número de cuerdas, o el número de trastes. La mayor parte del material
a continuación trata sobre el proceso de modificar diagramas y crear diagramas nuevos.

Los diagramas personalizados se pueden guardar en un paleta personalizada si se desea para uso futuro. Los diagramas
modificados pueden por supuesto ser copiados / pegados dentro de una partitura de las maneras usuales.

Para añadir un Diagrama de acorde

Para añadir un Diagrama de acorde a la partitura, utilice uno de los siguientes métodos::

Seleccione una nota en la voz 1 y haga doble clic en un Diagrama de acorde desde el Paletas.
Apriete y suelte un Diagrama acorde de una paleta a la posición deseada en la partitura.

A medida que el cursor se desplaza sobre el diagrama elegido dentro de la paleta, su nombre aparecerá como una
indicación emergente (vea el ejemplo en vista general).

Simbolo de acorde anclado a diagrama de acorde

Cuando se añade un diagrama de acorde a una partitura,también se crea automáticamente un símbolo de acorde. El
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símbolo del acorde se coloca normalmente sobre el diagrama, y usa el nombre del acorde de la celda de la paleta del
acorde. La colocación automática y el formato de un símbolo de acorde de diagramas se controla mediante ajustes de
estilo (ver ajustes de estilo) (#fretboard-diagram-style).

Un símbolo de acorde generado por diagrama de acorde puede ser seleccionado, movido y modificado como cualquier
otro elemento de texto. Se comporta generalmente como los símbolos de acorde comunes que se agregan utilizando
Añadir→Texto→Símbolo de Acorde o el acceso directo Ctrl+K.

Note 1: A field on the Chord Symbols style page (Style submenu: select Format→Style…→Chord symbols) – rather than on
the Fretboard Diagrams style page – controls the chord symbol's "Distance to Fretboard Diagram". This value interacts
with the Element "Minimum distance" field, within the Inspector, to control automatic placement of the chord symbol
relative to the diagram. Note also that the Fretboard Diagram's "top edge" includes the blank space where open/mute
string indicators would appear, even if that area is empty. This may leave a larger gap than is desired. As usual, manual
placement can be used to override the automatic settings.

Note 2: los símbolos de acordes automáticos generados para diagramas de acorde no están completamente integrados
con Símbolos de Acordes normales que pueden estar directamente asociados con las notas del pentagrama.
Específicamente, la seleccion no fluye del símbolo del acorde de un Diagrama de acorde de regreso a la secuencia de
otros símbolos en la página cuando se usa Barra espaciadora para moverse a través de los símbolos del acorde. Esta
pequeña cuestión se abordará en una futura actualización.)

Uso de Cifrados con el Diagrama de Acorde

Agregue un Cifrado de acorde automáticamente con solo añadir un Diagrama de Acorde como se describe
anteriormente.
Borrar el cifrado de un Diagrama de Acorde seleccionando el cifrado y borrandolo como haria con cualquier
objeto.
Agregue un nuevo cifrado a un diagrama que no lo tenga seleccionando el Diagrama de acorde y usando
Agregar→Texto→Cifrado de acorde o el atajo Ctrl+K.

To adjust a Fretboard Diagram's element properties (position, color, stacking order...)

The position of a Fretboard Diagram can be adjusted using the keyboard arrows in Edit mode; or with the X- and Y-
offsets in the "Element" section at the top of the Inspector.

Visibility, Color and Stacking order can also be adjusted in the "Element" section: see the diagram under editing.

To adjust global/default Fretboard Diagram style properties
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Certain default and global properties of Fretboard Diagrams (see diagram below) can be adjusted from the Style
submenu: select Format→Style…→Fretboard Diagrams. Some of these properties are subject to override via the Inspector; but
most affect all Fretboard Diagrams in the score.

Default vertical position specifies the default placement of the diagram relative to the staff. (Subject to override via
Inspector).
Scale specifies the default scale (i.e. diagram size). (Subject to override via Inspector).
Fret number font size and ...position control placement of fret numbers on all diagrams. (Global).
Barre line thickness controls how large a line is used to represent a barre on all diagrams. By default, this is the
same thickness as the solid dots. A smaller line will allow dots to be visible under the barre, for situations where that
is desirable. (Global).
Relative dot size controls the size of dots on all diagrams, relative to the size of the scaled grid. (Global).
String spacing controls the spacing between strings, and thus the total width of all diagrams. (Global).
Fret spacing controls the spacing between frets, and thus the total height of all diagrams relative to the number of
frets they each display. (Global).

Most Fretboard Diagram properties exposed by the Inspector offer "reset to style default" and "save as style default"
buttons. These values do not typically appear on the style page, but are manipulated via the Inspector.

To edit a Fretboard Diagram

When a Fretboard Diagram is selected, it can be edited in the Inspector as follows:

The Inspector displays three sections related to the Fretboard Diagram:

An Element section that controls the Fretboard Diagram's visibility, placement, color, and other aspects that are
used in common with other MuseScore elements; see adjust element properties and the Inspector for details.
A Fretboard Diagram section, with control fields and buttons that define the appearance of this diagram.
A magnified version of the Fretboard Diagram, showing its details and allowing editing.

Below is an example of the Inspector with a Fretboard Diagram selected.
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Editing Fretboard Diagram properties

(See Inspector properties above in the editing example.)

To adjust the scale (size) of the diagram: Use Scale.
To adjust the diagram's placement relative to the staff: Use Placement.
To adjust the number of instrument strings: Use Strings. Strings are added/removed from the left side of the
diagram.
To adjust how many frets to display (i.e. the height of the diagram): Use Frets. Frets are added/removed from the
bottom of the diagram.
To adjust the first fret position: Use Fret number. A digit is shown next to the first visible fret.
To specify thickening of the nut (a heavy line above the first fret): Use Show nut.
Place the finger dots as described below.

Finger dot editing (basic use)

(See Inspector properties above in the editing example.)

To remove all current dots, use the "Clear" button above the diagram. (Note: you could save a blank grid in a
custom palette, as a starting point for custom diagrams.)
To create a dot, click on a fret in the diagram at the bottom of the inspector; click again to remove the dot.
To move a dot, clear its current position by clicking on it; then create the desired dot.
To create a barre or partial barre: Click the "Barre" button above the diagram; then click at the leftmost position
desired for the barre. The barre will extend to the right edge of the fretboard. Keyboard shortcut: Holding the Shift
key, click on the string where you want a barre to begin.
To end a barre before the rightmost string: Click the "Barre" button above the diagram; then click at the rightmost
position desired on an existing barre. The barre will end at that string. Keyboard shortcut: Holding the Shift key,
click on the string where you want a barre to end.
To delete a barre: Click the "Barre" button above the diagram; then click at the leftmost position of the barre. It will
be removed. Keyboard shortcut: Holding the Shift key, click on the leftmost position of the barre.
To create multiple barres: Use the above steps to create one than one barre, e.g. to show the third finger covering
two strings.
To adjust the barre thickness: Use the Style options (Format->Style->Fretboard Diagrams) to adjust the barre line
thickness relative to the dots. This will allow dots to be visible on the barre, for cases where that is desired.
To Indicate open and mute strings (optional). Click just above the diagram to toggle a string between:
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Open (o)
Mute/unplayed (x)
No indication

Finger dot editing (advanced use)

Some arrangers and educators use a more advanced form of Fretboard Diagram that a) incorporates multiple types of
"dot", and that b) allows multiple dots per string.

This technique is particularly associated with the many books and arrangements published by Ted Greene and his
successors. (Note: No other notation software currently supports this diagram style.)

Multi-dot notation style. With this approach, the round dots are played first. Then, on successive beats, the notes
represented by the other dots are then played in order. This allows a single diagram to represent several beats of
music. (The usual sequence is: dot→X→square→delta. Usage varies however.) Here are two examples of multi-dot
diagrams.

Optional-note notation style. Another use of multiple dots per string allows other symbols to show optional notes,
rather than delayed notes. Typically, a related chord voicing is shown, such as an optional extension or an optional
rootless chord version. Here is an example of an optional extension.

MuseScore Fretboard Diagrams allow the creation of these and other types of multi-symbol diagrams. A chord is first
created and edited using the basic steps described above. Then, the multiple dot buttons above the diagram are used to
add secondary notes.

1. To begin adding multiple dots (i.e. symbols) to a diagram, click "Multiple dots".
2. To add another dot to a string, click above or below an existing symbol. The next symbol in sequence will be

placed at that position, e.g. if there is already a dot, an X will appear next.
3. To remove any symbol from a diagram, click on it.
4. To enter a particular symbol out of sequence, click on the button with that symbol before adding the dot; e.g. to

enter an X on a string with no current dots, because that note should be played after the rest of the chord, click on
the X and then place it as desired.

(Note: Experienced users of Ted Greene style diagrams will find that several secondary features from Ted's diagrams are
not yet supported in MuseScore. These include: a. Displaying the fret number on a higher fret than the first visible fret. b.
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Allowing the note symbols to include digits, not just the four dot styles currently supported. c. Allowing the creation of
annotation on and between diagrams, such as circling a particular note, or drawing lines linking notes in adjacent
diagrams. However, MuseScore does provide many tools for drawing and annotation that can serve in place of these
techniques.)

(Note: Because multi-note symbols are not standardized, even within the Ted Greene community, users must be careful
to indicate how they are being used within a given score.)

External links

How to use Fretboard Diagrams for custom/complex chords

Fretboard diagrams (prior to version 3.1)

Note: This page applies to versions of MuseScore prior to 3.1 only. Users of MuseScore 3.1 and above should go to
Fretboard diagrams.

A range of fretboard (or chord) diagrams for the guitar are provided in the Fretboard Diagrams palette in the Advanced
Workspace.

You can create a chord diagram for any fretted, stringed instrument by editing an existing one. It can be saved to a custom
palette for future use if required.

Add a fretboard diagram

To add a fretboard diagram to the score, use one of the following methods:

Select a note in voice 1 and double-click a fretboard diagram from a palette.
Drag and drop a fretboard diagram from a palette to the desired position in the score.

As the cursor hovers over the chosen diagram within the palette, its name will appear as a pop-up hint.

Edit a fretboard diagram

When a fretboard diagram is selected, it can be edited in the Inspector as follows:

To adjust the number of instrument strings: Use Strings.
To adjust the fret position number: Use Offset.
To adjust how many frets to display (height-wise): Use Frets.
To place the finger dots: Click on a fret to establish a dot; click again to remove the dot.
To create a barre or partial barre: First make sure that the desired fret position is clear of black dots (click on a dot
to remove it). Then, holding the Shift key, click on the string where you want the barre to begin. (Note: Only one barre
can be applied per diagram; a partial barre must end on the first string).
To delete a barre: Click on the black dot where the barre begins.
To Indicate open and mute strings (if applicable): Click just above the diagram to toggle a string between:

Open (o)
Mute/unplayed (x)
No indication.

To adjust the size: Use the Scale property.

To adjust a diagram's element properties

The position of a Fretboard Diagram can be adjusted using the keyboard arrows in Edit mode; or with the X- and Y-
offsets in the "Element" section at the top of the Inspector.

Visibility, Color and Stacking order can also be adjusted from the "Element" section.

To adjust a diagram's style properties

Certain default and global properties of Fretboard Diagrams (e.g. barre thickness, vertical position, scale, fret-number
font-size and position) can be adjusted from the Style submenu: select Format→Style…→Fretboard Diagrams. Some of these
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properties are subject to override via the Inspector; but most affect all Fretboard Diagrams in the score.

File formats

MuseScore can import and export a wide variety of file formats, allowing you to share and publish scores in the format that
best meets your needs.

MuseScore native format

MuseScore saves files in the following native formats:

*.mscz: The default MuseScore file format. Being compressed it takes up relatively little disk space.
*.mscx: An uncompressed MuseScore file format, mainly used for debugging or storing in a versioning system
.*.mscz, / .*.mscx,: These are backup files. Notice the point (full stop) added before the file name, and the comma
added to the file extension.

A note about fonts: MuseScore does not embed text fonts in saved or exported native format files. If you want your
MuseScore file to be viewed by other MuseScore users, make sure you are using the built-in Edwin (since version 3.6),
FreeSerif, or FreeSans font families for your text, or a font that the other parties have installed too. If a system does not
have the fonts specified in your original file, MuseScore will use a fallback option, which may cause your score to appear
differently.

MuseScore format (*.mscz)

MSCZ is the standard MuseScore file format and recommended for most uses. A score saved in this format takes up very
little disk space, but preserves all the necessary information. The format is a ZIP-compressed version of .mscx files and
includes any images the score may contain and a thumbnail.

Uncompressed MuseScore format (*.mscx)

MSCX is the uncompressed version of the MuseScore file format. A score saved in this format will retain all information,
except images. It can be opened with a text editor, allowing the user access to the file's source code.

MuseScore backup file (.*.mscz,) or (.*.mscx,)

Backup files are created automatically and saved in the same folder as your normal MuseScore file. The backup copy
contains the previously saved version of the MuseScore file and can be important if your normal copy becomes corrupted,
or for looking at an older version of the score.

The backup file adds a period to the beginning of the file name (.) and a comma (,) to the end (e.g. if your normal file is
called "untitled.mscz", the backup copy will be ".untitled.mscz,"), and the period and comma need to be removed from the
name in order to open the backup file in MuseScore. As it is stored in the same folder as your normal MuseScore file, you
may also need to give it a unique name (e.g. changing ".untitled.mscz," to "untitled-backup1.mscz").

Note: In order to see the MuseScore backup files, you may need to change your system settings to "Show hidden files".
See also How to recover a backup copy of a score .

Graphic files (export only)

MuseScore can export a score as a graphic file in either PDF, PNG or SVG format.

PDF (*.pdf)

PDF (Portable Document Format) files are ideal for sharing your sheet music with others who do not need to edit the
content. This is a very widely-used format and most users will have a PDF viewer of some kind on their computers.

To set the resolution of exported PDFs:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the resolution in the "PDF" section.

PNG (*.png)

PNG (Portable Network Graphics) files are based on a bitmap image format, widely supported by software on Windows,
Mac OS, and Linux, and very popular on the web. MuseScore creates PNG images as they would appear if printed, one
image per page.

To set the resolution of exported PNG images:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the resolution and transparency in the PNG/SVG section.
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Note: If you want to create images that show only parts of the score (with or without screen-only items such as frame
boxes, invisible notes, and out-of-range note colors), use Image capture instead.

SVG (*.svg)

SVG  (Scalable Vector Graphics) files can be opened by most web browsers (except Internet Explorer before version 9)
and most vector graphics software. However, most SVG software does not support embedded fonts, so the appropriate
MuseScore fonts must be installed to view these files correctly. SVG is the current format for all scores saved on
MuseScore.com.

To set resolution and transparency of exported SVG files, see the instructions under PNG (above). Note that MuseScore
does not (yet) support gradients on export (although it does for images in a score).

Audio files (export only)

MuseScore can create normalized, stereo audio of the score in any of the following formats: WAV, MP3, OGG VORBIS,
FLAC. To export an audio file:

1. From the menu, select File → Export...;
2. Choose the desired format from the dropdown menu, then press Save.

You can adjust the sample rate of all audio formats as follows:

1. From the menu bar, select Edit→Preferences... (Mac: MuseScore→Preferences...), and click on the Export tab;
2. Set "Sample rate" in the "Audio" section.

WAV audio (*.wav)

WAV (Waveform Audio Format) is an uncompressed sound format. This was developed by Microsoft and IBM, and is
widely supported by software for Windows, OS X, and Linux. It is an ideal format for use when creating CDs, as full sound
quality is preserved. For sharing via email or the internet, use a compressed alternative such as MP3.

MP3 (*.mp3)

MP3 is a very widely-used compressed audio format. MP3 files are ideal for sharing and downloading over the internet
due to their relatively small size.

To set the MP3 bitrate:

1. From the menu bar, choose Edit→Preferences... (Mac: MuseScore→Preferences...), and select the "Export" tab;
2. Set the MP3 bitrate in the "Audio" section.

FLAC audio (*.flac)

Free Lossless Audio Codec  (FLAC) is compressed audio format. FLAC files are approximately half the size of
uncompressed audio and just as good quality. Windows and OS X do not have built-in support for FLAC, but software
such as the free and open source VLC media player  can play FLAC files on any operating system.

Ogg Vorbis (*.ogg)

Ogg Vorbis  is intended as a patent-free replacement for the popular MP3 audio format (which MuseScore also supports
—see above). Like MP3, Ogg Vorbis files are relatively small (often a tenth of uncompressed audio), but some sound
quality is lost. Windows and OS X do not have built-in support for Ogg Vorbis. However, software such as VLC media
player  and Firefox  can play Ogg files on any operating system.

Share with other music software

MuseScore can import and export MusicXML and MIDI files; it is also able to import a variety of native format files from
other music notation programs.

MusicXML (*.musicxml, *.xml)

MusicXML  is the universal standard for sheet music. It is the recommended format for sharing sheet music between
different scorewriters, including MuseScore, Sibelius, Finale, and more than 100 others. MuseScore imports *.xml and
*.musicxml, exports *.musicxml, and the outdated *.xml(since version 3.5) because the program you want to import it needs
that, in previous MuseScore version you need to rename it yourself after the export.

Compressed MusicXML (*.mxl)

Compressed MusicXML creates smaller files than regular MusicXML. This is a newer standard and isn't as widely
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supported by older scorewriters, but MuseScore has full import and export support.

MIDI (*.mid, *.midi, *.kar)

MIDI (Musical Instrument Digital Interface) is a format widely supported by sequencers and music notation software. For
details of the protocol see the MIDI Association  website.

MIDI files are very useful for playback purposes but contain little in the way of score layout information (formatting, pitch
spelling, voicing, ornaments, articulations, repeats, key signatures etc.). To share files between different music notation
software, MusicXML is recommended instead.

For details about how to import MIDI files see MIDI import.

MuseData (*.md) (import only)

MuseData  is a format developed by Walter B. Hewlett beginning in 1983 as an early means of sharing music notation
between software. It has since been eclipsed by MusicXML, but several thousand scores in this format are still available
online.

Capella (*.cap, *.capx) (import only)

CAP and CAPX files are created by the score writer, Capella . MuseScore imports version 2000 (3.0) or later fairly
accurately.

Bagpipe Music Writer ( *.bww) (import only)

BWW files are created by the niche score writer, Bagpipe Music Writer .

BB (*.mgu, *.sgu) (import only)

BB files are created by the music arranging software, Band-in-a-Box . MuseScore's support is currently experimental.

Overture (*.ove) (import only)

OVE files are created by the score writer Overture . This format is mainly popular in Chinese-language environments,
such as Mainland China, Hong Kong, and Taiwan. MuseScore's support is currently experimental and seems to support
Overture 3 and later only.

Guitar Pro (various—import only)

MuseScore can open Guitar Pro  files with the following extensions: *.gtp, *.gp3, *.gp4, *.gp5, *.gpx, and, as of version
3.5, *.gp.

Power Tab Editor ( *.ptb) (import only)

PTB files are created by Power Tab Editor . MuseScore's support is currently experimental.

See also

Open/Save/Export/Print
Recovered files

External links

How to recover a backup copy of a score  (MuseScore HowTo)

Funcionalidades para música antigua

MuseScore ofrece diversas funciones especializadas para crear partituras de música antigua (en particular, medieval y
renacentista) similares a las ediciones comerciales realizadas desde el siglo XX en adelante.

Notación sin compás

En MuseScore, las notas cuya duración excede la del compás aparecen normalmente fraccionadas y ligadas entre
compases. Sin embargo, MuseScore dispone de una funcionalidad que permite que esas notas aparezcan tal cual, sin
fraccionamientos ni ligaduras. Ello permite escribir música sin barras de compás (es decir, no dividida en compases),
como se hacía en el Renacimiento:

1. En el menú, seleccionar Formato→Estilo...→Partitura.
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2. Active la casilla "Mostrar figuras que atraviesan la barra de compás"

3. Pulse "Aceptar" or "Aplicar." La partitura existente se actualizará de inmediato.

Ejemplo

1. El ejemplo de abajo muestra un fragmento de la partitura original de "De Profundis Clamavi", para 4 voces, de
Champion:

2. El mismo fragmento, en MuseScore:

3. Idem, tras activar la casilla "Mostrar figuras que atraviesan la barra de compás"

4. Para ocultar las barras de compás, desactive simplemente la casilla “Mostrar barras de compás” en la ventana de
Propiedades de Pentagrama/Parte. Ver también Mensurstrich (más abajo).

Nota: Esta funcionalidad está todavía en desarrollo y puede presentar errores. La duración de nota más larga soportada
es la longa (una longa con puntillo será fraccionada y ligada entre dos compases).

Mensurstrich

Como la total ausencia de barras de compás puede hacer que la interpretación resulte más dificultosa para los músicos
actuales, muchos grabadores modernos han adoptado una variante, denominada Mensurstrich, en la que las barras de
compás aparecen entre los pentagramas, pero sin cruzar éstos:

Para colocar barras de compás entre pentagramas:

1. En el pentagrama por debajo del Mensurstrich deseado, deseleccione la casilla "Mostrar barras de compás" en la
pantalla Propiedades de Pentagrama/Parte;

2. En el pentagrama por encima del Mensurstrich deseado, haga click con el botón derecho del ratón sobre una barra
de compás y elija Seleccionar→Todos los elementos similares en el mismo pentagrama ;

3. En la sección Barra de compás del Inspector, active la casilla "Extender al pentagrama siguiente";
4. En la sección Barra de compás del Inspector, ajuste el valor del parámetro "Abarcar desde" de manera que el

extremo superior de las barras de compás toque la línea inferior del pentagrama;
5. Repita la operación para otros pentagramas, según se requiera.

Ámbito

Antes de que existiera el concepto de afinación absoluta, los intérpretes debían transportar "sobre la marcha" la música
vocal a una tesitura ejecutable por parte de sus conjuntos. Para ayudarles en esta tarea, a veces se incluía al principio de
la pieza una indicación de ámbito, en la que aparecen las notas extremas que demanda el pentagrama para la voz
correspondiente.
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Para incluir un ámbito en un pentagrama puede hacer uso de uno de estos métodos:

Arrastre el símbolo de ámbito desde la paleta Líneas del espacio de trabajo Avanzado y suéltelo sobre la clave del
pentagrama.
Seleccione una clave y, a continuación, haga doble click sobre el símbolo de ámbito (en la paleta Líneas del
espacio de trabajo Avanzado).

El ámbito mostrará automáticamente la gama de notas que abarca el pentagrama en el que aparece. En el caso de que
exista un salto de sección, sólo mostrará la gama de notas de esa sección. Si se desea mostrar el ámbito de las
secciones sucesivas, tendrá que repetir la operación para ellas.

La gama de notas de un ámbito puede ser ajustada manualmente. Para ello, selecciónelo y cambie los valores de "Nota
superior" y "Nota inferior" mediante el Inspector. Para un ajuste automático, pulse Actualizar rango en el inspector.

Indicaciones mensurales de compás

En el sistema de notación mensural, las indicaciones de compás no definían la duración de un compás, sino la de la
breve (la cuadrada) o la semibreve (la actual redonda). MuseScore soporta símbolos de notación mensural como
"Apariencia" en la pantalla de Propiedades de la indicación de compás, pero la proporción entre, por ejemplo, blancas y
redondas no puede ser modificada.

Una forma de utilizar esos símbolos es imitar a los compositores renacentistas que hacían uso de varias voces con
distintas indicaciones de compás, sin recurrir a grupos irregulares. Edite la indicación de compás de cada pentagrama,
asegurándose de que el principio y el final de compás de todos los pentagramas coincide. En caso necesario, aumente la
duración del compás al mínimo común múltiplo.

De Profundis Clamavi para 5 voces, de Josquin Des Prez

Ver también

Operaciones de compás: Dividir y unir

Layer (experimental)

This feature is still experimental and only visible if MuseScore is started using the '-e' option, see Command line options

For the Open-Goldberg project, the ability to create different versions of the score was needed. One version is the
"Urtext", a score which is close to the original version of Bach. A second version could be a Czerny variation, which in
addition to the Urtext, contains fingerings.

The layer feature allows creating different versions out of one score file. If you want to add fingerings, you have to create a
layer and tag the fingering elements with the layer name.

First, create layers:
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Second, create a score variant:

Add the visible layer to the score variant, then select all fingerings and tag them with the name of the score variant:

Default layer:
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Czerny layer:

See also

Command line options

MIDI import

MuseScore can import MIDI files (.mid/.midi/.kar) and convert them into music notation.
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To import a MIDI file, use the standard Open command. This converts the MIDI file into a MuseScore file (.mscz)
and applies the default quantization settings.

The MIDI Import Panel appears at the bottom of the screen: you can expand this by dragging the interface with the
document window upwards. The panel shows all the tracks in the file (only those with note events are shown) and allows
you to adjust parameters affecting the conversion process. If there are multiple tracks, then one more track is added at
the top of the list to select all tracks at once.

To accept the default conversion: Simply press the "X" symbol on the top-left of the Import Panel to close it. The
panel can be re-opened at any time during the session by pressing "Show MIDI import panel" at the bottom of the
document window.

To reimport the file: Adjust the desired parameters in the Import Panel (see below) and press Apply. If you have
made changes to the Import Panel but wish to UNDO them, press Cancel. To close the Import Panel, press the "X"
symbol at the top-left of the panel.
If you reimport the file after making changes to the temporary generated result score, MuseScore will prompt you
what should happen with that modified score: Save it somewhere, Discard it or Cancel. The Save option will save the
modified score as a Musescore file in your \bin directory without modifying the original MIDI file. It will then reimport
the original MIDI file and apply the import panel settings. The import panel settings are NOT applied to the saved
file. The Discard option will UNDO your changes to the Musecore file, then reimport the original MIDI file and apply
the new settings. The Cancel option will reimport the original MIDI file in the first tab and apply any import panel
setting then create a new tab with your modified score but without applying any import panel settings. The second
tab is the same as hitting SAVE, then opening the saved file. Therefore, you cannot apply import panel settings to a
user modified score. You must first apply the import panel settings, make any changes to the score, then save the
score using the standard Save command.

Mouse wheel scrolling (MIDI Import Panel): Vertical scrolling is the default. For horizontal scrolling, press Shift or Ctrl
while using the wheel.

Available operations

MuseScore instrument
Assign a MuseScore instrument (listed in instruments.xml or in specified custom xml file in Preferences) that defines
staff name, clef, transposition, articulations, etc.

Quantization

Quantize MIDI notes by some regular grid. The grid MAX resolution can be set via the drop-down menu:

Value from preferences (default) - quantization value is taken from the main Preferences dialog of MuseScore
(in the “Import” tab)
Quarter, Eighth, 16th, 32nd, 64th, 128th - user-defined values

However, the actual quantization grid size is adaptive and reduces when the note length is small, so for each note
the quantization value is different. But there is an upper limit for the quantization value, and that value can be set by
the user as "max. quantization".
For example, if some note is long - say, half note, and the max. quantization is set to 8th, then the note will be
quantized with the 8th-note grid, not the half- or quarter-note grid as it supposed to be by the algorithm.
Such quantization scheme allows to quantize all notes in the score (with different lengths!) adequately.

Max. voices
Sets maximum count of allowed musical voices.

Search tuplets
When enabled, this option attempts to detect tuplets and applies the corresponding quantization grid to the tuplet
chords.

Is human performance
If enabled, this option reduces the accuracy of MIDI-to-score conversion in favor of readability. It is useful for
unaligned MIDI files, when no regular quantization grid is provided. For such files the automatic beat tracking
algorithm is used which tries to detect the bar positions throughout the piece.

2x less measure count
The option is active for unaligned MIDI files (when "Is human performance" is checked by default). It halves measure
count obtained in the internal beat tracking operation. It may be convenient when the beat tracking gives 2x more
frequent bar subdivision than necessary.

Time signature
The option is active for unaligned MIDI files. The user can choose an appropriate time signature for the whole piece
if the default detected value is wrong. The option is useful because it handles imported tuplets correctly unlike the
direct time signature setting from the palette.
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Split staff
This option is suited mainly for piano tracks - to assign notes to the left or right hand of the performer. It uses
constant pitch separation (the user may choose the pitch via sub-options) or floating pitch separation (depending on
the hand width - sort of a guess from the program point of view).
For drum tracks (“Percussion” sound in the track list) it splits the staff into multiple staves, each of which gets only
one drum pitch (i.e. drum sound). There is also a sub-option to allow/disallow the application of the square bracket
for the newly created set of drum tracks.

Clef changes
Small clefs can be inserted within a staff to keep chords closer to the 5 staff lines. Clef changes depend on the
average pitch of the chord. Tied groups of notes are not broken by the clef insertion (if it occurs, one can report a
bug for algorithm in importmidi_clef.cpp). This option is available for non-drum tracks only.

Simplify durations
Reduces number of rests to form more "simple" note durations. For drum tracks this option can remove rests and
lengthen notes as well.

Show staccato
Option to show/hide staccato markings in the score.

Dotted notes
Controls whether MuseScore will use dotted notes or ties.

Show tempo text
Shows/hides tempo text markings in the score.

Show chord names
Shows/hides chord names in the score, if any, for XF MIDI file format.

Recognize pickup measure
When enabled, this option doesn't change the time signature of the first bar that is shorter than the second bar. It is
also called anacrusis. This option is only available for all tracks at once.

Detect swing
MuseScore tries to detect swing, and automatically replace a pattern of 4th + 8th notes in triplets (for the most
common swing feel, 2:1), or a dotted 8th + 16th pattern (for shuffle, 3:1), with two straight 8ths and a “Swing” or
“Shuffle” text at the beginning.

Master palette

The Master Palette is a repository of symbols used to populate the workspaces (Basic, Advanced, and Custom). It is also
used to create new Time Signatures and Key Signatures.

To open, use either of the following options:

Press Shift+F9 (Mac: fn+Shift+F9).
From the menu, select View → Master Palette.

The Master palette is divided into sections based on symbol type. Hovering the mouse over an item shows a tool tip (a
short definition in black on yellow background).

To transfer a Master palette item to a custom palette:

Drag the symbol from the Master Palette window into a custom palette.

Note: Except for the Symbols section (below), it is not usual to add items directly to the score from the Master palette: use

186



the workspace palettes instead. However, if desired, items can be added directly using either (i) drag-and-drop or (ii) by
selecting one or more notes/rests and double-clicking the item.

Symbols

The Symbols section of the Master Palette is a large repository of hundreds of musical symbols in addition to those found
in the preset workspaces. You can open it from the Master Palette, or directly from the score by using the shortcut Z.

Find a symbol

The Symbols subcategories can be displayed by clicking on "Symbols". Use the font menu on the bottom right of the box
to specify Emmentaler-, Gonville- or Bravura-specific symbols. You can search for a particular symbol by entering a
keyword in the search box.

Apply a symbol

To add an item to the score from the Symbols section, use any of the following options:

Drag and drop a symbol onto a staff.
Select a note or rest and double-click a symbol.

The position of the symbol can be adjusted by dragging or by changing the horizontal / vertical offsets in the Inspector.
Color and visibility can also be adjusted in the Inspector.

Note: Elements from the Symbols section do not follow any positioning rules (in many cases unlike identical elements
from other sections of the Master Palette), nor do they affect score playback.

Connect symbols

Elements from the Symbols section can be connected to each other on the score page, so that they can be moved as one
unit:

1. Apply first symbol to the score. Adjust position as required.
2. Double-click, or drag-and-drop, a second element onto the first symbol. Adjust position as required.

Drag the first element and the attached element will follow.

See also

Palettes and workspaces
Symbols and special characters (add musical symbols to text objects)

Notación de pentagrama cruzado

En las partituras para piano es frecuente escribir frases musicales que se extienden a los dos pentagramas. En
MuseScore se hace de esta manera:

1. Introduzca las notas en uno de los pentagramas, por ejemplo:
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2. Seleccione una nota y pulse Ctrl+Mayús + ↓/↑ (Mac: ⌘+Mayús + ↓/↑). Las notas pertenecientes a esa voz se moverán
al otro pentagrama. Por ejemplo:

Nota : Si sólo desea mover determinadas notas de un acorde, deberá asegurarse previamente de que pertenecen a
voces distintas.

3. Para ajustar la barra de unión, haga doble click sobre ella para que se muestren los puntos de ajuste. Use las
flechas del teclado o arrastre dichos puntos con el ratón para cambiar el ángulo o la posición de la barra:

Ver también

Conectar barras de compás: Cómo extender las barras de compás a varios pentagramas.

Enlaces externos

Cómo extender un acorde o una plica a dos pentagramas  (MuseScore "Howto")

Note input modes

MuseScore allows you to choose from any of several note input modes. Step-time (see below) is the default, but others
can be accessed by clicking the small dropdown arrow next to the note entry button on the note input toolbar.

Step-time

This is the default method of note input and involves entering notes one at a time: first by selecting a note duration using
the mouse or computer keyboard, then choosing a pitch using the mouse, computer keyboard, MIDI keyboard or virtual
piano keyboard.

For details see Basic note entry.

Re-pitch

Re-pitch mode allows you to correct the pitches of a sequence of notes while leaving their durations unchanged (not to be
confused with Accidental: Respell pitches).

1. Select a note as your starting point;
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2. Select the Re-Pitch option from the Note input drop-down menu; or use the keyboard shortcut, Ctrl+Shift+I (Mac:
Cmd+Shift+I).

3. Now enter pitches using the computer keyboard, MIDI keyboard or virtual piano keyboard.

You can also use the Re-pitch function to create a new passage from an existing one of the same sequence of durations
—by copying and pasting the latter, then applying Re-pitch.

Rhythm

Rhythm mode allows you to enter durations with a single keypress. Combining Rhythm and Re-pitch modes makes for a
very efficient method of note entry.

1. Select your starting point in the score and enter Rhythm mode.
2. Select a duration from the note input toolbar, or press a duration shortcut (numbers 1-9) on your computer keyboard.

A note will be added to the score with the selected duration. In contrast to Basic note entry, pressing the . key will
toggle dotting or not dotting all subsequent durations. All following rhythms will be dotted until the . key is pressed
again. Unlike Basic note entry, the dot is to be pressed prior to entering the rhythm.

3. Entering rests is similar to adding dotted notes. Press the 0 key to toggle entering rests. All rhythms entered will be
rests until the 0 key is pressed again. This can be used concurrently with dotted notes.

4. Continue pressing duration keys to enter notes with the chosen durations.
5. Now use Re-pitch mode to set the pitches of the notes you just added.

Real-time (automatic)

The Real-time modes basically allow you to perform the piece on a MIDI keyboard (or MuseScore's virtual piano
keyboard) and have the notation added for you. However, you should be aware of the following limitations which currently
apply:

It is not possible to use a computer keyboard for Real-time input
You cannot enter tuplets or notes shorter than the selected duration
You cannot enter notes into more than one voice at a time

However, these restrictions mean that MuseScore has very little guessing to do when working out how your input should
be notated, which helps to keep the Real-time modes accurate.

In the automatic version of Real-time input, you play at a fixed tempo indicated by a metronome click. You can adjust the
tempo by changing the delay between clicks from the menu: Edit → Preferences... → Note Input (Mac: MuseScore → Preferences...
→ Note Input).

1. Select your starting position in the score and enter Real-time (automatic) mode.
2. Select a duration from the note input toolbar.
3. Press and hold a MIDI key or virtual piano key (a note will be added to the score).
4. Listen for the metronome clicks. With each click the note grows by the selected duration.
5. Release the key when the note has reached the desired length.

The score stops advancing as soon as you release the key. If you want the score to continue advancing (e.g. to allow you
to enter rests) then you can use the Real-time Advance shortcut to start the metronome.

Real-time (manual)

In the manual version of Real-time input, you have to indicate your input tempo by tapping on a key or pedal, but you can
play at any speed you like and it doesn't have to be constant. The default key for setting the tempo (called "Real-time
Advance") is Enter on the numeric keypad (Mac: Fn+Return), but it is highly recommended that you change this to a MIDI key
or MIDI pedal (see below).

1. Select your starting position in the score and enter Real-time (manual) mode.
2. Select a duration from the note input toolbar.
3. Press and hold a MIDI key or virtual piano key (a note will be added to the score).
4. Press the Real-time Advance key. With each press the note grows by the selected duration.
5. Release the note when it has reached the desired length.

Real-time Advance shortcut

The Real-time Advance shortcut is used to tap beats in manual Real-time mode, or to start the metronome clicks in
automatic Real-time mode. It is called "Real-time Advance" because it causes the input position to move forward, or
"advance", through the score.

The default key for Real-time Advance is Enter on the numeric keypad (Mac: Fn+Return), but it is highly recommended that
you assign this to a MIDI key or MIDI pedal via MuseScore's MIDI remote control. The MIDI remote control is available
from the menu: Edit → Preferences... → Note Input (Mac: MuseScore → Preferences... → Note Input).

Alternatively, if you have a USB footswitch or computer pedal which can simulate keyboard keys, you could set it to
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simulate Enter on the numeric keypad.

When the notes are entered they will be placed just before the selected starting element, which will be highlighted with a
square blue marker. The start element and any subsequent notes or rests within the same measure will be shifted
forward. You can move the insertion point forward and backward using the arrow keys → or ←, and the new insertion point
will then be highlighted.

Insert

Insert Input mode (called Timewise in versions prior to 3.0.2) allows you to insert and delete notes and rests within
measures, automatically shifting subsequent music forwards or backwards. Measure duration is automatically updated as
you go.

1. Make sure you are in Note input mode, and that you have the element selected where you want to start inserting
notes/rests;

2. Click on the arrow next to the Note input icon, and select Insert (or if Insert is the current default, just press N);
3. Enter a note or rest as you would in Step-Time mode. Each note is inserted before the current cursor position;
4. Move the cursor forward and backward if required (using the arrow keys), to change the insertion point.

Alternatively, if you have only one or two notes to insert, you may prefer to use a shortcut:

Press Ctrl+Shift (Mac: Cmd+Shift) while adding the note by Mouse-click or keyboard shortcut (A-G).

If, at any time, the total duration of the notes and rests within the measure does not match the time signature, a small + or
- sign will be shown above the measure.

See also: Remove selected range (Tools).

Normal mode

To leave Note Input mode, click on the Note Input tool button, press N, or press Esc. This puts you in Normal mode, in
which you can change durations and delete notes or rests as follows:

If you select a note and press Del the note will be replaced by a rest of the same duration.
If you select a note or rest and press Ctrl+Del the note/rest will be deleted, and subsequent notes moved backward
(see Remove selected range).
If you reduce the duration of a note or rest the remaining duration will be filled with rests.
If you increase the duration of a note or rest it will subtract duration from the subsequent notes/rests to make up the
duration. If this is done on the last note/rest in the measure, a note or rest with the required duration will be inserted
in the start of the following measure, and the two will be tied together.

See also

Note input
Copy and paste

External links

Video: Semi-Realtime MIDI Demo Part 1: New note entry modes
Introduction to the new Repitch Mode  (YouTube)

Notehead schemes

You can choose choose any one of nine notehead schemes for a standard staff. To set a notehead scheme:

Right-click on a staff and select Staff/Part Properties…; click on Advanced Style Properties… and choose from the
"Notehead scheme" dropdown list.

The schemes are as follows:

Normal: This is the default scheme and the one the vast majority of people will use: it is also the only scheme in
MuseScore 1 and 2. It uses normal noteheads which can be changed via the Noteheads palette or the Inspector.
Pitch name: Noteheads automatically and dynamically change to include the English pitch name in the notehead.
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German pitch name: Just like the previous one but B will be replaced by H, and Bb by B.

Solfège Movable Do (also called Tonic Solfa) : Noteheads include the solfege syllable, depending on the degree in
the scale. It uses Ti and not Si.

Solfège Fixed Do : Noteheads include the solfege syllable for the note name. As used in France, Italy, Spain, etc...
It uses Si and not Ti.

4 Shape (Walker): Noteheads follow the four-shape system used in books such as William Walker’s Southern
Harmony (1835).

7 Shape (Aikin): Noteheads follow the seven-shape system used in books such as Jesse B. Aikin’s The Christian
Minstrel (1846), and books by the Ruebush & Kieffer Publishing Company. It's the most used 7-shape system.

7 Shape (Funk): Noteheads follow the seven-shape system used in books such as Joseph Funk’s Harmonia Sacra
(1851).

7 Shape Walker: Noteheads follow the seven-shape system used in books such as William Walker’s Christian
Harmony (1867).
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(For more info about the different variant of shape notes, see the SMuFL specification )

The setting applies to a given staff and the notehead will be used when entering and editing notes. Here is an example.

Noteheads

A range of alternative noteheads can be accessed via the Note Heads palette of the Advanced workspace, or the
Inspector (see Change notehead group, below).

Note: The design of the notehead may vary depending on the music font selected (Leland, Emmentaler, Gonville,
Bravura, MuseJazz, Petaluma). Those in the palette are displayed as half notes in Bravura font.

Notehead groups

MuseScore supports a range of notehead styles:

Normal: A standard notehead.
Crosshead (Ghost note): Used in percussion notation to represent cymbals. It also indicates muted and/or
percussive effects in stringed instruments such as the guitar.
Diamond: Used to indicate harmonic notes in instruments such as the guitar, violin etc.
Slash: Used to notate rhythms (e.g. guitar strums).
Triangle up/down: Used in percussion notation.
Shape notes: Do, Re, Mi, Fa, Sol, La, Ti.
Circle cross: Used in percussion notation.
Circled noteheads
Slashed notehead: A notehead with an oblique line through it.
Plus noteheads
Alt. Brevis: Used in early music notation.
Brackets (Parentheses): applied around an existing note (or accidental).

Change notehead group

To change the shape of one or more noteheads in the score, use one of the following:

Select one or more notes and click a notehead in a palette (double-click in versions prior to 3.4).
Drag a notehead from a palette onto a note in the score.
Select one or more notes and change the notehead in the Inspector, using the drop-down list under Note → Head
group (not supported for drum staves).

Change notehead type

Occasionally you may need to change the apparent duration of a notehead—i.e. notehead type—without altering its
actual, underlying duration:

1. Select one or more notes.
2. Choose one of the following options from the Inspector under Note → Head type:

Auto: Automatic, i.e. apparent duration = actual duration.
Whole: Whole notehead, regardless of actual duration.
Half: Half notehead, regardless of actual duration.
Quarter: Quarter notehead, regardless of actual duration.
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Breve: Breve notehead, regardless of actual duration.

Shared noteheads

When two notes in different voices, but of the same written pitch, fall on the same beat, one of two things may happen:

The notes may share the same notehead.
The notes may be offset: i.e. arranged side by side.

MuseScore uses the following rules:

Notes with stems in the same direction do not share noteheads.
Dotted notes do not share noteheads with undotted notes.
Black notes do not share noteheads with white notes.
Whole notes never share noteheads.

Note: If two unison notes occur in the same voice they are always offset.

Change offset noteheads to shared

To turn offset noteheads in opposite voices into shared noteheads :

Make the smaller-value notehead invisible by selecting it and using the keyboard shortcut V (or unchecking the
"Visible" option in the Inspector).

In a small minority of cases (where the smaller value note is dotted) this workaround is not applicable, so use the following
alternative:

Select the smaller value notehead and, in the "Note" section of the Inspector, change "Head type" to match that of
the larger value note in the opposite voice.

Examples of notehead sharing

1. In the first example below, the notes of voices 1 and 2 share noteheads by default, because they are all black,
undotted notes:

2. By contrast, in the next example, white notes cannot share noteheads with black notes, so are offset to the right:

To create a shared notehead, change the black eighth note's head type to match that of the white note or, pre-3.5,
make it invisible (as explained above):

Remove duplicate fret marks

In certain cases, a shared notehead, when pasted to a tablature staff, may result in two separate fret marks on adjacent
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strings. To correct this, make any extraneous tablature notes invisible by selecting them and using the keyboard shortcut
V (or by unchecking the "visible" option in the Inspector).

External links

Shape notes  at Wikipedia.
Ghost notes  at Wikipedia.

Parts

MuseScore allows you to not only create and print a full score but also to generate individual player's parts from it.

A part can be created from a specific instrument staff in the main score or even from a specific voice within a staff. This
allows you to display multiple parts (e.g. Flute 1 & 2) on a single staff in the score but to extract them as separate parts.

Part Playback

Musescore "solos" the Part you're viewing during playback—i.e. no other Parts sound. This is because the Mixer’s “Play
Part Only” box is checked by default.

Simply uncheck the “Play Part Only” checkbox if you want hear all play enabled tracks while viewing a Part. Additionally
you can use the Mixer's mute and solo buttons to achieve various partial mixes of all available tracks. This can prove quite
helpful because it allows you to proofread, arrange and compose within any Part while hearing other tracks for context.

Create all parts

The most straightforward method is to create all parts at once. Parts are generated on a one-to-one basis from the
corresponding Instruments in the score:

1. From the menu, select File → Parts….
2. Click All Parts (MuseScore 3.2-3.3.4: Generate; prior to MuseScore 3.2: New All) (parts are named with the instrument

name, and a number added to differentiate parts that have the same label in the main score).

3. Click OK.

The parts can now be accessed by clicking on tabs above the document window.

Create specific parts

194

https://en.wikipedia.org/wiki/Shape_note
https://en.wikipedia.org/wiki/Ghost_note


This method allows you to generate specific parts for only selected instruments (rather than all-at-once):

1. In the Parts window click Single Part (prior to MuseScore 3.4 New) to create a part;
2. In the center pane, type the words you want to use for the "Part title" (this also serves for the corresponding part of

the filename when exporting);
3. Pick the instrument that you want to appear in your part from the "Instruments in Score" pane, and press + to add it

to the "Instruments in Part" pane.

If you wish to create more parts, repeat steps 1 through 3 (above) for each part.

4. Click OK to save the parts.

You have now finished setting up the parts. You do not need to do this again, unless you add or remove an instrument
from your full score.

Customize parts

Once you have generated a part (or all parts), you can select any part at the top and use the controls at the bottom to
control not only what instrument is in the part, but also which staves and voices within the instrument are included.

Add instruments to a part

To add instruments to an existing part:

1. Select the part in the "Parts" pane.
2. Select the instrument from the "Instruments in Score" pane.
3. Press + to add it to the "Instruments in Part" pane.

Remove instruments from a part

To remove instruments from an existing part:

1. Select the part in the "Parts" pane.
2. Select the instrument from the "Instruments in Part" pane.
3. Press - to remove the instrument.

Select staves for an instrument
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To select the staves of an instrument to include in the part:

1. Select the part in the "Parts" pane.
2. Click the arrow next to the instrument in "Instruments in Part" to expand the listing to show all staves and voices of

the instrument.
3. Select the staff to be removed.
4. Press - to remove it from the instrument.

Select voices for an instrument

1. Select the part in the "Parts" pane.
2. Click the arrow next to the instrument in "Instruments in Part" to expand the listing to show all staves and voices of

the instrument.
3. Uncheck the voices to be removed.

Note: If you select only voice 1 for a given staff, then only the content in voice 1 for that staff will be included in the part.
Thus, in order to share flute 1 & 2 on the same staff, you will need to enter all notes onto both voices, even in passages
where they share content. You also cannot enter the two parts as chords in the passages where they share rhythms.

Delete a Part

1. Open the Parts dialog (File → Parts…);
2. Select the relevant Part in the "Parts" pane;
3. Press Delete.

Export parts

In order to be able to export parts, those need to have been created first, see above

1. From the menu, select File → Export Parts…;
2. Navigate to the place you want them to be exported to and select the file format (PDF is the default);
3. For filename just enter whatever prefix is useful for all parts, or leave the default (the filename of your score);
4. Click OK.

This will generate files with the names "<title>" + "-" + "<part name>.<extension>". In addition, when exporting as PDF,
this will also generate "<title>" + "-Score_And_Parts.pdf".

Save parts

Parts and score are "linked", which means that any change to the content in one will affect the other, but changes to the
layout will not. When you have the parts created, they are saved along with the score (if you open the score you have
tabs for the score and every part you created).

However, if you wish to save a part individually:

1. Make sure the part is "active." Select its tab if not;
2. From the menu, select File → Save As….

Print a part

1. Make sure the part is "active." Select its tab if not;
2. From the menu, select File → Print to open the print dialog.

Plugins

What are Plugins?

Plugins are small pieces of software that add a particular feature to MuseScore. By enabling a plugin, a new menu option
is appended to the Plugins menu: subsequently, when this option is selected, the plugin performs a particular task in the
score.

Some plugins come pre-installed with MuseScore—see Plugins installed by default (below). You can find many more
plugins in the plugin repository : some work with MuseScore 3, others only with older versions of MuseScore, and some
work with either. To tell one from the other: MuseScore 3.x and 2.x plugin code files have an extension of .qml; for older
versions, it is .js.

Warning: Plugins can potentially contain bad or malicious code, which can compromise or damage your scores or
system. Plugins are entirely unvetted (except for those that are installed by default). You either need to trust the author or
check the code yourself.

Installation
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Note: Some plugins may require the installation of other components (fonts, e.g.) to work. Check the plugin's
documentation for more information.

Most plugins are provided as ZIP archives: download the plugin's .zip file and uncompress (unzip) it to one of the
directories mentioned below (depending on your OS). If the plugin is provided directly as an uncompressed .qml file,
simply download it and place into one of the same directories.

Once a plugin is installed, it needs to be enabled in the Plugin Manager in order to use it—see Enable/disable Plugins.

Windows

On Windows, new plugins should be installed into %HOMEPATH%\Documents\MuseScore3\Plugins. Alternatively, specify a
different folder in MuseScore's Preferences.

Pre-installed plugins can be found in %ProgramFiles%\MuseScore 3\Plugins (or %ProgramFiles(x86)%\MuseScore 3\Plugins for the 32-
bit versions) and in %LOCALAPPDATA%\MuseScore\MuseScore 3\plugins on Windows 7 and later. These folders should not be
modified.

macOS

On macOS, new plugins should be installed into ~/Documents/MuseScore3/Plugins. Alternatively, specify a different folder in
MuseScore's Preferences.

Pre-installed plugins can be found in the MuseScore bundle in /Applications/MuseScore 3.app/Contents/Resources/plugins (to reveal
files in the app bundle, right-click on MuseScore 3.app and choose "Show package contents"), and in ~/Library/Application
Support/MuseScore/MuseScore 3/plugins. These folders should not be modified.

Linux

On Linux, new plugins should be installed into ~/Documents/MuseScore3/Plugins. Alternatively, specify a different folder in
MuseScore's Preferences.

Pre-installed plugins can be found in /usr/share/mscore-3.x/plugins and in ~/.local/share/data/MuseScore/MuseScore3/plugins. These
folders should not be modified.

The directory names might be slightly different, depending on your operating system's language.

Enable/disable plugins

To be able to access the installed plugins from the Plugins menu, they need to be enabled in the Plugin Manager:

You do this simply by checking the appropriate tick box. This adds the name of the plugin to the list in the Plugins menu.

Create/edit/run plugins

It is possible to create new or edit existing plugins and run them via the Plugin Creator:
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Documentation of all available elements can also be found here.

Plugins installed by default

Some plugins come pre-installed with MuseScore, but they are not enabled by default. See Enable/disable plugins
(above) to enable plugins.

ABC Import

This plugin imports ABC  text from a file or the clipboard and converts it to MusicXML. Internet connection is required,
because it uses an external web-service  for the conversion.

Notes → Color Notes

This demo plugin colors notes in the selected range (or the entire score), depending on their pitch. It colors the note head
of all notes in all staves and voices according to the Boomwhackers convention. Each pitch has a different color. C and C♯
have a different color. C♯ and D♭ have the same color.
To color all the notes in black, just run that plugin again (on the same selection). You could also use the 'Remove Notes
Color' plugin  for this.

Create Score

This demo plugin creates a new score. It creates a new piano score with 4 quarter notes: C, D, E, F. It's a good start to
learn how to make a new score and add notes from a plugin.

helloQml

This demo plugin demonstrates some basic tasks.

Notes → Note Names

This plugin names notes in a selected range or for the entire score. It displays the names of the notes (as staff text)
according to MuseScore's language settings: voices 1 and 3 notes above the staff; voices 2 and 4 notes below the staff;
and chord notes in a comma separated list, starting with the top note.

Panel

This demo plugin creates a GUI panel.

random/random2

Creates a random score.

run

This demo plugin runs an external command. Probably this will only work on Linux.

scorelist

This test plugin iterates through the score list.

ScoreView
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Demo plugin to demonstrate the use of a ScoreView

Walk

This test plugin walks through all elements in a score

See also

Tools

External links

Plugins for 3.x

Preferences

You can customize many of MuseScore's default behaviors via the menu: Edit→Preferences... (Mac: MuseScore→Preferences...).

The Preferences dialog has multiple tabs:

Reset All Preferences to Default will reset all preferences to the ones MuseScore had when you installed it. Ok will save the
settings and close the dialog. Cancel will close the dialog without applying changes. Apply will make changes take effect
without closing the dialog.

General

Here you can define:

Program Start: Specify whether to start the session empty or to display a score. The options are one of the
following: Start empty (no score) / Continue last session / Start with new score (i.e. New Score Wizard automatically
opens) / Start with score (the program default, or one of your own choosing).
You can also choose which panels to display. This can be any combination of: Splash screen, Play Panel, Navigator,
or Start Center. Also select if Tours will be active.
Folders: Specify the default folders for score files, style files, custom score templates, plugins, additional
SoundFonts, images, and extensions.
Language: Choose the language used by the program. Translations may be updated from here too. Note that
language translation updates can also be done via the menu: Help→Resource Manager.
Telemetry: Tick/untick to authorize MuseScore to collect usage data. The type of data collected is listed, and
updated as needed, in telemetry .
Appearance: Specify a dark or light theme, and the width and height of icons. Set display "Font face" and "Font
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size".
Auto Save: How frequently the program autosaves.
OSC Remote Control

Canvas

Use Canvas to set your preferred color and wallpaper for the score background and paper. The default "Background" is
dark blue (RGB 20, 36, 51; Alpha 255) and the default "Paper," white.

Background: Use this to set the color or background around the score pages. Select "Color" then click on the bar to
the right and make a choice from the color picker; or select "Wallpaper," click on the file icon and set a background
image.
Paper: Sets the color or background of the score pages. Controls identical to "Background" (above). You can also
tick/untick "Use the same color in palettes".
Zoom: This defines the Default zoom level and keyboard/mouse zoom precion.
Scroll Pages: This defines the way that the pages are laid out in the score. Choose "Horizontally" for a row layout,
or "Vertically" for a column layout. To limit scrolling, tick "Limit scroll area to page borders".
Miscellaneous: "Draw antialiased" (the default option) makes diagonal lines and edges of shapes look smoother.
"Proximity for selecting elements" controls the distance the mouse may be from an object and still act on it. Smaller
numbers require more precision, making it harder to click on small objects. Larger numbers are less precise, making
it harder not to click on nearby objects unintentionally. Choose a comfortable working value.

Note input

200



On this tab there are note input and MIDI remote control preferences. Here the following can be set:

Note Input

Enable MIDI Input: Leave checked to allow MIDI input of notes.
Color notes outside of usable pitch range: For details, see Coloring of notes outside an instrument's range and
Usable pitch range (Staff properties: all staves).
Delay between notes in automatic real-time mode: See Real-time (automatic).
Play notes when editing: When ticked, MuseScore sounds the note when it is entered or selected. Tick "Play
whole chord when adding note," if you want to hear all the notes of a chord when it is added to. You can also edit the
"Default duration".

MIDI Remote Control

Midi Remote Control allows you to use certain keys on your MIDI keyboard to enter notes and rests and to select note
durations, without involving the computer mouse or (computer) keyboard. The default setting is off.

To assign a command to a MIDI key:

1. Ensure that "MIDI Remote Control" is checked (your MIDI keyboard should be connected before opening the
program).

2. Click the red button next to the option you wish to assign a MIDI key to: the red button now lights up.
3. Press a MIDI keyboard key. The red button becomes unlit and the green button lights up instead. The MIDI key has

now been assigned to the desired option.
4. Repeat "2" and "3" to assign other keys.

Once you have defined your key settings you can use the MIDI keyboard to control note input operations. You can verify
your key settings by observing the MuseScore Note Input toolbar while pressing the MIDI keys.

To temporarily deactivate Midi Remote Control: uncheck "Midi Remote Control": all MIDI input key action buttons are now
greyed out. Note: Your key assignments are always saved between MuseScore sessions and are not affected by
deactivation.

Notes: (1) The "Clear" option turns off all the green buttons for the current MuseScore session but all the user-recorded
MIDI key settings are retained and will be reloaded on the next session. (2) A MIDI key setting that is activated cannot
afterwards be turned off, and the green button will always remain lit: however it can be overwritten with a different MIDI
key by using the red button again. (3) If the same MIDI key is accidentally assigned to more than one option, then all the
associated green buttons remain lit although only one will work. To fix, see "(2)".

Score
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Score preferences include:

Default Files

Instrument list 1: Default instrument list file one
Instrument list 2: Default instrument list file two
Score order list 1: Default score order list file one (used for instrument ordering)
Score order list 2: Default score order list file two
Style: Default style for score
Style for part: Default style for parts

See also Load/Save Style

View

Show MIDI controls in mixer: Enable this option to show MIDI controls by default in the mixer.

I/O

PortAudio (API / Device)
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This enables you to set the audio interface (API) and specify the device to be used for audio playback: e.g. built-in
speakers/headphones, USB headset, wireless, etc.

MIDI Input/Output/Output Latency

When an external MIDI input device is connected, its identifier appears in MIDI Input. When the device is connected for
the first time, you also need to select the correct MIDI Output option in order to enable note input and correct audio
playback (e.g. in Windows, this might be "MMS<device name>"): then close and reopen the program to confirm the
changes.

Jack Audio Server

Check these options as required if using the JACK  Audio Connection Kit.

Audio Engine

In case of lost communication between your audio device or your MIDI keyboard and MuseScore (no sound output or
MIDI action), click on Restart Audio and MIDI Devices to restore them.

Import

These settings determine how files from other sources are imported:

Style Used for Import: Use either the built in MuseScore style or a style you choose (see Load/Save Style)
MusicXML: Set the MusicXML import options
Character Set Used When Importing Binary Files: Character Set used for Binary Files (Guitar Pro and Overture
character sets)
MIDI: Define the shortest note when importing MIDI files
When opening scores from older MuserScore versions: When enabled, you will be prompted if you want to
apply the new default engraving and style settings or not when opening a score created with a version before 3.6.

Export
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These settings determine how various files are exported from MuseScore:

PNG: PNG/SVG image resolution (in DPI) and whether to use transparent background.
MIDI: Whether to expand repeats in exported MIDI files.
PDF: PDF resolution (in DPI).
Audio: Set audio sample rate, MP3 bitrate, and whether to "normalize" exported audio.
MusicXML: Whether to export the layout and how to export system and page breaks to MusicXML.

Shortcuts

This tab lists all the commands in MuseScore and any keyboard shortcuts associated with them. Shortcuts listed in
preferences also appear next to their associated commands in the menus.

To search for a particular command: Enter its name in the "Search" box near the bottom of the window.

To create a new shortcut for a command:

1. Select an existing entry in the list.
2. Click Define...; or just double-click the entry.
3. Enter the new shortcut using up to four keys. Press Clear if you need to re-enter the shortcut.
4. Press Replace to change the existing shortcut; or Add, to keep the old shortcut and add the new one.
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Note: Some shortcuts, including default ones, may not work with some keyboards.

To reset a shortcut to its system default: Select a command in the list and press Reset Shortcut to Default.

To save the shortcuts list: Press Save and save to a file name of your choice.

To load a saved shortcut list: Press Load etc.

To clear all shortcuts for an entry: Select the entry and press Clear.

To print out the shortcuts list (incl. export to pdf): Press Print etc.

Update

This sets whether MuseScore will check for updates and extensions at startup.

Updates may be checked manually in Help→Check for updates.

Advanced

Allows you to control specific settings for "application, "export", "i/o" and "user interface", as well as color settings.
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See also

Keyboard shortcuts
Language settings and translation updates
Update checking

Posicionamiento automático

Inicialmente, MuseScore coloca los distintos elementos en la partitura según las propiedades por defecto que se hayan
establecido en el Estilo. Si dichos elementos tienen activado el posicionamiento automático, MuseScore trata de evitar
colisiones entre ellos, desplazándolos ligeramente si es necesario.

Posición por defecto

La posición por defecto de la mayoría de los elementos viene establecida por sus ajustes de estilo. Las propiedades
específicas que puede alterar el usuario dependen del tipo de elemento, pero entre ellas están:

Ubicación: Define si el elemento aparece encima o debajo del pentagrama.
Desplazamiento: Para elementos sin la propiedad de "Ubicación encima o debajo", este parámetro especifica la
posición por defecto. Ver Desplazamiento X/Y.
Distancia mínima de autocolocación: Distancia mínima respecto a otros elementos cuando el posicionamiento
automático está activado.

Para detalles acerca de los ajustes disponibles para cada tipo de elemento, ver Diseño y formato: Estilo.

Para cambiar la posición por defecto:

Use uno de estos métodos:

En el menú, seleccione Formato→Estilo...; elija un tipo de elemento y ajuste los valores de posición o colocación.
Seleccione un elemento de la partitura y ajuste los valores de posición o colocación mediante el Inspector; a
continuación, pulse el botón Establecer como estilo (S), que aparece a la derecha del parámetro. De este modo, se
actualiza el ajuste de Estilo correspondiente.

Ajustes manuales

Una vez un elemento se ha posicionado automáticamente, su posición puede ser alterada de forma manual mediante uno
de estos métodos:

Seleccione el elemento y ajuste su Desplazamiento X/Y con el Inspector.
Arrastre el elemento por medio del ratón.
Acceda al modo edición y mueva el elemento mediante las teclas de flecha.

Si el elemento puede ir colocado tanto encima como debajo del pentagrama, puede cambiar su ubicación de una de estas
maneras:

Cambiando su "Ubicación" con el Inspector
Tecleando X para alternar entre arriba y abajo

Nota: Cuando un elemento tiene activado el posicionamiento automático, no es posible colocarlo en un lugar que
provoque su colisión con otros elementos.

Deshabilitar el posicionamiento automático

Seleccione el elemento y deje sin marcar la casilla "Posicionamiento automático" en el Inspector.

El elemento retorna a su posición por defecto. Puede ser reubicado a voluntad y los demás elementos no evitarán
colisionar con él cuando se coloquen.

Orden de superposición

Para cambiar el valor del Orden de superposición:

Seleccione el elemento y cambie el valor asignado a su "Orden de superposición" mediante el Inspector.

En los casos en los que los elementos puedan superponerse, el Orden de superposición determina el orden en el que
irán colocados uno sobre otro. El elemento con el valor más bajo será colocado detrás.

Recovered files

If MuseScore or your computer should crash, or if power is lost, a pop-up message upon restarting MuseScore will ask if
you wish to restore the previous session:
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Click Yes, to initiate attempted recovery of files from the interrupted session. Or click No to ignore message.

Saving after session recovery

When MuseScore recovers files after a crash, it renames them with the full path name added in front of the original file
name. This very long name will appear in the tab(s) above the active score window.

To ensure that the file is saved in its original location. You should immediately save the restored file using the "Save As..."
option: this will open a window to allow you to navigate to the correct folder and directory. If you use the "Save" command
instead, the file will be saved in its current location which is unlikely to be the original one.

Finding recovered files

In the event that "Save" is used instead of "Save As..." with a recovered file, you will have to find the files in your computer.
The actual location of those files will vary, depending on your operating system, and in which directory MuseScore is
installed.

For Windows 7, with a default installation of MuseScore to the program files directory, recovered files are auto-saved to
C:\Program Files\MuseScore 3\bin (actually %ProgramFiles%\MuseScore 3\bin).

For Windows 10, look in C:\Users\[User Name]\AppData\Local\VirtualStore\Program Files\MuseScore 3\bin
(actually%LOCALAPPDATA%\VirtualStore\%ProgramFiles:~3%\MuseScore 3\bin).

You may need to run a system-wide search in order to find files saved directly after a session recovery. Use keywords
from the original file name as well as wildcards, and specify the date modified.

See also

Save/Export/Print

External links

How to recover a backup copy of a score  (MuseScore HowTo)

Score Comparison

The Score Comparison Tool allows you to compare two versions of a score to find the differences between them.

Introduction

To open the Score Comparison Tool:

From the menu, select View→Score Comparison Tool.

The dialog opens below the document window and consists of three sections (left to right):

Choose scores to compare: Select the scores you want to compare.
Diff mode: Select how to view the comparison.
Comparison: A line by line comparison of the scores is displayed.
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Select score

The first step is to select the score. Use the combo box next to "Score 1" to choose between the currently open scores, or
click on the Browse button to open the File Explorer and select a score from disk. Secondly, use the next combo box on the
right to choose whether the first score should be the current version, or the last saved version. Score 2 is set to the same
score you selected for Score 1, but you may choose another of the open scores.

When you have selected the scores and versions press Compare to do the comparison.

Choose view

"Intelligent comparison" is the default option in Diff mode: this displays the differences between the scores in a human-
readable format (e.g. "Measure 1: Note: property pitch changed from B4 to C5"). Change the Diff Mode selection to "Raw"
if you prefer to see the results displayed in XML code.

View comparison

When you press Compare a list of differences will be displayed to the right, and the score view will automatically change to
Documents Stacked. In the Comparison section, double-click on a difference from the list and both score views will
automatically pan to show you the changed element, which will also be highlighted.

Leave comparison

To exit the Score Comparison tool, turn off the two options "Score Comparison Tool" and "Documents Stacked" in the View
menu.

Example

Below you will see two small scores with a few differences between them.

Last saved:

Current:

The result of the comparison will look like this:

Score properties

The Score Properties dialog contains document meta tags such as "workTitle," "Composer," "Copyright" etc. To view the
dialog:

1. Make sure that the applicable score or instrument part is the active tab;
2. From the menu, select File → Score Properties.

Several meta tags are generated automatically when you create a score using the New Score Wizard, and others may be
added later. Meta tags can also be incorporated into a header or footer if required—see below.

Edit meta tags

1. Make sure that the applicable score or instrument part is the active tab;
2. From the menu, select File → Score Properties;
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3. Edit the text of the various meta tags as required;
4. To add another meta tag, click on the New button. Fill in the "New tag name" field and press OK;

Pre-existing meta tags

Every score displays the following fields in Score Properties:

File Path: The score file's location on your Computer.
MuseScore Version: The version of MuseScore the score was last saved with.
Revision: The revision of MuseScore the score was last saved with.
API-Level: The file format version.
arranger: (empty)
composer: This is initially set to the same text as "Composer" on the first page of the New Score Wizard.
copyright: This is initially set to the same text as "Copyright" on the first page of the New Score Wizard (if you need
a copyright symbols, copy/paste this: ©).
creationDate: Date of the score creation. This could be empty, if the score was saved in test mode (see Command
line options).
lyricist: This is initially set to the same text as "Lyricist" on the first page of the New Score Wizard.
movementNumber: (empty)
movementTitle: (empty)
originalFormat: This tag exists only if the score is imported (see file formats).
platform: The computing platform the score was created on. This might be empty if the score was saved in test
mode.
poet: (empty)
source: May contain a URL if the score was downloaded from or saved to MuseScore.com.
translator: (empty)
workNumber: (empty)
workTitle: This is initially set to the same text as "Title" on the first page of the New Score Wizard.

Entering Work / Movement / Part metadata

workNumber is the number of the larger work (e.g. 8—for "The Four Seasons," Op. 8, by Vivaldi).
workTitle is the title of the larger work (e.g "The Four Seasons,").
movementNumber is the number of the movement in the larger work (e.g. 3 for Autumn).
movementTitle is the title of the movement in the larger work (e.g.“Autumn”).

It is customary, when using the New Score Wizard, to create a work with the movementTitle as title (even though it ends
up in workTitle then) and, directly after creating the score, amending this information in the Score Properties dialogue.

Every part additionally has the following meta tag, generated and filled on part creation:
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partName: The name of the part as given on part creation (which is also used to fill the corresponding part name
text in the top vertical frame—be aware that later changes to one are not reflected in the other).

Header/Footer

To show the content of one or more meta tags in a header or footer for your score/part:

1. Make sure that the correct score or instrument part is the active tab;
2. From the menu, select Format → Style... → Header, Footer:

If you hover with your mouse over the Header or Footer text region, a list of macros will appear, showing their
meaning, as well as the existing meta tags and their content.

3. Add tags (e.g. $:workTitle:) and macros (e.g. $M) to the appropriate boxes, as required;
4. Click Apply to see how the header or footer looks in the score. Make corrections to the dialog if required;
5. If an instrument part is in the active tab, click Apply to all parts, if you want to apply these settings to all the score parts;
6. Click OK to assign the header or footer and exit the dialog.

See also

Layout and formatting: Header and footer
Command line options: Test mode

Staff / Part properties

The Staff / Part Properties dialog allows you to make changes to the display of a staff, adjust its tuning and
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transposition, change instrument etc. To open:

Right-click onto either an empty area in a staff, or the instrument name, and select Staff/Part Properties....

Staff / Part Properties dialog, as of version 3.0.

Staff Types

For practical purposes, there are four different types of staff:

1a. Standard staff I. A pitched staff used for most instruments except fretted, plucked-string ones.
1b. Standard staff II. A pitched staff containing a fretted, plucked-string instrument, with options to set the number of
instrument strings and tuning.
2. Tablature staff. A staff containing a fretted, plucked-string instrument, which displays music as a series of fret-marks on
strings. Also contains options to set the number of instrument strings and tuning.
3. Percussion staff. A pitched staff for percussion instruments.

It is possible to change one type of staff into another using the Instruments dialog, as long as the original staff is loaded
with the right instrument. For example, in order to change a standard staff to tablature, it must contain a plucked-string
instrument. Similarly, to change a standard staff to a percussion staff you need to ensure that it has an appropriate
percussion instrument loaded and so on.

Most options in the Staff / Part properties dialog are common to all staves, but each type also has one or two specific
options of its own.

Staff / Part Properties: all staves

The following Staff Properties options are common to all staves:

Lines
The number of lines making up the staff.

Line Distance
The distance between two staff lines, measured in spaces (abbr.: sp.). Note: It is not recommended to change this value
from the default shown. If you need to make the staff larger or smaller, use the Page Settings dialog instead.

Extra distance above staff
Increases or decreases the distance between the selected staff and the one above in all systems. Note: This setting does
not apply to the top staff of a system, which is controlled by the minimum/maximum system distance (see Layout and
formatting: Format → Style … → Page).

Notes: To alter the spacing above just one staff line in a particular system, see Breaks and Spacers.
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Scale
Changes the size of the selected staff and all associated elements, as a percentage (to adjust the overall score size, use
Scaling from the Format→Page Settings… menu).

Hide when empty
Together with the "Hide empty staves" setting in Format → Style ... → Score, this determines if the staff will be hidden
when it is empty.

Possible values:

Auto (default): The staff will be hidden if it is empty and "Hide empty staves" is set.
Always: The staff will be hidden when empty, even if "Hide empty staves" is not set.
Never: The staff will never be hidden when empty.
Instrument: For instruments containing multiple staves, the staff is hidden only if all staves for that instrument are
empty.

Show clef
Whether the staff clef will be shown.

Show time signature
Whether the staff time signature(s) will be shown or not.

Show barlines
Whether the staff barlines will be shown.

Hide system barline
Show/hide barline at left-hand edge of the staff.

Do not hide if system is empty
Never hide this staff, even if the entire system is empty. This overrules any "Hide empty staves" setting in Format → Style
... → Score.

Small staff
Create a reduced-size staff. You can set the default from the menu in Format → Style ... → Sizes.

Invisible staff lines
Make staff lines invisible.

Staff line color
Use a color picker to change the color of the staff lines.

Cutaway
Used to create a cutaway staff in which only measures containing notes are visible (e.g. ossias  (Wikipedia); or cutaway
scores). This can be used independently of "Hide when empty" or "Hide empty staves".

Instrument
The instrument loaded in the Instruments (I) or Select Instrument dialog. The sound associated with this instrument can
be changed, if desired, in the Mixer.

Note: The properties below (i.e. Part Name, Long Instrument Name etc.) are set to the default values defined in the
MuseScore instruments.xml  file.

Part name
The name of the part. This is also displayed in the Mixer and the Instruments dialog (I). Any edits you make to the Part
name affect only that particular instrument and no other.

Note: The Part name is defined by the value of the trackName element in the instruments.xml  file. If trackName has not
been defined, the value of longName (i.e. "Long instrument name"—see below) is used instead.

Long instrument name
Name displayed to the left of the staff in the first system of the score. The long instrument name may also be edited
directly as a text object (see Text editing).

Short instrument name
Name displayed to the left of the staff in subsequent systems of the score. The short instrument name may also be edited
directly as a text object (see Text editing). Editing affects all occurrences in the score.

Usable pitch range

Amateur: Notes outside this range will be colored olive green/dark yellow in the score.
Professional: Notes outside this range will be colored red in the score.

To disable out-of-range coloration of notes: From the menu, select Edit→Preferences... (Mac: MuseScore→Preferences...),
click on the "Note Input" tab, and uncheck "Color notes outside of usable pitch range."
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See also, Coloring of notes outside an instrument's range.

Transpose written pitches to sound
This option ensures that the staves of transposing instruments display music at the correct written pitch. Set the transpose
in term of a musical interval (plus octave if required) up or down.

Use single note dynamics (as of version 3.1)
Leave ticked to allow playback of single note dynamics (such as sfz etc.) and hairpins, diminendo and crescendo lines on
single (or tied) notes.

Navigation arrows
Use the ↑ and ↓ buttons, at the bottom left of the Staff Properties window, to navigate to the previous or next staff.

Staff / Part Properties: plucked strings only

Staves of fretted, plucked-string instruments have a few extra options in addition to those listed above,

Number of strings
Displays the number of instrument strings.

Edit String Data…
This button opens a dialog box which allows you to set the number and tuning of strings. See Change string tuning.

Advanced Style Properties

Clicking the Advanced Style Properties... button opens a window giving access to advanced display options for the staff. These
will vary depending on the staff type chosen: see the relevant sections below for details.

Template

At the bottom of the Advanced Style Properties dialog there are a number of buttons which allow you to easily change the
following:

The number of lines displayed by a percussion staff.
The staff type of a plucked-string instrument. For example, you can change from standard staff to tablature and vice
versa, or select from a number of tablature options.

1. Make a selection from the drop-down list labelled "Template";
2. Press < Reset to Template ;
3. Press OK to accept the changes and exit the dialog (or Cancel to cancel the operation).

Standard and Percussion staff options

Show clef / time signature / barlines / key signature / ledger lines
Option to turn the display of these elements ON or OFF.

Stemless
If checked, staff notes will have no stem, hook or beam.

Notehead scheme
See Notehead scheme.

Tablature staff options

Upside down
If not checked, the top tablature line will refer to the highest string, and the bottom tablature line to the lowest string (this is
the most common option). If checked, the top tablature line refers to the lowest string, and the bottom tablature line to the
highest line (e.g. Italian-style lute tablatures). For example:

'Upside down' tablature.

Tablature staff options: Fret Marks

Fret marks are the numbers or letters used to indicate the location of notes on the fingerboard. The following group of
properties define the appearance of fret marks:
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Font
The font used to draw fret marks. 8 fonts are provided supporting all the necessary symbols in 8 different styles (modern
Serif, modern Sans, Renaissance, Phalèse, Bonneuil-de Visée, Bonneuil-Gaultier, Dowland, Lute Didactic).

Size
Font size of fret marks in typographic points. Built-in fonts usually look good at a size of 9-10pt.

Vertical offset
MuseScore tries to place symbols in a sensible way and you do not usually need to alter this value (set to 0) for built-in
fonts. If the font has symbols not aligned on the base line (or in some other way MuseScore does not expect), this
property allows you to move fret-marks up (negative offsets) or down (positive offsets) for better vertical positioning.
Values are in sp.

Marks are
Choice of Numbers (‘1’, ‘2’...) or Letters (‘a’, ‘b’...) as fret marks. When letters are used, ‘j’ is skipped and ‘k’ is used for
the 9th fret.

Marks are drawn
Choice of placing fretmarks On lines or Above lines. For example:

Fretmark letters placed above line.

Lines are
Choice of Continuous (lines pass through fret marks) or Broken (a small space appears in the line where the fretmark is
displayed). For example:

Tablature with lines broken.

Show back-tied fret marks
If unticked, only the first note in a series of tied notes is displayed. If ticked, all notes in the tied series are displayed.

Show fingering in tablature
Tick to allow the display of fingering symbols applied from a palette.

Tablature staff options: Note Values

This group of properties defines the appearance of the symbols indicating note values.

Font
The font used to draw the value symbols. Currently 5 fonts are provided supporting all the necessary symbols in 5
different styles (modern, Italian tablature, French tablature, French baroque (headless), French baroque). Used only with
the Note symbols option.

Size
Font size, in typographic points. Built-in fonts usually look good at a size of 15pt. Used only with the Note symbols option.

Vertical offset
Applies only when Note symbols is selected (see below). Use negative offset values to raise the note value symbols,
positive values to lower them.

Shown as:

None: No note value will be drawn (as in the examples above)
Note symbols: Symbols in the shape of notes will be drawn above the staff. When this option is selected, symbols
are drawn only when the note value changes, without being repeated (by default) for a sequence of notes all of the
same value. E.g.
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Stems and beams: Note stems and beams (or hooks) will be drawn. Values are indicated for each note, using the
same typographic mechanics as for a regular staff; all commands of the standard Beam Palette can be applied to
these beams too. E.g.

Repeat:

If several notes in sequence have the same duration, you can specify if and where to repeat the same note symbol. i.e.

Never
At new system
At new measure
Always

Note: This option is only available if "Shown as: Note symbols" is selected (see above).

Stem style:

Beside staff: Stems are drawn as fixed height lines above/below the staff.
Through staff: Stems run through the staff to reach the fret marks.

Note: This option is only available when "Shown as: Stems and Beams" is selected (see above).

Stem position:

Above: Stems and beams are drawn above the staff.
Below: Stems and beams are drawn below the staff.

Note: This option is only available when "Shown as: Stems and Beams" and "Stem style: Beside staff" is selected (see
above).

Half notes:

None
As short stems
As slashed stems

Note: This option is only available when "Shown as: Stems and Beams and "Stem style: Beside staff" is selected (see
above).

Show rests
Whether note symbols should be used to indicate also the rests; when used for rests, note symbols are drawn at a slightly
lower position. Used only with the Note symbols option.

Preview

Displays a short score in tablature format with all the current parameters applied.

Change instrument

You can change any instrument in a score to a different instrument at any time. The following method updates instrument
sound, staff name, and staff transposition all at once.

1. Right-click on an empty part of any measure OR on the instrument name and choose Staff Properties...;
2. Click on Change Instrument... (under "Part Properties");
3. Choose your new instrument and click OK to return to the Staff Properties dialog;
4. Click OK again to return to the score.

Not to be confused with Mid-staff instrument change.

External links
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How to create an ossia with another staff  (for MuseScore 2, still works for MuseScore 3, but here the Cutaway
option might be the better choice)
How to create an ossia using image capture  (for MuseScore 2, still works for MuseScore 3, but here the Cutaway
option might be the better choice)

Staff Type Change

You can change the appearance of a staff mid-score by adding a Staff type change element to a measure, and adjusting
its properties in the Inspector.

Add a Staff Type Change

1. Select a measure in the score and, in the "Text" palette, click (double-click prior to version 3.4) the "Staff type

change" symbol, ; alternatively, drag the "Staff type change" icon onto a measure;
2. Select the symbol, and adjust its properties (see below) in the Inspector as required.

Staff type change properties

When you alter a Staff type change property in the Inspector, the new value takes precedence over the value shown in
the global Staff properties dialog. Only those property values in "Staff Properties" that cannot be changed in the "Staff
type change" dialog will be valid throughout the score.

The properties that can be altered in the Staff type change dialog in the Inspector are:

Offset
How far the changed staff shall be moved up or down: measured in spaces (abbr.: sp) .

Small
Tick the box to create a reduced-size staff.

Scale
Changes the size of the staff and all associated elements, as a percentage.

Lines
The number of lines making up the staff.

Line distance
The distance between two staff lines, measured in spaces (abbr.: sp).

Step offset
How many steps up or down the notes in the staff are offset.

Show barlines
Whether the staff barlines will be shown.

Show ledger lines
Whether ledger lines will be shown for notes above/below the staff lines.

Slash style
Whether the notes shall be shown in standard or slash style.

Notehead scheme
Allows selection of how noteheads are displayed.

Generate clefs
Whether the staff clef will be shown.

Generate time signatures
Whether the staff time signature(s) will be shown or not.

Generate key signatures
Whether the staff key signatures will be shown or not.

Example

To illustrate the use of Staff type change, the staff shown below was created using the following steps:

1. Add a Staff type change to measure 2.
2. Set size to "Small".
3. Set "Lines" to 4.
4. Add a second Staff Type Change to measure 3.

5. Change "Lines" to 7,
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5. Change "Lines" to 7,

Afterwards the global Staff Properties are changed using Staff properties:

1 Set "Lines" to 2.
2. Change "Staff Line Color".

As can be seen, the change in "Lines" is only effective up to the first staff type change, whereas the change to "Staff Line
Color" is effective throughout the score.

Timeline

Introduction

The timeline was developed as part of the Google Summer of Code 2017, and is included for the first time in MuseScore
3.0.

Overview

The timeline is a navigation tool that displays an abstraction of the score to the order of measure numbers and instrument
names. There are four parts to the timeline:

Meta labels

This is found in the top left corner of the timeline. These are the names of the meta rows.

Instrument labels

This is found in the bottom left corner of the timeline. These are the names of the rows in the main grid.

Meta rows

This is found in the top right corner of the timeline. These hold the meta values of the score.

Main grid

This is found in the bottom right corner of the timeline. This holds multiple 'cells' (a specific measure and staff in the score
represented as a square)

Meta

Meta are elements found on the score that are not notes, but are still important to the score (key signature, time
signature, tempo, rehearsal marks, bar lines, and jumps and markers).

Basic interaction

Select a measure

To select a measure in the timeline, press the mouse button on the cell. A blue box will appear around the selected cell
and the respective measure in the score will be selected. The score view will place the selected measure in view.
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Select multiple measures

Drag selection

Holding Shift and holding the left mouse button and dragging the mouse over the main grid will create a selection box.
Upon releasing the mouse button, all the cells underneath the selection box will be selected, as well as all the measures in
the score.

[Shift] selection

If a cell is already selected, holding Shift and selecting another cell in the timeline will stretch the selection to that new cell,
similar to how the score does

[Ctrl] selection

If no cells are currently selected, holding Ctrl and selecting a cell will select the entire measure

Clearing selection

To clear selection, holding Ctrl and clicking anywhere on the grid or the meta rows will clear any current selection.

Meta values selection

Selecting the meta values on the timeline will attempt to select the respective meta values in the score.

Scrolling

Standard scrolling

Scrolling the mouse wheel up or down will move the grid and instrument labels down or up respectively. The meta labels
and rows do not move.

[Shift] scrolling

Holding Shift and scrolling the mouse wheel up or down will move the grid and meta rows left or right respectively. The
meta labels and instrument labels do not move.

[Alt] scrolling

Holding Alt and scrolling the mouse wheel up or down will move the grid and meta rows left or right respectively, faster
than Shift scrolling. The meta labels and instrument labels do not move.

Dragging

To drag the contents of the timeline, hold the left mouse button and move it around.

Labels interaction

Rearranging meta labels

All meta labels besides the measures meta may be rearranged in any way. By moving the mouse cursor onto one of the
meta labels, small up and down arrows will appear. Click the left mouse button on the up arrow to swap the meta label
with the one above it. Click the left mouse button on the down arrow to swap the meta label with the one below it.

Collapsing the meta labels

In order to hide all the meta labels while keeping all the meta information on the timeline, there is an arrow that appears on
the measures meta when the mouse is over it. Click the left mouse button on the large up arrow to collapse all the
currently visible meta rows into one row, where the meta values are staggered in that row. Click the left mouse button on
the large down arrow to expand the meta rows again.

Hiding instruments

All instruments--hidden or not--will be displayed on the timeline. To start this interaction, the mouse cursor is moved over
an instrument label. A small eye will appear on the right side of the label that is open if the instrument is visible on the
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score, and closed if the instrument is hidden. Click the left mouse button on the eye to toggle between the two options.

Zooming

To zoom in or out of the score, hold Ctrl and scroll the mouse wheel up or down respectively (Mac: Cmd + scroll).

Context menus

To bring up a context menu, right-click on the timeline. There are three context menus found in these locations: meta
labels, instrument labels, and meta rows.

Meta labels context menu

Upon clicking the right mouse button on the meta labels, a context menu appears that displays all possible meta labels as
well as two options: "Hide all" and "Show all." Next to each meta label in the menu, there is a check box that shows if the
meta label is currently being shown on the timeline. To show or hide one of the meta labels, select the box of the meta
label in the context menu. Selecting "Hide all" will hide all meta labels except for the measures meta. Selecting "Show all"
will display all meta labels.

Meta rows context menu

Clicking the right mouse button on the meta rows will display the same context menu as the meta labels.

Instrument context menu

Clicking the right mouse button on the instrument labels will display a context menu with the option to "Edit Instruments."
Selecting this will bring you to the same dialog as Edit > Instruments... or pressing I for the shortcut.

Tools

A number of useful commands can be found in the Tools menu.

Transpose

This opens the Transpose dialog with various options for transposing passages of music.

See Automatic transposition.

Explode

The explode command allows you to select a passage of music in a single staff and split (explode) the chords into their
constituent notes or voices as follows:

If the passage is all in voice 1, the top note of the chord is retained on the top staff, while the lower notes are moved
to subsequent staves.
If the passage contains multiple voices, voice 1 notes are retained on the top staff, while other voices are moved to
subsequent staves. All exploded voices are now in voice 1.

To explode a section of the score:

1. Ensure that there are enough staves underneath the source staff to receive the exploded notes. Create extra staves
if necessary using the Instruments dialog.

2. Choose one of two options:
Select a range of measures in the source staff: this allows all notes to be exploded if there are enough staves
available.
Select a range of measures that includes both the source staff and also extends downwards to include one or
more destination staves: This limits the number of exploded notes/voices to the number of selected staves.

3. Choose Tools→Explode.

Notes: (1) If the selection is all in voice 1, MuseScore will discard the lowest note(s) of any chord that contains more notes
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than the number of staves in the selection. (2) If the selection is all in voice 1, and If a given chord has fewer notes than
the number of destination staves, then notes will be duplicated as needed so that every staff receives a note. (3) Any
existing music in the destination staves is overwritten. (4) If you select a partial measure, the explode command will
automatically expand it to a full measure.

Implode

The Implode command works in the opposite way to "explode":

With one staff selected, all notes in voices 1–4 are combined into voice 1.
With multiple staves selected, the notes in the second staff are copied to the first available voice in the top staff, the
notes in the third staff are copied to the next available voice in the top staff and so on.

Apply implode to a single staff

1. Select a range of measures in the desired staff.
2. Choose Tools→Implode.

All selected notes in the staff are now displayed in voice 1.

Apply implode to multiple staves

1. Ensure that there is only one voice in each staff.
2. Select a range of measures in the destination staff and extend this selection downwards to include the other staves

to be imploded.
3. Choose Tools→Implode.

Voices

This allows you to swap the voices of a selected measure-range of notes. See Exchange voices.

Measure

Join or split measures. See Measure operations: Split and join.

Remove selected range

This command is used to completely remove an element, or range of elements from the score.

To remove measures (including partial measures):

1. Select a range of notes/rests, or a range of measures;
2. Use one of the following methods:

Press Ctrl+Del (Mac: Cmd+Del).
Select Tools→Remove selected range.

Note: If the selected range includes only part of a measure, the result will include a measure of smaller duration than the
indicated Time Signature. This is indicated by a small - (minus) sign just above the system.

To join measures:

1. Select (i.e. click on) a barline;
2. Use one of the following methods:

Press Ctrl+Del (Mac: Cmd+Del).
Select Tools→Remove selected range.

The following table is a comparative summary of the Delete and Remove selected Range commands when applied to
single elements:

Selected
Element Apply Delete Apply Remove selected range

Note Replaces with rest Removes score section
Rest (voice 1) No effect Removes score section
Rest (voices 2-4) Deletes rest Removes score section

Barline No effect Deletes barline and joins
measures

Measure Replaces contents with
rest Removes measure

Note: To insert notes, see Insert.
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Fill with slashes

This command fills the selection with slashes, one per beat:

1. Select one or more measures;
2. From the menu, select Tools→Fill With Slashes.

If a measure is empty the slashes are added to voice 1, full-sized and centered on the middle line of the staff:

Notes: (1) If there are already notes in a measure in the selection, the command will put the slashes into the first
available empty voice. (2) Voice 2 slashes are full-sized and centered on the middle line of the staff; voices 3 slashes
appear small and above the staff; voice 4 slashes are small and below the staff. (3) If a measure contains notes in all 4
voices, voice 1 will be overwritten. (4) All slashes are set to not transpose or playback.

Toggle rhythmic slash notation

This command toggles selected notes between normal notes and rhythmic slash notation:

1. Select a range of notes or measures (Note: use the selection filter if you need to exclude certain voices);
2. From the menu, select Tools→Toggle Rhythmic Slash Notation.

The selected noteheads are changed to slash noteheads which do not transpose or playback.

Slash-notehead notes in voices one or two are fixed to the middle staff line; those in voices three or four are small
("accent" notation) and fixed above or below the staff:

In percussion staves, notes in voices 3 and 4 are not converted to small slashes but to small notes above or below the
staff.

Respell pitches

Corrects accidentals to fit in with the current key signature. See Accidentals: Respell pitches.

Regroup Rhythms

This option corrects note ties, durations and beaming so that they are grouped according to standard music notation
practice. For example:

Before:

After:

Any notes that are tied and are the same length as a dotted note will be changed to the dotted note with two limitations. (i)
Only the last note of a group of tied notes will have a single dot. Notes with more than one dot are not produced using this
option. (ii) Dotted notes will not span from one group of beamed notes to another unless their duration is the same as all
of the beam groups it covers. Any notes with more than one dot will be regrouped according to the above rules.
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To apply:

1. Select the section of the score you want to reset. If nothing is selected, the operation will apply to the whole score;
2. Select Tools→Regroup Rhythms.

Note: This is an experimental feature and there are known bugs. Articulations and ornaments are deleted and some
pitches respelled. Ties across barlines may be lost on UNDO.

Resequence rehearsal marks

The Resequence Rehearsal Marks command allows you to re-order the numbering/lettering of rehearsal marks if, for
any reason, they have got out of sequence. For details see Automatically resequence rehearsal marks.

Unroll Repeats (version 3.1 and above)

This command creates a copy of the score (in a new tab), eliminates the repeat barlines and notates the repeat sections in
full instead.

Copy lyrics to clipboard

This command copies all the lyrics of the score to the clipboard:

From the menu, select Tools→Copy Lyrics to Clipboard .

Image capture

Take a snapshot of a selected part of the document window. PNG, PDF and SVG formats are supported. See Image
capture.

Remove empty trailing measures

This automatically removes any blank measures at the end of the score.

See also

Breaks and spacers
Rehearsal marks

External links

How to merge/combine/implode two staves in one with two voices  (MuseScore HowTo)

Support
This chapter describes how to find help using MuseScore: the best places to look, the best way to ask a question on the
forums, and tips for reporting a bug.

Helping to improve translations

You can help translate the MuseScore software and documentation into your own language, as mentioned in
Development / Translating .

Software translation

1. Ask in the forum to improve translation
2. Connect to Transifex/MuseScore http://translate.musescore.org , which will redirect you to

https://www.transifex.com/projects/p/musescore
3. Select the language and then the section you want to help with (MuseScore, Instruments, Start Center or tours)
4. Click on the "translate" button (the button text will depend on your language...)
5. Search for "strings" (informational meaning) you want to translate (you could filter "already translated items")

Here is a technical explanation: Continuous translation for MuseScore 2.0

Website and handbook translation

See Translation instructions

See also
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Language Settings and Update Translation, Update Translation

Revert to factory settings

MuseScore has the option to revert back to the standard built-in presets or "factory-settings". This can be necessary if
your settings are corrupted. Warning: Reverting to factory settings removes any changes you have made to the
preferences, palettes, or window settings. This is not a commonly needed procedure; consult the forums first, as there
may be a way to solve your problem without resetting everything.

Via menu

If MuseScore still starts, it is possible to revert from within MuseScore.
Go to Help→Revert to Factory Settings. A warning dialog will appear:

Clicking Yes resets all MuseScore's settings as if the program was installed for the first time, and MuseScore will
immediately restart. No will safely cancel the revert.

Via command line

If MuseScore does not start, you must run this process via the command line.

Instructions for Windows

1. If you have MuseScore open, you need to close it first (File→Quit)
2. Type ⊞ Win+R to open the Run dialog. Alternatively select "Start" using your mouse and type "run," then click the

"Run" program.
3. Click Browse...
4. Look for MuseScore3.exe on your computer. The location may vary depending on your installation, but it is probably

something similar to My Computer → Local Disk → Program Files → MuseScore 3 → bin → MuseScore3.exe

5. Click Open to leave the Browse dialog and return to the Run dialog. The following text (or something similar) should
display in the Run dialog

C:\Program Files\MuseScore 3\bin\MuseScore3.exe (actually %ProgramFiles%\MuseScore 3\bin\MuseScore3.exe)

For the 32-bit version of MuseScore in a 64-bit version of Windows, the location is

C:\Program Files (x86)\MuseScore 3\bin\MuseScore3.exe (actually %ProgramFiles(x86)%\MuseScore 3\bin\MuseScore3.exe)

For the Windows Store version (Windows 10), it is pretty well hidden, search for it via Windows Explorer

6. Click after the quote and add a space followed by a hyphen and a capital F: -F

7. Press OK

After a few seconds, MuseScore should start and all the settings reverted to "factory settings".

For advanced users, the main preference file is located at:

C:\Users\[USERNAME]\AppData\Roaming\MuseScore\MuseScore3.ini
(actually %APPDATA%\MuseScore\MuseScore3.ini)

The other preferences (palettes, session, shortcuts, workspaces...) are in:

C:\Users\[USERNAME]\AppData\Local\MuseScore\MuseScore3\ (actually %LOCALAPPDATA%\MuseScore\MuseScore3\)

For the Windows Store version (Windows 10), these are pretty well hidden, search for them via Windows Explorer

Instructions for MacOS
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1. If you have MuseScore open, you need to quit the application first (MuseScore→Quit)
2. Open Terminal (in Applications/Utilities, or via Spotlight search) and a session window should appear

3. Type (or copy/paste) the following command into your terminal line (include the '/' at the front):

/Applications/MuseScore\ 3.app/Contents/MacOS/mscore -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. Note that
you cannot quit the Terminal without quitting MuseScore. You can safely quit MuseScore, quit the Terminal, and then
reopen MuseScore in the normal fashion, ready to continue using.

For advanced users, the main MuseScore preference file is located at ~/Library/Preferences/org.musescore.MuseScore3.plist.
The other preferences (palettes, session, shortcuts, workspaces...) are in ~/Library/Application\ Support/MuseScore/MuseScore3/.

Instructions for Linux

The following is true for Ubuntu, and most likely all other Linux distributions and UNIX-style operating systems.

1. If you have MuseScore open, you need to quit the application first (File→Quit)
2. From the Ubuntu main menu, choose Applications→Accessories→Terminal. A Terminal session window should appear

3. Type, (or copy/paste) the following command into your terminal line (Ctrl+Shift+V to paste in Terminal):

mscore -F

Or, if you are using the AppImage version, you must first use the cd command to change directory to wherever you
saved the AppImage. For example, if you saved it to your Desktop (and there is only one):

cd ~/Desktop
./MuseScore*.AppImage -F

This resets all MuseScore preferences to factory settings and immediately launches the MuseScore application. You can
now quit Terminal, and continue using MuseScore.

For advanced users, the main MuseScore preference file is located at ${XDG_CONFIG_HOME:-
~/.config}/MuseScore/MuseScore3.ini.
The other preferences (palettes, session, shortcuts, workspaces, …) are in ${XDG_DATA_HOME:-
~/.local/share}/MuseScore/MuseScore3/.

See also

Command line options

Bug reports and Feature requests

Before filing bug reports or feature requests in the Issue Tracker  it is recommended first to post it in the relevant
Forum  so others may help establish a bug as genuine, or provide ideas and second opinions for new features.
Include a link to such discussion when creating the Issue.

Bug reports

Before posting in the issue tracker :

Try to reproduce the issue with the latest nightly . You may also view the version history  to check whether it has
been fixed/implemented already.

Please include as much of the following information as you know and limit each issue to one report:

Version/revision of MuseScore you are using (e.g. version 3.0, revision 871c8ce ). Check Help → About...
(Mac: MuseScore → About MuseScore...).
Operating system being used (e.g. Windows 10, macOS 10.15 or Ubuntu 20.04)
Describe the precise steps that lead to the problem (where do you click, what keys do you press, what do you
see, etc.).
If you are not able to reproduce the problem with the steps, it is probably not worth reporting it as the
developers will not be able to reproduce (and solve) it either. Remember that the goal of a bug report is not
only to show the problem, but to allow others to reproduce it easily.

Please remember:

Attach the score that shows the problem, at least a minimal example —use the "File attachments" option at the
bottom of the page, just above the Save and Preview buttons when you're typing your post.

Feature requests

224

https://musescore.org/project/issues
https://musescore.org/forum
https://musescore.org/project/issues
https://musescore.org/download#Development-builds
https://github.com/musescore/MuseScore/commits/master
https://github.com/musescore/musescore/commit/871c8ce


When posting in the Issue Tracker :

Be brief, but describe the goal as precisely as you can
Describe the context in which the new feature is intended to work
Suggest a specific workflow, if you can

Cross linking issues

When you write a comment in a forum topic, you can refer to an issue in the issue tracker using the following notation:
´[#number]´
That way the link in the comment will include the issue title and reflect the current status of the issue. Furthermore, it'll
lead to the forum topic being listed in the issue itself.
Type [#153286] get #153286: Change instrument causes a crash

External links

How to write a good bug report: step-by-step instructions  (MuseScore HowTo)
How to attach a file  (MuseScore HowTo)
Compose tips

Appendix

Atajos de teclado

La mayoría de los atajos de teclado se pueden personalizar a través del menú: select Edit→Preferences...→Shortcuts (Mac:
MuseScore→Preferences...→Shortcuts). A continuación hay una lista de los atajos de teclado predeterminados.

Navegación

Comienzo de la partitura: Home (Mac: Fn+←)
Última página de la partitura: End (Mac: Fn+→)
Buscar (número de compás, marca de ensayo, or pXX donde XX es un número de página): Ctrl+F (Mac: Cmd+F)

Siguiente partitura: Ctrl+Tab
Partitura anterior: Shift+Ctrl+Tab

Aumentar Zoom: Ctrl++ (no funciona en algunos sistemas) (Mac: Cmd++); or Ctrl (Mac: Cmd) + scroll up
Alejar Zoom: Ctrl+- (Mac: Cmd+-); or Ctrl (Mac: Cmd) + scroll down

Página siguiente: Pg Dn; or Shift + scroll down (Mac: Fn+↓)
Página anterior: Pg Up; or Shift + scroll up (Mac: Fn+↑)

Compás siguiente: Ctrl+→ (Mac: Cmd+→)
Compás anterior: Ctrl+← (Mac: Cmd+←)

Nota siguiente: →
Nota anterior: ←

Nota inferior (dentro de un acorde o en un pentagrama inferior): Alt+↓
Nota superior (dentro de un acorde o en un pentagrama más alto): Alt+↑

Nota más alta del acorde: Ctrl+Alt+↑ (Ubuntu usa este atajo de teclado para el Espacio de trabajo)
Nota inferior en el acorde: Ctrl+Alt+↓ (Ubuntu usa este atajo de teclado para el Espacio de trabajo)

Elemento siguiente (accessibilidad): Alt+→
Elemento anterior (accessibilidad): Alt+←

Introducción de notas

Iniciar el modo de introducción de notas: N
Salir del modo de introducción de notas: N o Esc

Duración

1 ... 9 selecciona una duración. Ver también Introducción de notas.

La mitad de la duración de la nota anterior: Q
El doble de la duración de la nota anterior: W
Disminuir la duración en un puntillo: (como en la versión 2.1) Shift+Q (por ejemplo una negra con puntillo se convierte en
una negra; una negra se convierte en una corchea con puntillo)
Aumentar la duración en un puntillo : (como en la versión 2.1) Shift+W (por ejemplo una corchea se convierte en corchea
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con puntillo; una corchea con puntillo se convierte en una negra)

Voces

Para seleccionar una voz en el modo de introducción de notas.

Voz 1: Ctrl+Alt+1 (Mac: Cmd+Alt+1)
Voz 2: Ctrl+Alt+2 (Mac: Cmd+Alt+2)
Voz 3: Ctrl+Alt+3 (Mac: Cmd+Alt+3)
Voz 4: Ctrl+Alt+4 (Mac: Cmd+Alt+4)

Alturas

Los tonos pueden ser introducidos por su nombre de letra (A-G), o a través de un teclado MIDI. Ver Note input para más
detalles.

Repetir nota o acorde anterior: R (la repetición puede ser de un valor de nota diferente seleccionando previamente
duration )

Repetir selección: R (La selección se repetirá desde la primera posición de la nota después del final de la selección)

Subir la nota una octava: Ctrl+↑ (Mac: Cmd+↑)
Bajar la nota una octava: Ctrl+↓ (Mac: Cmd+↓)

Subir la nota un semitono (preferiblemente sostenido): ↑
Bajar la nota un semitono (preferiblemente bemol): ↓
Subir la nota de manera diatónica: Alt+Shift+↑
Bajar la nota de manera diatónica: Alt+Shift+↓

Enarmonizar la nota tanto escrita_como en vista de_ tono de concierto: J
Enarmonizar la nota en la vista actual solo: Ctrl+J (Mac: Cmd+J)

Silencio: 0 (cero)

Intervalos

Añadir intervalo sobre la nota actual: Alt+[Number]

Diseño

Invertir dirección (plica, ligadura, corchete de tresillo, etc.): X
Invertir cabeza de nota: Shift+X
Aumentar ancho de compás(es): }
Reducir el ancho de compás(es): {
Salto de pentagrama en la barra de compás seleccionada: Return
Salto de página en la barra de compás seleccionada: Ctrl+Return (Mac: Cmd+Return)

Articulationes

Staccato: Shift+S
Tenuto: Shift+N
Sforzato (accent): Shift+V
Marcato: Shift+O
Notas de adorno (acciaccatura): /
Crescendo: <
Decrescendo: >

Introducción de Texto

Texto de pentagrama: Ctrl+T (Mac:Cmd+T)
Texto de sistema: Ctrl+Shift+T (Mac: Cmd+Shift+T)
Tempo text: Alt+Shift+T
Rehearsal Mark: Ctrl+M (Mac: Cmd+M)

Introducción de letra

Introducción de texto en una nota: Ctrl+L (Mac: Cmd+L)
Sílaba anterior: Shift+Space
Sílaba siguiente: Si la sílaba actual y la siguiente están separadas por '-': -, si no Space
Mover la sílaba a la izquierda 0.1sp: ←
Mover la sílaba a la derecha 0.1sp: →
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Mover la sílaba a la izquierda 1sp: Ctrl+← (Mac: Cmd+←)
Mover la sílaba a la derecha 1sp: Ctrl+→ (Mac: Cmd+→)
Mover la sílaba a la izquierda 0.01sp: Alt+←
Mover la sílaba a la derecha 0.01sp: Alt+→

Hasta la estrofa anterior: Ctrl+↑ (Mac: Cmd+↑)
Hasta la próxima estrofa: Ctrl+↓ (Mac: Cmd+↓)

Para más atajos de teclado sobre letra, ver Letras.

Mostrar

Línea de tiempo: F12 (Mac: Fn+F12)
Panel de reproducción: F11 (Mac: Fn+F11)
Mezclador: F10 (Mac: Fn+F10)
Paletas: F9 (Mac: Fn+F9)
Inspector: F8 (Mac: Fn+F8)
Teclado de piano: P
Filtro de selección: F6
Mostrar pantalla completa: Ctrl+U

Miscelánea

Hacer visible/invisible el elemento o elementos seleccionado(s): V
Mostrar diálogo de instrumentos: I
Activar/desactivar compases de espera: M
Reajustar el elemento a la ubicación predeterminada: Ctrl+R (Mac: Cmd+R)

Ver también

Preferences: Shortcuts

Command line options

MSCORE(1) — General Commands Manual Page

NAME

mscore, MuseScore3 — MuseScore 3 sheet music editor

SYNOPSIS

You can launch MuseScore from the command line by typing

mscore [options] [ filename …] (Mac and Linux/BSD/Unix)
musescore [options] [ filename …] (Linux/BSD/Unix)
MuseScore3.exe [options] [ filename …] (Windows)

[options] and [filename] are optional. For this to work the MuseScore executable must be in %PATH% (Windows) resp. $PATH
(Mac and Linux). If it is not, see Revert to factory settings for detailed instructions on how and where to find and execute
the MuseScore executable from the command line on the various supported platforms.

A more detailed synopsis follows:

mscore [-deFfhIiLmnOPRstvw]
[-a | --use-audio driver]
[-b | --bitrate bitrate]
[-c | --config-folder pathname]
[-D | --monitor-resolution DPI]
[-d | --debug]
[-E | --install-extension extension file]
[-e | --experimental]
[-F | --factory-settings]
[-f | --force]
[-h | -? | --help]
[-I | --dump-midi-in]
[-i | --load-icons]
[-j | --job file.json]
[-L | --layout-debug]
[-M | --midi-operations file]
[-m | --no-midi]
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[-n | --new-score]
[-O | --dump-midi-out]
[-o | --export-to file]
[-P | --export-score-parts]
[-p | --plugin name]
[-R | --revert-settings]
[-r | --image-resolution DPI]
[-S | --style style]
[-s | --no-synthesizer]
[-T | --trim-image margin]
[-t | --test-mode]
[-v | --version]
[-w | --no-webview]
[-x | --gui-scaling factor]
[--diff]
[--long-version]
[--no-fallback-font]
[--raw-diff]
[--run-test-script]
[--score-media]
[--score-meta]
[--score-highlight-config]
[--score-mp3]
[--score-parts]
[--score-parts-pdf]
[--score-transpose]
[--source-update]
[--template-mode]
[file ...]

DESCRIPTION

MuseScore is a Free and Open Source WYSIWYG cross-platform multi-lingual music composition and notation software,
released under the GNU General Public Licence (GPLv2).

Running mscore without any extra options launches the full graphical MuseScore program and opens any files specified
on the command line.

The options are as follows:

-a | --use-audio driver

Use audio driver: one of jack, alsa, portaudio, pulse

-b | --bitrate bitrate

Set MP3 output bitrate in kbit/s

-c | --config-folder pathname

Override configuration and settings directory

-D | --monitor-resolution DPI

Specify monitor resolution (override autodetection)

-d | --debug

Start MuseScore in debug mode

-E | --install-extension extension file

Install an extension file; soundfonts are loaded by default unless -e is also specified

-e | --experimental

Enable experimental features, such as layers

-F | --factory-settings

Use only the standard built-in presets (“factory settings”) and delete user preferences; compare with the -R option
(see also Revert to factory settings)

-f | --force
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Ignore score corruption and version mismatch warnings in “converter mode”

-h | -? | --help

Display an overview of invocation instructions (doesn’t work on Windows)

-I | --dump-midi-in

Display all MIDI input on the console

-i | --load-icons

Load icons from the filesystem; useful if you want to edit the MuseScore icons and preview the changes

-j | --job file.json

Process a conversion job (see EXAMPLES below)

-L | --layout-debug

Start MuseScore in layout debug mode

-M | --midi-operations file

Specify MIDI import operations file (see EXAMPLES below)

-m | --no-midi

Disable MIDI input

-n | --new-score

Start with the New Score wizard regardless whether it’s enabled or disabled in the user preferences

-O | --dump-midi-out

Display all MIDI output on the console

-o | --export-to file

Export the given (or currently opened) file to the specified output file. The file type depends on the extension of the
filename given. This option switches to “converter mode” and avoids the graphical user interface.

-P | --export-score-parts

When converting to PDF with the -o option, append each part’s pages to the created PDF file. If the score has no
parts, all default parts will temporarily be generated automatically.

-p | --plugin name

Execute the named plugin

-R | --revert-settings

Use only the standard built-in presets (“factory settings”) but do not delete user preferences; compare with the -F
option

-r | --image-resolution DPI

Set image resolution for conversion to PNG files. Default: 300 DPI (actually, the value of “Resolution” of the PNG
option group in the Export tab of the preferences)

-S | --style style

Load a style file first; useful for use with the -o option

-s | --no-synthesizer

Disable the integrated software synthesizer

-T | --trim-image margin

Trim exported PNG and SVG images to remove whitespace surrounding the score. The specified margin, in pixels,
will be retained (use 0 for a tightly cropped image). When exporting to SVG, this option only works with single-page
scores.
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-t | --test-mode

Set test mode flag for all files, includes --template-mode

-v | --version

Display the name and version of the application without starting the graphical user interface (doesn’t work on
Windows)

-w | --no-webview

Disable the web view component in the Start Center

-x | --gui-scaling factor

Scale the score display and other GUI elements by the specified factor; intended for use with high-resolution
displays

--diff

Print a conditioned diff between the given scores

--long-version

Display the full name, version and git revision of the application without starting the graphical user interface (doesn’t
work on Windows)

--no-fallback-font

Don’t use Bravura as fallback musical font

--raw-diff

Print a raw diff between the given scores

--run-test-script

Run script tests listed in the command line arguments

--score-media

Export all media (except MP3) for a given score as a single JSON document to stdout

--highlight-config

Set highlight to svg, generated from a given score

--score-meta

Export score metadata to JSON document and print it to stdout

--score-mp3

Generate an MP3 for the given score and export it as a single JSON document to stdout

--score-parts

Generate parts data for the given score and save them to separate mscz files

--score-parts-pdf

Generate parts data for the given score and export it as a single JSON document to stdout

--score-transpose

Transpose the given score and export the data to a single JSON file, print it to stdout

--source-update

Update the source in the given score

--template-mode

Save files in template mode (e.g. without page sizes)

MuseScore also supports the automatic Qt command line options .
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Batch conversion job JSON format

The argument to the -j option must be the pathname of a file comprised of a valid JSON document honoring the following
specification:

The top-level element must be a JSONArray, which may be empty.

Each array element must be a JSONObject with the following keys:

in: Value is the name of the input file (score to convert), as JSONString.
plugin: Value is the filename of a plugin (with the .qml extension), which will be read from either the global or per-
user plugin path and executed before the conversion output happens, as JSONString. Optional, but at least
one of plugin and out must be given.
out: Value is the conversion output target, as defined below. Optional, but at least one of plugin and out must be
given.

The conversion output target may be a filename (with extension, which decided the format to convert to), as
JSONString.

The conversion output target may be a JSONArray of filenames as JSONString, as above, which will cause the
score to be written to multiple output files (in multiple output formats) sequentially, without being closed, re-opened
and re-processed in between.

If the conversion output target is a JSONArray, one or more of its elements may also be, each, a JSONArray of two
JSONStrings (called first and second half in the following description). This will cause part extraction: for each such
two-tuple, all extant parts of the score will be saved individually, with filenames being composed by concatenating
the first half, the name (title) of the part, and the second half. The resulting string must be a valid filename (with
extension, determining the output format). If a score has no parts (excerpts) defined, this will be silently ignored
without error.

Valid file extensions for output are:

flac
Free Lossless Audio Codec (compressed audio)

metajson
various score metadata (JSON)

mid
standard MIDI file

midi
standard MIDI file

mlog
internal file sanity check log (JSON)

mp3
MPEG Layer III (lossy compressed audio)

mpos
measure positions (XML)

mscx
uncompressed MuseScore file

mscz
compressed MuseScore file

musicxml
uncompressed MusicXML file

mxl
compressed MusicXML file

ogg
OGG Vorbis (lossy compressed audio)

pdf
portable document file (print)

png
portable network graphics (image) — Individual files, one per score page, with a hyphen-minus followed by the
page number placed before the file extension, will be generated.

spos
segment positions (XML)

svg
scalable vector graphics (image)

wav
RIFF Waveform (uncompressed audio)

xml
uncompressed MusicXML file

See below for an example.

ENVIRONMENT
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SKIP_LIBJACK
Set this (the value does not matter) to skip initialization of the JACK Audio Connection Kit library, in case it causes
trouble.

XDG_CONFIG_HOME
User configuration location; defaults to ~/.config if unset.

XDG_DATA_HOME
User data location; defaults to ~/.local/share if unset.

Note that MuseScore also supports the normal Qt environment variables such as QT_QPA_GENERIC_PLUGINS,
QT_QPA_PLATFORM, QT_QPA_PLATFORMTHEME, QT_QPA_PLATFORM_PLUGIN_PATH, QT_STYLE_OVERRIDE, DISPLAY, etc.

FILES

/usr/share/mscore-3.0/ contains the application support data (demos, instruments, localization, system-wide plugins,
soundfonts, styles, chords, templates and wallpapers). In the Debian packages, system-wide soundfonts are installed into
/usr/share/sounds/sf2/, /usr/share/sounds/sf3/ or /usr/share/sounds/sfz/, respectively, instead.

The per-user data (extensions, plugins, soundfonts, styles, templates) and files (images, scores) are normally installed
into subdirectories under ~/MuseScore3/ but may be changed in the configuration. Note that snapshot, alpha and beta
versions use MuseScore3Development instead of MuseScore3 in all of these paths.

$XDG_CONFIG_HOME/MuseScore/MuseScore3.ini contains the user preferences, list of recently used files and their locations,
window sizes and positions, etc. See above for development version paths.

$XDG_DATA_HOME/data/MuseScore/MuseScore3/ contains updated localization files downloaded from within the program, plugin
information, cached scores, credentials for the musescore.com community site, session information, synthesizer settings,
custom key and time signatures and shortcuts. See above for development version paths.

EXAMPLES

Convert a score to PDF from the command line

mscore -o 'My Score.pdf' 'My Score.mscz'

Run a batch job converting multiple documents

mscore -j job.json

This requires the file job.json in the current working directory to have content similar to the following:

[
  {
    "in": "Reunion.mscz",
    "out": "Reunion-coloured.pdf",
    "plugin": "colornotes.qml"
  },
  {
    "in": "Reunion.mscz",
    "out": [
      "Reunion.pdf",
      [ "Reunion (part for ", ").pdf" ],
      "Reunion.musicxml",
      "Reunion.mid"
    ]
  },
  {
    "in": "Piece with excerpts.mscz",
    "out": [
      "Piece with excerpts (Partitura).pdf",
      [ "Piece with excerpts (part for ", ").pdf" ],
      "Piece with excerpts.mid"
    ]
  }
]

The last part of the job would, for example, cause files like “Piece with excerpts (part for Violin).pdf ” to be generated alongside the
conductor’s partitura and a MIDI file with the full orchestra sound, whereas the equivalent part of the Reunion conversion
will be silently ignored (because the Reunion piece (a MuseScore demo) has no excerpts defined).

MIDI import operations

The attached midi_import_options.xml  is a sample MIDI import operations file for the -M option.

DIAGNOSTICS

The mscore utility exits 0 on success, and >0 if an error occurs.
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SEE ALSO

fluidsynth(1), midicsv(1), timidity(1), qtoptions(7)

https://musescore.org/handbook

Online Handbook, full user manual

https://musescore.org/forum

Support Forum

https://musescore.org/en/node/278582

Reverting to factory settings (troubleshooting)

https://musescore.org/project/issues

Project Issue Tracker — Please check first to if the bug you’re encountering has already been reported. If you just
need help with something, then please use the support forum  instead.

http://doc.qt.io/qt-5/qguiapplication.html#supported-command-line-optio…

Documentation of automatic Qt command line options

STANDARDS

MuseScore attempts to implement the following standards:

MusicXML 3.1 (score interchange format)
SF2 (SoundFont 2.01)
SF3 (SoundFont with OGG Vorbis-compressed samples)
SFZ (Sforzato soundfont)
SMuFL (Standard Music Font Layout 1.20)

HISTORY

MuseScore was split off the MusE sequencer in 2002 and has since become the foremost Open Source notation software.

AUTHORS

MuseScore is developed by MuseScore BVBA and others.

This manual page was written by mirabilos <tg@debian.org >.

CAVEATS

The automatic Qt command line options are removed from the argument vector before the application has a chance at
option processing; this means that an invocation like mscore -S -reverse has no chance at working because the -reverse is
removed by Qt first.

BUGS

MuseScore does not honor /etc/papersize.

Probably some more; check the project’s bug tracker (cf. SEE ALSO).

MuseScore — January 12, 2021

New features in MuseScore 3.6

New score setup and layout features

MuseScore 3.6 introduces a new music font, Leland, a new default text font, Edwin (a version of New Century
Schoolbook), and many new default settings. It also introduces a number of new features which are available in all newly-
created scores by default, and which can also be applied automatically or manually to existing scores.

The three main features, which are interrelated, are:

Automatic instrument ordering
Automatic brackets and braces
Vertical justification of staves
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The first two features apply at score creation time and are available in the New Score Wizard, though they can also be
accessed later in the Instruments panel. Previously, it was up to the user to arrange instruments and add brackets
manually once the score was created. The aim of these new features is to save time and give a better default result in the
majority of cases, but it is not intended to accommodate every possible score setup. For unusual layouts, the results can
be customised after the score is created, the features can be turned off completely, or a template could be used.

Automatic instrument ordering

When creating a new score via 'Choose Instruments', there is now an 'Ordering' dropdown showing the current system of
instrument ordering. 'Orchestral' is the default. As instruments are added to the score, they will be added in the correct
position according to the select ordering. (Previously, each instrument would appear below whichever was currently
selected in the right-hand list.) This also makes it easy to, for instance, add a double wind section, by selecting Flute,
Oboe, Clarinet and Bassoon in the left-hand list, and clicking 'Add to score' twice.

Each ordering defines a position in the score for solo instruments. For example, in an orchestral ordering, this is above the
strings. With an instrument selected in the right-hand list, the 'Make soloist' button will move it to that position. You can
designate multiple soloists; within the soloist 'section' the overall ordering will apply. Solo instruments will have "solo"
added to their name by default, and will be numbered separately from non-solo instruments, where relevant. Note that the
soloist designation is a score layout feature only and has no impact on playback.

One quirk is that, for now, only a single soloist position is defined per ordering, so a work with a chorus plus both vocal
and instrumental soloists will place the instrumental soloists above the chorus. These will need to be moved manually.

As before, instruments can be moved up and down manually with the buttons that are now to the right of the list. In the
dropdown the ordering will have '(Customised)' appended to its name. The customised ordering is saved with the score.
You can reset the order by selecting the original ordering (or a different one) from the dropdown.

Selecting the 'Custom' ordering disables this feature entirely, as well as the automatic bracketing.

Automatic brackets and braces

The predefined ordering assigns instrument families (flutes, oboes, clarinets, etc.) and arranges those families into
sections (woodwind, brass, percussion, etc.). Brackets are added automatically according to these simple rules:

A heavy bracket is applied to all adjacent instruments of the same section, assuming there is more than one
a thin square bracket is applied to all adjacent identical instruments (four horns, for example)
a curly brace is applied to each single instrument which is notated on more than one stave (piano and harp, most
commonly)

Again, while this should provide reasonable defaults for most scores, it won't give perfect results for every possible style or
layout. Fortunately, it is easy to make adjustments once the score is created.

Vertical justification of staves

234



There is a new algorithm for vertically justifying staves to properly fill the page, which is turned on by default for new
scores in MuseScore 3.6. To turn this off, untick Format > Style > Page > Enable vertical justification of staves.

The basic principle of the algorithm is to try to make the space between staves equal, subject to two settings (all in
Format > Style > Page):

The space either side of a system may be increased proportionally by adjusting the "Factor for distance above/below
bracket" setting to a value greater than 1. For example, if this is set to 1.5, the algorithm will attempt to make the
space either side of a bracket 1.5 times the 'standard' space used elsewhere.
The same thing can be applied to braces with the "Factor for distance above/below brace" setting.

The space between a brace and bracket will be determined by the larger of these two values. The "Max. great staff
distance" setting is used to limit the amount of distance between staves joined by a curly brace. This is useful as these
staves generally need to be read at once in a single glance by the player.

The "Max. system distance" and "Max. stave distance" should have reasonably large values to enable the routine to fill
even quite sparse pages. Sometimes a page will not have enough staves for it to make sense to justify. In this case, once
the algorithm first equalises the space as described above, it then adds extra space between the staves up to a maximum
of the setting given in "Max. page fill distance" (multiplied by any relevant factor setting). If you find many pages are not
fully justified, but you'd like them to be, try adjusting this setting. In general, a low value is likely to be best for a score with
a small number of staves per system, and a larger one for larger numbers of staves.

The vertical justification is dynamic, and not tied to the section assignments of instruments used to determine the score
order at the setup stage, so if you add or remove brackets the spacing will change accordingly. In the same way, if empty
staves are hidden on a given system, the spacing will be determined only by the brackets which are present on that
system.

Hopefully the default settings give good results in most cases, but it might take a bit of experimentation with the settings
depending on the makeup of a score. If you are used to using spacers to achieve similar results, it is best to try to find
settings which give a good result for the majority of the score, and use spacers only where local adjustments are
necessary. It is planned for future versions to make this more configurable. For example, extra space could be suppressed
for a specific bracket, or the value might be increased or decreased for a particular page or system.

Indentation of first systems

This new option, which is turned on by default, is found in Style > Score > Enable indentation on first system. As the name
suggests, it will indent the first system of a section in the customary way for classical scores. (The old workaround of using
a frame for this is no longer necessary.) If there are instrument labels present, the maximum of either the value given for
this setting or the length of the labels will apply.

Applying new features to existing scores
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When opening an old score, a dialog box gives the option to apply either the new notation font Leland, or the new text font
Edwin, or both. Each of these applies a subset of the new default 3.6 style settings beyond just the font changes, for
example, line widths and text sizes, but does not apply every one of the the new defaults, in the interest of minimising
disruptive layout changes.

To apply all of the new defaults, including these text and notation font changes, open the Format > Style window and click
the "Reset All Styles to Default" button at the bottom. This was formerly the Format > Reset Style menu option. The button
behaves the same way, except that it no longer resets the page layout options which are set in the Format > Page
Settings window; that window now has its own equivalent button, which will reset only those settings it contains. This
means that the new style options can be tried out without completely ruining the layout of the score, though a few settings
in the Score and Page settings of the Style window may need to be re-set manually.

If it is an option, delete any non-essential system and page breaks, then select the whole score and select Format >
Stretch > Reset Layout Stretch. Also delete spacers if you want to see the default results of the new vertical justification
algorithm (see below).

Edwin has wider character sizes in general than FreeSerif (though slightly smaller default point sizes are used) so it is
quite likely that the Edwin option will cause layout changes, particularly in scores with lyrics. Leland will affect the spacing
less radically, but some adjustments may still be necessary.

Text items which have local style overrides applied will not have those customisations removed, either as part of the score
migration process, or via the Reset Styles options. This may result in an inconsistent score where some text retains its old
font face or size. The new menu option Format > Reset Text Style Overrides will remove these customisations, resetting
all text items to match the currently defined text styles. (This is equivalent to clicking 'Reset to style default' for each
attribute in the Text area of the Inspector.) Note that this does not remove Custom Formatting, which must be done
manually if required.

Applying new automatic instrument ordering and bracketing

Press I to open the Instruments panel, or choose the Edit > Instruments menu item. Assuming the score was created pre-
3.6, the selected ordering will be 'Custom'. If you wish to apply a standard ordering, select one from the menu, for
example 'Orchestral'. The instruments in the score will be reordered according to that definition, and have brackets and
braces applied accordingly. Note that any existing brackets and braces will be deleted.

Applying vertical justification of staves

If you want to use this feature but have previously been using spacers to create extra or fixed distance between staves, it
would be best to delete all those spacers first, as they will distort how the new algorithm works. A quick way to do this is
by right-clicking any spacer, choosing Select > All Similar Elements, and pressing Delete.

Turn this feature on by selecting Style > Page > Enable vertical justification of staves. Then you can reintroduce spacers if
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there are specific places where the default spacing needs adjustment.

Other engraving changes in 3.6

In the process of investigating style settings, engraving issues, and creating a new music font, many issues were
uncovered which needed to be corrected and which may have a small impact on the appearance of existing scores. In
some cases it is possible to undo these manually.

Beam spacing

A long-standing error in the interpretation of the beamDistance setting that is defined alongside SMuFL fonts meant that
this value was frequently half as big as it ought to be in MuseScore, including with Emmentaler and Bravura. (MuseScore
defines the distance between beams as a percentage of the thickness of a beam, but for SMuFL the setting is an absolute
distance in stave spaces. The normal thickness of a beam is 0.5sp, and the standard distance between beams is also
0.25sp, which MuseScore interpreted as 25% of 0.5sp, i.e. 0.125sp.)

The new correct interpretation of this value, 50%, will be applied even to existing scores, unless this value had been
explicitly overridden. The extra space is added inwards, so the position of the outermost beams remains the same. If you
really want the old, very-tight spacing, set Style > Beams > Beam distance manually to 25%.

Before (beam distance 25%):

After (beam distance 50%):

Ledger line length

In a similar way, MuseScore interpreted this SMuFL value as the total extension of the ledger line beyond the notehead
(i.e. x/2 at each side), when the value is meant to be the extension at each side. This error was also masked by a square
cap being used for the line, rather than a straight cap, thus also adding half of the line thickness at each end.

As with beam spacing, if this setting was not explicitly overridden in the file, a new default will be applied even in old
scores, but this will give identical results. If you did adjust this value, this value will be preserved, but will produce ledger
lines that are too long. You can convert the value manually with the formula:

new value = (x / 2) - (y / 2)

where x is the previous 'Ledger line length' value, and y is the 'Ledger line thickness' value. Or, just use the now correctly-
interpreted default settings for each font:

Leland: 0.35sp
Bravura, Gonville, Petaluma: 0.40sp
Emmentaler: 0.38sp

Stem caps and flag positions

Round caps were previously drawn on stems. This has been replaced with a flat cap. Partly this is to make the length of
the stem more exact, but mainly it is so that the round cap does not obscure the design of the tip of the flag symbols in
each font. Emmentaler's flags, for instance, are designed with a flat tip; Bravura and Leland have rounded tips which are
not exactly symmetrical.

The placement of flags was also previously at odds with SMuFL fonts: a calculation was made of how much to extend the
stem for a given number of flags, and then the flag symbol was drawn with the top or bottom of its bounding box at the
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end of the stem. Now, the presence of flags does not affect stem length (i.e. a normal length stem is used for a note
according to its vertical position and stem direction) and the flag symbol is then placed with its y=0 at the end of the stem.
Any 'extension' of the stem is thus determined by the extent to which the flag symbol extends above or below y=0. The
flags in Emmentaler, as used within MuseScore, have been repositioned to reflect this, and to match other SMuFL fonts.

The result of this is that flags may appear slightly lower or higher than they did previously; however, their positioning now
reflects the intentions of the designers of each of the available fonts. Beamed notes are not affected.

Before (Bravura, in 3.5):

After (Bravura, in 3.6):

Bracketed accidentals

Previously MuseScore did not add any space between the bounding boxes of accidentals and brackets around them. Now
a small amount of padding is added, which can be customised via Style > Accidentals > Padding inside parentheses.

Before (Bravura, in 3.5):

After (Bravura, in 3.6):

Accidentals in Emmentaler

These have been replaced with those taken from Parnassus. For details, see PR #6747 .

New features in MuseScore 3

MuseScore 3 includes a number of new and improved features. For a brief summary, see the Release notes for
MuseScore 3 . More details can be found in the summaries below and by referring to the relevant pages of the
handbook.

Automatic Placement

MuseScore initially places elements in the score according to (a) the properties specified in style defaults and (b) any
manual adjustments made. For elements that have automatic placement enabled, however, MuseScore will attempt to
avoid collisions by moving one or more of them as needed.
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See Automatic placement.

Default position

The default position for most elements is controlled by settings in Format → Style. You can either change the default
there, or, in the Inspector, apply a manual adjustment (see below) and then use the "Set as style" control (the S to the
right of the value you wish to set).

The specific properties you can set vary by element type but include:

placement (whether the element appears above or below the staff by default)
position above/below (specific positions when placed above or below)
offset (same as position above/below, for which placement is the default)
autoplace min distance (minimum distance from other elements when autoplace is enabled)

See Automatic placement.

Manual adjustments

Many elements can be placed either above or below the staff. To flip an element from above to below or vice versa, use
the "Placement" setting in the Inspector, or press the shortcut "X".

Manual adjustments to position can be performed by dragging or by changing the offsets in the Inspector. Neither method
will allow you to position an element in a way that causes a collision, however. To take full control of the position of an
element, you can disable automatic placement for it.

See Automatic placement.

Disabling automatic placement

To disable automatic placement for an element, untick the "Automatic placement" box in the Inspector. The element will
revert to its default position, and it will no longer be considered when automatically placing other elements.

See Automatic placement.

Stacking order

The "Stacking order" setting in the Inspector controls which elements overlap which in the cases where they actually do
overlap and are not moved due to autoplacement.

See Automatic placement.

Text Formatting

Formatting of text is controlled by three factors:

The text style associated with the element sets the defaults for properties such as the font, alignment, and frame.
Changes to these text properties can be applied to selected elements via the Inspector.
Custom formatting can be applied to specific characters within the text using the text toolbar.

See Text basics, Text styles and properties.

Text Styles

Each text element has a text style associated with it. The default style for an element is determined by the type of the
element itself - staff text defaults to the Staff text style, dynamics to the Dynamics text style, etc. This text style determines
the default font face, size, style (bold/italic/underline), alignment, and frame properties.

You can change the defaults for any of these text styles using Format → Style → Text Styles. For instance, you can make
rehearsal marks bigger, or change lyrics to be italicized. This will affect all existing elements using that style as well as
elements you add later. Some elements also contain a limited set of text style controls in their own sections of the Format
→ Style dialog (although this might not be the case in the final release). The settings are linked: you can change the font
size for measure numbers in either Format → Style → Measure Numbers, or in Format → Style → Text Styles: Measure
Number. The effect is the same: all measure numbers in the score will take on this size. You can also change the defaults
for a text style using the Inspector; see Text Properties below.

For most text elements that you create directly (like staff text, rehearsal marks, and lyrics), you can apply a different text
style using the Style control in the Inspector. This will cause them to display using that style instead of the "native" style for
the element. For example, you can select one or more staff text elements and give them the Tempo style to force them to
display as if they were tempo markings.

See Text basics, Text styles and properties.
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Text Properties

The text style controls the default properties for elements using that style, but you can override any of these properties for
selected elements using the Inspector. For example, you can select a handful of staff text elements using Ctrl+click, then
use the Inspector to make them larger. The Reset to Default button next to each property control returns it to the default.
You can also click the Set as Style button to change the style to match. So another way to change the size of all
measures numbers is to select one, change its size in the Inspector, then click Set as Style.

See Text basics, Text styles and properties.

Custom Formatting

Custom formatting is applied to text using the toolbar at the bottom of the main window in the same manner as in previous
releases. Thus, you can embolden one word in a sentence while the rest is normal, or superscript a particular character
etc. You can also remove all custom formatting from select text elements using the "Remove Custom Formatting" button
in the Inspector. This returns the text to the settings currently shown in the Inspector.

See Text editing.

Staff Type Change

You can change various staff properties mid-score, including staff size, notehead scheme (e.g., for pitch name
noteheads), generation of time signatures, and others. The staff type change element is found on the Text palette
(currently, but see #278205: Move Staff Type Change to another palette (it is not text)  - it may move). Add it to the
measure where you want the change to occur, then use the Inspector to change properties of the staff type change
element.

See Staff Type Change

Temporary and Cutaway Staves

To create a temporary staff that appears on certain systems only: first add the staff normally (Edit / Instruments), then add
notes, then right-click the staff, click Staff Properties, and set "Hide when empty" to "Always". This will cause the staff to
show only where needed even without needing to turn on "Hide empty staves" for the whole score (in Format / Style). The
default for "Hide when empty" is "Auto", meaning the staff will be hidden when empty if "Hide empty staves" is enabled.
Additional values include "Never" (the staff will not be hidden when empty even if "Hide empty staves" is enabled) and
"Instrument" (for instruments containing multiple staves, the staff is hidden only if all staves for that instrument are empty).

To create a cutaway staff in which only the measures containing notes are visible (for ossia or cutaway scores, for
example), right-click the staff, click Staff Properties, and enable the "Cutaway" option. This can be used independently of
"Hide when empty" or "Hide empty staves".

System Dividers

System dividers are a set of short diagonal lines that are used to visually separate systems on a page. MuseScore can
add these to your score automatically. In Format → Style → System, you can enable dividers on the left, right, or both,
and you can set their default position. You can also adjust the position of individual dividers in your score manually or
mark them invisible (this currently does not survive saving).

Staff Spacing

As part of the automatic placement in MuseScore, staves are now spaced automatically, so you can set a comfortable
minimum distance and depend on MuseScore to open up more space where needed. You can use staff spacers as in
MuseScore 2 to increase distance between staves, but MuseScore 3 now also provides a way to decrease it—the "fixed"
staff spacer, found on the Breaks & Spacers palette. Just add the spacer and adjust its height. This will also prevent
MuseScore from automatically adding more space to avoid collisions, allowing you to manage this yourself.

See Spacers.

Don't Break

Currently disabled

In addition to the system, page, and section breaks familiar from MuseScore 2, the "Breaks & Spacers" palette now
contains a new "Don't Break" element. This allows you to force two measures to be kept together, for example, if there is
some complex passage that spans the measures and you want to make sure they are adjacent. If both measures don't fit
on a system, MuseScore moves them both to the next system. (currently, this leaves a "hole" at the end of the first staff -
is this a bug or is there some purpose behind it?)

Parts from Voices
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In addition to the ability to generate parts from the different instruments in your score, you can now also associate a part
with a specific staff within the instrument or even a specific voice within a specific staff. This allows you to combine
multiple parts (e.g., Flute 1 & 2) onto a single staff in the score while still generating separate parts.

The Parts dialog now contains two sections at the bottom, Instruments in Score and Instruments in Part. Once you have
generated a part (or all parts) using the New and New All buttons, you can select any part at the top and use the controls
at the bottom to control not only what instrument is in the part, but also which staves and voices within the instrument are
included.

To add an instrument to a part, select it from "Instruments in Score" and press "+". To remove an instrument from a part,
select it from "Instruments in Part" and press "-". To customize the part at the staff or voice level, click the arrow next to
the instrument in "Instruments in Part" to expand the listing to show all staves and voices of the instrument. You can
remove a staff by selecting it and pressing "-", or remove a voice by unchecking it.

Limitations: If you select only voice 1 for a given staff, then only the content in voice 1 for that staff will be included in the
part. Thus, in order to share flute 1 & 2 on the same staff, you will need to enter all notes onto both voices, even in
passages where they share content. You also cannot enter the two parts as chords in the passages where they share
rhythms.

Explode and Implode

Explode has been updated to allow separation of voices as well as notes. See Explode.

The implode tool (Tools / Implode) works in one of two modes.

With a single staff selected, the implode command merges notes in different voices into chords where possible (when
notes are on the same beat and have the same duration). This is the same as recent versions of MuseScore, although
some bugs have been fixed.

With multiple staves selected, the implode command combines the content of the first four non-empty voices (on any
staves) into multiple voices on the top selected staff. This is different from MuseScore 2, where notes would be combined
into chords rather than using multiple voices, and thus required the rhythms to match. The MuseScore 3 approach
preserves the original rhythms even where they differ, and is intended to produce the expected results when combining
two different parts onto one staff for use with the parts from voices feature, or when reducing an open (four-stave) SATB
score into a closed (two-stave) version. To further merge the voices into chords where possible, simply run the command
again.

See Tools.

Insert mode

You can insert and delete notes and have the measure automatically expand or contract to accommodate the change.
This can be useful in creating unmetered music or in ordinary editing.

To insert a note before the currently-selected note, press Ctrl+Shift while adding the note normally. For example, in note
input mode, Ctrl+Shift+click will insert a note of the currently-selected duration at that location. Ctrl+Shift+B will insert a B of
the currently-selected duration before the note at the current cursor position. You can also switch to Insert mode using the
dropdown menu next to the note input button on the toolbar. In this mode, all notes you add act as if you were pressing
Ctrl+Shift - they are inserted rather than replacing the existing notes or rests at that location.

To delete notes, you must be in normal (not note input) mode. Select either a single note or a range and press Ctrl+Del.

See Note input modes, Remove selected range (Tools)

Split/Join Measures

To split a measure before a given note, simply insert a barline from the palette at that point while holding Ctrl. For example,
you can select the note, and Ctrl+double-click the barline in the palette, or Ctrl+drag the barline to the note. You can also
use Tools → Measure → Split Measure Before Selected Note/Rest.

To join two measures, Ctrl+Del the barline between them. You can also use the menu command Tools → Measure → Join
Measures.

See Measure operations.

Timeline

The Timeline presents a graphical overview of your score. To access it, use View →Timeline (F12). The top portion of the
Timeline shows the location of tempo, key, and time signature changes as well as rehearsal marks, repeats, and double
barlines. The bottom portion shows the staves of your score, with non-empty measures highlighted. You can click
anywhere within this view to jump to the corresponding spot in the score.
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See Timeline

Score Comparison Tool

The Score Comparison Tool (View / Score Comparison Tool) allows you to compare two versions of a score to find the
differences between them. Select the two scores you want to compare and whether you want to compare the current
version or the last saved version (note you can compare the current version of a score against the last saved version of
the same score to see what you have changed since the last save), then click the Compare button. A list of differences
will be displayed to the right. The score view will automatically change to Documents Side by Side, with the two scores
you have selected displayed within. Double-click on a difference from the list and both score views will automatically pan
to show you the changed element, which will also be highlighted.

Normally you would want the default Intelligent comparison, which displays the differences in human-readable format (e.g.
"Measure 1: Note: property pitch changed from B4 to C5"). There is also a Raw mode to show the results according to the
actual XML code.

See Score comparison.

Mixer

See Mixer.

Piano Roll Editor

See Piano roll editor (preliminary page).

Capo changes

Capo changes are now a property of staff text, and can be used to automatically change the pitch of all notes that follow
them, up until another capo change.

See Capo playback.

Fretboard Diagrams

New UI. See Fretboard diagrams.

External links

Release notes for MuseScore 3.x
Transitioning from version 2 to version 3

Known limitations of MuseScore 3.x

While all members of the development team did their best to make the software easy to use and bug-free, there are some
known issues and limitations in MuseScore 3.x.

Local time signatures

The local time signature feature, which allows you to have different time signatures in different staves at the same time, is
very limited. You can only add a local time signature to measures that are empty, and only if there are no linked parts.
When adding notes to measures with local time signatures, you can enter notes normally via note input mode, but copy
and paste does not work correctly and may lead to corruption or even crashes. The join and split commands are disabled
for measures with local time signatures.

Regroup Rhythms

The Regroup Rhythms command found under the Tools menu may have unintended side effects, including changing the
spelling of pitches and deleting some elements like articulations, glissandos, tremolos, grace notes and, esp. on undo,
ties. Use this tool with caution on limited selections, so that you can tell if any unwanted changes are made.

Tablature staff linked with standard staff

When entering multiple-note chords on a standard staff in a linked staff/tablature system, the notes should be entered in
order from the top (first) string to the bottom string to ensure correct fret assignment.

This limitation does not apply if entering notes directly onto a tablature staff, or when using an unlinked staff/tablature
system.
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Mixer

Changing settings in the mixer other than the sound doesn't mark the score 'dirty'. That means if you close a score you
may not get the warning "Save changes to the score before closing?". Changing mixer values are also not undoable.

Header & footer

There is no way to edit Header and Footer in a WYSIWYG manner. The fields in Format → Style → Header, Footer are
plain text. They can contain "HTML like" syntax, but the text style, layout, etc. can't be edited with a WYSIWYG editor.

Upgrade from MuseScore 1.x or 2.x

How to upgrade MuseScore

Download and install the latest version from the download  page as described at Installation.

Installing MuseScore 3 won't uninstall 1.x nor 2.x —all three versions can coexist peacefully and can even be used in
parallel. So this isn't really an upgrade but an installation of a new and different program.

Opening 1.x or 2.x scores in MuseScore 3

MuseScore 3 significantly improved the typesetting quality to make scores attractive and easier to read. Improvements
cover many items such as beam slope, stem height, layout of accidentals in chords and general note spacing. However,
this means that sheet music made with MuseScore 1.x or 2.x looks slightly different from sheet music made with 3.x.

It also means that scores saved with 3.x won't open with 1.x nor 2.x.

To prevent you from accidentally overwriting your 1.x or 2.x scores, 3.x treats them as an import, which means:

The score gets marked as being modified, even if you haven't changed anything
On exiting MuseScore you're asked to save the score (as a result from the above)
MuseScore uses the "Save As" dialog to save it, not the "Save" dialog
MuseScore uses the score's title to create a default filename rather than taking the old filename

Relayout

If you did not manually adjust the layout of a 1.x or 2.x score, then MuseScore uses the 3.x typesetting engine to layout
the score. If you did touch the layout of the 1.x or 2.x score, the individual adjustments you may have made should remain
after opening it in MuseScore 3.x, but due to slight changes in the surrounding layout they may still not appear correct in
context. If you wish to reset even manual adjustments to use the 3.x typesetting engine throughout, select the complete
score with the shortcut Ctrl+A (Mac: Cmd+A) and reset the layout with Ctrl+R (Mac: Cmd+R).

Note: When you open a 1.x or 2.x file in MuseScore 3, it will ask you if you want to reset the layout to the defaults.

Getting the sound from MuseScore 1.x

While the sound in 2.x/3.x has been much improved, you may still prefer the sound from MuseScore 1.x. In that case, you
can get the 1.x sound in 3.x by downloading the 1.3 SoundFont and add it in 3.x. You can do this in two steps:

1. Download the 1.3 SoundFont named TimGM6mb
2. Install and use the TimGM6mb SoundFont in 2.0

Known incompatibilities

Hardware incompatibilities

The following software is known to crash MuseScore on startup:

Samson USB Microphone, driver name "Samson ASIO Driver", samsonasiodriver.dll. More info
Digidesign MME Refresh Service. More info
Windows XP SP3 + Realtek Azalia Audio Driver. More info
Wacom tablet. More info  and QTBUG-6127

Software incompatibilities

Maple virtual cable is known to prevent MuseScore  from closing properly.
KDE (Linux) window settings can cause the whole window to move when dragging a note. Changing the window
settings of the operating system  avoids the problem.
Nitro PDF Creator may prevent MuseScore 2 from starting  on Windows 10, if being used as the default printer.
Same for Amyumi/Quickbooks PDF Printer, see here  and also some cloud printing services, see here .
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Creative Sound Blaster Z Series ASIO driver may prevent MuseScore 2 from starting  on Windows 10.
Untrusted Font Blocking policy prevents MuseScore 2 from starting  (except in debug mode, i.e. using the -d
option) on Windows 10. (Solution in the links provided here )
The SteelSeries Engine 3 Audio Visualizer will prevent MuseScore from starting up, or cause MuseScore to crash if
the Audio Visualizer is started when MuseScore is already running.

AVG Internet Security hangs MuseScore

MuseScore requires access to your internet connection with AVG. MuseScore doesn't need an internet connection to
function, but if AVG blocks it, MuseScore hangs.

If AVG prompts you, Allow MuseScore and check "Save my answer as a permanent rule and do not ask me next time."

If it doesn't prompt you anymore,

1. Open the AVG user interface (right-click on the AVG icon, close to your clock -> Open AVG User Interface)
2. Click on Firewall
3. Click Advanced Settings
4. Click Applications
5. Find MSCORE.EXE in the list and double-click it
6. Change Application Action to Allow for All

Font problem on macOS

MuseScore is known to display notes as square when some fonts are damaged on macOS.
To troubleshoot this issue:

1. Go to Applications -> Font Book
2. Select a font and press ⌘+A to select them all
3. Go to File -> Validate Fonts
4. If any font is reported as damaged or with minor problems, select it and delete it
5. Restart MuseScore if necessary

In this forum article , a user believes to have found the font "Adobe Jenson Pro (ajenson)" to be the culprit, regardless of
not being reported as broken, or problematic as per the above validation, and solved the problem by deleting that font, so
this is worth checking too.

Font problem on Linux

If the default desktop environment application font is set to bold, MuseScore will not display the notes properly.
To troubleshoot this issue (gnome 2.*/MATE users):

1. Right-click on your desktop and select Change Desktop background
2. Click on Fonts tab
3. Set Regular style for Application font
4. Restart MuseScore if necessary

For GNOME 3/SHELL users

1. Open the shell and open "Advanced Settings"
2. Click on the Fonts option in the list
3. Set the default font to something non-bold
4. Restart MuseScore if necessary

Save As dialog empty on Linux

Some users reported that the Save As dialog is empty on Debian 6.0 and Lubuntu 10.10.
To troubleshoot this issue:

1. Type the following in a terminal

which mscore

2. The command will answer with the path of mscore. Edit it with your preferred text editor and add the following line at
the beginning

export QT_NO_GLIB=1

Launch MuseScore and the problem should be solved.

Glossary

The glossary is a work in progress—please help if you can. You can discuss this page in the documentation forum .
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The list below is a glossary of frequently used terms in MuseScore as well as their meaning. The differences between
American English and British English are marked with "(AE)" and "(BE)", respectively.

A

Acciaccatura

 A short →grace note which appears as a small note with a stroke through the stem. It is quickly executed and
technically takes no value from its associated note.

Accidental
A sign appearing in front of a note that raises or lowers its pitch. The most common accidentals are →sharps, →flats
or →naturals, but double sharps and double flats are also used. Also →koron, and →sori and other quarter tone
accidentals. Accidentals affect all notes on the same →staff position only for the remainder of the measure in which
they occur, but they can be canceled by another accidental. In notes tied across a →barline, the accidental
continues across the →barline to the tied note, but not to later untied notes on the same →staff position in that
measure.

Ambitus
Note (or vocal) range used in a →staff. Used particularly in Early Music

Anacrusis
See →Pickup measure.

Anchor
The point of attachment to the score of objects such as Text and Lines: When the object is dragged, the anchor
appears as small brown circle connected to the object by a dotted line. Depending on the object selected, its anchor
may be attached to either (a) a note (e.g. fingering), (b) a staff line (e.g. staff text), or (c) a barline (e.g. repeats).

Appoggiatura
A long →grace note which takes value from its associated note. Its functions include: passing tone, anticipation,
struck suspension, and escape tone.

Arpeggio
An arpeggio tells the performer to break up the chord into the constituent notes, playing them separately and one
after the other. An arrow on the arpeggio indicates the direction in which the player should play the notes of the
chord.

B

Bar (BE)
See →measure.

Barline
Vertical line through a →staff, staves, or a full →system that separates →measures.

Beam
Notes with a duration of an →eighth  or shorter either carry a →flag or a beam. Beams are used for grouping
notes.

BPM
Beats Per Minute is the unit for measuring tempo, traditionally counted in quarter note durations. See →metronome
mark

Breve
Brevis

A double whole note or breve is a note that has the duration of two whole notes.

C

Caesura
A caesura (//) is a brief, silent pause. Time is not counted for this period, and music resumes when the director
signals.

Cent
An interval equal to one hundredth of a semitone.

Chord
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A group of two or more notes sounding together. To select a chord in MuseScore, press Shift and click on a note. In
the Inspector, however, the word "Chord" only covers notes in the same voice as the selected note(s).

Clef
Sign at the beginning of a →staff, used to tell which are the musical notes on the lines and between the lines.
Clefs are very useful for →transposition.

Concert pitch
Enables you to switch between concert pitch and transposing pitch (see Concert pitch and Transposition).

Crotchet (BE)
See →Quarter note.

D

Double Flat
A double flat (♭♭ or �) is a sign that indicates that the pitch of a note has to be lowered two semitones.

Double Sharp
A double sharp (♯♯ or �) is a sign that indicates that the pitch of a note has to be raised two semitones.

Demisemiquaver (BE)
A thirty-second note.

Duplet
See →tuplet.

Dynamic
A symbol indicating the relative loudness of a note or phrase of music—such as mf (mezzoforte), p (piano), f (forte)
etc., starting at that note.

Dynamic, Single note
A dynamic marking which applies only to one note—such as sfz (sforzando), fp (fortepiano) etc.

E

Edit mode
The program mode from which you can edit various score elements.

Eighth note
A note whose duration is an eighth of a whole note (semibreve). Same as a quaver (BE).

Endings
See →volta.

Enharmonic notes
Notes that sound the same pitch but are written differently. Example: G♯ and A♭ are enharmonic notes.

F

Flag
See →beam.

Flat
Sign (♭) that indicates that the pitch of a note has to be lowered one semitone.

G

Grace note
Grace notes appear as small notes in front of a normal-sized main note. See →acciaccatura and →appoggiatura.

Grand Staff (AE)
Great Stave (BE)

A system of two or more staves, featuring treble and bass clefs, used to notate music for keyboard instruments and
the harp.

H

Half Note
A note whose duration is half of a whole note (semibreve). Same as a minim (BE).

Hemidemisemiquaver (BE)
A sixty-fourth note.

I

Interval
The difference in pitch between two notes, expressed in terms of the scale degree (e.g. major second, minor third,
perfect fifth etc.). See Degree (Music)  (Wikipedia).

J

Jump
In MuseScore, "jumps" are notations such as "D.S. al Coda", found in the "Repeats & Jumps" palette.
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K

Key Signature
Set of →sharps or →flats at the beginning of the →staves. It gives an idea about the tonality and avoids repeating
those signs all along the →staff.
A key signature with B flat means F major or D minor tonality.

Koron
An Iranian →accidental which lowers the pitch of a note by a quarter tone (in comparison to the →flat which lowers a
note by a semitone). It is possible to use this accidental in a →key signature.
See also →Sori.

L

Longa
A longa is a quadruple whole note.

Ledger Line
Line(s) that are added above or below the staff.

M

Measure (AE)
A segment of time defined by a given number of beats. Dividing music into measures provides regular reference
points to pinpoint locations within a piece of music. Same as → bar (BE).

Metronome mark
Metronome marks are usually given by a note length equaling a certain playback speed in →BPM. In MuseScore,
metronome marks are used in Tempo texts.

Minim (BE)
See →Half note.

N

Natural
A natural (♮) is a sign that cancels a previous alteration on notes of the same pitch.

Normal mode
The operating mode of MuseScore outside note input mode or edit mode: press Esc to enter it. In Normal mode you
can navigate through the score, select and move elements, adjust Inspector properties, and alter the pitches of
existing notes.

Note input mode
The program mode used for entering music notation.

O

Operating System
OS

Underlying set of programs which set up a computer, enabling additional programs (such as MuseScore). Popular
OSes are Microsoft Windows, macOS, and GNU/Linux.
Not to be confused with a sheet music →system.

P

Part
Music to be played or sung by one or a group of musicians using the same instrument. In a string quartet, 1st part =
Violin 1, 2nd part = Violin 2, 3rd part = Viola, 4th part = Cello, in a choir there might be parts for soprano, alto, tenor
and bass. A part has one or more →staves (e.g. Piano has 2 staves, Organ can have 2 or 3 staves).

Pickup Measure (also known as an Anacrusis or Upbeat)
Incomplete first measure of a piece or a section of a piece of music. See Measure duration and Create new score:
Pickup measure. Also Exclude from measure count.

Q

Quadruplet
See →tuplet.

Quarter note
A note whose duration is a quarter of a whole note (semibreve). Same as a crotchet (BE).

Quaver (BE)
See →eighth note.

Quintuplet
See →tuplet.

R
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Respell Pitches
Tries to guess the right accidentals for the whole score (see Accidentals).

Rest
Interval of silence of a specified duration.

Re-pitch mode
Allows you to rewrite an existing passage of music by changing the note pitches without altering the rhythm.

S

Semibreve (BE)
A whole note (AE). It lasts a whole measure in 4/4 time.

Semiquaver (BE)
A sixteenth note.

Semihemidemisemiquaver (Quasihemidemisemiquaver) (BE)
An hundred and twenty eighth note.

Sextuplet
See →tuplet.

Slash chord
See Slash chord  (Wikipedia).

Slash notation
A form of music notation using slash marks placed on or above/below the staff to indicate the rhythm of an
accompaniment: often found in association with chord symbols. There are two types: (1) Slash notation consists of a
rhythm slash on each beat: the exact interpretation is left to the player (see Fill with slashes); (2) Rhythmic slash
notation indicates the precise rhythm for the accompaniment (see Toggle rhythmic slash notation).

SFZ
A virtual instrument format supported by MuseScore (along with →SoundFonts). An SFZ library consists of one or
more SFZ text files, each defining a particular instrument setup, and many audio sound samples.

Sharp
Sign (♯) that indicates that the pitch of a note has to be raised one semitone.

Slur
A curved line over or under two or more notes, meaning that the notes will be played smooth and connected
(legato).
See also →tie.

Sori
An Iranian →accidental which raises the pitch of a note by a quarter tone (in comparison to the sharp which raises it
by a semitone). It is possible to use this accidental in a →key signature.
See also →Koron.

SoundFont
A virtual instrument format supported by MuseScore (along with →SFZ). A SoundFont is a special type of file
(extension .sf2, or .sf3 if compressed) containing sound samples of one or more musical instruments. In effect, a
virtual synthesizer which acts as a sound source for MIDI files. MuseScore 2.2 comes with the SoundFont
"MuseScore_General.sf3" pre-installed.

Spatium (plural: Spatia) / Space / Staff Space / sp. (abbr./unit)
The distance between the midpoints of two lines of a music staff (or one-quarter the size of the full five-line staff,
assuming a hypothetical staff line thickness of 0). The sizes of most elements in the score are based on this setting
(see Page settings).

Staff (AE) / Staves (plural)
A set of lines and spaces, each representing a pitch, on which music is written. In ancient music notation (before
11th century) the staff may have any number of lines.

Staff Space
See Spatium (above).

Stave (BE)
See Staff (above).

Step-time input
MuseScore's default note input mode, allowing you to enter music notation one note (or rest) at a time.

System
Set of staves to be read simultaneously in a score.
See also →Operating System (OS).

T

Tie

A curved line between two or more notes on the same pitch to indicate a single note of combined duration:

Quarter note + Tie + Quarter note = Half note
Quarter note + Tie + Eighth note = Dotted Quarter note
Quarter note + Tie + Eighth note + Tie + 16th note = Double Dotted Quarter note
See also →slur.

Transposition

The act of moving the pitches of one or more notes up or down by a constant interval. There may be several
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The act of moving the pitches of one or more notes up or down by a constant interval. There may be several
reasons for transposing a piece, for example:

1. The tune is too low or too high for a singer. In this case the whole orchestra will have to be transposed as well
—easily done using MuseScore.

2. The part is written for a particular instrument but needs to be played by a different one.
3. The score is written for an orchestra and you want to hear what the individual instruments sound like. This

requires changing the transposing instrument parts to concert pitch.
4. A darker or a more brilliant sound is desired.

Triplet
See →tuplet.

Tuplet
A tuplet divides its next higher note value by a number of notes other than given by the time signature. For example
a →triplet divides the next higher note value into three parts, rather than two. Tuplets may be: →triplets, →duplets,
→quintuplets, and other.

U

Upbeat
See →pickup measure.

V

Velocity
The velocity property of a note controls how loudly the note is played. This usage of the term comes from MIDI
synthesizers. On a keyboard instrument, it is the speed with which a key is pressed that controls its volume. The
usual scale for velocity is 0 (silent) to 127 (maximum).

Voice
Polyphonic instruments like Keyboards, Violins, or Drums need to write notes or chords of different duration at the
same time on the same →staff. To write such things each horizontal succession of notes or chords has to be written
on the staff independently. In MuseScore you can have up to 4 voices per staff. Not to be confused with vocalists,
singing voices like soprano, alto, tenor and bass, which are better viewed as instruments.

Volta
In a repeated section of music, it is common for the last few measures of the section to differ. Markings called voltas
are used to indicate how the section is to be ended each time. These markings are often referred to simply as
→endings.

External links

http://www.robertcarney.net/musical-terms-definitions.htm
https://en.wikipedia.org/wiki/List_of_musical_symbols
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